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PROPRIETARY NOTICE

The product information and design disclosed herein were 
originated by and are the property of Bosch Security Systems, Inc. 
Bosch reserves all patent, proprietary design, manufacturing, 
reproduction, use and sales rights thereto, and to any article 
disclosed therein, except to the extent rights are expressly granted 
to others.

COPYRIGHT NOTICE

Copyright 2012 by Bosch Security Systems, Inc. All rights 
reserved. Reproduction, in whole or in part, without prior written 
permission from Bosch is prohibited.

*All other trademarks are property of their respective owners.

**MOTOROLA and the Stylized M logo are registered in the U.S. 
Patent and Trademark Office.

WARRANTY AND SERVICE INFORMATION

For warranty and service information, refer to www.telex.com/
warranty.

FACTORY SERVICE CENTER

Factory Service Center
Bosch Security Systems, Inc.
Radio Dispatch Products
8601 East Cornhusker Highway
Lincoln, Nebraska, 68507

PHONE NUMBERS

Sales:

Phone (800) 752-7560

Fax(402) 467-3279

E-mailTelexDispatch@us.bosch.com

Customer Service Repair:(800) 553-5992

Technical Support:

Phone (800) 898-6723

E-mailTelexDispatchtechsupport@us.bosch.com

CLAIMS

No liability will be accepted for damages directly or indirectly 
arising from the use of our materials or from any other causes. Our 
liability shall be expressly limited to replacement or repair of 
defective materials.
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Bosch Security Systems, Inc.
Telex Radio Dispatch C-Soft and 
Network Recorder Application
End User Software License Agreement

8601 E. Cornhusker Highway

P.O. Box 5579
Lincoln, Nebraska 68507, USA
Tel. +1 402 467 5321
Fax +1 402 467 3279
www.telex.com

            IMPORTANT INFORMATION 

PLEASE READ THIS END USER LICENSE AGREEMENT (THE 
“LICENSE”) CAREFULLY BEFORE OPENING THE PACKAGE 
AND/OR USING THE CONTENTS THEREOF AND/OR BEFORE 
DOWNLOADING OR INSTALLING THE SOFTWARE PROGRAM.  

IF YOU DO NOT AGREE TO THIS LICENSE DO NOT OPEN THE 
PACKAGE AND/OR DOWNLOAD AND/OR INSTALL THE SOFT-
WARE AND PROMPTLY (AND IN ANY EVENT, WITHIN 7 DAYS 
FROM THE DATE YOU RECEIVED THIS PACKAGE ) RETURN 
THE SOFTWARE WITH THE ORIGINAL PACKAGE TO BOSCH, 
ERASE THE SOFTWARE, AND ANY PART THEREOF, FROM 
YOUR COMPUTER AND DO NOT USE IT IN ANY MANNER 
WHATSOEVER.

Bosch Security Systems, Inc. (“Bosch”) licenses the software comprised in 
the Telex Radio Dispatch C-Soft and Network Recorder Application 
(each, together with associated documentation, the “Software”) for the 
nonexclusive use by the end user (the “Licensee”). Licensee has read this 
License, and Licensee understands, accepts and expressly agrees to abide by 
all the terms, provisions and conditions of this License.

1.0 License of Software. Under the terms of this nonexclusive and 
nontransferable License:

1.1 Licensee may use a machine-readable form of the Software on a single 
computer or a single server at a time and only for the operation of 
Bosch products. Licensee may not and shall not (A) use the Software 
except as expressly authorized in this License and in the User 
Documentation; (B) sell, sub-license, lease, rent, assign, pledge, or 
otherwise transfer, make available or share Licensee’s rights under this 
License with any party or entity;
(C) modify, translate disassemble, decompile, reverse engineer, revise 
or enhance the Software or attempt to discover the Software’s source 
code or create derivative works thereof; or (D) install the Software 
onto a server so that it is accessible via a public network. 

1.2 This License does not convey to Licensee an ownership interest in or 
title to the Software, in whole or in part, but only the right to use the 
Software in accordance with the terms of this License. Nothing in this 
License constitutes a waiver of Bosch’s intellectual property rights 
under any law.

1.3 Open Source Software. The Software contains certain software 
components that are licensed by Bosch from various open source 
distributors (individually and collectively, the "Open Source 
Software"), and redistributed by Bosch to Licensee in accordance with 
the provisions of the open source licenses governing the Open Source 
Software (each, the “Open Source License”). The Open Source 
Software and applicable Open Source Licenses are listed in Schedule 
A to this License.   Upon Licensee’s written request, Bosch will (A) 
provide to Licensee a copy of the applicable Open Source License(s) 
or (or specify where such license(s) may be found); and (B) provide to 
Licensee a copy of the Open Source Software source code, if it is 
publicly available without charge (although a distribution fee or a 
charge for related services may be applicable).  

A. No Support of Open Source Software. Licensee acknowl-
edges and agrees that the Open Source Software is sublicensed 
by Bosch to Licensee without support from Bosch. Licensee 

additionally understands and acknowledges that the open 
source licenses governing the Open Source Software offer few, 
if any, warranties.

B. Open Source Rights; Restrictions on Use of Software. 
Licensee may use, modify, link, distribute the Open Source 
Software to the full extent permitted under the applicable Open 
Source License; provided that Licensee will not incorporate, 
link, distribute or use any third party software or code in con-
junction with the Software in any way that (i) creates any obli-
gation with respect to the Software, including the obligation to 
disclose or distribute its source code; or (ii) grants to any third 
party any rights to the Software.   Without limiting the general-
ity of the foregoing, Licensee will not incorporate, link, distrib-
ute or use the Software with any code or software licensed 
under the GNU General Public License (“GPL”), Lesser Gen-
eral Public License (“LGPL”), Mozilla, or any other Open 
Source License, in any manner that could cause the Software 
(or any modifications thereto) to become subject to the terms of 
the GPL, LGPL, Mozilla or such other Open Source License. 
Licensee, and any other third party receiving the Software or 
any copies thereof, do not and will not receive any right to use 
the Software or copies thereof in a manner that will cause any 
patents, copyrights or other intellectual property rights that are 
owned or controlled by Bosch or any of its Affiliates to become 
subject to any encumbrance or terms and conditions of any 
third party or Open Source License. These restrictions, limita-
tions, exclusions and conditions will apply even if Bosch 
becomes aware of or fails to act in a manner to address any vio-
lation or failure to comply therewith. Also, no act by Bosch 
will be construed as inconsistent with the intent not to cause 
any intellectual property rights that are owned or controlled by 
Bosch or any of its affiliate to become subject to any Open 
Source License. For clarity and the avoidance of doubt, the 
restrictions set forth in this Section 1.3(B) are not intended and 
shall not be construed to apply to the Open Source Software. 

1.4 This License will terminate automatically if Licensee fails at any time 
to comply with any of its terms or conditions.

1.5 Licensee may terminate this License at any time by returning the 
Software to Bosch and complying with the terms of Section 1.6 below.

1.6 Except as expressly stated in this License, Bosch has no obligation to 
provide support, maintenance, upgrades, modifications, or new 
releases of the Software.

1.7 Upon any termination of this License, Licensee shall immediately 
return the Software to Bosch, or destroy all items of the Software and 
delete same from Licensee's hardware. After termination of this 
License, Bosch will not provide any further support for the Software.

1.8 The Software, including the AMBE® voice coding technology (the 
“Technology”) embedded therein, is protected by intellectual property 
rights including patent rights, copyrights, and trade secrets of Digital 
Voice Systems, Inc. The Technology is licensed solely for use within 
the Software without further modification. The user of the Software is 
expressly prohibited from attempting to decompile, reverse engineer, 
or disassemble the Object Code, or in any other ways convert the 
Object Code into human-readable form. U.S. Pat. Nos. #5,870,405, 
#5,826,222, #5,754,974, #5,701,390, #5,715,365, #5,649,050, 
#5,630,011, #5,581,656, #5,517,511, #5,491,772, #5,247,579, 
#5,226,084 and #5,195,166.]

2.0 Ownership and Propriety Rights; No Implied Rights. The Software 
is owned and copyrighted by Bosch and/or its suppliers. Except for the 
rights expressly granted herein, no rights whatsoever are granted to or 
implied in favor of Licensee. Bosch and its suppliers retain all rights to 
the Software, including, without limitation, all right, title and interest in 
or to all copyright, patent, trade secret, and other intellectual and 
proprietary rights therein, and any copies thereof, in whole or in part, all 
of which are the valuable property of Bosch and/or its suppliers. 
Licensee may not remove, change, or delete the copyright notice from 
the Software. Licensee will instruct its employees and others having 
access to the Software in, and ensure their compliance with the terms of, 
this License. Licensee shall use its best efforts to prevent any 
unauthorized copying of the Software. Licensee shall be responsible for 
any breach of any provision of this License by Licensee's employees. 
Licensee shall not sell, transfer, publish, disclose, commercially exploit 
or otherwise make available, the whole or any part of the Software, or 
any copies thereof, to any third party or persons not permitted by the 
terms of, and pursuant to the terms contained in this License and each 
applicable Open Source License. Licensee shall not be not in violation 
of this License, including this section, when a third party views the 
functional output resulting from Licensee's use of the Software.

3.0 Software Key. Licensee understands, acknowledges and agrees that, in 
order to use the Software and receive the benefit of the Software’s 
functionality, Licensee must utilize the applicable Software key made 
available by Bosch to purchasers of the Telex Radio Dispatch-IP 
Console (each, the “Software Key”). Licensee understands that a 
specific Software Key must be used for each of C-Soft and the Network 
Recorder Application.

3.1 Licensee may not and shall not (A) use the Software Key except as 
expressly authorized in this License and User Documentation (B) sell, 
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sub-license, lease, rent, assign, pledge, or otherwise transfer the 
Software Key; (C) modify, disassemble, decompile, reverse engineer, 
revise or enhance the Software Key or create derivative works thereof.

3.2 Licensee acknowledges and agrees that its rights to the Software Key 
are subject to the intellectual property rights of Bosch and/or third 
parties. This License does not convey to Licensee an ownership 
interest in or title to intellectual property rights associated with the 
Software Key Nothing in this License constitutes a waiver of 
intellectual property rights of Bosch or any third party with respect to 
the Software Key.

4.0 Taxes. The License Fees for the Software is exclusive of all applicable 
federal, state, provincial and local taxes including, without limitation, 
sales, use, property, value added, goods and services, excise, and similar 
taxes, and all such taxes shall be assumed and paid by Licensee, 
excluding taxes on Bosch’s net income. In the event that Bosch 
determines that any such taxes are subject to withholding requirements, 
Bosch may bill Licensee for such taxes, and Licensee shall promptly 
pay the amount billed. If any such tax for which Licensee is responsible 
hereunder is paid by Bosch, Licensee agrees to promptly reimburse 
Bosch therefor. 

5.0 Warranty, Limitation of Liability, Remedies. 

5.1 THE SOFTWARE IS PROVIDED "AS IS", WITHOUT 
WARRANTY OF ANY KIND INCLUDING A WARRANTY THAT 
THE SOFTWARE IS ERROR FREE OR WILL RUN 
UNINTERRUPTED, OR THAT IT IS FREE FROM 
INFRINGEMENT CLAIMS. ANY WARRANTY IMPLIED BY 
LAW, INCLUDING WARRANTY OF MERCHANTABILITY OR 
WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE, IS 
EXPRESSLY DISCLAIMED HEREBY NEITHER BOSCH NOR 
ITS SUPPLIERS SHALL BE LIABLE FOR ANY LOSS OF 
PROFITS, LOSS OF USE, LOSS OF BUSINESS, GOODWILL OR 
ECONOMIC OPPORTUNITY, INTERRUPTION OF BUSINESS, 
LOSS OF DATA, LOSS OF PROGRAMMING AND/OR 
PRODUCTION MATERIALS, DAMAGE TO BUSINESS 
REPUTATION, OR FOR INDIRECT, SPECIAL, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES OF ANY KIND, WHETHER 
UNDER THIS AGREEMENT OR OTHERWISE, OR FOR ANY 
CLAIM BY ANY OTHER PARTY. Bosch does not warrant the 
functions provided by the Software. However, Bosch warrants the 
diskette or other media on which the Software is furnished to be free 
from material defects in materials and workmanship, under normal 
use, for a period of 90 days from the date of original purchase. Bosch's 
entire liability to Licensee, and Licensee's exclusive remedy, shall be 
the replacement of the diskette or other media not meeting Bosch's 
warranty, provided that Licensee returns the defective diskette or other 
media to Bosch. The replacement will be warranted for the remainder 
of the term of the original warranty, or 30 days, whichever is longer. 
Licensee acknowledges that it is solely responsible for the selection of 
the Software to achieve Licensee's intended results, and for the 
installation, use, and results obtained from the Software.   

5.2 Limited Warranty of Software Key; Remedies.  Bosch warrants, for 
Licensee's benefit alone, that (i) the Software Key, when and as 
delivered to Licensee, and for a period of three (3) years after the date 
of delivery (i) will perform in all material respects in accordance with 
the User Documentation, provided that it is used on the computer 
hardware and with the operating system specified in the User 
Documentation; and (ii) will be in all material respects free from 
significant defects in materials and workmanship under normal use 
thereof. Use of the Software Key other than normal, which shall 
render this warranty void, includes misuse, tampering, modification, 
neglect or failure to follow Bosch instructions. This warranty 
additionally does not cover defects not caused by Bosch (including 
accidents or malfeasance while the Software Key is in transit or in 
Licensee’s possession, custody or control, or any defects or errors 
arising from any modification of the Software, including any Open 
Source Software, that is not made or approved by Bosch). Repairs not 
covered by this warranty shall be available on a time and material 
basis.  Licensee understands, acknowledges and expressly agrees that 
all repair(s) and replacement(s) of a Software Key shall require the 
return of the original Software Key, and that lost Software Keys will 
not be replaced.  If, at any time during the applicable warranty period, 
Bosch, or Licensee discovers one or more defects or errors in the 
Software Key or if the Software Key fails to operate in accordance 
with applicable specifications or is otherwise defective, Bosch's sole 
obligation shall be to repair or replace the defective item.

EXCEPT AS EXPRESSLY STATED IN THIS AGREEMENT, 
BOSCH DOES NOT WARRANT THAT THE SOFTWARE KEY 
WILL MEET LICENSEE’S REQUIRMENTS OR THAT THE 
OPERATION OF THE SOFTWARE KEY WILL BE 
UNINTERRUPTED OR ERROR-FREE. BOSCH EXPRESSLY 
DISCLAIMS ALL EXPRESS WARRANTIES NOT STATED 
HEREIN AND ALL IMPLIED WARRANTIES, INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED WARRANTIES OF 

MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE.   FURTHER, NOTHING IN THIS LICENSE IS 
INTENDED OR SHALL BE CONSTRUED AS A WARRANTY 
BY BOSCH OF ANY OPEN SOURCE SOFTWARE, OR AN 
AGREEMENT BY BOSCH TO PROVIDE ANY SUPPORT OR 
MAINTENANCE WITH RESPECT TO THE OPEN SOURCE 
SOFTWARE; ANY SUCH WARRANTY OR AGREEMENT 
BEING EXPRESSLY DISCLAIMED HEREBY

6.0 U.S. Government Restricted Rights. Licensee will not use the 
Software or Software Key in any manner prohibited by applicable 
law, including any restrictions imposed by the United States 
Government.    The Software is provided with restricted rights. Use, 
duplication, or disclosure is subject to legal restrictions of the U.S. 
Government as set forth in subparagraph (c)(1)(ii) of the Rights in 
Technical Data and Computer Software clause at DFAR 252.227-7013, 
Federal Acquisition Regulation clause 52.227-19 (c) (2) Commercial 
Computer Software Restricted Rights, NASA clause 52.227.86 (d) 
Commercial Computer Software Licensing, or their successor.

7.0 Export Control Laws

7.1 Bosch's responsibility for delivery is limited to the delivery of the 
Software to Licensee.  Bosch will not be responsible for obtaining any 
export licenses or re-export licenses which may be required for any 
subsequent shipping of the Software to destinations determined by 
Licensee.

7.2 In the event that Licensee, or any subsequent party handling the 
Software after delivery by Bosch to Licensee, does export the 
Software then, as between Bosch and Licensee:

7.3 Licensee shall be solely responsible for compliance with all applicable 
laws and regulations relating to such export including, but not limited 
to (a) export licenses or license exceptions, (b) determining correct 
classification at the time of export; and (c) any other regulatory agency 
approval requirements; and

7.4 any diversion of the Software contrary to applicable law (including but 
not limited to U.S. law and the law of the jurisdiction in which 
Licensee is located) by Licensee or any such subsequent party is 
prohibited, and Licensee shall be solely responsible for any diversion 
which is contrary to applicable law.

8.0 DISCLAIMER OF CONSEQUENTIAL DAMAGES. 
NEITHER PARTY SHALL BE LIABLE (WHETHER 
UNDER CONTRACT, TORT (INCLUDING 
NEGLIGENCE) OR OTHERWISE) TO THE OTHER 
PARTY FOR ANY LOSS OR DAMAGE (INCLUDING 
INDIRECT, SPECIAL OR CONSEQUENTIAL 
DAMAGES), INCLUDING, WITHOUT LIMITATION, 
ANY LOSS OR DAMAGE TO BUSINESS EARNINGS, 
LOST PROFITS OR GOODWILL AND LOST OR 
DAMAGED DATA OR DOCUMENTATION, SUFFERED 
BY ANY PERSON, ARISING FROM AND/OR RELATED 
WITH AND/OR CONNECTED TO DELIVERY, 
INSTALLATION, USE OR PERFORMANCE OF THE 
PRODUCT AND/OR ANY COMPONENT OF THE 
PRODUCT, EVEN IF SUCH PARTY IS ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES.

9.0 Governing Law. This License shall be construed according to the laws 
of the State of New York and the U.S. The provisions of the United 
Nations Convention on Contracts for the International Sale of Goods 
shall not apply. Any dispute will be subject to arbitration under the rules 
of the American Arbitration Association and shall take place in Lincoln, 
Nebraska, Metropolitan area of Rochester, New York, U.S.A.

10.0 Entire Agreement. This License any Bosch Standard Terms and 
Conditions as applicable from time to time, as well as all exhibits, 
schedules or appendices hereto, constitutes the complete and exclusive 
statement of the terms hereof and supersedes all prior oral and written 
statements of any kind made by the parties or their representatives with 
respect to the subject matter hereof. Any customer purchase order or 
similar document issued by Licensee or subsequent shall not be part of 
this License and shall not add to or modify any of the terms hereof. This 
License may not be changed or supplemented except by a written 
amendment signed by authorized representatives of the parties.



SCHEDULE A
Bosch Security Systems, Inc.

Telex Radio Dispatch C-Soft and Network Recorder 
Application

End User Software License Agreement

Open Source Software
 and Open Source Software Licenses

1. Linux Operating System (www.kernel.org) GNU GPL 
License

2. OPAL SIP library – (http://www.opalvoip.org) – MPL 
License

3. Cherokee web server (http://www.cherokee-project.com) 
– GPL License

4. ALSA – Advance Linux Sound Architecture – (http://
www.alsa-project.org) – LGPL

5. Expat – XML parser – (http://www.libexpat.org) – MIT 
License

6. Direct Frame Buffer – (http://www.directfb.org) – LGPL 
License

7. Busybox – (http://www.busybox.net) – GPL version 2 
license

www.kernel.org 
http://opalvoip.svn.sourceforge.net/viewvc/opalvoip/opal/trunk/mpl-1.0.htm
http://opalvoip.svn.sourceforge.net/viewvc/opalvoip/opal/trunk/mpl-1.0.htm
(http://www.alsa-project.org
(http://www.alsa-project.org
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CHAPTER 1

Description
Overview

The Telex C-Soft Console Software is a Microsoft1 Windows application that enables a PC with a Full-Duplex sound card and 
a network connection to monitor and control 2-way radios connected to the network. Utilized in conjunction with an 
infrastructure of Telex VoIP (Voice Over Internet Protocol) products, the C-Soft application offers a powerful and convenient 
method for controlling a radio network using standard computer equipment.

The software console can support up to 200 lines and is fully compatible with popular touch screen monitors. In addition, 
standard desk microphones, headsets, and foot-switches are supported through the use of the HB-3 Plus or ADHB-4 headset 
adapter panel.

NOTE: Application Notes containing instructions for specific product installation are available for download at
www.telexradiodispatch.com.

Computer System Requirements

1. See “Copyright Notice” on page 2.

Operating System: Microsoft Windows XP Service Pack 3 (SP3) (32-bit only), or Windows 7 (supports both 
32-bit and 64-bit).

Sound System: Full-duplex windows compatible sound system. 

Network Connection: 10Mbps or 100Mbps, Full-duplex TCP/IP connection. Static IP Address preferred to 
DHCP.

Processor Speed: Intel Pentium Dual CPU 1.80GHz.

Random Access Memory: Minimum of 2GB recommended.
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Optional Features

C-Soft Application Software

C-Soft Designer Program

The C-Soft Designer program provides the ability to create custom dispatch screens designs. Console operators with differing 
requirements can be given different screen designs. Once the screen layout is created, the C-Soft Designer program generates 
a file read by the C-Soft Runtime program. 

NOTE: A hardware security key (also known as a dongle) is not required to operate C-Soft Designer.

C-Soft Runtime Program

The C-Soft Runtime program does the actual network communications with the other radio elements available on the network. 
This single screen design file makes it easy for the designer to send updates to users wherever they may be located.

NOTE: A hardware security key is required to run the C-Soft Runtime program. The hardware security key does not 
have to be in place to install the software.

Part Number Description Model Number

F.01U.166.263 SIP Enhanced 2 Line Donglea

a. Telex cannot be responsible for lost or stolen dongles. 

SIP 2 Line Dngl

F.01U.166.264 SIP Enhanced 6 Line Donglea SIP 6 Line Dngl

F.01U.166.265 SIP Enhanced 2 Line SW Code for ADHB-4 SIP 2 Line SW

F.01U.166.266 SIP Enhanced 6 Line SW Code for ADHB-4 SIP 6 Line SW

F.01U.170.532 SIP Enh 2 Line SW Code ADHB-4 (Field) SIP 2 LN SW Fld

F.01U.170.666 SIP Enh 6 Line SW Code ADHB-4 (Field) SIP 6 LN SW Fld

F.01U.201.591 P25 2 Line@P1

F.01U.215.699 P25 Dongle@P1

F.01U.217.165 P25 SWKEY@P1
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CHAPTER 2

Installation and Setup
This chapter includes information on the installation of and the initial system setup requirements for the C-Soft program.

Sections include:

• Install the Software

• Hardware Security Key Driver Installation

• Initial Volume Control Settings
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Install the Software—Windows XP

To install the CSoftDesigner.exe and CSoftRuntime.exe files, do the following:

1. Insert the C-Soft CD into the CD/DVD drive on the computer.

2. Navigate to the CD drive and double-click the Setup.exe file. 
The C-Soft Setup wizard appears.

3. Click Next.
The Select Destination Location window appears.

4. Click Next, to accept the default folder location for C-Soft (recommended).
The Select Start Menu Folder window appears.
OR
Click Browse, to select a different folder location for C-Soft.
The Browse window appears.
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5. Click Next, to accept the default shortcut folder (recommended).
The Select Additional Tasks window appears.
OR
Click Browse, to select a different folder location for the program’s shortcut files
The Browse window appears.

6. From the Additional icons list, select check boxes for the shortcuts you want to create. 
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7. Click Next.
The Ready to Install window appears

NOTE: The destination location and start menu folder paths appear in this window. 

8. Click Install.
C-Soft installs and the Completing the C-Soft Setup wizard appears.

9. Click Finish.
C-Soft Designer and C-Soft Runtime are installed.
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Install the Software—Windows 7

To install the CSoftDesinger.exe and CSoftRuntime.exe files, do the following:

1. Insert the C-Soft CD in the CD/DVD drive on the computer.

2. Navigate to the CD drive and double-click the Setup.exe file.
The C-Soft Setup wizard appears.

3. Click Next.
The Information window appears.

4. Follow the instructions in the window and click Next.
The Select Destination Location window appears.
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5. Click Next to accept the default folder location for C-Soft (recommended).
The Select Start Menu Folder window appears.
OR
Click Browse, to select a different folder location for C-Soft.
The Browse window appears.

6. Click Next, to accept the default shortcut folder (recommended).
The Select Additional Tasks window appears.
OR
Click Browse, to select a different folder location for the program’s shortcut files.
The Browse window appears

7. From the Additional icons list, select check boxes for the shortcuts you want to create.

8. Click Next.
The Ready to Install window appears.
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NOTE: The destination location and start menu folder paths appear in this window.

9. Click Install.
C-Soft installs and the Completing the C-Soft Setup Wizard appears.

10. Click Finish.
C-Soft Designer and C-Soft Runtime are installed. The ADHB-4 Device Installer wizard appears on systems running 
Window 7.

NOTE:

• The ADHB-4 driver is required for dispatch systems using an ADHB-4. 

• We recommend installing this driver whether or not an ADHB-4 is installed on the system. See 
“ADHB-4 Driver Installation” on page 46.

REFERENCE: For users running Windows XP, see the ADHB-4 Technical Manual 
(F01U196239) for driver installation instructions.
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ADHB-4 Driver Installation

To install the ADHB-4 driver, do the following:

NOTE: When installing the ADHB-4 on a system running Windows 7, the ADHB-4 Device Installer wizard appears 
automatically at the end of the C-Soft installation process. 

1. From the Welcome to the ADHB-4 Installer wizard, click Next.
The Windows Security message appears.

2. Click Next.
The Windows Security window appears.

3. Click Install.
The Congratulations! You are finished Installing the ADHB-4 window appears.
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4. Click Finish.
The ADHB-4 driver installation is complete.

NOTE:

• When the installation is finished, the C-Soft executable files are located at: 
C:\Program Files\Telex Communications-Soft.

• The cposi.txt, keyset.dat, and DefaultVeg.txt files are located at:
C:\Documents and Settings\All Users\Application data\Telex Communications\design_folder for 
Windows XP or C:\Programdata\Telex Communications\design_folder for Windows 7.

Initial Volume Control Settings

There are two (2) sets of volume control settings on the computer crucial to the operation of the C-Soft programs. The first set 
controls playback volumes, and the second set controls recording volumes. Before using the C-Soft applications, these settings 
need to be checked and adjusted, if necessary.

NOTE: These settings only affect the volume of an HB-3 installed on the system.

REFERENCE: For more information about volume settings when an ADHB-4 is installed, see the ADHB-4 Technical 
Manual (F01U196239).
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Playback Volumes—Windows XP

To set the playback volume, do the following:

1. Double-click the speaker icon  in the system tray.
The Master Volume window appears.

2. Set the Master Volume and Wave to the maximum level.

3. Select Mute for the microphone volume.
If mute is not selected, the microphone audio will feedback from the speakers.

4. Close the Master Volume window.

Recording Volume—Windows XP

To set the recording volumes, do the following:

1. Double-click the speaker icon  in the system tray.
The Volume Control window appears.

2. From the Options menu, select Properties.
The Properties window appears.

3. From the Adjust volume for group box, select the Recording check box.

4. Select Microphone as the selected input.

5. Click OK.
The Recording Control window appears.

6. Set the microphone volume control to approximately the second tick.

7. Close the Recording Control window.
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To turn off the Mic Boost function, do the following:

NOTE: When using an HB-3 Plus, you must turn off the Mic Boost function.

1. Double-click the speaker icon  in the system tray.
The Volume Control window appears.

2. From the Options menu, select Properties.
The Properties window appears.

3. On the Recording Control window, click Advanced.
The Advanced Controls for Microphone window appears.

4. Verify the Mic Boost check box is cleared.

Playback Volumes—Windows 7

To set the playback volume, do the following:

1. Double-click the speaker icon  in the system tray.
The Mixer window appears.

2. Click Mixer.
The Volume Mixer window appears

3. Set the Device Volume to the maximum level.
The C-Soft Console volume slider moves to maximum.

4. Double -click the Device Speaker’s icon.
The Speaker Properties window appears.

5. Click Levels.
The Levels page appears.
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6. If a universal no symbol does not appear on the Microphone’s speaker icon, click the microphone icon.
The universal no symbol appears on the icon.
OR
If the universal no symbol appears on the microphone icon, go to the next step.

7. Click OK.
The window closes.

Recording Volumes—Windows 7

To set the recording volumes, do the following:

1. Double-click the speaker icon  in the system tray.
The Mixer window appears.

2. Click Mixer.
The Volume Mixer window appears.

3. Double-click the Systems Sounds icon.
The Sound window appears

4. Click Recording.
The Recording page appears.

5. Click Microphone.
The Microphone Setup Wizard begins.
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6. Click Configure.
The Configure Speech Recognition screen appears.

7. Select the type of microphone you want to configure.

8. Click Next.
The Set up your microphone window appears.

9. Follow the instructions in the window.

10. Click Next.
The Adjust Volume window appears.

11. Follow the instructions in the window.

12. Click OK.
The Sound window closes.

13. Close the Volume Mixer window.

To turn off the Mic Boost function, do the following:

NOTE: When using an HB-3 Plus, you must turn off the Mic Boost function.

1. Double-click the speaker icon  in the system tray.
The Mixer window appears.

2. Click Mixer.
The Volume Mixer window appears.

3. Double-click the Systems Sounds icon.
The Sound window appears.

4. Double-click the microphone 
The Speaker properties window opens.

5. Click Custom.
The Custom page appears.

6. Verify the Mic Boost check box is selected.

7. Click OK.
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CHAPTER 3

Communications System Design
Designing a C-Soft console requires an understanding of the radio network and how the various radios and other 
communication equipment connected.

Before you begin to design the C-Soft console, create a roadmap of the radio, console, and any other communication 
equipment locations. 

This roadmap must include the following:

• Multicast Addresses for each channel of TX (transmit) and RX (receive) communication.

• Port numbers for each channel of TX and RX communication.

• Base IP Addresses assigned to each console or radio on the network and the number of frequencies each 
radio operates on.

• The number of channels each radio may operate on.

Communications Control

Tone Remote Control

Telex Radio Dispatch sells a full line of tone control consoles and radio adaptors. This technology requires an analog 
connection between console and radio. Each console needing to control an individual radio is wired in parallel to allow 
multiple operator positions to monitor and control the same radio. For a large system with multiple console positions and 
multiple radio channels, an entire rack might be devoted to bridging audio to all interested parties. In addition, due to loading 
of multiple consoles on a particular circuit, additional bridging hardware might be required, increasing wiring and tuning of 
the system for acceptable performance. The Ethernet-based IP network solves many of these issues and provides for a number 
of other services not previously possible.

VoIP Radio Control

VoIP is referred to generically throughout this document to mean RoIP (Radio Over Internet Protocol). RoIP terminology is a 
subset of VoIP and referred to as VoIP generically throughout this document. VoIP is a method of breaking analog audio up 
into packets to be transferred over a computer data network. Because of the Ethernet delivers information packets, audio is 
generally broken into 10-40ms chunks of audio, compressed, and placed on the Ethernet. The nodes of the network are then 
free to utilize or ignore any combination of packets. If a particular audio stream is of interest, the stream of audio packets are 
captured, encompassed, converted back to analog, and played on available speakers.
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Given the popularity of the Ethernet-based networks, many companies and agencies already have an existing network or LAN 
(Local Area Network). Beyond that, a large number of companies exist to provide WAN (Wide Area Network) connections 
between sites with significant distances between them. The WAN connections can be used to connect offices across the street 
from one another, around the world, or anywhere in between. Possibly the best thing about these connections is they may 
already exist. In many cases, WAN links are less expensive than a comparable leased analog line and they can carry more 
conversations simultaneously.

The most compelling reason to consider basing the next radio control system upgrade on VoIP technology is the simplification 
in wiring requirements. Instead of needing to bring a pair or more of wires, per channel, to each console, only a single 
connection to the Ethernet is required. Since Ethernet can easily handle dozens of simultaneous connections, it becomes the 
only pipeline required for all communications.

Network Requirements

IP Operation Overview

The network options today have essentially converged on Ethernet. A local electronics store may sell many of the components 
for both a wired or wireless network solution. For more advanced network applications, an in-house or external network 
hardware source may be required. These sources of information can also help with the design of the network, as well as 
provide sources for advanced networking equipment, such as routers and hubs from Cisco and other network vendors. This 
section is an overview of the protocols operating on the top of the Ethernet network.

Ethernet as Physical Layer

Ethernet is a network and has a low level method for transferring data from one (1) location to another. Source and 
destinations are based on the MAC (Media Access Control) which is embedded in the Ethernet interface. The MAC Address 
is unique for all devices in the world and cannot be changed. The IEEE (Institute of Electrical and Electronics Engineers) 
controls the allocation of the MAC Addresses. The definition for Ethernet includes requirements for inter-operation at speeds 
of 10 and 100 Mbps. Higher speeds are available, but generally have not filtered down into end-user equipment. 

Bandwidth

Each VoIP channel requires 50kBit of bandwidth while active. Full-duplex conversation requires 100kBit of bandwidth.

Some radio systems transmit go-ahead beeps when it is clear to talk. In order for the console operator to hear the beeps, the 
system must support full-duplex communication. Full-duplex bandwidth may only be required for the first few seconds of a 
conversation, due to the brief nature of the go-ahead beeps at the beginning of the transmission.

When using Telex’s IP-223 or IP-224 with a PIB (Phone Interface Box) or TDI (Telephone Dispatch Interface) adapter, 
C-6200, or a NI-223 for a telephone connection, a full 100kBit is required since it is a full-time, full-duplex conversation.

Multicast

In general, Telex Dispatch Systems require Multicast to function. The network must be able to create a static Multicast 
Address, accessible at all times.

Once an IGMP (Internet Group Management Protocol) join message is sent out, networks typically enable Multicast and then 
prune branches after a period of time. Due to intermittent usage patterns of 2-way radios, such a system can appear to work 
flawlessly for a period of time and then no longer work. 

NOTE: When using Cisco technology, IP PIM dense mode is recommended. Generally speaking, sparse-dense-mode can 
also be implemented effectively. We recommend explicitly joining the Multicast group with an IP IGMP 
static-join X.X.X.X command. For more information on Cisco and IGMP visit www.cisco.com.
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Internet Group Management Protocol

IGMP can be used to control where Multicast is allowed to propagate. This should be limited to subnets utilizing the C-Soft 
program as the dispatch console and only when used on an intermittent basis (when the C-Soft program is used for a period of 
time and then shut down). When a console on the subnet is expected to be continually operational, Multicast must be active for 
the subnet at all times.

Network Performance

Networks should perform well under any loading conditions. The default audio delay is 120ms, plus any delay added by the 
network. While delay alone does not cause issues, variable delay (also known as jitter) does. Jitter, in a network, cannot exceed 
the maximum packet buffer of any individual product buffer. Refer to the individual product manuals for these specifications. 
For example, the IP-223 or IP-224 can handle approximately 600ms of network jitter.

NOTE: Losing more than 5% of the total packets transmitted compromises audio quality and system performance. 
Optimally, packet loss should be less than 1%.

TCP/IP and UDP/IP

TCP/IP (Transmission Control Protocol/Internet Protocol) is the best-known protocol for use in computer communications. It 
is the basis for communications on the Internet and World Wide Web. It is a guaranteed method of transferring data between 
two (2) computers. Being guaranteed means for every packet of information transferred from one (1) computer to another an 
acknowledgement packet is returned. Additional handshaking is utilized from the outset of the data communications to ensure 
both ends of the connection. Because of this guaranteed communications and its implementation utilizing handshaking (no 
other method is available), TCP/IP adds a great deal of overhead to data communications is not desirable for audio traffic over 
a network. This is where UDP/IP finds its acceptance.

UDP/IP (Universal Datagram Protocol/Internet Protocol) has existed as long as TCP/IP as an unreliable method of data 
communications. The term unreliable should not be thought of as a problem for audio communications over a network 
connection. UDP allows for a computer to send a packet of data to another computer without the handshaking sequence 
required within TCP/IP. Because of this, the computer sending the packet has no confirmation the packet arrived at its 
destination. While the loss of packets can be a problem, it generally is accounted for when the UDP application is developed. 
In the case of VoIP, the loss of a packet, which only contains 10-40ms of audio, is not a problem, as the human ear generally 
ignores the small chunk of lost audio. The largest single factor in the loss of UDP/IP packets is network design and loading. 
UDP applications use algorithms which makes the loss of information the largest single factor in UDP/IP network design and 
loading. As long as a network is well designed with capacity for all of its chartered requirements, packet loss can be a 
non-issue. Because of its lower overhead and its ability to Multicast, UDP/IP is the protocol of choice for VoIP development.

Multicast UDP/IP

Multicast is an extension to UDP/IP. It enables one (1) computer to broadcast data packets to multiple recipients. This is an 
ideal model for radio communications when multiple people need to monitor the audio. A single VoIP connected radio is setup 
to broadcast Multicast VoIP packets when receiving audio. Since the Multicast packets can be received by any interested party, 
all consoles monitoring the audio can receive and decode the packets for playback. In addition to simplifying monitoring of 
audio traffic by multiple listeners, Multicast also greatly reduces the bandwidth requirement on the network. Instead of having 
to regenerate the received audio into a UDP/IP data stream to each individual monitor, which uses the bandwidth times the 
number of monitoring consoles, a single data stream is generated and monitored by all.

Implementation of a Multicast protocol requires a few things for seamless use on a network. First, clients must all support the 
protocol. This is accepted as given since all Telex Radio Dispatch products utilize Multicast for audio communications. 
Second, consider if the network infrastructure supports Multicast.
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Multicast packets are defined to be all packets with a destination address of between 224.0.0.0 and 239.255.255.255. Some of 
these addresses are commonly used for broadcast audio and are not necessarily available. When a computer opens a UDP/IP 
port within this address range, it also joins the group. By joining the group, a packet is sent out to all addresses saying it is 
interested in seeing the traffic on this Multicast address. Routers that receive this broadcast message to join a particular 
Multicast Address then pass packets through because the router is now aware a listener is interested in this traffic. The routers 
utilized in the network must support this. The protocol used to alert routers to parties who are interested in certain Multicast 
Address traffic is IGMP (Internet Group Management Protocol). Telex radio Dispatch products support IGMPv1, as defined 
in RFC 1112.

In addition to the joining of Multicast broadcast groups, clients on the network can also specify a packet TTL (Time To Live). 
The TTL is the number of routers the packet goes through before being stopped. As an example, the TTL for a particular 
broadcasting node on the network is set to 3. This means when a packet is transmitted, it arrives at the first router in the 
network. This router examines the TTL value in the packet and determines if it should pass it through since it is not zero (0). 
When it passes the packet, the router decrements the TTL value by 1 to a value of 2. The next router encountered by packets 
does the same, reducing the value of TTL to 1. The next router does the same and the TTL is reduced to 0. The next router the 
packet reaches examines the TTL value, sees it is zero (0), and the packet is not to be retransmitted. Setting a large TTL value 
may allow for packets to get from one (1) host to another on a large network, but also adds additional bandwidth requirements 
due to the larger number of packets being transferred.

Telex Radio Dispatch Port-Centric Method

As mentioned earlier, Telex utilizes Multicast for all audio communications. Typically only one (1) Multicast is used for all 
traffic. In addition to a valid Multicast Address, a port number is required. The port is an additional two (2) bytes of 
information ranging between 1054 and 65535 that further specifies how the data traffic should be handled. For example, 
assume the base Multicast Address chosen is 225.8.11.81. Port 1054 is used to distinguish channel 1's RX traffic. Port 1072 is 
used to specify channel 1's TX traffic. Channel 2 might use 1055 for RX and 1073 for TX traffic. By making each channel’s 

TX and RX ports different and unique, full-duplex1 audio can be supported and many channels of traffic can be supported 
using only one (1) Multicast Address. It is through this method a single console can pick and choose the particular radio 
resources available on the network without concern for what the console right next to it is utilizing.

1. Full-duplex data transmission means data can be transmitted in both directions on a signal carrier at the same time.
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CHAPTER 4

C-Soft Designer Program
The C-Soft Designer program is a console designer application used by system specialists to design and configure custom 
dispatch windows. Various combinations of buttons, sliders, text, and pop-up windows can be included in a window design. 
These elements are then configured to operate on specific lines.

The designer can place elements in any desired location, and can include or omit functions based on the requirements of the 
system and the console operator.

When you are finished designing your VoIP system, the C-Soft console can be created. Before you begin, determine the TX 
and RX port of each radio, the multicast group(s) used, the number of radios to control, and the frequencies used by each radio.

Starting the C-Soft Designer Program

To start the C-Soft Designer program, do the following: 

 > Double-click the C-Soft Designer desktop shortcut created during program installation.
The C-Soft Designer program appears.
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C-Soft Designer Window

When the C-Soft Designer program is started, the console window, shown in Figure 1, appears. This window is the 
workspace. It contains the commands and tools needed to design and configure a customized software console.

The C-Soft Designer workspace includes the following components:

Title Bar

Menu Bar

Toolbar

Console Window

Status Bar

Title Bar

The Title Bar is located across the top of each window. When a file is opened, the path sequence and file name appear on the 
title bar.

FIGURE 1. C-Soft Designer Workspace
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Menu Bar

The Menu Bar is located directly below the title bar and displays menus that contain commands for accessing the 
C-Soft Designer functions. For example, the Insert menu contains commands to add UI Element Buttons, Volume Sliders, 
Text, and pop-up Windows.

Toolbar

The Toolbar is located directly below the menu bar and provides quick, easy access to commonly used tasks. See Table 1 on 
page 59 for a brief description of each button on the toolbar and the action taken when the button is selected.

To move the toolbar, do the following:

 > Click, hold, and drag the move handle on the toolbar or the title bar (blue bar on a floating toolbar) to a new location. 
The toolbar can be docked on any side of the window or as a floating toolbar, inside or outside the workspace.

To display the toolbar, do the following:

 > From the View menu, select Toolbar.
The toolbar appears in the spot where it was previously closed.

To hide the toolbar, do the following:

 > From the View menu, select Toolbar.
The toolbar closes.
OR

When the toolbar is floating, click the Close button. 

The toolbar closes.

TABLE 1. C-Soft Designer Toolbar

Icon Tool Name Description

Open Open an existing console design. You can also use File|Open.

Save Save the current console design. You can also use File|Save.

Cut Delete the selected item(s). You can also use Edit|Cut or the Delete key on the 
keyboard.

NOTE: This does not place the cut item on the clipboard.

After information is cut, you can not retrieve it.

Copy Copy the selected item(s). You can also use Edit|Copy.

NOTE: This places the copied item on the clipboard.

Paste Insert the item(s) on the clipboard into the console design. You can also use 
Edit|Paste.

About Display the software version, company contact information, and various statistics 
about the console design. You can also use Help|About C-Soft Designer.
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Console Window

The Console Window displays the open console design. The console window contains a grid for easy alignment of elements 
on the window. The grid is a window alignment tool and is not displayed on the console position window.

Status Bar

The Status Bar is located at the bottom of the workspace window. 

To display or hide the status bar, do the following:

 > From the View menu, select Status Bar.
The status bar view toggles on and off. If there is a check mark next to Status bar in the view menu, the Status bar is 
visible.

Increase Width Increase the width of the selected element. Proportionally increase the size of the 
selected text.

Decrease Width Decrease the width of the selected element. Proportionally decrease the size of 
the selected text.

Increase Height Increase the height of the selected element. Proportionally increase the size of the 
selected text.

Decrease Height Decrease the height of the selected element. Proportionally decrease the size of 
the selected text.

Rotate Window Rotate the selected pop-up window 90° counter-clockwise around the selected 
pop-up button. Rotate the selected text 90° counter-clockwise.

Move Right Move the selected item(s) to the right.

Move Left Move the selected item(s) to the left.

Move Up Move the selected item(s) up.

Move Down Move the selected item(s) down.

Start C-Soft 
Runtime

Run C-Soft Runtime with the current .veg file loaded in C-Soft Designer.

TABLE 1. C-Soft Designer Toolbar

Icon Tool Name Description
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User Interface Element Manipulation

The C-Soft Designer program is heavily dependent on the mouse for interacting with the elements that comprise the console 
window design. The mouse is used for selecting and moving objects, to access a form or window, and to perform actions on 
the displayed element or text.

Several standard Windows shortcuts are supported and are listed next to the command on the menu. This section describes 
C-Soft Designer features available to assist in component manipulation on the console window.

To select a single item, do the following:

 > Click the desired item. 
A red target is displayed on the selected element or in the case of text, there is a bounding outline around the selected 
text.

To select a group of items, do the following:

1. Position the mouse pointer at the top and to the side of the objects to be selected.

2. Press and hold the left mouse button while dragging the mouse over the objects to be selected.
This draws a box around the items selected. 

3. When all items are included within the box, release the mouse button.
A red target appears on the selected element(s), and, in the case of text, there is a box around the selected text.

NOTE: You can select all items by pressing Ctrl+A.

NOTE: A group of items cannot be moved using the mouse. When selected, use either the positioning tools 

 on the toolbar or the arrow keys on your keyboard to move the items.

To move an individual item, do the following:

1. Select the item to be moved.

2. Drag the item to its new location on the window.
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To copy and move an individual item at the same time, do the following:

1. Select the item while holding down the Ctrl key.

2. Drag the item to the new location on the window.
This moves the copied item into the new location with all the parameters of the copied item intact. When a pop-up 
button is copied using the Ctrl key, the pop-up window is also copied. 

NOTE: The Ctrl key copies items to allow for large sections of the console window to be designed, copied, and then 
modified slightly to quickly design the console window.

To change the line number associated with a group of items, do the following:

1. Select a group of items.

2. Right-click an element within the selected group.
A shortcut menu appears.

3. From the shortcut menu, select Group Line Number.
The UI Group Properties window appears.

4. From the Line to Associate Function With drop down menu, select the line to associate with the selected group.

5. Click OK.
The line number for the group is changed.

To change the border color of a group of items, do the following:

1. Select a group of items.

2. Right-click an element within the selected group.
A shortcut menu appears.

3. From the shortcut menu, select Group Border Color.
The UI Group Border Color window appears.

4. From the Border Color drop down menu, select the color to associate to the group.

5. Click OK.
The border color for the group of items is changed.
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To change the font used on the elements in the group, do the following:

1. Select a group of items.

2. Right-click an element within the selected group.
A shortcut menu appears.

3. From the shortcut menu, select Group Font Change.
The Font window appears.

4. Select the Font, Font style, and Size you want to display on the elements.
A sample of the selected style displays in the Sample field at the bottom of the Font window.

5. Click OK.

NOTE: The position of the pop-up window in relation to the pop-up button can be changed. The border color of a 
group can also be changed.

To change the position of a pop-up window, do the following:

1. Right-click a UI element pop-up button.
A shortcut menu appears.

2. From the shortcut menu, select Open pop-up.
A pop-up window appears.

3. From the toolbar, select the rotate icon. 
Each click on the tool rotates the window 90° counter-clockwise around the selected pop-up button.

To change the border color of a pop-up window, do the following:

1. Draw a box around a group of pop-up windows.

2. Right-click an element within the selected group.
A shortcut menu appears.

3. From the shortcut menu, select Group Border Color.
The UI Group Border Color window appears.

4. From the Border Color drop down menu, select the color to associate to the group.

5. Click OK.
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To change to a text string, do the following:

1. Select the text you want to change.
A bounding outline appears around the text.

2. Right-click on the text.
The Dialog window appears.

3. In the Enter New Text String field, make the changes to the text. 

4. Click OK to accept the changes. 
OR
Click Cancel.
The text is changed.

To change the size of a button, volume control or text string, do the following:

1. Select an item or group of items.

2. From the menu bar, select the increase or decrease width and height icons .
OR
Press the Ctrl key while pressing the arrow keys on your keyboard. 

To change the size of a pop-up window, do the following:

1. Right-click on a UI element pop-up button.
A shortcut menu appears.

2. From the shortcut menu, select Open pop-up.
A pop-up window appears.

3. Select the pop-up button.

4. Use the increase or decrease width and height icons  to size the button.
OR
Press the Ctrl key while pressing the arrow keys on your keyboard, to size the button.

NOTE: For more information see, table 1, “C-Soft Designer Toolbar” on page 59.
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File Menu

The File menu contains commands for working with files.

Open

Only files in the C-Soft Designer file format (*.veg) can be opened by the C-Soft Designer program.

NAVIGATION: Select File|Open from the menu bar.

Save

The C-Soft Designer program saves all files in the file *.veg file format.

NAVIGATION: Select Edit|Save from the menu bar.

Design Errors Window

The Design Errors window appears when a file is saved. The default name of the file validated by the application is 
C6200F_Default. 

To save a file by a different name, do the following:

 > In the File Name field, enter the desired file name.
When the file is saved, the C-Soft Designer program performs a validation on the console design. The results of the 
validation are displayed in the Design Errors window.

NOTE: When using a file name other than C6200_Default, the file must be associated with the C-Soft program 
before it can be opened by the C-Soft Runtime program. This is explained in “C-Soft Runtime Program” on 
page 361.
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If design errors are found, the last line of the list reads:

--------------------End of Error List--------------------

If no design errors are found, the last line of the list reads:

--------------------No Errors Found--------------------

NOTE: When all the results cannot be displayed within the window, scroll bars are provided to navigate through all of 
the test results.

Exit

The Exit option is used to save the file and exit the C-Soft Designer program.

Edit Menu

The Edit menu, shown in Figure 2, contains commands for the set up and revision of per line and global parameters for your 
VoIP network. This menu also contains commands to create and modify individual elements of the console position design.

FIGURE 2. Edit Menu
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Per Line Parameters Window

The Per Line Parameters window, shown in Figure 3, is used to configure line types, addresses, port information, and line 
frequencies for the VoIP network. This window allows configuration of up to 200 separate entries.

The frequency, vocoder, backup IP and signaling parameters for all lines included in the console design must be set up on this 
window. If the line is not set up on this window, the line is not available as an option when setting up the user interface 
elements.

NOTE: Additions and changes can be made to the Per Line Parameters window at any time, however, make sure all 
UI Elements, assigned to the line, are updated.

NAVIGATION: Select Edit|Setup Per Line Parameters from the menu bar.

Line Number Field

The Line Number field displays the number of the line. This number is used for identification purposes in the design of the 
console position.

FIGURE 3. Per Line Parameters Window
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Line Type Drop Down Menu

The Line Type drop down menu identifies the type of line being configured. When a selection is made in the line type field, 
the fields necessary to enter the setup information for that line type are enabled. 

Available selections for this field are:

Disabled - Line is not enabled. When the line is configured, it can be disabled without losing
configuration settings.

NOTE: Line 1 cannot be disabled.

Telex - Compatible with Telex VoIP radio dispatch products, such as the C-6200, IP-223 or IP-224.

Select Telex for FleetSync, MDC-1200, or MOTOTRBO**1 Professional Digital Two-Way 
Radio System.

Phone - Allows the console to access a telephone line from across the network. Phone configurations require the 
use of Telex’s PIB or TDI adapter. For more information, see the IP-223 Phone Interface Box Technical 
Manual (F.01U.188.265) or the Telephone Dispatch Interface Technical Manual (F.01U.196.107)
available for download at www.telexradiodispatch.com.

SIP Phone - This option is available on consoles with a hardware security key that carries 24 lines or more. 
For more information see SIP (Session Initiation Protocol) configuration, and see 
“SIP Phone Line Configuration” on page 143.

P25-DFSI- For more information, see Appendix E, “Setting up a P25-DFSI Line Type” on page 382.

Line Name Field

The Line Name field is used to enter a descriptive name for the line. This name is used for identification purposes in the 
console position design.

This field can contain up to 30 characters.

RX Multicast Address Field

The RX Multicast Address fields identify the broadcast address for all audio traffic. This dotted quad number must be 
between 224.0.0.2 and 239.255.255.255. Devices can have the same or different Multicast Address for RX channels. Telex 
VoIP enabled equipment can use one (1) Multicast Address for all lines with the port number defining the RX channels.

NOTE: The RX Multicast Address must match the RX Multicast Address setup on the IP-223, IP-224, or a C-6200 if it 
is the gateway.

TX Multicast Address Field

The TX Multicast Address fields identify the broadcast address for all audio traffic. This dotted quad number must be 
between 224.0.0.2 and 239.255.255.255. Devices can have the same or different Multicast Address for TX channels. Telex 
VoIP enabled equipment can use one (1) Multicast Address for all lines with the port number defining the TX channels.

NOTE: The TX Multicast Address must match the TX Multicast Address setup on the IP-223, IP-224, or a C-6200 if it is 
the gateway.RX Port Fields

The RX Port fields identify the RX port numbers. These numbers must be unique per channel and must be greater than 1054.

NOTE: The RX port number must match the port number set up on the IP-223, IP-224, or a C-6200 if it is the gateway.

1. See “Copyright Notice” on page 2.
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TX Port Fields

The TX Port fields identify the TX port numbers. These numbers must be unique per channel and must be greater than 1054.

NOTE: The TX port number must match the port number set up on the IP-223, IP-224, or a C-6200 if it is the gateway.

EXAMPLE: In Figure 4, the RX Port is 1054 and the TX Port is 1254 for Line 1. All consoles monitoring receive 
audio for channel 1 must share the same Multicast Address, as well as the same RX port number. Any 
console transmitting on the network must set its port number to 1254 to cause the radio to key up.

Base Radio IP Field

The Base Radio IP field identifies the IP Address of the IP-223 or IP-224 used by the C-Soft program to create a socket 
between two (2) IP Addresses. This address is required for the C-Soft program to create an internal ping command. It is also 
required for full-duplex mode (i.e., telephone mode) and to generate encoded message strings (i.e., 5/6 Tone). We recommend 
you include a base radio IP Address for all lines within your system design.

The base radio IP Address is periodically pinged to determine if a network connection still exists for a particular radio. If there 
is no response received from the ping, the backup IP radio addresses are used. 

A backup button is available for the console design. This button is used to force a switch, or to monitor whether the primary or 
backup channel is used. Additional information on this feature is provided in “Backup Line” on page 205. 

TTL Field

The TTL field identifies the number of routers the Multicast audio packets go through before being stopped. The network 
design dictates this value. If audio is not reaching a particular node on the network, increasing this value may correct the 
problem.

The range for this field is 1 to 99.

Packet Delay Field

The Packet Delay field identifies the length of delay before playback, in 20ms packets. Some buffering of these packets must 
occur before playback to help absorb network delays, jitters, and lost packets. The typical entry for this field is 6, which 
translates to a delay of 120ms before playback (each packet is 20ms of audio). Larger values may be required for complicated 
networks, smaller values for simpler networks.

The range for this field is 4 to 64.

Echo Packets Enable Check Box

The Echo Packets Enable check box indicates the system operates on networks that do not support multicast. The C-Soft 
program must be running at all times to translate and transfer packets from one (1) IP subnet to another.

A typical application has a number of radios spread throughout a network without multicast. In this case, the radio adapters 
(IP-223s, IP-224s or C-6200s) are programmed to send packets to the IP Address of the PC running the C-Soft program with 
Echo Packets enabled.

An example of an Echo Packet system, where three (3) different radios are connected through a WAN, is shown in Figure 203 
on page 375. In each of the subnets, a single copy of the C-Soft program is used to communicate to the radio in its subnet. A 
second console is used to echo the audio traffic to other copies of the C-Soft program. The C-Soft program also echoes all 
traffic to a Multicast Address within its subnet so additional consoles can be added to the system by specifying the Multicast 
Address.
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Options Button

The Options button opens the Line Options Setup window, shown in Figure 4, for the selected line.

Line Options Setup Window

The Line Options Setup window is used to configure the monitoring capabilities, digital format in the line setup options and 
the backup IP to use if network resources of the primary radio interface identified for the line fails.

NOTE: Vocoder configurations must be the same across devices.

To open the Line Options Setup window, do the following:

1. Select Edit|Per Line Parameter.
The Per Line Setup window appears. 

2. Click Options.
The Line Options window appears.

FIGURE 4. Line Options Setup Window
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Line Setup Options Group Box

Vocoder Type Drop Down Menu

The Vocoder Type drop down menu indicates the bit rate at which audio is converted into digital format. This feature is used 
to configure communication between C-Soft and an IP-223 or 
IP-224.

Available selections for this field are: TELEX 32K, G.726 16K, G726 32K (IP224 Only), and G.711 64K (IP224 Only).

The G.726 32K (IP224 Only) and G.71164K (IP224 Only) vocoders are only supported on C-Soft version 6.100 or higher, 
Network Recorder version 4.500 or higher, and the IP-224.

The TELEX 32K is the same as the previous ADPCM 32K, and the G.726 16K is the same as the previous ADPCM 16K.

Tx Mon Enable Check Box

The Tx Mon Enable check box indicates the console operator can monitor TX traffic from other console operators.

Scannable Check Box

The Scannable check box indicates the console operator is allowed to control the scan list of a particular radio. The frequency 
button is used in C-Soft Runtime to add or delete radio channels from the scan list.

NOTE: This feature is not supported on all radios, only Kenwood TK-x80, TK-x150/180 and NEXEDGE support.

Backup IP Setup Group Box

RX Multicast Address and Port Fields

The RX Multicast Address and Port fields identify the receive Multicast Address and port to use if the primary receive path 
fails.

TX Multicast Address and Port Fields

The TX Multicast Address and Port fields identify the transmit Multicast Address and port to use if the primary transmit path 
fails.

Base Radio IP Field

The Base Radio IP field identifies the backup IP Address of the base radio, should the primary address fail.

FIGURE 5. Vocoder Type Drop Down Menu - Line Options Setup
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OK Button

The OK button saves the entries and closes the window.

Cancel Button

The Cancel button clears any entries made and closes the window.

Freqs Button

The Freqs button opens the Frequency Parameters window, shown in Figure 6 and Figure 7, for the selected line.

Frequency Parameters Window

The Frequency Parameters window, shown in Figure 6, is used to enter the parameters for the individual function tones 
available for the selected line.

NOTE: Additions and changes can be made to the Frequency Parameters window at any time. However, if any user 
interface elements have been placed on the console window, the changes made to a line must also be changed on 
the individual elements, if needed.

Enable Check Box

The Enable check box indicates the corresponding frequency numbers are available to the console operator for selection on 
the line.

FIGURE 6. Frequency Parameters Window
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Frequency Name Field

The Frequency Name field is used to enter a descriptive name for the frequency. This name is used to identify the frequency 
for the elements used in the design of the console position and is made available for selection in a list of variables. 

NOTE: If the Frequency Name field is changed, the Line to Associate Function With field on the UI Element Setup 
window for the frequency button must be updated.

This field can contain up to 20 characters.

Close Button

The Close button saves the entries and closes the window.

Load File Button

The Load File button is used to download a .csv file into the current frequency window.

NOTE: When the .csv file is downloaded, all items in the current list are overwritten. 

To download a saved frequency .csv file, do the following:

1. Click Load File.
The Open window appears.

2. In the Open window, select the file you want to download.

3. Click Open.
The file is downloaded, the Frequency Name field is populated and the Enable check box is selected. 

Save File Button

The Save File button is used to save the current frequency names to a .csv file. 

To save the currently enabled frequency names to a .csv file, do the following:

1. Click Save File.
The Save As window appears.

2. In the Filename field, enter a name.

3. Click Save.
The .csv file is saved in the current folder.

Pair Mode Setup Check Boxes

The Pair Mode Setup check boxes allow function tones to have control functions not used for actual control of the radio. 
There are four (4) wildcard groups available per line. Function tones 1 and 2 are not allowed in a wildcard group and a 
function tone may not be selected in more than one (1) group. One (1) function tone from each group can be active at a time, 
plus either F1 or F2.

RX Block Lines Display Box

The RX Block Lines display box contains a list of all the lines in the system. Each line selected in the list has its received 
audio blocked from the speaker when the line you are currently configuring is selected. This allows the console operator to 
transmit on a radio that has overlapping coverage with other radios without getting feedback from the radios receiving the 
transmitted signal. This function also operates when a parallel console is transmitting on the line.
Bosch Security Systems, Inc. Administrator’s Guide F.01U.218.561 Rev 03



74  C-Soft Designer Program C-Soft Administrator’s Guide
To mute a line during transmission, do the following:

1. Select the line(s) in the display box.
The line is highlighted.

2. Click the line(s) a second time to clear the selection.
The line is no longer highlighted.

Frequency Parameters Windows—MOTOTRBO

Channel Setup Page. When the Freq button for a MOTOTRBO line is clicked, the Frequency Parameters window opens to 
the Channel Setup page. 

The Channel Setup page, shown in Figure 7, is used to enter the MOTOTRBO line’s channel, zone, channel name, pair mode 
setup and RX block. 

NOTE: The General Signal Setup window must be configured for MOTOTRBO system type before MOTOTRBO 
parameters are available on this page. See “System Type Drop Down Menu” on page 78.

FIGURE 7. Frequency Parameters—Channel Setup Page
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Enable Check Box

The Enable check box indicates the corresponding frequency numbers are available to the console operator for selection on 
the line.

Zone Field

The Zone field is used to enter a MOTOTRBO zone number. The same zone number must also be configured in the radio. 

Chan Field

The Chan (Channel) field is used to enter a MOTOTRBO channel number. The same channel number must also be configured 
in the radio.

Channel Name Field

The Channel Name field is used to enter a user-recognizable name for the frequency. This name identifies the frequency for 
elements used in the console design and is available for selection in C-Soft Runtime. 

NOTE: If the Channel Name field is changed, the Line to Associate Function With field on the UI Element Setup 
window for the frequency button must be updated.

This field can contain up to 20 characters. 

All Call Check Box

The All Call check box indicates the All Call function is enabled in C-Soft for the associated channel. The MOTOTRBO radio 
must be configured for All Call.
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Zone Setup Page. When the Zone Setup tab is clicked from the Frequency Parameters window, the Zone Setup page appears. 
The Zone Setup page, shown in Figure 8, is used to set up zone names. 250 different zones are supported.

Zone Name Field

A Zone is a place channels are stored in a radio. 

The Zone Name field is used to enter a user-recognizable name for the zone.

This field can contain up to 20 characters.

NOTE: The name should match the zone name configured in the radio.

Channel Pool Zone Field

The Channel Pool Zone field indicates the zone number used for a channel pool.

REFERENCE: If a there is a fixed zone for channel pool programmed in the MOTOTRBO radio, the zone must be entered 
in this field. For more information, see Motorola’s technical documentation.

Close Button

The Close button saves the entries and closes the window.

Load File Button

The Load File button is used to download a .csv file into the current frequency window.

NOTE: After the .csv file is downloaded, all items in the current list are overwritten. 

FIGURE 8. Frequency Parameters Window—Zone Setup Page
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To download a saved frequency .csv file, do the following:

1. Click Load File.
The Open window appears.

2. In the Open window, select the file you want to download.

3. Click Open.
The file is downloaded, the Frequency Name field is populated and the Enable check box is selected. 

Save File Button

The Save File button is used to save the current frequency names to a .csv file. 

To save the currently enabled frequency names to a .csv file, do the following:

1. Click Save File.
The Save As window appears.

2. In the Filename field, enter a name.

3. Click Save.
The .csv file is saved in the current folder.

Pair Mode Setup Check Boxes

The Pair Mode Setup check boxes allow function tones to have control functions not used for actual control of the radio. 
There are four (4) wildcard groups available per line. Function tones 1 and 2 are not allowed in a wildcard group and a 
function tone may not be selected in more than one (1) group. One (1) function tone from each group can be active at a time, 
plus either F1 or F2.

RX Block Lines Display Box

The RX Block Lines display box contains a list of all the lines in the system. Each line selected in the list has its received 
audio blocked from the speaker when the line you are currently configuring is selected. This allows the console operator to 
transmit on a radio that has overlapping coverage with other radios without getting feedback from the radios receiving the 
transmitted signal. This function also operates when a parallel console is transmitting on the line.

To mute a line during transmission, do the following:

1. Select the line(s) in the display box.
The line is highlighted.

2. Click the line(s) a second time, to clear the selection.
The line is no longer highlighted.

Signal Setup Button

The Signal Setup button opens the Signaling Parameters window, shown in Figure 9.
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Signaling Parameters Window

When Telex is selected in the Line Type drop down menu, and the Signal Setup button on the Per Line Parameters window is 
clicked, the General Signal Setup page, shown in Figure 9, appears. 

System Settings Group Box

System Type Drop Down Menu

The System Type drop down menu is used to configure the signaling type for the individual line.

Available selections for Telex Line Type are: 

Generic - For more information, see “Generic System Type” on page 79.

5/6 Tone/DTMF ANI - For more information, see “5/6 Tone DTMF ANI Setup Page” on page 80.

FleetSync - For more information, see “FleetSync Setup Page” page 87.

iDEN - For more information, see “iDEN System Type” on page 89.

Kenwood-5x10 For more information, see“Kenwood-5x10 System Type” on page 93.

MDC-1200 - For more information, see “MDC-1200 System Type” on page 94.

MOTOTRBO - For more information, see “MOTOTRBO System Type” on page 97.

Available selections for Phone Line Type are: 

Generic - For more information, see “Generic System Type” on page 79.

 Phone - For more information, see “Phone System Type” on page 99.

FIGURE 9. General Signal Setup Page
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Available selections for P25-DFSI Line Type are:

P25-DFSI For more information, see Appendix E, “Setting up a P25-DFSI Line Type” on page 382.

NOTE: The Signaling Setup button is disabled for lines types of Disabled and SIP.

System Name Drop Down Menu

The System Name drop down menu is used to select a system for the selected line. If the System Type field is set to FleetSync, 
MDC-1200 or MOTOTRBO this field becomes active.

NOTE: Systems are configured by the user. See “Edit System List Window” on page 168.

Signaling AutoFill Setup Group Box 

Enable Signaling Autofill Check Box

The Enable Signaling Autofill check box indicates the signaling parameters configured on the current line are copied and 
then pasted into the corresponding line numbers.

Starting Line Number Field

The Starting Line Number field is used to indicate the first line to copy signaling parameters to. 

NOTE: The Enable Signaling Autofill check box must be selected to enable autofill.

Ending Line Number Field

The Ending Line Number field is used to indicate the last line to copy signaling parameters to. 

NOTE: The Enable Signaling Autofill check box must be selected to enable autofill.

Call Logging

Display All Calls Check Box

The Display All Calls check box allows you to choose to display all calls sent to the console’s ID. If cleared, only calls sent to 
the console or a group containing the console’s ID display.

OK Button

The OK button saves the entries and closes the window.

Cancel Button

The Cancel button clears any entries made and closes the window.

Generic System Type

The Generic System Type option is used to configure the line for a system type other than those listed.
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To configure the line for a Generic system, do the following:

1. Select Edit|Per Line Parameters.
The Per Line Parameters window appears.

2. From the Line Type drop down menu, select Telex.

3. Click Signal Setup.
The Signaling Parameters window appears.

4. From the System Type drop down menu, select Generic.

5. Select Display All Calls, to show all IDs in the call list.

5/6 Tone DTMF ANI System Type

The 5/6 Tone/DTMF ANI (Automatic Number Identification) system type option is used to set the line type signal to 5/6 tone 
or DTMF signaling. 

To configure the line for a 5/6 DTMF ANI type, do the following:

1. Select Edit|Per Line Parameters. 
The Per Line Parameters window appears.

2. From the Line Type drop down menu, select Telex.

3. Click Signal Setup.
The Signaling Parameters window appears.

4. From the System Type drop down menu, select 5-6 Tone/DTMF ANI. 
The 5/6 Tone DTMF ANI Setup tab and Call Setup tab appear.

5/6 Tone DTMF ANI Setup Page. When 5/6 Tone DTMF ANI is selected from the System Type drop down menu, the 
5/6 Tone/DTMF ANI Setup page appears, shown in Figure 10.

FIGURE 10. 5/6 Tone/DTMF ANI Setup Page—Signaling Parameters
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Per Line Console ID Group Box

Unit ID Field

The Unit ID field is used to assign a numeric identifier to the console’s line. The unit ID appears when a radio is called from 
the specified console line.

This field can contain up to 8 digits.

Signaling Setup Group Box

Signaling Type Drop Down Menu

The Signaling Type drop down menu identifies the signaling type used when generating a call. 

Available selections for this field are:

Digit Duration Field

The Digit Duration field represents the length of time, in ms, the digit tone plays when it is active.

The range for this field is 25 to 9999ms.

Interdigit Duration Field

The Interdigit Duration field represents the length of time, in ms, between the digit tones within a group.

The range for this field is 25 to 9999ms.

Pause Duration Field

The Pause Duration field represents the length of time, in ms, allowed between transmitted groups.

NOTE: The pause duration must be at least the sum of the Digit and Interdigit Duration fields.

The range for this field is 25 to 9999ms.

CCIR1

CCIR2

DTMF

DZVEI

EEA

EIA

EURO

KENWOOD 5-TONE

MODAT

NATEL

PCCIR

PDZVEI

PZVEI

ZVEI1

ZVEI2
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Preamble Duration Field

The Preamble Duration field represents the length of time, in ms, the first tone digit plays. With some radio systems, the first 
tone needs to be longer than subsequent tones. For example, the first tone may be used to activate a dormant (battery saving) 
state.

NOTE: The preamble duration must be at least the amount of the Digit Duration field.

The range for this field is 25 to 9999ms.

Level Field

The Level field represents the relative level, in dB, the encoded message sends.

The range for this field is -20dB to +12dB.

Twist Level Field

The Twist Level field represents the relative level difference, in dB, of high and low tones generated when using DTMF tone 
types. This field is only active when DTMF is the selected tone type.

The range for this field is -10dB to +10dB.

Group Digit Field

The Group Digit field represents the group identification defined by the radio system. Typically this digit is not used 
anywhere else in the system.

This range for this field is 0–9 or A–D, # and *.

Repeat Digit Field

The Repeat Digit field identifies a repeat digit. Repeat digits are used to signal a digit has been repeated. Repeat digits are 
used to maintain tone transitions at appropriate intervals, which simplifies the decode function.

EXAMPLE: The repeat digit is E and the subscriber ID is 23335. The encoder string would actually send a tone 
string of 23E35.

Auto Ack Setup Group Box

Auto Ack Type Drop Down Menu

The Auto Ack Type drop down menu allows you to choose the signaling type desired to acknowledge receipt of a call. 

Available selections for this field are:

Disabled - Indicates no acknowledgement is sent after receiving a call.

Single-Tone - Indicates a single tone is sent after receiving a call.

Signaling - Indicates the Auto Ack field is available for formatting. 
For more information, see “Auto Ack Field” on page 84.
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Auto Ack Delay Field

The Auto Ack Delay field allows you to configure the lead-in delay, in ms, for receiving messages configured to transmit 
acknowledgements back to the calling radio. 

The range for this field is 0 to 9999ms.

Single Tone Auto Ack Setup Group Box

Frequency Field

The Frequency field represents the frequency, in Hz, generated during a single tone acknowledgement.

The range for this field is 0 to 4000Hz.

Duration Field

The Duration field represents the duration, in ms, of the single tone acknowledgement.

The range for this field is 25 to 9999ms.

Level Field

The Level field represents the relative level, in dB, the single tone acknowledgement sends. 

The range for this field is -20dB to +12dB.

Signaling Delays Group Box

Initial Delay Field

The Initial Delay field represents the lead-in delay, in ms, for console-generated messages transmitted to the field radios.

The range for this field is 0 to 9999ms.

End Delay Field

The End Delay field identifies the delay, in ms, at the end of transmitted messages to the field. It delimits the tone string.

The range for this field is 0 to 9999ms.

IMPORTANT: A value is required for this field. Do not leave blank.
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Call Setup Page. When 5/6 Tone/DTMF Tone ANI is selected from the System Type drop down menu the Call Setup page 
appears, shown in Figure 11. 

Call Setup Group Box

Auto Ack Field

The Auto Ack field represents an automatically generated acknowledgement message that is sent to the field after receiving a 
select call. First, configure the “Auto Ack Type Drop Down Menu” on page 82, then configure this field using the proper 
format.

This field can contain up to 32 characters.

Fields values can be:

DTMF Format - Allows for 0–9, *, #, A–D, G, I, K, P, R, and S.

5-Tone Format - Allows for 0–9, A–F, G, I, K, P, R, and S.

For more information, see table 2.

FIGURE 11. Call Setup Page—Signaling Parameters
Bosch Security Systems, Inc. Administrator’s Guide F.01U.218.561 Rev 03



C-Soft Administrator’s Guide C-Soft Designer Program  85
Ack Field

The ACK field represents the message sent each time an emergency ACK button, for that line, is pressed. This is also used if 
an emergency is sent to a specific console ID and auto acknowledge is enabled.

This field can contain up to 32 characters.

NOTE: A message is sent only if the emergency is active.

Field values can be: 

DTMF Format - Allows for 0–9, *, #, A–D, G, I, K, P, R, and S.

5-Tone Format - Allows for 0–9, A–F, G, I, K, P, R, and S.

For more information, see table 2.

PTT BOT Field

The PTT BOT (Push-To-Talk Beginning Of Transmit) field represents the message sent each time the PTT button is pressed 
on the console at the beginning of transmit. 

This field can contain up to 32 characters.

Field values can be: 

DTMF Format - Allows for 0–9, *, #, A–D, G, I, K, P, R, and S.

5-Tone Format - Allows for 0–9, A–F, G, I, K, P, R, and S. 

For more information, see table 2.

PTT EOT Field

The PTT EOT (Push-To-Talk End Of Transmit) field represents the message sent each time the PTT button is pressed on the 
console at the end of transmit.

This field can contain up to 32 characters.

Field values can be:

DTMF Format - Allows for 0–9, *, #, A–D, G, I, K, P, R, and S.

5-Tone Format - Allows for 0–9, A–F, G, I, K, P, R, and S.

For more information, see table 2.

Call 1–10 Format Field

The Call (1–10) Format fields represent the message sent when selected by the console operator on the Per Line Call History, 
Call List Window, or the Manual Call List window, see Figure 12. 

This field can contain up to 32 characters.

Field values can be: 

DTMF Format - Allows for 0–9, *, #, A–D, G, I, K, P, R, and S.

5-Tone Format - Allows for 0–9, A–F, G, I, K, P, R, and S.

For more information, see table 2.
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Call (1–10) Label Field

The Call 1–10 Label fields represent the label applied to the button on the Per Line Call History, the Manual Call Window, 
and the Call List Window pop-up button, shown in Figure 12. 

This field can contain up to 31 alphanumeric characters.

FIGURE 12. Per Line Call History Window

TABLE 2. Call Setup Group Format Descriptions

VALUE DESCRIPTION

I Stands for Console ID. Use the “Unit ID Field” on page 81 or “User ID Field” on page 88 to configure the Console ID. This 
value must match the number of digits in the Console ID.

For example, the Console ID is 123, the value entered in the format field would be III.

G Stands for Group. This is used to make a Group Call. The Group ID is configured on the “Edit System List Window - System 
Menu” on page 172 to configure Group IDs. This value must match the number of digits in the Group ID.

For example, the Group ID is 5000A, the value entered in the format field would be GGGGG.

NOTE: Not applicable for iDEN setup.

S Stands for Status. Use the “Status Message ID List Window” on page 163 to configure Status IDs

P Stands for Pause. When you want to format a pause into the string being sent out, use a P. Pause Duration is set up in 
Signaling Setup.

R Stands for Radio ID. You must enter the exact number of digits in the radio ID. For example, if you pick User ID 12356, you 
must enter RRRRR.

K Takes all the digits in the User ID of the type of call being made. In this format, you can enter a K, which enters all numbers 
associated with the User ID column.

NOTE: You can use any combination of these values with the numerical digits to create formats.
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FleetSync System Type

The FleetSync System Type option is used to configure the line used to encode/decode FleetSync IDs and status codes. 

To set the system type to FleetSync, do the following:

1. Select Edit|Per Line Parameters from the menu bar.
The Per Line Parameters window appears. 

2. From the Line Type drop down menu, select Telex.

3. Click Signal Setup. 
The Signaling Parameters window appears.

4. From the System Type drop down menu, select FleetSync.
The FleetSync Setup tab, appears.

5. From the System Name drop down menu, select a system for the line.

FleetSync Setup Page. When FleetSync is selected from the System Type drop down menu, the FleetSync Setup page 
appears, shown in Figure 14.

FIGURE 13. FleetSync System Type

FIGURE 14. FleetSync Setup Page—Signaling Parameters
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Per Line Console ID Group Box

Fleet ID Field

The Fleet ID field is used to enter the Fleet ID number of a group of FleetSync radios and is assigned per line. The Fleet ID is 
three (3) digits long and is added to the beginning of a 4-digit FleetSync ID, to form a 7-digit ID number. The Fleet ID is added 
to the unit ID to create the per line console ID. This ID appears on radio when receiving data/audio from that console line.

EXAMPLE: Fleet ID is 123 for the selected line. When the console operator selects FleetSync ID 4567, a call is 
made or status is sent to FleetSync ID number 1234567. Whenever the operator presses the PTT button 
or send a FleetSync data message, the receiving radios display the console ID configured for the line. 

The range for this field is 100 to 349.

User ID Field

The User ID field is used to identify the console’s Fleet ID and User ID to FleetSync radios programmed for 
Over-The-Air-Protocol. The FleetSync radio must be connected to an IP-223 or IP-224 through the Radio 1 or Radio 2 port. 

The range for this field is 1000 to 4999.

NOTE:

• The IP-223 or IP-224 must be configured for Over-The-Air-Protocol.

• The User ID does not appear on radios connected with the serial port.

Call Permission Setup Group Box

Allow Broadcast Calls on this Line Check Box

The Allow Broadcast Calls on this Line check box is used to grant the line permission to place FleetSync broadcast calls. 

Allow InterFleet Calls on this Line Check Box

The Allow InterFleet Calls on this Line check box is used to grant the line permissions to place calls to fleets or units outside 
the console’s fleet.

User Display Options Group Box

Only Display Filters Check Box

The Only Display Filters check box indicates, in addition to the system name, that only filters containing fleets and units 
display in the C-Soft Runtime system list, see Figure 15. All components in the system are visible including groups and 
individuals, otherwise only filters and their components are visible.
Bosch Security Systems, Inc. Administrator’s Guide F.01U.218.561 Rev 03



C-Soft Administrator’s Guide C-Soft Designer Program  89
NOTE: The Only Display Filters check box controls the system list appearance only. Component permissions are 
controlled per line, see “FleetSync Setup Page. When FleetSync is selected from the System Type drop down 
menu, the FleetSync Setup page appears, shown in Figure 14.” on page 87.

iDEN System Type

The iDEN System Type option is used to configure the line for iDEN type.

To configure the line for an iDEN type, do the following:

1. Select Edit|Per Line Parameters. 
The Per Line Parameters window appears. 

2. From the Line Type drop down menu, select Telex.

3. Click Signal Setup. 
The General Signal Setup page appears.

4. From the System Type drop down menu, select iDEN.
 The iDEN Setup tab and Call Setup appears.

FIGURE 15. FleetSync System List Filters Display in C-Soft Runtime

FIGURE 16. iDEN System Type
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iDEN Setup Page. When iDEN is selected from the System Type drop down menu, the iDEN Setup page appears, shown in 
Figure 17.

Signaling Setup Group Box

Signaling Type Drop Down Menu

The Signaling Type drop down menu, shown in Figure 18, identifies the signaling type used when generating an iDEN call. 

NOTE: DTMF is the default field value and can not be changed.

Digit Duration Field

The Digit Duration field represents the length of time, in ms, the digit tone plays when it is active.

The range for this field is 100 to 9999ms.

FIGURE 17. iDEN Setup Page—Signaling Parameters

FIGURE 18. Signaling Type Drop Down Menu— iDEN Setup
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Interdigit Duration Field

The Interdigit Duration field represents the length of time, in ms, between the digit tones within a group.

The range for this field is 50 to 9999ms.

Pause Duration Field

The Pause Duration field represents the length of time, in ms, allowed between transmitted groups.

NOTE: The pause duration must be at least the sum of the Digit and Interdigit Duration fields.

The range for this field is 150 to 9999ms.

Preamble Duration Field

The Preamble Duration field represents the length of time, in ms, the first tone digit plays. With some radio systems, the first 
tone needs to be longer than subsequent tones. For example, the first tone may be used to activate a dormant (battery saving) 
state.

NOTE: The preamble duration must be at least the amount of the Digit Duration field.

The range for this field is 100 to 9999ms.

Level Field

The Level field represents the relative level, in dB, the encoded message sends.

The range for this field is -20dB to +12dB.

Twist Level Field

The Twist Level field represents the relative level difference, in dB, of high and low tones generated when using DTMF tone 
types. This field is only active when DTMF is the selected tone type.

The range for this field is -10dB to +10dB.

Signaling Delays Group Box

Initial Delay Field

The Initial Delay field represents the lead-in delay, in ms, for console-generated messages transmitted to the field radios. 

NOTE: For iDEN configuration, this field is always set to 0ms and is not editable.

End Delay Field

The End Delay field identifies the delay, in ms, at the end of transmitted messages to the field. It delimits the tone string. 

NOTE: It is required to enter a value in this field. Do not leave blank.

The range for this field is 0 to 9999ms.
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Call Setup Page. When iDEN is selected from the System Type drop down menu, the Call Setup page appears, shown in 
Figure 19.

Call Setup Group Box

Auto Ack Field

The Auto Ack field for iDEN setup is disabled.

Emerg Resolved Field

The Emerg Resolved (Emergency Resolved) field for iDEN setup is disabled.

PTT BOT Field

The PTT BOT field for iDEN setup is disabled.

PTT EOT Field

The PTT EOT field for iDEN setup is disabled. 

Call 1–10 Format Field

The Call (1–10) Format fields represent the message sent when selected by the console operator using the Per Line Call 
History, Call List Window, or the Manual Call List window, see Figure 12. 

This field can contain up to 32 characters.

Field values can be:

DTMF Format - Allows for 0–9, *, #, A–D, G, I, K, P, R, and S.

For more information, see table 2.

FIGURE 19. Call Setup Page—Signaling Parameters: iDEN
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Call (1–10) Label Field

The Call 1–10 Label fields represent the label applied to the button on the Per Line Call History, the Manual Call Window, 
and the Call List Window pop-up button, shown in Figure 20. 

This field can contain up to 31 alphanumeric characters.

Kenwood-5x10 System Type

The Kenwood-5x10 System Type option is used to configure the line to encode/decode FleetSync IDs and status codes. 

To set the system type to FleetSync, do the following:

1. Select Edit|Per Line Parameters from the menu bar.
The Per Line Parameters window appears. 

2. From the Line Type drop down menu, select Telex.

3. Click Signal Setup. 
The Signaling Parameters window appears.

4. From the System Type drop down menu, select Kenwood-5x10.

5. From the System Name drop down menu, select a system for the line.

FIGURE 20. Per Line Call History Window

FIGURE 21. Kenwood-5x10 System Type
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MDC-1200 System Type

The MDC-1200 System type option is used to configure the line for MDC-1200 use. 

To configure the line for a MDC-1200 type, do the following

1. Select Edit|Per Line Parameters. 
The Per Line Parameters window appears.

2. From the Line Type drop down menu, select Telex.

3. Click the Signal Setup button.
The Signaling Parameters window appears.

4. Select MDC-1200 from the System Type drop down menu.
The MDC-1200 Setup tab, appears.

5. From the System Name drop down menu, select a system for the line. 

MDC-1200 Setup Page. When MDC-1200 is selected from the System Type drop down menu, the MDC-1200 Setup page 
appears, shown in Figure 22.

Per Line Console ID Group Box

Group ID: (In Hex) Field

The Group ID: (In Hex) field is used to identify the group ID for the console.

This field requires a 3-digit hexadecimal number (0–EEE).

IMPORTANT: Do not use the letter F in this field. It is reserved as a wild card digit used to create MDC-1200 custom 
call groups.

FIGURE 22. MDC-1200 Page—Signaling Parameters
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Unit ID (In Hex) Field

The Unit ID (In Hex) field is used to identify the MDC-1200 unit for the line.

This field requires a 4-digit hexadecimal number (1–DEEE).

NOTE:

• Apply the ID numbers as given in table 3.

• The letter F is reserved as a wild card digit used to create MDC-1200 custom call groups.

• A call sent to an ID containing the letter F is received by all units that match all the non-F characters.

EXAMPLE: A call sent to D1FF is received by all units with an ID between D100 and D1EE.

PTT ID Options 

PTT ID Options Drop Down Menu

The PTT ID Options drop down menu is used to indicate when an ID is sent while transmitting. 

Available selections for this field are: 

None - No PTT ID is sent when transmitting from the console.

Pre Only - The console’s PTT ID is sent before the voice stream begins.

Post Only - The console’s PTT ID is sent after the voice stream ends.

Pre and Post - The console’s PTT ID is sent both before and after the voice stream begins and ends.

TABLE 3. MDC-1200 Unit ID Ranges

Call Type ID Range

Unit Call 0001-DEEE

Group Call E000-EEEE

System Call FFFF

FIGURE 23. PTT ID Options Drop Down Menu
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Call Permission Setup Group Box

Allow Broadcast Calls on the Line Check Box

The Allow Broadcast Calls on the Line check box indicates the console operator is allowed to place call alerts, and place 
select calls to the entire system. 

NOTE: The system user ID is FFFF.

User Display Options Group Box

Only Display Filters Check Box

The Only Display Filters check box indicates, in addition to the system name, only groups and units contained in the filter 
display in the system list in C-Soft Runtime, shown in Figure 24. When selected, only filters and their components are visible 
otherwise all components in the system appear in the system list. 

NOTE: The Only Display Filters check box controls the system list appearance. Component permissions are controlled 
per line. For more information, see “Call Permission Setup Group Box” on page 88.

FIGURE 24. MDC-1200 System List Filters Display in C-Soft Runtime
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MOTOTRBO System Type

The MOTOTRBO system type option is used to configure the line for MOTOTRBO use.

To configure the line for MOTOTRBO type, do the following:

1. Select Edit |Per Line Parameters from the menu bar. 
The Per Line Parameters window appears.

2. From the Line Type drop down menu, select Telex.

3. Click Signal Setup.
The Signaling Parameters window appears.

4. From the System Type drop down menu, select MOTOTRBO.
The MOTOTRBO Setup tab appears. 

5. From the System Name drop down menu, select a system for the line.

MOTOTRBO Setup Page 

When MOTOTRBO is selected from the System Type drop down menu, the MOTOTRBO setup page appears, shown in 
Figure 25.

FIGURE 25. MOTOTRBO Setup Page
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SOIP Setup Group Box

The SOIP Setup group box is used to set up communication between the IP-223 or IP-224 and C-Soft to send and receive 
serial data. The fields in this section must match the same fields for the specified line on the IP-223 or IP-224. 

REFERENCE: For more information, see the MTRBi Installation Manual (F01U247183).

RX Multicast Address Field

The RX Multicast Address field indicates the Multicast Address used to receive serial data over the network. This is the same 
Serial Over IP RX Multicast Address set up in the IP-223’s or IP-224’s Multicast Address Setup window for the associated 
MOTOTRBO line.

RX Port Field

The RX Port field indicates the RX port number used to receive serial data. This is the same Serial Over IP RX port number 
set up on the IP-223 or IP-224 for the associated MOTOTRBO line.

TX Multicast Address Field

The TX Multicast Address field indicates the Multicast Address used to send serial data. This is the same Serial Over IP TX 
Multicast Address set up in the IP-223’s or IP-224’s Multicast Address Setup window for the associated MOTOTRBO line.

TX Port Field

The TX Port field indicates the TX port number used to send serial data. This is the same Serial Over IP TX port number set 
up on the IP-223 or IP-224 for the associated MOTOTRBO line.

Control Line Setup Group Box

The Control Line Setup group box section is used to set up multiple C-Soft consoles to communicate with the same 
MOTOTRBO radio.

Multicast Address Field

The Multicast Address field indicates the Multicast Address used by the console to communicate with MOTOTRBO radio. 
The Multicast Address is configured for the line in the Per Line Parameters window.

This field is not editable.

Control Port Field

The Control Port field indicates the port used to communicate with the MOTOTRBO radio. 

The default value for this field is 1000 more than the TX Port value configured for the line on the Per Line Parameters 
window. 

To change the TX Port value, do the following:

1. Clear the Default check box.
The Control Port field becomes editable. 

2. In the Control Port field, enter a port number.
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Default Check Box

The Default check box is used to accept the control port’s default value. The default value is calculated by adding 1000 to the 
TX Port number for the line. When the check box is selected, this value is automatically entered in the field. Clear the check 
box to enter a different value.

Network Setup Group Box

The Network Setup group box section is used to set up the MOTOTRBO radio to send text messages and allow GPS (Global 
Positioning System) to work in C-Soft.

NOTE: The CAI (Common Air Interface) Network and CAI Group Network fields in C-Soft Designer must match the 
CAI network and CAI Network Group configured in the MOTOTRBO CPS software.

REFERENCE: For more information, see Motorola’s technical documentation.

CAI Network Field

The CAI Network field is used to enter the value for the CAI network configured on the radio.

The range for this field is 1 to 126.

CAI Group Network Field

The CAI Group Network field is used to enter the value for the CAI Group Network configured on the radio.

The range for this field is 225 to 239.

Phone System Type

The Phone system type option is used to configure the line for standard phone use, as shown in Figure 26.

Available selections for this field are: 

Generic - If Generic is selected no additional signalling is being used.
For more information, see “Generic System Type” on page 79. 

Phone - Phone enables the ability to send additional DTMF signalling to IP-223.
For more information, see “Phone System Type” on page 99.

To configure the line for a phone type, do the following:

1. Select Edit|Per Line Parameters. 
The Per Line Parameters window appears. 

2. From the Line Type drop down menu, select Phone.

FIGURE 26. Phone System Type
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3. Click the Signaling Setup button. 
The Signaling Parameters window appears.

4. From the System Type drop down menu, select Phone.
The Phone Setup tab and the Call Setup tab appear.

Phone Setup Page. When Phone is selected from the System Type drop down menu, the Phone Setup page appears, shown in 
Figure 27.

Signaling Setup Group Box

Signaling Type Drop Down Menu

The Signaling Type drop down menu, shown in Figure 28, identifies the signaling type used when generating a phone call. 
DTMF is the default field value and can not be changed.

FIGURE 27. Phone Setup Page—Signaling Parameters

FIGURE 28. Signaling Type Drop Down Menu—Phone Setup Page
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Digit Duration Field

The Digit Duration field represents the length of time, in ms, the digit tone plays when it is active.

The range for this field is 100 to 9999ms.

Interdigit Duration Field

The Interdigit Duration field represents the length of time, in ms, between the digit tones within a group.

The range for this field is 50 to 9999ms.

Pause Duration Field

The Pause Duration field represents the length of time, in ms, allowed between transmitted groups.

NOTE: The Pause Duration must be at least the sum of the Digit and Interdigit Duration fields.

The range for this field is 150 to 9999ms.

Preamble Duration Field

The Preamble Duration field represents the length of time, in ms, the first tone digit plays. With some radio systems, the first 
tone needs to be longer than subsequent tones. For example, the first tone may be used to activate a dormant (battery saving) 
state.

NOTE: The Preamble Duration must be at least the amount of the Digit Duration field.

The range for this field is 100 to 9999ms.

Level Field

The Level field represents the relative level, in dB, the encoded message sends.

The range for this field is -20dB to +12dB.

Twist Level Field

The Twist Level field represents the relative level difference, in dB, of high and low tones generated when using DTMF tone 
types. This field is only active when DTMF is the selected tone type.

The range for this field is -10dB to +10dB.
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Signaling Delays Group Box

Initial Delay Field

The Initial Delay field represents the lead-in delay, in ms, for console-generated messages transmitted to the field radios.

The range for this field is 0 to 9999ms.

End Delay Field

The End Delay field identifies the delay, in ms, at the end of transmitted messages to the field. It delimits the tone string. 

NOTE: It is required to enter a value in this field. Do not leave blank.

The range for this field is 0 to 9999ms.

When Phone is selected from the System Type drop down menu, the Call Setup page appears, shown in Figure 29.

Call Setup Group Box

Auto Ack Field

The Auto Ack field for phone setup is disabled.

Emerg Resolved Field

The Emerg Resolved field for Phone Setup is disabled. 

FIGURE 29. Call Setup Page—Signaling Parameters Phone
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PTT BOT Field

The PTT BOT field for Phone Setup is disabled. 

PTT EOT Field

The PTT EOT field for Phone Setup is disabled.

Call 1–10 Format Field

The Call (1–10) Format fields represent the message sent when selected by the console operator on the Per Line Call History, 
Call List Window, or the Manual Call List window, shown in Figure 12.

This field can contain up to 32 characters.

Field values can be:

DTMF Format - Allows for 0–9, *, #, A–D, G, I, K, P, R, and S.

For more information, see table 2.

Call (1–10) Label Field

The Call 1–10 Label fields represent the label applied to the button on the Per Line Call History, the Manual Call Window, 
and the Call List Window pop-up button, shown in Figure 30.

This field can contain up to 31 alphanumeric characters.

FIGURE 30. Per Line Call History Window
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SIP Button

After the Line Type is set to SIP Phone on the Per Line Parameters window, the SIP button, shown in Figure 31, is available 
for selection.

The SIP button opens the Configuration SIP Settings window, shown in Figure 32. 

Configure SIP Settings Window

The Configure SIP Settings window, shown in figure 32, is used to register the SIP Address, set up automatic call answering, 
and set the display’s background color.

Address of Record Field

The Address of Record field is used to enter the SIP server registration address, which is typically in the format <extension 
number>@<server address>. An example of an SIP server registration address: 200@192.168.0.100.

Name Field

The Name field is used to specify the username used to register the SIP Server. This is typically the same as the extension 
number on the SIP server.

Password Field

The Password field is used to specify the password used to register to the SIP server. This is typically known as secret on the 
SIP server. 

FIGURE 31. SIP Button - SIP Phone Line Type

FIGURE 32. Configure SIP Settings Window
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Realm Field

The Realm field is used to specify the realm used to register to the SIP server. This is typically the same as the address or name 
of the SIP server. 

Registrar Compatibility

The Registrar Compatibility field is used to specify the compatibility level of the specified registrar server with RFC 3581 (SIP 
Symmetric Response Routing). The default selection is “Fully Compliant”.

Available selections for this field are:

Fully Compliant -                                    Registrar is fully compliant with RFC 3581 and will register any number and all 
types of listeners in the SIP packet header’s Contact field.

Cannot Register Multiple Contacts - Registrar is able to register only one contact in the SIP packet header’s 
Contact field.

Cannot Register Private Contacts - Registrar is unable to register any contacts in the SIP packet header’s 
Contact field.

Has Application Layer Gateway - Network address translations will be handled externally by a router with an
Application Layer Gateway. Network address translations should not be
performed by C-Soft.

Incoming Calls are Automatically Answered Check Box

The Incoming Calls are Automatically Answered check box indicates all incoming calls on the line are automatically 
answered. 

Color Drop Down Menu

The Color drop down menu is used to change the background color on the SIP Call display window. A lighter color is 
recommended.

For more information see, “SIP Phone Line Configuration” on page 143.

To configure the line for a SIP phone, do the following:

1. From the menu bar, select Edit|Setup Per Line Parameters. 
The Per Line Parameters window appears.

2. From the Line Type drop down menu, select SIP phone.
The SIP button is active.

3. In the Line Name field, enter a name for the line.

4. Select the Echo Packets check box (optional).

a. In the RX Multicast Address field, enter the desired echo destination.

b. In the RX port field, enter the desired Port number. 

5. In the TTL field, enter a value between 1 and 99.

6. Click SIP.
The Configure SIP Setting For Line X - (where X is the line number) window appears.

7. In the Address of Record field, enter the SIP Address for the particular line.

EXAMPLE:If the account number is 12345 and it is registered through HuskerAccess.com then the complete 
account number is 12345@HuskerAccess.com.
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8. In the Name field, enter the authorized name.

9. In the Password field, enter the authorized password.

10. In the Realm field, enter and authorized realm parameters.

NOTE: Parameters for registering your SIP line are obtained from your server administrator.

11. Select the Incoming Calls are Automatically Answered check box to automatically answer phone calls on the line.

12. From the Color drop down menu, select a background color for the SIP Call Display.

13. Click OK.
The Configure SIP Settings window closes.

14. Click OK. 
The Per Line Parameters window closes.

AutoFill Button

The AutoFill button, shown in Figure 33, opens the AutoFill Line Parameters window.

AutoFill Line Parameters Window

The AutoFill Line Parameters window, shown in Figure 34, is used to eliminate repetitious data entry by automatically 
populating the corresponding fields on the Per Line Parameters window with the entries shown in the AutoFill Line Properties 
window. The RX and TX entry automatically increment by one (1) for each filled line. 

NOTE: Enter the starting line number and ending line numbers to automatically fill in the appropriate line.

FIGURE 33. Per Line Parameters AutoFill Button

FIGURE 34. AutoFill Line Parameters Window
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RX IP Address Field

The RX IP Address field indicates the IP Address used to receive serial data over the network. 

TX IP Address Field

The TX IP Address field indicates the IP Address used to send serial data over the network. 

Line Type
The Line Type drop down menu displays the available selections for the line type.

Available selections for this field are Disabled, Telex, Phone, SIP Phone and P25-DFSI.

RX Port Start Field

The RX Port Start field indicates the RX port start number used to receive serial data. 

TX Port Start Field

The TX Port Start field indicates the TX port start number used to transmit serial data.

TTL Field

The TTL field indicates the lifespan of data in a computer or network.

The range for this field is 1 to 100.

Packet Delay Field

The Packet Delay field, is used to enter a packet delay number.

The range for this field is 4 to 27.

Vocoder Type Drop Down Menu
The Vocoder Type drop down menu indicates the bit rate at which audio is converted into digital format. This feature is used
to configure communication between C-Soft and an IP-223 or IP-224.

Available selections for this field are: TELEX 32K, G.726 16K, G.726 32K (IP224 Only), and G.711 64K (IP224 Only).

Starting Line Number Field

In the Starting Line Number is used to enter a starting line number.

The range for this field is 1 to 200.

Ending Line Number Field

In the Ending Line Number field is used to enter an ending line number.

The range for this field is 1 to 200.

To fill line parameters with the autofill feature, do the following:

1. From the menu bar, select File|Setup Per Line Parameters.

2. Click Autofill.
The AutoFill Line Parameters window appears.

3. In the RX IP Address field, enter an RX IP Address.

4. In the TX IP Address, enter a TX IP Address.
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5. In the Line Type drop down menu, select a Line Type.

6. In the RX Port Start field, enter an RX Port start number.

7. In the TX Port Start field, enter a TX Port start number.

8. In the TTL field, enter a TTL.

9. In the Packet Delay field, enter a Packet Delay number.

10. In the Starting Line Number filed, enter a starting line number.

11. In the Ending Line Number field, enter an ending line number.

12. Click OK.
The IP Addresses, port numbers and TTL automatically fill in the appropriate fields starting and ending with line 
numbers entered in the AutoFill Line Parameters window. 

OK Button

The OK button saves the entries and closes the window.

Cancel Button

The Cancel button clears any entries made and closes the window.

Global Parameter Setup Window

The Global Parameter window, shown in Figure 35, is used to navigate to the Appearance, Audio, Control Settings, Local 
Consoles, Peripherals, and Recording pages to configure global settings.

NAVIGATION: Select Edit|Setup Global Parameters from the menu bar.
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Appearance Page. The Appearance page, shown in Figure 35, is used to configure the caller ID, change the background 
color, and apply a logo to the console desktop and set the button style.

ANI Setup Group Box

Enable Sticky ANI Check Box

The Enable Sticky ANI field indicates the ANI displayed on the select button remains visible until the next call is received.

FIGURE 35.  Appearance Page—Global Parameters Setup
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Enable Residual ANI Check Box

The Enable Residual ANI check box indicates the previous caller’s ANI continues to display after receiving a call from a user 
without ANI capabilities; otherwise, the caller’s ANI disappears when the call is ended.

Clear ANI on PTT Check Box

The Clear ANI on PTT check box indicates the ANI, normally displayed on the select button, is cleared when a PTT 
operation is selected.

Console Name Group Box

Console Name Field

The Console Name field is used to assign a name to the console. If a name is assigned, it appears in the Network Devices list 
in Telex System Manager, otherwise the console’s IP Address appears.

This field can contain up to 12 characters.

Logo Group Box

Bitmap Filename Field

The Bitmap Filename field identifies the file name and location for a bitmap (typically a company logo) saved in the current 
console position’s folder. The file must be a bitmap (.bmp) and it must be located in the same directory as the C-Soft. 
Runtime.exe file.

NOTE: C-Soft supports 1-bit, 4-bit, 8-bit and 24-bit bitmaps.

The field can contain up to 255 characters.

Browse Button

The Browse button opens the Open window, used to navigate to the logo bitmap file. 

To change the bitmap file, do the following: 

1. Click Browse.
The Open window appears.

2. Select the file you want to use for the bitmap.

3. Click Open.
The path to the bitmap file appears in the field.

Position Drop Down Menu

The Position drop down menu is used to select the location of the bitmap logo on the console window.

Available selections for this field are: Upper-Left, Upper-Right, Lower-Left, Lower-Right, Center and Stretch.
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Background Color Group Box

Background Color Drop Down Palette

The Background Color drop down palette displays the background color for the console and pop-up windows. Use the drop 
down button to open a palette to select the desired color.

The default color is black.

Button Style Group Box

The Button Style group box is used to select a button style. Selections include: Classic, Glossy Cir, Glossy Rec, and Vista.

Classic Radio Button

The Classic button, if selected, indicates the buttons are displayed in a classic style.

Glossy Cir Radio Button

The Glossy Cir radio button, if selected, indicates the buttons are displayed in a glossy circle style.

FIGURE 36. Classic Button Style

FIGURE 37. Glossy Cir Button Style
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Glossy Rec Radio Button

The Glossy Rec radio button, if selected, indicates the buttons are displayed in a glossy rectangle style.

Vista Radio Button

The Vista radio button, if selected, indicates the buttons are displayed in a vista style.

Button Border Group Box

The Button Border group box is used to select the thickness of the border.

Thickness Spin Box

The Thickness spin box is used to set the thickness of the border around the UI button. The higher the value, the thicker the 
border. 

The range for this field is 0 to 10. 
The default is 5.

Button Flash Color Group Box

The Button Flash Color section is used to set the blink color for Select buttons when receiving one (1) of the following call 
types.

Call Alert Drop Down Palette

The Call Alert drop down palette is used to set the button color when a Call Alert is being received. The button blinks when 
an alert is received.

FIGURE 38. Glossy Rec Button Style

FIGURE 39. Vista Button Style
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Group Call Drop Down Palette

The Group Call drop down palette is used to set the button color when a Group Call is being received. The button blinks when 
a Group Call is received.

Emergency Drop Down Palette

The Emergency drop down palette is used to set the button color when an Emergency call is being received. The button blinks 
when an Emergency call is received. 

Select Call Drop Down Palette

The Select Call drop down palette is used to set the button color when a Select call is being received. The button blinks when 
a Select call is received. 

Audio Page. The Audio page, shown in Figure 40, is used to configure audio routing and blocking.

Audio Muting and Routing Group Box

Sum Unselect to Headset when On Check Box

The Sum Unselect to Headset when On check box indicates when an HB-3 or ADHB-4 is active, select and unselect audio is 
combined and routed to the headset.

Mute Select Audio During PTT Check Box

The Mute Select Audio During PTT check box indicates select audio is muted when PTT is used.

FIGURE 40. Audio Page—Global Parameters Setup
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Mute Unselect Audio During PTT Check Box

The Mute Unselect Audio During PTT check box indicates unselect audio is muted when PTT is used.

Mute Lines When Unselected Check Box

The Mute Lines When Unselected check box indicates unselected lines are automatically muted (only selected line is heard).

Allow Muting Selected Lines Check Box

The Allow Muting Selected Lines check box indicates the console operator is able to mute selected lines on the console.

Mute Selected Channels with RX Block Check Box

The Mute Selected Channels with RX Block check box indicates the console operator is able to mute channels on which RX 
Block is enabled.

Disable Local iDEN Tones Check Box

The Disable Local iDEN Tones check box indicates the console does not generate go ahead beeps. Beeps are generated by the 
iDEN radio attached to the system. 

Audio Blocking Group Box

RX Block Delay Field

The RX Block Delay field identifies the amount of time, in ms, the release of the RX blocked line is delayed. The RX blocked 
lines are selected on the Per Line Frequency Setup window, see “RX Block Lines Display Box” on page 77. This delay allows 
any IP- and/or system-delayed audio to end before releasing the muted lines.

The range for this field is 300 to 5000ms.
The default is 0.

To disable this feature, do the following:

 > In the RX Block Delay field, enter 0 ms.

DTMF Setup Group Box

Flywheel Field

The Flywheel field identifies the amount of time, in ms, allowed to pass between clicks of different DTMF keypad keys before 
the radio is keyed down by the console.

The range for this field is 300 to 5000ms.
The default is 2000.

Level Field

The Level field identifies, in dB, the relative audio level to be transmitted. The actual level transmitted by the radio varies 
depending on the system. This field allows the console designer to adjust the relative level up or down after the remainder of 
the system is aligned and operational.

The range for this field is -30 to 10dB.
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MIC AGC Group Box

The MIC AGC (Automatic Gain Control) group box indicates the C-Soft program supports a software based microphone 
AGC. It has no effect on ADHB-4 operation.

Enable Check Box

The Enable check box is used to help equalize speech level variations caused by the use of different microphones, different 
speaking distances to the microphone, and different volumes of speech

Target Level Field

The Target Level field identifies the audio level, in dB, the MIC AGC packets are adjusted to. 

• If the measured audio level is above the target level, the audio is reduced in gain. 

• If the incoming level is below the target, up to 6dB of gain is applied to bring the level up.

The range for this field is -30dB to 6dB.

Min Active Field

The Min Active field identifies the audio level, in dB, at which the AGC software stops trying to adjust the audio level. If 
audio below this level is detected, the AGC software does not attempt to adjust the audio. This prevents open mics from 
amplifying background noise onto the transmit channel.

The range for this field is -60 to 0 dB.

Control Settings Page. The Control Settings page, shown in Figure 41, is used to enable various console controls, a 
supervisor password and points to FleetSync, MDC1200 and MOTOTRBO system files.

FIGURE 41. Control Settings Page—Global Parameters Setup
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User Control Options

Allow Freq Update Anytime Check Box

The Allow Freq Update Anytime check box indicates frequency updates are accepted at any point in the RX stream. 
Otherwise, frequency updates are accepted at the beginning of a call, before audio playback begins. 

Always Stack Pages Check Box

The Always Stack Pages check box indicates pages are stacked before sending. This prevents pages from being sent 
accidentally or before the stack is finished. The console operator must click the Page button before sending the stacked pages.

NOTE: This option must be selected if using the Stack Programmed Page Stacks option. See “Stack Programmed Page 
Stacks Check Box” on page 116.

Disable Spacebar PTT Check Box

The Disable Spacebar PTT check box indicates the spacebar is not used for PTT.

Kill Lines on Crosspatch Check Box

The Kill Lines on Crosspatch check box indicates the console operator cannot transmit on a line included in a crosspatch by 
a parallel console operator. Otherwise, the console operator is allowed to transmit on the lines even if another console operator 
has included the lines in a crosspatch.

Stack Programmed Page Stacks Check Box

The Stack Programmed Page Stacks check box indicates multiple Page Stack Programmed buttons can be stacked together 
using the Page Stack button. This check box must be selected to enable the console operator to stack programmed stack pages 
using the Page Stack button or when the Always Stack Pages option is selected.

Page Frequency Revert

The Page Frequency Revert check box is used when a Page is set up to go to a specific frequency and the check box is 
enabled. The line switches back to the previous frequency it was set on after the Page goes out. The Page has 0 talk time.

Control Timeouts Group Box

Supervisor Field

The Supervisor field controls the parallel console crosspatch timeout. The timeout is controlled by the Supervisor console 
initiating the action. 

The range for this field is 0 to 3600 seconds

EXAMPLE: Console 1 has supervisor timeout set to 10 seconds.
Console 2 has supervisor timeout set to 2 seconds.
Case 1: If console 1 initiated the action, then both consoles timeout after 2 seconds.
Case 2: If console 2 initiated the action, then console 2 times out in 2 seconds and console 1 times out in 
10 seconds.

To disable supervisor timeout, do the following:

 > In the Supervisor field, enter 0.
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Crosspatch Field

The Crosspatch field indicates the amount of time, in seconds, a crosspatch is allowed to remain inactive before it is dropped. 

The range for this field is 0 to 3600 seconds

To disable crosspatch inactivity, do the following:

 > In the Crosspatch field, enter 0.

Save Runtime Setting Group Box

Save Runtime Status on Close Check Box

The Save Runtime Status on Close check box indicates the console size, position, settings, and selections are saved to the 
cposi.txt when the program is closed. Otherwise, the size position, and selections are not saved when C-Soft Runtime is 
closed. 

NOTE:

• For more information, see “Window Sizing” on page 367.

• C-Soft opens only the current version of the cposi.txt file.

System List Group Box

Filename Field

The Filename field indicates the name of the default system file used when the Edit System window appears. If left blank, the 
Edit System window opens to a blank system. The filename identifies the path to the saved FleetSync, MDC-1200, and/or 
MOTOTRBO system file.

NOTE: For more information, see “Edit System List Window” on page 168.

Supervisor Password

Supervisor Password Field

The Supervisor Password field is used to assign a password for the supervisor function and any other password protected 
functions.

This field can contain up to 16 alphanumeric characters.

NOTE: The supervisor password saved in earlier versions of C-Soft automatically updates.

Window Controls Group Box

Window Controls Check Boxes

The Window Controls check boxes indicate the standard window controls are included on the dispatch console window. 
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Available selections for this field are:

Allow Minimize - allows the console operator to minimize the dispatch window to a button on the toolbar.

Allow Maximize - allows the console operator to maximize the dispatch window.

Allow Resize - allows the console operator to resize the dispatch window.

Allow Move - allows the console operator to move a dispatch window that has been resized.

Allow Close - allows the console operator to close a dispatch window. If this selection is not enabled, the only 

way to shut down the dispatch console position is to use the Windows Task Manager1.

DTMF Radio Button

The DTMF radio button indicates DTMF tones are used when keyboard number keys are pressed.

Knox Radio Button

The Knox radio button indicates Knox tones are used when keyboard number keys are pressed. Knox tones are specific tones 
used to unlock Knox boxes. These boxes are used primarily by fire departments.

Local Console Page. The Local Console page, shown in Figure 42, is used to configure the IP Address of a local console. 

Local Console IP Addresses Group Box

Local Console IP Address Fields

The Local Console IP Address fields identify up to 10 base IP Addresses of the Hardware IP Console (IP-2002, IP-1616, and 
C-6200) and C-Soft consoles that reside in the same room.

The source of the audio is examined by the C-Soft program, and, if the source is from a console in this list, the audio is muted. 
An exception to the muting rule is, if an HB-3 or an ADHB-4 is connected and the headset is turned on. In this case, the 
received audio is routed to the headset earpiece and is played, ignoring the crossmute condition.

1. Press Ctrl+Alt+Delete to open Windows Task Manager

FIGURE 42. Local Console Page—Global Parameters Setup
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Crossmute File

The Crossmute File is used to allow each position to have its own crossmute settings without requiring a different design 
file by populating the Local Console IP Address fields with a .txt file, 

To create a crossmute file, do the following:

1. In a .txt file, enter up to 100 IP Addresses (one per line).

2. Select File|Save from the menu bar.
The Save window opens.

3. In the File Name field, enter csoft_crossmutes.txt.

4. From the Look in drop down menu, select C:\Documents and Settings\AllUsers\Application Data\Telex 
Communications\design_folders. (Windows XP)
OR
From the Look in drop down menu, select C:\ProgramData\Telex Communications\design_folder. (Windows 7)

5. Click Save.
The IP Addresses are loaded from this file and replace the entries in the Global Properties Setup window. 

Peripherals Page. The Peripherals page, shown in Figure 45, is used to configure a network phone and peripheral devices.

FIGURE 43. Peripherals Page—Global Parameters Setup
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Network Setting Group Box

IP Interface Spin Box

The IP Interface spin box is used to select the network interface. The C-Soft program can be configured to use any of the first 
four (4) interfaces.

If no traffic is detected on the selected interface, do the following:

1. From the IP Interface spin box, select a different interface (0–3).

2. Save the C-Soft Designer.exe file. 

3. Restart the C-Soft Runtime console.

NOTE: If at least one (1) Ethernet connection is present, the value always defaults to zero (0), often resulting in no 
traffic detected. If your computer has an Ethernet connection not being used to run C-Soft Runtime, we 
recommend turning off that connection or setting the value in the field to 1, 2, or 3.

IMPORTANT: If you choose to run a simultaneous Ethernet connection and run C-Soft at the same time, you might 
lose your C-Soft Ethernet connection.

EXAMPLE: The wireless connection is located at interface 0 and the C-Soft Ethernet connection is located at 
interface 1. If the computer becomes disconnected from the wireless connection, Windows 
automatically moves the C-Soft Ethernet connection from interface 1 to interface 0. In this case, C-Soft 
is disconnected from the Ethernet.

Radio Ping Interval Field

The Radio Ping Interval field identifies the time, in seconds, between ping attempts on the base radio IP Address. The typical 
amount of time is 300 seconds or five (5) minutes. A value of zero (0) disables the function.

The range for this field is 0 to 9999 seconds.

TCP/IP Time Out Field

The TCP/IP Time Out field indicates the amount of time, in ms, before the TCP/IP connection times out. 

The range for this field is 1000 to 20000ms.

Enable RX Multicast Loopback Check Box

The Enable RX Multicast Loopback check box is used to enable the current console configuration to receive Multicast audio 
sent from the same PC currently running C-Soft.
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Phone Group Box

Ring Multicast and Port Fields

The Ring Multicast and Port fields identify the IP Address and port number the ring signal is broadcast to. The entry in this 
field should correspond to the values set in a C-6200 console with an actual phone card interface, on IP-223 or IP-224 with 
Telex’s PIB or TDI Adapter attached.

Ring Port Field

The Ring Port field is used to identify the port number the ring signal is broadcast to. The entry in this field should correspond 
to the values set in a C-6200 console with an actual phone card interface, Telex’s IP-223 or IP-224 with a PIB, or Telex’s TDI 
adapter attached.

Ring Sound Drop Down Menu

The Ring Sound drop down menu is used to select the ring sound heard when a call is received.

Available selections for this field are: Ring 1, Ring 2, Ring 3, and Ring 4.

Ring in Unselect Speaker Check Box

The Ring in Unselect Speaker check box is used to indicate the phone ring is heard in the Unselect speaker instead of the 
Select speaker (ear piece).

Auto Hold Phone Line on PTT Check Box

The Auto Hold Line on PTT check box is used to indicate any phone currently offhook is put on hold when any PTT button 
is pressed.

NOTE: Feature supported in both Line Types “Phone and SIP”.

NEO-10 Group Box

The NEO-10 device sends out a UDP packet anytime one (1) of its inputs or outputs changes state. The C-Soft program 
monitors this traffic and allows all users of the equipment to see input and output status changes.

Multicast Field

The Multicast field identifies the Multicast Address of the NEO-10 device. 

The entry in this field should correspond to the entry on the NEO-10 Multicast Setup window. 

Update Port Field

The Update Port field identifies the port number of the NEO-10 device. 

The entry in this field should correspond to the entry on the NEO-10 Mulitcast Setup window.
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License Server Group Box

IP Address/Name Field

The IP Address/Name field identifies the IP Address or the name of the license server on which the key management driver is 
installed. This allows a remote key server to be used for license management.

When a single PC is loaded with the key management driver, up to 10 individual keys can be connected to the server PC. 
Five (5) of each key type is supported by the key management driver software. This means five (5) USB and five (5) parallel 
port keys can be connected to the server.

When the server PC is set up, each individual computer with the hardware security key driver installed on it has the direct IP 
Address or the network name of the server PC entered in the License Server IP Address/Name field. The server allows 
concurrent use of the C-Soft software up to its key count number. This method has the advantage of making the C-Soft 
software more portable across a network.

If more than 10 concurrent licenses are required, contact the Telex Radio Dispatch sales department for license server options. 
See page 2.

Rather than entering the IP Address or the name of the license server the key management driver is installed on, dual mode can 
be entered in the field as the license server. When dual mode is entered in the field, the console looks for a hardware security 
key on the local machine first. If a hardware security key is not found, the console looks for license servers on the network. 
This option allows multiple license servers to reside on a network, providing greater redundancy and fault tolerance.

NOTE: This option can cause a slightly slower boot-up. 

HB-3 Group Box

Serial Port Drop Down Menu

The Serial Port drop down menu identifies the PC serial port connection for the HB-3 Headset Adapter Panel. The HB-3 unit 
allows the connection of standard dispatcher accessories including a desk mic, two (2) headsets, and a footswitch. This 
functionality allows the C-Soft program to respond to PTTs from a footswitch without requiring the console operator to move 
a mouse cursor to the C-Soft application. This operates even if the C-Soft application does not have the focus.

Available selections for this field are: Disable, Com 1, Com 2, Com 3, and Com 4.

FIGURE 44. Serial Port Drop Down Menu
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ADHB-4 Speaker Volume Group Box

Speaker 1–6 Min Volume Field 

The Speaker 1–6 Min Volume field indicates the minimum selectable volume level for speakers connected to jacks 2–6. 
During C-Soft operation, the volume for the specified speaker cannot be set lower than the percentage configured for the 
speaker in this field. 

NOTE: Speaker 1’s volume is controlled with the Volume Master Select button. See “UI Element Setup Window—Add 
UI Vol. Control” on page 337.

This field ranges from 0% to 100%.

Recording Page. The Recording page, shown in Figure 45, is used to configure a recording with Telex’s Network Recorder. 

REFERENCE: For more information, see the Telex Network Recorder Technical Manual and Archive Database Reviewer
(F01U188143).

NOTE: The microphone only records during activity, such as a telephone call or PTT.

FIGURE 45. Recording Page—Global Parameters Setup
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Enable Check Box

The Enable check box is used to enable the Select speaker, Unselect speaker, speakers 3–6, microphone, or NENA for 
recording from the indicated IP Address and port.

NOTE: Speakers 3–6 and NENA are used when an ADHB-4 is connected to the network.

Vocoder Type Drop Down Menu

The Vocoder Type drop down menu indicates the bit rate at which audio is converted into digital format. This feature is used 
to configure communication between C-Soft and an IP-223 or IP-224.

Available selections for this field are: TELEX 32K, G.726 16K, G726 32K (IP224 Only), and G.711 64K (IP224 Only).

Multicast Field

The Multicast field indicates the console’s Multicast Address for the selected speaker, microphone, or NENA.

NOTE: If multiple consoles are in use, this option requires a separate configuration for each console.

Port Field

The Port field indicates the port used for the selected speaker, microphone or NENA audio. 

NOTE: The port number must be unique from all other ports configured on the console.

TTL Field

The TTL field indicates the lifespan of data in a computer or network.

The range for this field is 1 to 128.
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Global Call Parameters Window

The Global Call Parameters window, shown in Figure 46, is used to configure call window names, buttons, button labels, 
button color codes, column labels, fonts, and the number of lines to display in the window.

NAVIGATION: Select Edit|Setup Global Call Parameters from the menu bar.

Window Titles Group Box

Active Emergency Field

The Active Emergency field allows you to name the window that appears when the Active Emergency button is clicked in the 
C-Soft Runtime program.

This field can contain up to 10 characters.

Emergency History Field

The Emergency History field allows you to name the window that appears when the Emergency History button is clicked in 
the C-Soft Runtime program.

This field can contain up to 10 characters.

FIGURE 46. Global Call Parameters Window
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Per Line Call History Field

The Per Line Call History field allows you to name the window that appears when the Per Line Call History button is clicked 
in the C-Soft Runtime program.

This field can contain up to 10 characters.

Call List Field

The Call List field allows you to name the window that appears when the Call List button is clicked in the C-Soft Runtime 
program.

This field can contain up to 10 characters.

Manual Call List Field

The Manual Call List field allows you to name the window that appears when the Manual Call List button is clicked in the 
C-Soft Runtime program.

This field can contain up to 10 characters.

Status List Field

The Status List field allows you to name the window that appears when the Status List button is clicked in the C-Soft Runtime 
program.

This field can contain up to 10 characters.

Global Call History Field

The Global Call History field allows you to name the window that appears when the Global Call History button is clicked in 
the C-Soft Runtime program.

This field can contain up to 10 characters.

Button Labels Group Box

The Button Labels group box contains fields to enter custom labels appearing on buttons in the Call List, Per Line, Manual 
Call List, Set Status and Active Emergency windows.

Emergency Clear Field

The Emergency Clear field creates a button label that displays in the Active Emergency window. When the button is clicked 
in C-Soft Runtime, the Emergency is cleared from the list. 

This field can contain up to 10 characters.

ACK Field

The ACK field creates a button label that displays in the Active Emergency window. When the button is clicked in 
C-Soft Runtime, the emergency is acknowledged by sending a message to the radio that initially declared the emergency.

This field can contain up to 10 characters.
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Done Field

The Done field creates a button label that displays in all call windows. When the button is clicked in C-Soft Runtime, the 
window closes.

This field can contain up to 10 characters.

Set Status Field

The Set Status field creates a button label that displays in the Per Line Call History, Manual Call List and Call List windows. 
When the button is clicked in C-Soft Runtime, the Status List window appears and a status ID can be selected and sent.

This field can contain up to 10 characters.

Clear Field

The Clear field creates a button label that displays in the Manual Call List window. When the button is clicked in 
C-Soft Runtime, the User ID field is cleared.

This field can contain up to 10 characters.

Cancel Field

The Cancel field creates a button label that displays in the Set Status window. When the button is clicked in C-Soft Runtime, 
changes are discarded and the window closes.

This field can contain up to 10 characters.

Backspace Field

The Backspace field creates a button label that displays in the Manual Call window. When the button is clicked in C-Soft 
Runtime, the last character entered in the User ID field is cleared.

This field can contain up to 10 characters.

Digit A-F Fields

The Digit A-F fields create a button label that displays in the Manual Call window. When the button is clicked in C-Soft 
Runtime, the digit it is assigned to is entered in the User ID field.

This field can contain up to 10 alphanumeric characters.

Call Options Group Box

Call-to-Console Color Field

The Call-to-Console Color field allows you to label the button used for an incoming call.

This field can contain up to 10 characters.

Change Color Button

The Change Color button opens the color palette. From the color palette, you can choose the color you want to display when 
a call is received at the console.
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Date Format Drop Down Menu

The Date Format drop down menu selects the date format displayed in the call logs. 

Available formats for this field are MM/DD/YYYY and DD/MM/YYYY.

Per Line Call History Window Lines Field

The Per Line Call History Window Lines field sets the number of lines displayed in the Call History window. When the call 
history window is full, the oldest call is removed. 

The range for this field is 1 to 500 lines. 

Per Line Call History Font Size Field

The Per Line Call History Font Size field specifies the text size for the call history list.

The range for this field is 1 to 72.

Emergency Call History Window Lines Field

The Emergency Call History Window Lines field sets the number of lines displayed in the Emergency Call History window. 
When the call history window is full, the oldest call is removed. 

The range for this field is 1 to 500 lines.

Emergency Call History Font Size Field

The Emergency Call History Font Size field specifies the text size for the Emergency Call History window. 

The range for this field is 1 to 72.

Active Emergency Font Size Field

The Active Emergency Font Size field specifies the text size for the Active Emergency Call History window. 

The range for this field is 1 to 72.

Call List Font Size Field

The Call List Font Size field specifies the text size for the Call List window. 

The range for this field is 1 to 72.

Status List Font Size Field

The Status List Font Size field specifies the text size for the Status List window. 

The range for this field is 1 to 72.
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Column Headings and Static Text Group Box

Date Field

The Date field is used to create the column label applied to the date column in call windows. 

This field can contain up to 31 characters.

Time Field

The Time field is used to create the column label applied to the time column in call windows. 

This field can contain up to 31 characters.

Channel Field

The Channel field is used to create the column label applied to the channel column in call windows. 

This field can contain up to 31 characters.

Freq Field

The Freq field is used to create the column label applied to the frequency column in call windows. 

This field can contain up to 31 characters.

Status Field

The Status field is used to create the column label applied to the status column in call windows. 

This field can contain up to 31 characters.

User ID Field

The User ID field is used to create the column label applied to the user ID column in call windows. 

This field can contain up to 31 characters.

Calling ID Field

The Calling ID field is used to create the column label applied to the calling ID column in call windows. 

This field can contain up to 31 characters.

Status ID Field

The Status ID field is used to create the column label applied to the status ID column in call windows. 

This field can contain up to 31 characters.

Alias Field

The Alias field is used to create the column label applied to the alias column in call windows. 

This field can contain up to 31 characters.
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ID Type Field

The ID Type field is used to create the column label applied to the ID type column in call windows. 

This field can contain up to 31 characters.

Filters Field

The Filters field is used to create the filters label applied to the Call List window. 

This field can contain up to 31 characters.

No Filters Field

The No Filters field is used to create the label applied when no filters are selected in the filters display in the Call List window. 

This field can contain up to 31 characters.

No Status Field

The No Status field is used to create the label applied when no statuses are selected in the status display in call windows. 

This field can contain up to 31 characters.

OK Button

The OK button saves the entries and closes the window.

Cancel Button

The Cancel button clears any entries made and closes the window.

Defaults Button

The Default button resets all parameters to their default values. 
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Pagers Window

The Pagers window, shown in Figure 47, is used to configure pager settings for both individual and group pages.

NAVIGATION: Select Edit|Setup Pagers from the menu bar.

Pager Number Field

The Pager Number field displays the pager number. 

Up to 10 pre-defined pages can be configured. 

Pager Drop Down Menu

The Pager drop down menu, to the right of the pager number, is used to select a pre-defined pager from a list.

Available selections for this field are:

2 Tone 100 (Quickcall II 100)

2 Tone 1000 (Quickcall II 1000)

DTMF

Knox

In addition to the pager selections provided on this window, a UI element is provided. For more information see,“Page Manual 
Entry” on page 288.

FIGURE 47. Pagers Window
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Setup Button

The Setup button is used to open the appropriate window for the type of pager selected in the drop down menu. 

For more information, see: 

“2 Tone 100 Page Setup Window” on page 133.

“2 Tone 1000 Setup Window” on page 135.

“DTMF Paging Setup Window” on page 138.

“Knox Paging Setup Window” on page 139.

Inter-page Delay Field

The Inter-page Delay field is used to set the amount of time, in ms, C-Soft waits between stacked pages. This feature enables 
page decoders to distinguish between different pages. 

The range for this field is 0 to 9999ms.

Send Sequentially Check Box

The Send Sequentially check box indicates the paging codes are sent sequentially. Otherwise, paging tones steered to 
different lines are sent simultaneously.

Correct Low Freq Tone Levels (Flatten Levels) Check Box

The Correct Low Freq Tone Levels (Flatten Levels) check box indicates tones across 300kHz to 3kHz spectrum are 
flattened for better level adjustment. Depending on the load being driven, it is possible additional roll-off of the lower 
frequency tone (sub 1kHz) levels can occur.

OK Button

The OK button saves the entries and closes the window.
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2 Tone 100 Page Setup Window

The 2 Tone 100 Page Setup window, shown in Figure 48, is used to configure a 2-digit code paging sequence for this format. 

Page Name Field

The Page Name field is used to enter a descriptive name to associate with the paging sequence for this encoder. The name, 
when assigned, is displayed in the Pager Setup window next to the Pager Number field, and is included for selection in a list of 
variables for the user interface element page function.

This field can contain up to 12 characters.

Page Level Field

The Page Level field identifies the output, in dB, of the relative paging tone.

The range for this field is -60 to 10dB.

Initial Delay Field

The Initial Delay field identifies the amount of time, in ms, allowed from PTT until the first tone is played.

The range for this field is 0 to 2000ms.

FIGURE 48. 2 Tone 100 Page Setup Window
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Tone 1 Group and Tone 2 Group Fields

The Tone 1 Group and Tone 2 Group fields identify which two (2) frequencies are played in succession. 

The range for this field is 1 to 15.

To determine the entry for each field, do the following:

 > Using Table 7 on page 369, (Appendix A), find the desired Telex Tone Group number for the first and second tones. 

Tone 1 Time Field

The Tone 1 Time field identifies the duration, in ms, of tone 1. The tone and gap durations for standard paging plans are 
shown in Table 9 on page 370.

The range for this field is 0 to 10000ms.

Gap Duration Field

The Gap Duration field identifies the duration, in ms, of the gap duration. The tone and gap durations for standard paging 
plans are shown in Table 9 on page 370.

The range for this field is 0 to 15000ms.

Tone 2 Time Field

The Tone 2 Time field identifies the duration, in ms, of tone 2. The tone and gap durations for standard paging plans are 
shown in Table 9 on page 370.

The range for this field is 0 to 10000ms.

Group Tone Time Field

The Group Tone Time field identifies the duration, in ms, of the group tone. The tone and gap durations for standard paging 
plans are shown in Table 9 on page 370.

The range for this field is 0 to 10000ms.

Enable Diagonal Check Box

The Enable Diagonal check box indicates the tone specified in the Diag Tone Freq field is used in place of either the first or 
second tone depending on the selection in the Diag Location check box. Otherwise, the group tone is played for the diagonal 
tone duration period.

Diag Tone Freq Field

The Diag Tone Freq field identifies the frequency, in Hz, of the diagonal tone when the Enable Diagonal check box is 
selected.

The range for this field is 0 to 3000Hz.

Diag Location Check Box

The Diag Location check box indicates the diagonal tone is used in place of the first tone; otherwise, the group tone is used.
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OK Button

The OK button saves the entries and closes the window.

Cancel Button

The Cancel button clears any entries made and closes the window.

2 Tone 1000 Setup Window

The 2 Tone 1000 Setup window, shown in Figure 49, is used to configure a 3-digit paging code. 

Page Name Field

The Page Name field is used to enter a descriptive name to associate with the setup for this encoder. The name, once assigned, 
is displayed on the Pager Setup window next to the Pager Number field, and is included for selection in a list of variables for 
the user interface element page function. 

This field can contain up to 12 characters.

Page Level Field

The Page Level field identifies the output of the relative paging tone.

The range for this field is -60 to 10dB.

Initial Delay Field

The Initial Delay field identifies the amount of time allowed from PTT until the first tone is played.

The range for this field is 0 to 2000ms.

FIGURE 49. 2 Tone 1000 Setup Window
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Tone Plan Number Field

The Tone Plan Number field is used to configure the first and second page tones. See “Telex Tone Group Numbers” on 
page 369.

The range for this field is 1 to 25.

EXAMPLE: If the pager to be reached is N349, the Telex Code Plan Number would be set to 12 which corresponds 
to group Mot N. The Pager Capcode 3 corresponds to the line (3+3), in Group N (Tone Plan Number 
12), from which the 2 Tone Group Frequencies are selected. 

From using Telex Code Plan #12, Tone Group #3, and Tone Group #3 for N349, the first tone (Telex 
Tone Group Number 3 and Tone Group 4) sent would be 313.0, followed by the second tone (Telex 
Tone Group Number 3 and Tone Group 9) 1063.2. 

Below is the break down of each digit in the pager number N349 and a description of the encoder 
parameters identified by the digit.

Tone 1 Time Field

The Tone 1 Time field identifies the amount of time of the duration for tone 1. The tone and gap durations for standard paging 
plans are shown in Table 9 on page 370.

The range for this field is 1 to 10000ms.

Gap Duration Field

The Gap Duration field identifies the amount of time of the gap duration. The tone and gap durations for standard paging 
plans are shown in Table 9 on page 370.

The range for this field is 1 to 15000ms.

TABLE 4. Example Tone Plan Number Locator

DIGIT IDENTIFIES DESCRIPTION

N Pager Locate the Mot N group pagers in “2 Tone 1000 Plan 
Numbers” on page 371.

Enter the Telex Codeplan # from the top row in the Tone 

Plan Number (12)a.

a. This digit can also identify the entries for the Tone 1 Time, Gap Duration, Tone 2 Time and Group Tone Time fields, see “Tone and 
Gap Durations for Standard Paging Plans” on page 370.

Where the Telex code plan # 
(12) and the Pager Capcode 
(3xx) intersect in the table to 
identify the Telex Group No. 
(3+3). This identifies the 
frequencies for tone 1 and 
Tone 2. 

3 Pager Capcode Locate the Pager Capcode (3xx) in “2 Tone 1000 Plan 
Numbers” on page 371.

In the table’s left column.

4 Tone 1 
Frequency

Using the first number identified above (3), locate the 
Telex Group No. 3 and Tone Group 4 (second digit in 
pager number), from “Telex Tone Group Numbers” on 
page 369.

Where these two (2) items 
intersect in the table 
identifies the frequency of 
tone 1 (313.0).

9 Tone 2 
Frequency

Using the second number in the Telex Group number (3), 
locate the Telex Group No. 3 and Tone Group 9 (third 
digit in pager number) from “Telex Tone Group 
Numbers” on page 369.

Where these two (2) items 
intersect in the table 
identifies the frequency of 
tone 2 (1063.2).
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Tone 2 Time Field

The Tone 2 Time field identifies the amount of time of the duration for tone 2. The tone and gap durations for standard paging 
plans are shown in Table 9 on page 370.

The range for this field is 1 to 10000ms.

Group Tone Time Field

The Group Tone Time field identifies the amount of time of the tone duration for the group tone. The tone and gap durations 
for standard paging plans are shown in Table 9 on page 370.

The range for this field is 1 to 10000ms.

Enable Diagonal Check Box

The Enable Diagonal check box indicates the frequency entered in the Diag Tone Freq field is used in place of either the first 
or second tone depending on the selection made in the Diag Location check box. Otherwise, the second tone is played for the 
diagonal tone duration period.

Diag Tone Freq Field

The Diag Tone Freq field identifies the frequency of the diagonal tone when the Enable Diagonal check box is selected.

The range for this field is 0 to 3000Hz.

Diag Location Check Box

The Diag Location check box indicates the diagonal tone is used in place of the first or second tone. If selected, the diagonal 
tone overrides either the first or second group tone. Otherwise, group tone is used

OK Button

The OK button saves the entries and closes the window.

Cancel Button

The Cancel button clears any entries made and closes the window.
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DTMF Paging Setup Window

The DTMF Paging Setup window, shown in Figure 50, is used to configure standard paging tones level, delay, time length 
and string length.

Page Name Field

The Page Name field is used to enter a descriptive name to associate with the paging sequence for this encoder. The name, 
once assigned, is displayed on the Pager Setup window next to the Pager Number field, and is included for selection in a list of 
variables for the user interface element page function.

This field can contain up to 12 characters.

Page Level Field

The Page Level field identifies the output of the relative paging tone.

The range for this field is -60 to 10dB.

Initial Delay Field

The Initial Delay field identifies the amount of time allowed from PTT until the first tone is played.

The range for this field is 0 to 2000ms.

DTMF On Time Field

The DTMF On Time field identifies the amount of time the DTMF digit is played.

The range for this field is 20 to 2000ms.

DTMF Off Time Field

The DTMF Off Time field identifies the amount of time in between the time each DTMF digit is played.

The range for this field is 20 to 2000ms.

FIGURE 50. DTMF Paging Setup Window
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DTMF Digits Field

The DTMF Digits field identifies the number of digits in a standard page. The number of digits specified are expected by all 
pages using this option.

The range for this field is 1 to 16.

OK Button

The OK button saves the entries and closes the window.

Cancel Button

The Cancel button clears any entries made and closes the window.

Knox Paging Setup Window

The Knox Paging Setup window, shown in Figure 51, is used to configure the pager name, output level, digit duration, pause 
times, and digits required in the page.

Page Name Field

The Page Name field is used to enter a descriptive name to associate with the paging sequence for this encoder. The name, 
once assigned, is displayed on the Pager Setup window next to the Pager Number field, and is included for selection in a list of 
variables for the user interface element page function.

This field can contain up to 12 characters.

Page Level Field

The Page Level field identifies the output of the relative paging tones.

The range for this field is -60 to 10dB.

FIGURE 51. Knox Paging Setup Window
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Initial Delay Field

The Initial Delay field identifies the amount of time allowed from PTT until the first tone is played.

The range for this field is 0 to 2000ms.

Knox On Time Field

The Knox On Time field identifies the amount of time the knox digit is played.

The range for this field is 20 to 2000ms.

Knox Off Time Field

The Knox Off Time field identifies the amount of time in between the time each Knox Digit is played.

The range for this field is 20 to 2000ms.

Knox Digits Field

The Knox Digits field identifies the number of digits in a standard page. The number of digits specified are expected by all 
pages using this option.

The range for this field is 1 to 16.

OK Button

The OK button saves the entries and closes the window.

Cancel Button

The Cancel button clears any entries made and closes the window.
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Tone Levels Window

The Tone Levels window, shown in Figure 52, is used to configure the tone level, in dB, of individual tones.

NAVIGATION: Select Edit|Setup Tone Level from the menu bar.

Emergency Tone Field

The Emergency Tone field indicates the tone level at which the emergency tone is heard.

The range for this field is -60 to 0 dB.

Group Call Tones Field

The Group Call Tones field indicates the tone level at which the group call tones are heard.

The range for this field is -60 to 0 dB.

Talk Permit Tones Field

The Talk Permit Tones field indicates the beep level at which the iDEN beeps are heard.

The range for this field is -60 to 0 dB.

Input Beeps Field

The Input Beeps field indicates the beep level at which the input beeps are heard.

The range for this field is -60 to 0 dB.

Page Beeps Field

The Page Beeps field indicates the beep level at which the page beeps are heard.

The range for this field is -60 to 0 dB.

FIGURE 52. Tone Levels Window
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Phone Rings Field

The Phone Rings field indicates the ring level at which the phone rings are heard.

The range for this field is -60 to 0 dB.

Select Call Tones Field

The Select Call Tones field indicates the tone level at which select call tones are heard.

The range for this field is -60 to 0 dB.

Sidetones Field

The Sidetones field indicates the level at which sidetones are heard.

The range for this field is -60 to 0 dB.

OK Button

The OK button saves the entries and closes the window.

Cancel Button

The Cancel button clears any entries made and closes the window.
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SIP Phone Line Configuration

C-Soft supports SIP Phone lines. SIP (Session Initiation Protocol) provides an alternative method of telephone line installation 
into your dispatch system. With SIP you can easily adapt and configure many telephone lines into a C-Soft console position 
without having to connect external hardware. 

SIP Basic lines are available on C-Soft security keys. 

• Two (2) SIP Basic lines are available on security keys carrying 24–49 lines. 

• Six (6) SIP Basic lines are available on security keys carrying 50 lines or more.

SIP enhanced lines are available on C-Soft hardware security keys licensed to carry SIP Enhanced features. SIP Enhanced is 
an optional purchase.

• SIP-enhanced licenses can be purchased for two (2) or six (6) lines.   

NOTE: Alternatively, the SIP Enhanced features can be accessed by entering a purchased license code on the ADHB-4 
web configuration.

REFERENCE: For more information, see the ADHB-4 Technical Manual (F01U196239).

SIP Basic

The SIP Basic option is used to access the following features: crosspatch, outbound DTMF, per line call history, call directory 
editing on-the-fly, auto-answer incoming calls, stun and proxy server, auto adjustments, silence detection, and network 
recording or monitoring. 

SIP Enhanced

The SIP Enhanced option allows access to all SIP Basic features as well as providing access to the following: call hold, do not 
disturb, 3-way-calls, microphone mute, line conference, consultant transfer, blind transfer, missed call history, call waiting, 
and conditional forwarding.

To configure your system for SIP calls:

Step 1 Obtain a SIP account through your IT system administrator or internet service provider.

Step 2 Configure a SIP phone line in C-Soft Designer, see “SIP Button” on page 104.

Step 3 If using a network recorder or monitor, configure echo packets in C-Soft Designer, see page 144.

Step 4 Setup global SIP configurations in C-Soft Designer, see “Global SIP Configuration Window” on page 145.

Step 5 Create a SIP Call Control button in C-Soft Designer, see “SIP Call Control” on page 313.

Step 6 Test the registration parameters in C-Soft Runtime, see “Test the SIP Registration” on page 149.
Bosch Security Systems, Inc. Administrator’s Guide F.01U.218.561 Rev 03



144  C-Soft Designer Program C-Soft Administrator’s Guide
Configure SIP for Recording or Monitoring

The SIP Phone line can be recorded or monitored. This is configured in the Per Line Parameters window. 

For more information, see “Per Line Parameters Window” on page 67.

To configure the SIP line for network recording or monitoring, do the following:

1. From the Per Line Parameters window, select the Echo Packets Enable check box.

2. In the RX Multicast Address field, enter an IP Address.

3. In the Rx Port field, enter an RX port number.

4. Click Close.
The Per Line Parameters window closes.

FIGURE 53. SIP Line Type—Per Line Parameters
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Global SIP Configuration Window

The Global SIP Configuration window, shown in Figure 54, opens to the SIP Network page that is used to enter the default 
username, IP Address, port, server, LAM, proxy server. The Audio page allows LAM, silence detection, and jitter buffering 
configuration.

NAVIGATION: Select Edit|Setup SIP Phone from the menu bar.

SIP Network Page. The SIP Network page, shown in Figure 54, is used to identify the console position and configure 
processes that occur on the network. 

Default Identity Group Box

User Field

The User field is used to identify the console to remote SIP callers. The username appears in the first portion of a SIP address.

EXAMPLE: If the SIP address is 12345@HuskerAccess.com, the username is 12345.

Display Name Field

The Display Name field is used to enter an alias name for the console for easy identification. The display name appears on the 
SIP phone if the SIP phone or SIP/PSTN gateway is capable and configured to display the alias.

Listen on Specific IP Address Check Box

The Listen on Specific IP Address check box indicates the IP Address you enter in the Listen on Specific IP Address field is 
active.

NOTE: The Listen on Specific IP Address field must also be configured. 

FIGURE 54. Network Page—Global SIP Configuration
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Listen on Specific IP Address Field

The Listen on Specific IP Address field is used to enter the specific IP Address to use for sending and receiving phone calls. 
This feature is useful when the computer has multiple NICs (Network Interface Cards).

NOTE: The Listen on Specific IP Address check box must also be selected.

Use Non-Standard Port Check Box

The Use Non-Standard Port check box indicates the port number entered in the field is used for SIP communication. 
Otherwise, the default port number 5060 is used.

NOTE: The Use Non-Standard Port field must also be configured.

Use Non-Standard Port Field

The Use Non-Standard Port field is used to enter a port number for SIP communications. 

NOTE: The Use Non-Standard Port check box must also be selected. 

Use STUN Server Check Box

The Use STUN Server check box indicates the STUN (Session Traversal Utilities for NAT [Network Address Translation]) 
server entered in the field is used to negotiate packet routing through NAT firewalls or NAT routers.

Use Stun Server Field

The Use Stun Server field is used to enter a server address for packet routing. 

NOTE: The Use Stun Server check box must also be selected. 

Typically, if C-Soft is running on a computer running on a private IP network, then it is necessary to enable the use of STUN 
server option. The STUN protocol allows C-Soft to use a STUN server on the internet to determine how the NAT gateway 
translates the UDP addressing between the private network and the public internet. 

Proxy Server Group Box

Use Outbound SIP Proxy Check Box

The Use Outbound SIP Proxy check box indicates traffic is initially sent through the proxy server entered in the Use 
Outbound SIP Proxy field.

NOTE: The Use Outbound SIP Proxy field must also be configured.

Use Outbound SIP Proxy Field

The Use Outbound SIP Proxy field is used to enter the proxy server’s address. 

NOTE: The Use Outbound SIP Proxy check box must also be selected.

User ID Field

The User ID field is used to enter the proxy server User ID. 
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Password Field

The Password field is used to enter the proxy server password.

Audio Page. The Audio page, shown in Figure 55, is used to configure time-outs, silence detection and audio adjustments.

LAM Setup Group Box

The LAM Setup group box is used to control LAM (Line Activity Monitor) during SIP phone to radio crosspatch activity. 

LAM Level (dB) Spin Box

The LAM Level (dB) spin box is used to set the audio threshold at which the crosspatched line or echo packets begin to send 
audio packets to the Ethernet.

The range for this field is -60 to 0 dB.

LAM Time (s) Spin Box 

The LAM Time spin box is used to set the amount of time for radio crosspatch activity. The LAM time determines how long 
the SIP line is active after the audio level is below the LAM level threshold.

The range for this field is 0 to 60 sec.

FIGURE 55. Audio Page—Global SIP Configuration
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Silence Detection Group Box

None Radio Button

The None radio button indicates there is no silence detection for any SIP phone line in the system. Audio continues to 
transmit, even if silent. 

Fixed Threshold Radio Button and Threshold Spin Box

The Fixed Threshold radio button is used to activate the minimum audio detection mode. When the audio level reaches the 
specified threshold configured in the spin box, it is no longer considered silent. Audio levels below the specified raw digital 
value in the spin box are ignored and considered silent.

This setting is used with the Voice Deadband and Silence Deadband spin boxes.

The range for this field is 0 to 8000.

Adaptive Threshold Radio Button and Period Spin Box

The Adaptive Threshold radio button is used to activate the dynamic audio detection mode and is the recommended 
configuration for silence detection. The minimum audio is automatically adjusted after the software determines the average 
audio received over the amount of time specified in the Period spin box. 

This setting is used with the Voice Deadband and Silence Deadband spin boxes.

The range for this field is 10 to 10000ms.

Voice Deadband (ms) Spin Box

The Voice Deadband spin box is used to configure the minimum duration of audio above the threshold needed to start sending 
audio. 

NOTE: If audio is choppy after setting the value, try setting to a shorter amount of time.

The range for this field is 10 to 10000ms.

Silence Deadband (ms) Spin Box

The Silence Deadband (ms) spin box is used to configure the minimum duration of audio below the threshold before the 
audio is considered silent. The time should be long enough so that gaps between spoken words are not detected as silence, 
otherwise the audio may sound choppy. 

The range for this field is 10 to 10000ms.

Jitter Buffering Group Box

The Jitter Buffering group box contains settings for buffering incoming audio packet delivery to reduce jitter. When the 
minimum and maximum are set, the duration of jitter buffer is dynamically adjusted between the two (2) values. A longer 
duration can improve the audio quality if network latency is variable, but when the duration is set for too long, audio delay can 
interfere with conversation. Experimentation is the best way to optimize your settings.
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Min Duration (ms) Spin Box

The Min Duration (ms) spin box is used to configure minimum buffer duration for incoming audio.

The range for this field is 10 to 10000ms.

Max Duration (ms) Spin Box

The Max Duration (ms) spin box is used to configure maximum buffer duration for incoming audio. 

The range for this field is 10 to 10000ms.

Restore Defaults Button

The Restore Defaults button is used to restore factory defaults. The default values appear in Figure 55.

OK Button

The OK button saves the entries and closes the window. 

Cancel Button

The Cancel button clears any entries made and closes the window.

Test the SIP Registration

Test the SIP registration to confirm successful connectivity and authentication to the SIP server. SIP Server status is recorded 
in the Global Call History page in C-Soft Runtime and a success or failure registration message appears in the status bar.

NOTE: Before testing the SIP connections, you must create a SIP Call Control UI element button. See “SIP Call 
Control” on page 313.

To test the SIP connection in C-Soft Runtime, do the following:

 > Open the C-Soft console. 
A message appears in the console status bar:

• If the connection is successful, a success message appears.

• If the connection fails a failure message appears. 
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NOTE: SIP registration messages are recorded in the Global Call History. 
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System Configuration

C-Soft supports Kenwood-5x10, FleetSync, MDC-1200, and MOTOTRBO signaling protocols. In C-Soft Designer, systems 
are created to help manage permissions, organize units and groups, and setup status message. In C-Soft Runtime the system is 
accessible through the FleetSync, MDC-1200, or MOTOTRBO Dispatching windows.

For more information, see “FleetSync Dispatching Window” on page 221. 

For more information, see “MDC-1200 Dispatching Window” on page 255.

For more information, see “MOTOTRBO Dispatching Window” on page 274.

To configure a FleetSync System, follow these steps:

Step 1 Plan your system. 

NOTE: A FleetSync system example is shown in Figure 56.

Step 2 Create the system filters, see “Filter List Setup Window” on page 152.

Step 3 Setup a user ID List, see “User ID List Window” on page 154.

Step 4 Setup a group ID list, see “Group ID List Window” on page 158.

Step 5 Setup a status ID list, see “Status Message ID List Window” on page 163.

Step 6 Create the system. see “Edit System List Window” on page 168, use filters and lists created in steps 2–5. 

Step 7 Setup Per Line Parameters, see “Signaling AutoFill Setup Group Box” on page 79.

Step 8 Add an FleetSync UI element button, see “FleetSync” on page 220.

Step 9 Manage default system file, see “Filename Field” on page 117.
If you create more than one (1) system file you can manage which system appears, by default, in the Edit 
System List window. 

FIGURE 56. Basic FleetSync System Hierarchy Structure
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Filter List Setup Window 

The Filter List Setup window, shown in Figure 57, is used to create a list of filters for the console operator to use during 
FleetSync, MDC-1200, and MOTOTRBO system creation to sort and organize units and groups or fleets of user IDs in the 
system. The filters are also used by the console operator to filter units and groups while in the Call List window, the FleetSync 
Dispatching window, or the MOTOTRBO Dispatching window. 

This list can contain up to 30 filters.

NAVIGATION: Select Edit|Edit Filters from the menu bar.

Filter List Setup Field

The Filter List Setup field is used to enter a label for the filter.

This field can contain up to 16 alphanumeric characters.

List Field

The List field displays the list of all filters created in the system.

This list can contain up to 30 filters.

Cancel Button

The Cancel button clears any entries made and closes the window. 

FIGURE 57. Filter List Setup Window
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Add Filter Button

The Add Filter button is used to add the filter entry in the filter list setup field to the list of filters.

To add a filter, do the following:

1. In the Filter List Setup field, enter a name for the filter.

2. Click Add Filter. 
The new filter appears in the Filter List Setup field.

Delete Filter Button

The Delete Filter button is used to delete an unwanted entry from the list of filters.

To delete a filter, do the following:

1. In the list field, select the filter name.

2. Click Delete Filter.
The filter is deleted from the list. 

Clear List Button

The Clear List button is used to clear the entire list of filters from the window. 

To clear all entries, do the following:

 > Click Clear List. 
The list is cleared from the window.

NOTE: If you accidentally click the clear list button and did not want to delete the entire list then click Cancel and 
reopen the window.
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User ID List Window 

The User ID List window, shown in Figure 58, Figure 59, and Figure 60, is used to create a list of individual users in the 
system for recall later. It is used in conjunction with the ANI features of certain radios. When the window is closed and 
reopened, the user IDs are sorted in descending order. See Figure 60.

Up to 5000 user IDs can be created. 

NAVIGATION: Select Edit|Edit User ID List from the menu bar.

NOTE: When the User ID List is closed and opened again, the blank rows are deleted and the list is sorted in descending 
order.

FIGURE 58. User ID List Window—FleetSync Example
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FIGURE 59. User ID List Window—MDC-1200 Example

FIGURE 60. User ID List Window—MOTOTRBO Example
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Name Field

The Name field is used to enter a descriptive name to associate with the User ID. 

When the ANI is received, this name appears on the select button for the line and in the User ID column of the Per Line Call 
History window, Call List window, and the Manual Call List window. If no name is associated with a User ID, the User ID 
appears on the line’s button and in the history and call list windows.

This field can contain up to 16 characters.

NOTE: For more information about ANI display configuration, see “ANI Setup Group Box” on page 109. 

User ID Field

The User ID field is used to configure the user ID or status ID number transmitted by the radio.

This field can contain up to 32 characters.

Type Drop Down Menu

The Type drop down menu is used to select the system type the user ID is associated with. 

Available selections for this field are: Generic, FleetSync, iDEN, Kenwood-5x10, MDC-1200, MOTOTRBO, P25-DFSi and 
Phone.

TX Inhibit Check Box

The TX Inhibit check box indicates the caller’s alias displays when received, but does not display in the Call List or 
FleetSync window. 

FIGURE 61. User ID List - Type Drop Down Menu
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Filters Button

The Filters button is used to assign a filter(s) to the ID. When the filter button is clicked, the Select Filters window appears 
and displays all filters you created earlier. See “Filter List Setup Window” on page 152. 

To assign filters to the user ID, do the following:

1. Select the filters you want to add the User ID to.
All the filters you want to include the User ID in are selected. 

2. Click OK.
The User IDs are added to the selected filters.

To deselect a filter, do the following:

 > Click the filter.

Select Filters Window

The Select Filters window is used to select filters to associate the user with. You can assign multiple filters to a 
single User I.D.

Load File Button

The Load File button is used to download a .csv file into the current frequency window.

NOTE: When the .csv file is downloaded, all items in the current list are overwritten. 

To download a saved frequency .csv file, do the following:

1. Click Load File.
The Open window appears.

2. In the Open window, select the file you want to download.

3. Click Open.
The file is downloaded, the Username, ID, and Type field are populated. If configured in the file, TX inhibit and filters 
are also populated.

Save File Button

The Save File button is used to save the current user names to a .csv file. 

To save the currently enabled frequency names to a .csv file, do the following:

1. Click Save File.
The Save As window appears.

2. In the Filename field, enter a name.

3. Click Save.
The .csv file is saved in the current folder.

Close Button

The Close button saves the entries and closes the window.
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Group ID List Window

The Group ID List window, shown in Figure 62, Figure 63, and Figure 64, is used to configure both the decode and encode 
group ID’s for group ANIs. The Group ID List window is sorted using the Group ID field column. The group IDs are sorted 
from the largest value to the smallest value (see Figure 62).

Up to 5000 Group IDs can be created.

NAVIGATION: Select Edit|Edit Group ID List from the menu bar.

NOTE: When the Group ID List is closed and opened again, the blank rows are deleted and the list is sorted in 
descending order. 

FIGURE 62. Group ID List Window—FleetSync Example
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Group Field

The Group field is used to enter a descriptive name to associate with the Group ID. This name is displayed on the Select 
button of the line when the ANI is received and in the User ID column of the Per Line Call History Window, Call List Window, 
and the Manual Call List Window. If no name is associated with a Group ID, the Group ID appears.

This field can contain up to 16 characters.

FIGURE 63. Group ID List Window—MDC-1200 Example

FIGURE 64. Group ID List Window—MOTOTRBO Example
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Group ID Field

The Group ID field is used to enter the particular resource group’s identification number transmitted by the radio.

This field can contain up to 8 characters.

ID number format:

• No spaces or special characters (except for iDEN ID and group numbers, see below) are allowed.

• Character limitations for each device:

Generic - Up to 8 digits are allowed

Phone - Up to 8 digits are allowed.

Radio Phone - Up to 8 digits are allowed. 

iDEN - Up to 8 digits are allowed.

Kenwood-5x10 Maximum value of 65535.

Motorola MDC-1200 - Up to 3 digits allowed.

MOTOTRBO - Maximum value of 16776125.

P25-DFSI Maximum value of 65535.

Type Drop Down Menu

The Type drop down menu is used to select the system type for the assigned group. 

Available selections for this field are Generic, FleetSync, iDEN, Kenwood-5x10, MDC-1200, MOTOTRBO and P25-DFSI.

To assign the system type to the group, do the following:

 > From the Type drop down menu, select the type of system associated to the group.

TX Inhibit Check Box

The TX Inhibit check box indicates the caller’s alias displays when received, but does not display in the Call List or 
FleetSync window.

FIGURE 65. Group ID List Window—Type Drop Down Menu
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Set Color Check Box

The Set Color check box is used to set a color for the group ID. When the set color check box is selected, the Set Color button 
can be used to assign a color to the selected items. For more information, see “Set Color Button” on page 162.

Filters Button

The Filters button is used to assign a filter(s) to the group. When a filter is assigned, the group is included any time the 
selected filter(s) is chosen.

Load File Button

The Load File button is used to download a .csv file into the current frequency window.

NOTE: When the .csv file is downloaded, all items in the current list are overwritten. 

To download a saved group ID .csv file, do the following:

1. Click Load File.
The Open window appears.

2. In the Open window, select the file you want to download.

3. Click Open.
The file downloads, the Group name and Group ID fields populate. If included in the saved file, the group color, 
filters and TX Inhibit also populate.

Save File Button

The Save File button is used to save the current frequency names to a .csv file. 

To save the currently enabled group ID to a .csv file, do the following:

1. Click Save File.
The Save As window appears.

2. In the Filename field, enter a name.

3. Click Save.
The .csv file is saved in the current folder.

FIGURE 66. Color Window
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Uncheck All Button

The Uncheck All button clears all Set Color check boxes.

Set Color Button

The Set Color button opens the color palette. With this palette you can assign a color to display as the background for the 
group and group ID in C-Soft Runtime. The colors aid the user in quick selection when scrolling the list.

To set a color for the group ID, do the following:

1. Select the Set Color check box for each group you want to assign a color.
Each group ID you want to color is selected.

2. Click Set Color.
The Color window appears.

3. Select a color.
The color appears in preview box.

4. Click OK, to apply the color in the preview box.
The color is applied to the selected group(s).

NOTE: Click Cancel, to close the window and discard changes.

Reset Colors

The Reset Colors button sets all Group ID background colors to white.

Close Button

The Close button saves the entries and closes the window.
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Status Message ID List Window

The Status Message ID List window, shown in Figure 67, is used to configure status messages and status IDs that are either 
sent or received by the console.

This list can contain up to 5000 status messages.

NOTE:

• When the window is closed and reopened, the list is sorted in descending Status ID order.

• Any row left unfilled is deleted and the list is sorted by descending group ID number when the Group 
ID List is closed and opened again.

NAVIGATION: Select Edit|Edit Status Message ID List from the menu bar.

Status Message Field

The Status Message field creates an alias or descriptive message to associate with the Status ID. This message appears on the 
Per Line Call History and Status Window.

This field can contain up to 32 characters.

Status ID Field

The Status ID field identifies the message transmitted by the radio. For example, using Figure 67, if status 11 were sent to the 
console, the console displays Out of Service.

This field can contain up to 8 characters.

FIGURE 67. Status Message ID List Window
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Password Protected Check Box

The Password Protected check box is used to indicate the supervisor password is required before the status ID can be sent. 
See “Supervisor Password Field” on page 117.

Set Color Check Box

The Set Color check box activates the Set Color button.

Load File Button

The Load File button is used to download a .csv file into the current frequency window.

NOTE: When the .csv file is downloaded, all items in the current list are overwritten. 

To download a saved status message .csv file, do the following:

1. On the Status Message ID List window, click Load File.
The Open window appears.

2. In the Open window, select the file you want to download.

3. Click Open.
The file is downloaded, the Status Message and ID fields are populated. If configured in the saved file, status color 
and password protection is also populated.

Save File Button

The Save File button is used to save the current frequency names to a .csv file. 

To save the currently enabled status messages to a .csv file, do the following:

1. On the Status Message ID List window, click Save File.
The Save As window appears.

2. In the Filename field, enter a name.

3. Click Save.
The .csv file is saved in the current folder.

Uncheck All Button

The Uncheck All button clears all the Set Color check boxes.
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Set Color Button

The Set Color button is used to set a color for the Status ID. 

To set the Status ID color, do the following:

1. Select the Set Color check box for all messages you want to assign a color.

2. On the Status Message ID List window, click Set Color.
The Color window appears.

3. From the Basic colors group box or the palette, select a color.

4. Click OK.
The selected Status IDs are colored.

Reset Colors Button

The Reset Colors button sets all Status ID background colors to white.

Close Button

The Close button saves the entries and closes the window.
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Text Message ID List Window

The Text Message ID List window, shown in Figure 68, is used to configure static text messages (aliases) and an associated 
ID. When a user enters the ID, the configured text message is sent to the console.

This list can contain up to 300 text messages.

NAVIGATION: Select Edit|Edit Text Message ID List from the menu bar.

Text Message Field

The Text Message field is used to create a descriptive message or the Text ID. This message can be selected by the console 
operator from the Per Line Call History window, MDC-1200 Dispatching window, MOTOTRBO Dispatching window and 
P25-DFSI Dispatching window while in C-Soft Runtime. 

This field can contain up to 48 characters.

Text ID Field

The Text ID field indicates the ID number entered on the radio to send the text message. This ID number also appears in the 
Quick Text drop down menu on the MOTOTRBO Dispatching window in C-Soft Runtime for selecting a text message to send 
to the radio.

This field can contain 1 to 3 digits. 

FIGURE 68. Text Message ID Window
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Load File Button

The Load File button is used to download a .csv file in to the current frequency window.

NOTE: When the .csv file is downloaded, all items in the current list are overwritten.

To download a saved status message .csv file, do the following:

1. In the Text Message ID List window, click Load File.
The Open window appears.

2. In the Open window, select the file you want to download.

3. Click Open
The file is downloaded, the Status Message and ID fields are populated. If configured in the saved file, status color 
and password protection is also populated.

Save File Button

The Save File button is used to save the current frequency names to a .csv file.

To save the currently enabled status messages to a .csv file, do the following:

1. Click Save File.
The Save As window appears.

2. In the Filename field, enter a name.

3. Click Save.
The .csv file is saved in the current folder.

Close Button

The Close button saves the entries and closes the window.
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Edit System List Window

The Edit System List window, shown in Figure 69, is used to create and manage units, groups, and fleets included in your 
FleetSync, MDC, or MOTOTRBO system.

NOTE:

• For more information about creating a UI Element button for a FleetSync, MDC-1200, or MOTOTRBO 
system:

• See “FleetSync” on page 220.

• See “MDC-1200” on page 251.

• See “MOTOTRBO Radio Setup Page” on page 266.

• For more information about using the dispatching window that appears when the console operator 
selects a FleetSync, MDC-1200 or MOTOTRBO dispatching window button in C-Soft Runtime:

• "FleetSync Dispatching Window” on page 221.

• "MDC-1200 Dispatching Window” on page 255.

• See “MOTOTRBO Dispatching Window” on page 274

This list can contain up to 200 FleetSync systems.

NAVIGATION: Select Edit|Edit System from the menu bar.

FIGURE 69. Edit System List Window—Blank
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To create a new system, do the following:

1. From the File menu, select New.

2. From the Edit System List window, select System|New System.
The New System window appears.

3. In the New System Name field enter a name.
A new system with empty filters and empty statuses appears in the System List field.

NOTE: System names cannot contain the characters shown in table 5.

File Menu - Edit System List

The File menu, in the Edit System List window, shown in Figure 70, is used to create new, open existing, save the current 
system list, or close the current window.

Available selections for this field are New, Open, Save, and Close.

New

Selecting New from the File menu clears the current System List field display so you can create a new system list in the 
window. 

To create a new system list from the Edit System List window, do the following:

1. From the File menu, select New.
A prompt to save the current system appears, if one already exists.

2. From the System menu, select New System.
The New System window appears.

3. In the name field, enter a name for your new system.

4. From the System Type drop down menu, select a system type.

NOTE:

• If a system(s) is currently displayed in the System List field, then you are prompted to save changes to 
the current system before the window refreshes.

• If no system is currently displayed, selecting File|New has no affect. Click System|New System, to 
begin to create a new system.

TABLE 5. Characters

Characters not permitted in system names

“ ‘ ; : & < > ( ) ,

FIGURE 70. File Menu—Edit System List Window
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Open

Selecting Open from the File menu opens a window to select a file from.

To open an existing system list, do the following: 

1. From the File menu, select Open.

NOTE: If a system is currently displayed in the System List field, then you are prompted to save changes to the 
current system before the window refreshes.

2. From the Open window, select the system file you want to add to the System List field. 
The system file is highlighted. 

3. Click Open. 
The system is added to the System List field and system components are available for selection.
OR
Click Cancel to exit without selecting a system list.

Save

Selecting Save from the File menu saves the currently displayed system to a file.

To save a system list file, do the following:

1. From the File menu, click Save. 
The Save As window appears.

2. In the name field, enter a name for the system list. 
OR
Verify the filename is the name you want to use.

3. Click Save.

IMPORTANT: If this is the first time you are saving the system list, click the Save button, the Open window appears. 
Choose a file to open or click the close button.
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Save as Default xml File Check Box

The Save as Default xml File check box indicates the selected system list file is designated as the default system for the 
console position. 

To save the current system list as the default .xml file, do the following:

1. From the File menu, click Save.
The Save As window appears.

2. In the name field, enter a name for the system list. 
OR
Verify the filename is the name you want to use.

3. Select the Save as Default xml File check box.

4. Click Save.
The system list is saved as default and appears the next time the Edit System window opens.

NOTE: This feature works in conjunction with the “Filename Field” on page 117.

Close

Selecting Close from the File menu closes the Edit System List window. 

To close the Edit System window, do the following:

1. From the File Menu, select Close.
A C-Soft Designer window appears.

2. Click Save, to save changes.
OR
Click No, to discard changes and close the window.
OR
Click Cancel, to discard changes.
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Edit System List Window - System Menu

The System Menu, shown in Figure 71, is used to select a new system, copy from an existing system, or automatically build a 
system with filters, groups, statuses, and units you defined earlier.

Available selections for this field are: New System, Copy System, and Auto Build System.

New System Window

The New System window item, shown in Figure 71, is used to open the New System window. The New System window is 
used to configure the system type and name the new system.

New System Setup Group Box

The New System Setup group box is used to enter a System Name and select a System Type.

System Name Field

The System Name field is used to enter a name for your new system. 

This field can contain up to 23 characters.

FIGURE 71. System Drop Down Menu—System List
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System Type Drop Down Menu

The System Type drop down menu indicates the type of system you are configuring. 

Available selections for this field are: FleetSync, Kenwood-5x10, MDC-1200, and MOTOTRBO and P25-DFSI.

OK Button

The OK button saves the entries and closes the window.

To copy a system, do the following:

1. From the Source System drop down menu, select a system to copy.

2. In the Destination System field, enter a name for the new system.

3. Click OK. 
The system is added to the System List field.

NOTE: If systems already appear in the System List field, the copied system is added to the current system list and 
placed at the bottom of the list. If you are creating a new system, it is placed in the System List field with 
empty filters and status containers.

Cancel Button

The Cancel button clears any entries made and closes the window.

NOTE: The new system is not saved until the system file is saved. 

FIGURE 72. System Type Drop Down Menu- New System
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Copy System Window

The Copy System window, shown in Figure 73, is used to open the Copy System window, shown in Figure 73. From this 
window, you can specify one system (source system) to copy to another system (destination system)

NAVIGATION: Select File|Copy System from the System List menu bar.

Source System Drop Down Menu

The Source System drop down menu is used to select an existing system to copy. The list is populated with systems defined 
and saved earlier. For more information, see “Edit System List Window” on page 168.

Destination System Field

The Destination System field is used to enter a name for the new system being created.

OK Button

The OK button saves the entries and closes the window.

Cancel Button

The Cancel button clears any entries made and closes the window.

Auto Build System Command

The Auto Build System from the File menu is used to automatically create a new system based on the current console 
configuration.

To build a system with the Auto Build command, do the following:

1. From the System menu, click New System.
A New System window appears.

2. In the New System Name field, enter a name for the new system.
The new system is added to the system list field with empty filters and status containers.

3. In the system list field, select the check box for the new system.

4. From the System window, select Auto Build System.
The new system is populated with all Filters, User IDs, Status IDs, Group IDs, and Units IDs saved while completing
steps 2–5 in “System Configuration” on page 151.

NOTE: Delete unwanted filters, IDs, and statuses as needed.

FIGURE 73. Copy System Window
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System List Group Box

The System List group box is used to display the current system and its components. 

To change the system list view, do one of the following:

• Click the expand button to view components. 

• Click the collapse button to hide components. 

System List Check Boxes

The System List check boxes indicate the component is selected for removal. For more information, see “Remove From List 
Button” on page 180.

System Components Check Boxes

The System Components check boxes indicate the component is selected to add to the system list. For more information, see 
“Add to List Button” on page 180.

System Components Group Box

Component Type Drop Down Menu

The Component Type drop down menu, shown in Figure 74, is used to select a category to pull data from. 

Available selections for this field are Filters, Groups, Statuses, Text Messages and Units.

Filters Component

The Filters component is used to select a filter. You must create filters, see “Filter List Setup Window” on page 152, before a 
list is available for selection. For more information, see “Filter List Setup Window” on page 152.

FIGURE 74. Component Type Drop Down Menu—System List
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When the filter component is selected, the filter aliases you created appear in the list. .

Groups Components

The Groups component is used to select groups to include in your system. You must create groups, see “Group ID List 
Window” on page 158, before a list of groups is available for selection.

When the Groups component is selected, the group aliases you created appear in the list. See Figure 76.

Group Alias Column

The Group Alias column displays the alias for available groups.

Group ID Column

The Group ID column displays the ID number used to connect to the group.

Group Type Column

The Group Type column displays the signaling type configured for the group.

Available selections for this field are: FleetSync, MDC-1200, and MOTOTRBO.

FIGURE 75. Filter Alias List Example

FIGURE 76. Groups Alias List
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Statuses Components

The Statuses components is used to select statuses to include in your system. You must create statuses, see “Status Message ID 
List Window” on page 163, before a list is available for selection.

When the Status component is selected, the status aliases you create appear in the list. See Figure 77.

Status Alias Column

The Status Alias column displays the alias configured for the status message.

Status ID Column

The Status ID column displays the ID used to send the status message.

FIGURE 77. Status Alias List Example
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Text Messages

The Text Messages component is used to select text messages to include in your system. You must create text messages, see 
“Text Message ID List Window” on page 166, before a list is available for selection.

When the Text message component is selected, the text messages you create appear in the list. See Figure 78.

Text Message Column

The Text Message column displays the text message. 

To see the entire text message, do the following:

 > Click and drag the column separator.
The entire message appears.

Text Message ID Column

The Text Message ID column displays the ID used to send the message.

FIGURE 78. Text Messages List Example
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Units Components

The Units component is used to select units (individual users) to add to either a system or an MDC-1200 group. The unit 
becomes a child when added to an MDC-1200 group. This helps organize users in the system list. You must create units, see 
“User ID List Window” on page 154, before a list of units is available for selection.

To add units to a group, do the following:

1. From the Component Type drop down menu, select Units.
The list of units you created appears.

2. Select units to add to the system list.

3. Select the group’s check box you want to add the unit to.

4. Click Add to List.
The selected units are added to the group.

Unit Alias Column

The Unit Alias column displays the alias for each configured unit.

Unit ID Column

The Unit ID column displays the individual ID the message is sent to.

Unit Type Column

The Unit Type column displays the unit’s signaling system type.

Available selections for this column are: FleetSync, MDC-1200 and MOTOTRBO.

FIGURE 79. Units List Example
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Add to List Button

The Add to List button is used to add components selected in the System Component field, to the currently selected system.

To add a component to the current system, do the following:

1. From the System List, select the system you want to add the component to.

2. In the System Component field, select the items you want to add to the system.
The selected items are highlighted in the System Component field.

3. Click Add to List.
The highlighted components are added to the selected system in the System List field.

Remove From List Button

The Remove From List button is used to remove components from the System List.

To remove a component from a system list, do the following:

1. From the System List, select the system component you want to remove from the system.

2. Click Remove From List.
The highlighted components are removed from the selected system in the System List field.

Select All Button

The Select All button is used to select each component currently listed in the System Components list. When clicked, all 
component’s check boxes are selected.

Deselect All Button

The Deselect All button is used to deselect all components currently listed in the System Components list. When clicked, all 
component’s check boxes are cleared.
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Window Design Edit Commands

The Window Design Edit commands include several standard Windows commands. The shortcut key for the command is 
listed next to the command on the menu. Most of the Edit menu commands can be accessed by the toolbar buttons described in 
Table 1 on page 59. A shortcut menu with a list of commands relevant to the selected item can also be displayed by
right-clicking a user interface element.

Additional details for these commands are provided in “User Interface Element Manipulation” on page 61 and in “Console 
Screen Design Tutorial” on page 135.

To select all elements on the window, do the following:

 > Click Ctrl+A. 
All elements are selected.

To deselect all, do the following:

 > Click the console window background.
All elements are deselected.

Command Description

Cut Select Cut from the Edit menu to delete the selected item.

NOTE: The Cut command does not place the selected item(s) into the clipboard. Also, the Delete 
key on the keyboard can be used to delete design elements from the window.

Copy Selecting Copy from the Edit menu copies the selected item(s) to the clipboard.

Paste Select Paste from the Edit menu to insert the item(s) in the clipboard onto the console window. The 
clipboard is specific to the C-Soft Designer program and cannot be used to exchange data with other 
applications. Any item(s) in the clipboard can be pasted multiple times. Each succeeding paste 
appears as a cascading item off the original item pasted to allow for easy selection and placement of 
the object(s).

Increase Width Select Increase Width from the Edit menu to increase the width of the selected element. When text 
is selected, the size of the selected text is proportionally increased.

Decrease Width Select Decrease Width from the Edit menu to decrease the width of the selected element. When 
text is selected, the size of the selected text is proportionally decreased.

Increase Height Select Increase Height from the Edit menu to increase the height of the selected element. When 
text is selected, the size of the selected text is proportionally increased.

Decrease Height Select Decrease Height from the Edit menu to decrease the height of the selected element. When 
text is selected, the size of the selected text is proportionally decreased.

Rotate Window Select Rotate Window form the Edit menu to rotate the pop-up window counter-clockwise around 
the selected pop-up button.

Move Right Select Move Right from the Edit menu to move the selected item(s) to the right.

Move Left Select Move Left from the Edit menu to move the selected item(s) to the left.

Move Up Select Move Up from the Edit menu to move the selected item(s) up.

Move Down Select Move Down from the Edit menu to move the selected item(s) down.

Open pop-up Select Open pop-up from the Edit menu to open the pop-up window for the selected pop-up button.

Properties Select Properties from the Edit menu to open the UI Element Setup window for the selected item, 
or, in the case of text, a window to enter a new text string.
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Insert Menu

The Insert menu contains commands to add controls and descriptive text to the console window.

Available selections for this field are:

Add UI Button

Add UI Vol. Control

Add pop-up Button

Add Text

Add Clock

Add VU Meter

Add Frame

Add Frequency Control

When a command is selected, a button or control appears in the upper-left corner of the console window. 

NOTE: Pop-up buttons can also be placed inside pop-up windows. 

Learn how to position items on the console window, see “User Interface Element Manipulation” on page 61.

EXAMPLE: An example, Figure 80, shows the console workspace after Add UI Button is added from the Insert 
menu and the button is right-clicked.

To insert a UI Element button, do the following:

 > From the Insert menu, click Add UI Button.
The UI button appears in the upper left corner of the console window.

FIGURE 80. Selected UI Button and Shortcut Menu
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UI Element Setup Window - Add UI Button

The UI Element Setup window is used to configure the button to perform the assigned command when clicked in C-Soft 
Runtime.

To open the UI Element Setup window for a UI Button, do the following:

1. Right-click the UI Element button.
The properties menu appears.

2. Click Properties.
The UI Element window appears.

NOTE: The first field on the UI Element Setup window identifies the type of button you are configuring and cannot 
be changed. In this case, it is UI Element: Button. The type is determined by the button you right-click.

Type Page. The Type page, shown in Figure 81, is used to configure the type of function for the UI Element button. Some UI 
Elements require further configuration and when selected from the function drop down menu, additional configuration pages 
appear. See Figure 82. 

UI Element Function Drop Down Menu

The UI Element Function drop down menu is used to select an operation for the button. For more information on individual 
function configurations, see “UI Element Function Configuration” on page 194.

Line to Associate Function With Drop Down Menu

The Line to Associate Function With drop down menu is used to select a line to associate the function with. Not all functions 
are associated per line. This field is grayed out if the UI element function is a global function.

FIGURE 81. Type Page—UI Element Setup
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OK Button

The OK button saves the entries and closes the window.

NOTE: If the console contains a UI Element button with no assigned function, ERROR! Button with no assigned UI 
element function appears in the Design Errors window when the C-Soft Designer is saved. See Figure 83.

FIGURE 82. Alert Setup Page—UI Element Setup

FIGURE 83. Design Errors Window
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Colors Page. When Add UI Button or Add pop-up Button is selected from the Insert Menu the Colors page appears. This 
page also provides a visual display of the button in the up position with the selected attributes. See Figure 84.

Button Up and Button Down Group Box

Button Drop Down Menu

The Button drop down menu displays the color of the button when it is available for selection (Button Up) or when it is 
selected (Button Down). Default button colors are defined for each UI element function. The button colors can be changed by 
selecting the drop down menu to open a color palette.

Text Drop Down Menu

The Text drop down menu displays the color of the text on the button when it is available for selection (Button Up) or when it 
is selected (Button Down). Default text colors are defined for each UI element function. The text colors can be changed by 
selecting the drop down menu to open a color palette.

FIGURE 84. Colors Page—UI Element Setup
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Button Bitmaps Group Box

The Button Bitmap group box is used to add a graphic to a button.

NOTE:  

• The use of customized icons is supported. By default, small circular LEDs are used for TX, RX, 
Intercom, Mute and Crossmute icons. The icon must be a 24-bit color bitmap (.bmp) file and use the 
following naming conventions: txled.bmp, rxled.bmp, icled.bmp, muteled.bmp, and xtxled.bmp, 
respectively, are required for C-Soft to render the graphics on the console buttons. The bitmap file must 
be located in the same directory as the CSoftRuntime.exe file. For a transparent button, use RGB color 
192, 192, 192.

• Suggested maximum image size is 1680 x 1050 pixels. 
Suggested maximum resolution is 72dpi.

Up Position and Down Position Bitmap Fields

The Up Position and Down Position Bitmap fields identify the bitmap to use on the button. Use the browse button  
located next to the field to select the bitmap. The file must be a bitmap and it must be located in the same directory as the 
C-Soft Runtime.exe file.

To use the same bitmap on the Up and Down button position, do the following:

 > Using the browse button located next to the Down Position Bitmap field, select the bitmap.

To use a different bitmap for the Up and Down button position, do the following:

 > Using the browse button located next to the bitmap field, select the bitmap for each field.

To clear an entry from the Up and Down button position bitmap fields, do the following:

 > Click the DEL button located next to the bitmap field.

Button Up Text Field

The Button Up Text field identifies the text displayed on the button when the button is available for selection.

This field can contain up to 49 characters.

Button Down Text Field

The Button Down Text field identifies the text displayed on the button when the button is selected.

This field can contain up to 49 characters.

Border Color Drop Down Menu

The Border Color drop down menu displays the color of the border around the button. The border color can be changed by 
opening the palette with the drop down menu to select the desired color. The button border is half of the grid size on the 
console window. This allows UI Elements with the same color border to be grouped together, or to help create a visual 
separation between groups of buttons.

Set Font Button

The Set Font button displays a Font window used to select the text attributes for the button text.
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OK Button

The OK button saves the entries and closes the window.

Radio Command Buttons

The Radio Command buttons, shown in Figure 85, allow the user to send a radio command to specific user or group. The 
button is composed of two (2) individual buttons; the command button and a drop down button. 

Radio Command Drop Down Button

The Radio Command drop down button is used to display all the users or groups associated with the radio command.

The following button function types display users in the drop down list:

• GPS Read

• GPS Trigger On

• GPS Trigger Off

• Private Call

• Radio Call Alert

• Radio Check

• Radio Disable

• Radio Enable

• Radio Status Request

• Remote Monitor 

NOTE: The Group Call button function type displays groups associated with the line’s signaling system.

FIGURE 85. Radio Command Button
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To select a user from the drop down list, do the following:

1. Click the Radio Command button.
The drop down list opens displaying users/groups configured in the line’s signaling system.

2. From the Radio Command drop down list, select a user.
The Command Button displays the selected user name. When the command button is selected, the button’s configured 
command is sent to the selected user.
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UI Element Setup Window

Type Page. The Type page, shown in Figure 86, is used to select the button’s filter, function and line.

Filter Drop Down Menu

The Filter drop down menu is used to select a system for the selected line.

UI Element Function Drop Down Menu

The UI Element Function drop down menu is used to select a function type. If a Radio Command Button function type is 
selected, the Global Radio Button check box appears.

Line to Associate Function With Drop Down Menu

The Line to Associate Function With drop down menu is used to select a desired line.

Global Radio Button Check Box

The Global Radio Button check box, if selected, indicates that a Radio Command Button function type is selected in the UI 
Element function drop down menu. 

• Enable the Global Radio Button check box to send the configured radio command on any selected line. 

• If the Global Radio Button check box is not enabled, the configured radio command is sent on the 
associated line only.

FIGURE 86. UI Element Setup for Radio Command Button - Type Page
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Colors Page. The Colors page, shown in Figure 87, is used to setup the colors and text of the Radio Command Button.

Button Up Group Box

Button Drop Down Menu

The Button drop down menu displays the color of the Up Button when it is available for selection. Default button colors are 
defined for each UI element function. The button colors can be changed by selecting the drop down menu to open a color 
palette.

Text Color Drop Down Menu

The Text Color drop down menu displays the color of the text on the Button when it is available for selection. Default text 
colors are defined for each UI element function. The text colors can be changed by selecting the drop down menu to open a 
color palette.

Text Field

The Text field identifies the text displayed on the button when it is available for selection.

This field can contain up to 49 characters.

FIGURE 87. UI Element Setup for Radio Command Button Colors Page
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Button Down Group Box

Button Drop Down Menu

The Button drop down menu displays the color of the button when it is selected. Default button colors are defined for each UI 
element function. The button colors can be changed by selecting the drop down menu to open a color palette.

Text Color Drop Down Menu

The Text Color drop down menu displays the color of the text on the button when it is selected. Default text colors are defined 
for each UI element function. The text colors can be changed by selecting the drop down menu to open a color palette.

Text Field

The Text field identifies the text displayed on the button when it is selected.

This field can contain up to 49 characters.

Drop Down Button Settings Group Box

The Drop Down Button Settings group box contains settings which control the appearance of the drop down button. 

Button Size Field

The Button Size field sets the height (if drop down direction is above or below) or width (if drop down direction is left or 
right) of the drop down button. This is used to enlarge the drop down button to accommodate users of touch screen monitors. 

The range for this field is 10 to 200.
The default value for this field is 17.

Arrow Color Drop Down Menu

The Arrow Color drop down menu displays the color of the arrow in the drop down button. The arrow color can be changed 
by opening the palette with the drop down menu to select the desired color.

Border Color Drop Down Menu

The Border Color drop down menu displays the color of the border around the button. The border color can be changed by 
opening the palette with the drop down menu to select the desired color. The button border is half of the grid size on the 
console window. This allows UI Elements with the same color border to be grouped together, or to help create a visual 
separation between groups of buttons.

Set Font Button

The Set Font button displays a Font window used to select the text attributes for the button text.
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Drop Down Direction Group Box

The Drop Down Direction group box specifies the direction the drop down list containing the list of the available users or 
groups is displayed relative to the button.

Above Radio Button

The Above radio button indicates the drop down list displays above the button.

Below Radio Button

The Below radio button indicates the drop down list displays below the button.

Left Radio Button

The Left radio button indicates the drop down list displays to the left of the button.

Right Radio Button

The Right radio button indicates the drop down list displays to the right of the button.

OK Button

The OK button saves the entries and closes the window.

Options Page. The Options page, shown in Figure 88, is used to select the settings for list and scroll settings. 

FIGURE 88.  Options Page - UI Element Setup
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List Settings Group Box

Background Color Drop Down Menu

The Background Color drop down menu displays the background color of the drop down list. The background color can be 
changed by selecting the drop down menu to open a color palette.

Text Color Drop Down Menu

The Text Color drop down menu displays the color of the text in the drop down list. The text color can be changed by 
selecting the drop down menu to open a color palette.

Entry Spacing Field

The Entry Spacing field determines the amount of space in pixels between individual entries in the drop down list. The value 
entered for Entry Spacing and the font type determine the height of the individual entries in the drop down list. The entry 
spacing value can be increased to allow individual entries to be selected from a touch screen. 

The range for this field is 0 to 99.
The default value for this field is 8.

Visible Entries Field

The Visible Entries field determines the number of users visible in the drop down list without scrolling. 

The range for this field is 1 to 99.
The default value for this field is 10. 

Scrolling Settings Group Box

Scrollbar Width Field

The Scrollbar Width field determines the width in pixels of the scollbar in the drop down list.

The range for this field is 1 to 99.
The default value for this field is 17.

Minimum Slider Size Field

The Minimum Slider Size field determines the minimum height of the scollbar’s thumbtack slider in the drop down list.
The thumbtack slider is sized proportionally based on the total number of entries in the list and the number of entries which are 
displayed. The minimum slider size ensures the scrollbar is always as large as the entered value.   

The range for this field is 1 to 99.
The default value for this field is 17. 
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UI Element Function Configuration

The UI Element Functions drop down menu, on the Type page, contains UI Element functions for selection. Configuration 
for each function is described in the following section and listed alphabetically, as it appears in the drop down menu.

TABLE 6. UI Elements

UI Element Function Cross Reference

Active Emergency Window Opens the Active Emergency 
window to display emergency calls.

"Active Emergency Window” on page 198.

ADHB-4 Mic Control Allows the user to switch between two 
mic control inputs when the ADHB-4 
is connected to C-Soft.

"ADHB-4 Mic Control” on page 199.

ADHB-4 Select speaker 
Control

Allows the user to turn on and off the 
select speaker when the ADHB-4 
when the headset is connected.

"ADHB-4 Select Speaker Control” on page 200.

Alert Configures tones and duration for 
alerts.

"Alert” on page 201.

Annunciation Allows the user to send a 
pre-recorded .wav file.

“Annunciation” on page 203.

Auto-Dial Assign a string to send when the 
button is clicked.

"Auto-Dial” on page 204.

Backup Line Switches to backup IP Address. "Backup Line” on page 205.

Call List Window Opens the Call List window to 
display a list of user IDs. 

"Call List Window” on page 207.

Crosspatch Crosspatches two (2) or more lines. "Crosspatch” on page 212.

Crosspatch Block Blocks a crosspatch line from 
transmitting.

"Crosspatch Block” on page 213.

Crosspatch Clear Clears a specific group from a 
crosspatch. 

"Crosspatch Clear” on page 214.

Crosspatch Programmed Crosspatches a pre-defined group. "Crosspatch Programmed” on page 214.

Crosspatch PTT Transmits from the console to 
crosspatched lines.

"Crosspatch PTT” on page 215.

DTMF Digit Creates a DTMF digit button. "DTMF Digit” on page 216.

Emergency ACK Acknowledges an active emergency. “Emergency ACK” on page 218.

Emergency Clear Stops emergency tones from playing 
on the console.

"Emergency Clear” on page 218.

Emergency History Window Opens the Emergency History 
window to view received calls.

"Emergency History Window” on page 219.

Encryption Toggles encryption on/off. "Encryption” on page 219.

FleetSync Opens a FleetSync Dispatching 
window.

"FleetSync” on page 220.

Frequency Change Changes to a pre-defined frequency. "Frequency Change” on page 231.
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*GPS Read Reads the GPS coordinates of a radio. 
(MOTOTRBO Only)

"GPS Read Button” on page 232.

*GPS Trigger Off Turns off the trigger reading of the 
GPS coordinates of a radio. 
(MOTOTRBO Only)

"GPS Trigger Off Button” on page 233.

*GPS Trigger On Reads the GPS coordinates of a radio 
at a set periodic time. 
(MOTOTRBO Only)

“GPS Trigger On Button” on page 233.

Group Programmed Broadcasts to a pre-defined group. “Group Programmed” on page 235.

Group Select Creates a pre-defined group. "Group Select” on page 236.

Group Select Limited Limits the number of lines which can 
be selected simultaneously. 

"Group Select Limited” on page 237.

Input Indication Monitors NEO-10, HB-3, or 
ADHB-4 activity.

"Input Indication” on page 238.

Instant Recall Plays back audio. "Instant Recall” on page 241.

Intercom Allows console to console 
communication.

"Intercom” on page 243.

Intercom-Per Line Allows pre-defined console to 
console communication.

"Intercom-Per Line” on page 243.

Knox Digit Creates a Knox digit button. "Knox Digit” on page 244.

Launch Application Opens specified application. "Launch Application” on page 244.

Manual Call List Window Opens the Manual Call List window. "Manual Call List” on page 245.

Marker Tone Keys and sends a tone burst to a 
pre-defined radio channel.

“Marker Tone” on page 247.

MDC-1200 Window Opens the MDC-1200 Dispatching 
window.

"MDC-1200” on page 251.

Monitor Sends packets to open squelch or 
ignore CTCSS tones.

"Monitor” on page 265.

MOTOTRBO Window Opens the MOTOTRBO Dispatching 
window.

“MOTOTRBO Window” on page 275.

Mute Group Mutes audio on a pre-defined group. "Mute Group” on page 279.

Mute Main Mutes all currently selected lines. "Mute Main” on page 280.

Mute-Per line Toggles mute on a pre-defined line. "Mute-Per Line” on page 280.

NENA-Hold Places a hold on the NENA line. "NENA-Hold” on page 282.

NENA-Hook Control Indicates if the NENA line is off or 
on-hook.

"NENA-Hook Control” on page 283.

TABLE 6. UI Elements

UI Element Function Cross Reference
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NENA-Indication Indicates the current on or offhook 
state of a NENA line.

"NENA-Indication” on page 283.

NENA-Mute Mutes the NENA line. "NENA-Mute” on page 284.

P25-DFSI Window Opens the P25-DFSI Dispatching 
Window.

"P25-DFSI Window” on page 284.

Page Pages a specific line and frequency. “Page” on page 286.

Page Manual Entry Sends a page to a pager number 
entered by the console operator.

"Page Manual Entry” on page 288.

Page Send Sends a group of pages, when stacked. "Page Send” on page 289.

Page Stack Stacks pages. "Page Stack” on page 290.

Page Stack Programmed Stacks a pre-defined group of pages. "Page Stack Programmed” on page 290.

Per Line Call History Opens the Per line Call History 
window. 

"Per Line Call History” on page 292.

Phone Flashhook Flashhooks a phone line. "Phone-Flashhook” on page 294.

Phone Hold Mutes the phone line from RX and 
TX.

"Phone-Hold” on page 295.

Phone On/Offhook Toggles a phone line on/off. "Phone-On/Offhook” on page 295.

PTT Group Call Transmits audio to a group of radios. "PTT-Group Call” on page 297.

PTT -Main Transmits audio to all selected lines. "PTT-Main” on page 298.

PTT Per Line Keys a pre-defined line. "PTT-Per Line” on page 298.

PTT Private Call Transmits audio to a single radio. "PTT-Private Call” on page 299.

PTT - Talk Back Transmits to the last line that received 
audio.

"PTT-Talk Back” on page 300.

*Radio Call Alert Sends a Call alert to a Radio. "Radio Call Alert” on page 300.

*Radio Check Checks if a Radio is on/off. “Radio Check” on page 301.

*Radio Disable Disables a Radio. "Radio Disable” on page 302.

*Radio Enable Enables a Radio. "Radio Enable” on page 302.

*Radio Status Request Requests the Status of a Radio.    
(P25-DFSI Only)

“Radio Status Request” on page 303.

Radio On/Offhook Toggles radio on/off periodically to 
keep the radio active. 

“Radio-On/Offhook” on page 303.

Relay Control Button Controls an HB-3, ADHB-4, or 
NEO-10 relay.

"Relay Control Button” on page 304.

*Remote Monitor Turns on Monitoring of a Radio. "Remote Monitor” on page 308.

RX All Disengages mute on selected lines. "RX All” on page 309.

Scan Scans the selected line. "Scan” on page 309.

TABLE 6. UI Elements

UI Element Function Cross Reference
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Select Toggles TX channels when PTT is 
selected.

"Select” on page 310.

SIP Call Control Opens the SIP Calls window. "SIP Call Control” on page 313.

Supervisor Seizes control of a line or group of 
lines.

"Supervisor” on page 336.

Talk Around Toggles the Kenwood talk around 
feature on/off.

"Talk Around Button (Kenwood Radio Only)” 
on page 336.

Text Button Displays text on the console. "Text Button” on page 336.

TX All Selects all lines for TX. "TX All” on page 337.

Add UI Volume Control Inserts a graphical volume control 
slider.

“UI Element Setup Window—Add UI Vol. 
Control” on page 337.

Volume-Master Select Controls the volume on all select 
lines.

“Volume-Master Select” on page 338.

Volume-Master Unselect Controls the volume on all unselected 
lines.

“Volume-Master Unselect” on page 338.

Volume-NENA Controls the NENA volume on an 
ADHB-4.

“Volume-NENA” on page 338.

Volume-Per Line Controls volume per line. “Volume-Per Line” on page 338.

Add Pop-up Button Adds a Pop-up button. “UI Element Setup Window - Add UI Pop-up 
Button” on page 340.

Pop-up Window Control Opens the Global Call History 
window.

"Pop-up Window Control” on page 346.

Pop-up Call History Configures the call history display “Pop-up Call History” on page 342.

Pop-up Webpage Opens a window that displays a 
pre-defined webpage. 

“Pop-up Webpage” on page 344.

Add Text Adds text lines to console design. “UI Element Setup Window—Add Text” on 
page 347.

Add Clock Adds a clock to the console.  “UI Element Setup Window—Add Clock” on 
page 348.

Add VU Meter Adds a VU meter to the console. “UI Element Setup Window—Add VU Meter” 
on page 352.

Add Frame Adds a frame to the console. “UI Element Setup Window—Add Frame” on 
page 353.

Add Frequency Control Adds a frequency control to the 
console.

 “UI Element Setup Window—Add Frequency 
Control” on page 354.

* These features only work for 
P25-DFSI, MOTOTRBO or 
both radios.

TABLE 6. UI Elements

UI Element Function Cross Reference
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Active Emergency Window

The Active Emergency Window function displays a list of current active emergencies.

When clicked in the C-Soft Runtime program, the Active Emergency window appears. The Active Emergency window 
displays a list of current active emergencies.

For more information, see “Emergency Button” on page 261 and “Emergency Type” on page 263.

When an emergency call is received, the Active Emergency button blinks. When the Active Emergency button is clicked, the 
Active Emergency window opens. One (1) of two (2) actions can be taken on an emergency call listed in the window:

Clear the emergency - By clearing the emergency, the red button turns orange, the tones stop, and a Clear 
message is sent to the MDC-1200 radio that declared the emergency. The user can clear 
multiple emergency calls at once.

Acknowledge the emergency - By acknowledging the emergency, the red button turns green. The user can acknowledge 
only one emergency at a time. This can be accomplished without first clearing the 
emergency.

To add an Active Emergency button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Active Emergency Window.

5. Click OK.
The button color changes and Active Emergency appears on the button.
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ADHB-4 Mic Control

The ADHB-4 Mic Control allows the user to switch between two (2) mic control inputs when the ADHB-4 is connected to
C-Soft.

ADHB-4 Mic Control Button Setup Page. When the ADHB-4 Mic Control is selected from the UI Element Function drop 
down menu, the ADHB-4 Mic Control Button Setup page appears.

To add an ADHB-4 Mic Control button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element Function drop down menu, select ADHB-4 Mic Control.

5. Click on the ADHB-4 Mic Control Button Setup button.
The Select ADHB-4 Mic Toggle States drop down menu appears.

6. From the ADHB-Mic Toggle States drop down menu, select one (1) of the following

• Controller

• RHB1

• RHB2

• Desk Mic

7. Click OK.
The button color changes and Active Emergency appears on the button.

FIGURE 89. ADHB-4 Mic Control

FIGURE 90. ADHB-4 Mic Control Button Setup
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ADHB-4 Select Speaker Control

The ADHB-4 Select Speaker Control, shown in Figure 91, allows the user to turn the selected speaker on and off when the 
headset is connected.

To add an ADHB-4 Select Speaker Control button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select ADHB-4 Select Speaker Control.

5. Click OK.
The button color changes and Active Emergency appears on the button.

FIGURE 91. ADHB-4 Select Speaker Control
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Alert

The Alert function allows the console operator to send a tone to all selected lines.

In C-Soft Runtime, if PTT is not active when an Alert button is pressed, the PTT button is automatically activated to key the 
remote radios before the tones are generated.

Alert Setup Page. When the Alert function is selected from the UI Element Function drop down menu, the Alert Setup page 
appears. See Figure 92.

Tone Type Group Box

The Tone Type group box identifies the type of tone to play. When a selection is made, the fields necessary to enter the setup 
information for the tone type are enabled on the page. 

Tone Radio Button

The Tone radio button indicates a single steady tone is used as an alert tone.

To add a tone alert button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Alert.
The Alert Setup tab appears.

5. Click the Alert Setup tab.
The Alert Setup window appears.

6. In the Tone Type group box, select the Tone radio button.

7. In the Low Frequency field, enter the frequency (in Hz).

8. In the Tone Level field, enter the tone level (in dB).

9. Click OK.
The button changes color and Alert appears on the button.

FIGURE 92. Alert Setup Page—UI Element Setup
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Pulsed Tone Radio Button

The Pulsed Tone radio button indicates a pulsed tone is used as an alert tone.

To add a Pulsed Tone alert button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Alert.
The Alert Setup tab appears.

5. Click the Alert Setup tab.
The Alert Setup window appears.

6. From the Tone Type group box, select the Pulsed Tone radio button.

7. In the Low Frequency field, enter the frequency (in Hz).

8. In the Low/On Duration field enter the duration in ms. 

9. In the Hi/Off Duration field, enter the duration in ms.

10. From the Tone Level field, enter the tone level (in dB).

11. Click OK.
The button changes color and Alert appears on the button.

Hi-Lo Radio Button

The Hi-Lo radio button indicates a Hi-Lo warble is used as an alert tone.

To add a Hi-Lo alert button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Alert.
The Alert Setup tab appears.

5. Click the Alert Setup tab.
The Alert Setup window appears.

6. From the Tone Type group box, select the Hi-Lo radio button.

7. In the Low Frequency field, enter the frequency (in Hz).

8. In the Low/On Duration field, enter a duration (in ms).

9. In the Hi Frequency field, enter a frequency (in Hz).

10. In the Hi/Off Duration field, enter the duration (in ms).

11. From the Tone Level field, enter the tone level (in dB).

12. Click OK.
The button changes color and Alert appears on the button.
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Low Frequency Field

The Low Frequency field identifies the frequency of the low tones sent when the button is pressed.

The field values can range from 0 to 3000Hz.

Low/On Duration Field

The Low/On Duration field identifies the duration at which the frequency is played.

The range for this field is 0 to 2000ms.

Hi Frequency Field

The Hi Frequency field identifies the frequency of the high tones sent when the button is pressed.

The range for this field is 0 to 3000Hz.

Hi/Off Duration Field

The Hi/Off Duration field identifies the duration at which the frequency is stopped.

The range for this field is 0 to 2000ms.

Tone Level Field

The Tone Level field identifies the relative change allowable in the level of the tone generated.

The range for this field is -30 to 0dB.

Annunciation

The Annunciation function allows the console operator to send a pre-recorded .wav file to radio users. When clicked the .wav 
file waits for all console TX and RX traffic to clear before sending the recording. If multiple annunciation buttons are clicked, 
the .wav files are sent in the order they were clicked.

Annunciation Setup Page. When the Annunciation function is selected from the UI Element drop down menu the 
Annunciation Setup page appears.

FIGURE 93. Annunciation Setup Page—UI Element Setup
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File Path Field

The File Path field is used to specify the path for the .wav file recording. When preparing the .wav file, ensure the file is saved 
with a 16-bit, 8.000kHz sample rate. The .wav format can be changed by using the Microsoft Sound recorder which is 
installed by default on the Telex Nexus Dispatch console. The .wav file must be located in the same folder as C-Soft Runtime.

REFERENCE: For more information, see the Microsoft website.

Level Field

The Level field indicates the relative level change, in dB, for the .wav file.

The range for this field is -30dB to 10dB.

Send on Selected Lines Check Box

The Send on Selected check box indicates the console operator can select which line(s) the .wav file can be sent on. 

If unselected, the .wav file is sent only on the line associated to the UI Element button currently being configured. Otherwise, 
the .wav file is sent to all selected lines.

Browse Button

The Browse button is used to browse for and select the .wav file to be used. 

Auto-Dial

The Auto-Dial function allows the console operator to quickly dial a pre-defined number.

Auto-Dial String Entry Page. When the Auto-Dial String Entry function is selected from the UI Element drop down menu 
the Auto-Dial String Entry page appears. See Figure 94.

FIGURE 94. Auto-Dial String Entry Page—UI Element Setup
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To add an Auto-Dial button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Auto-Dial.
The Auto-Dial String Entry tab appears.

5. Click the Auto-Dial String Entry tab.
The Auto-Dial String Entry page appears.

6. In the Enter Dial String field, enter the Auto-Dial number for the button.

NOTE: Commas entered in this field add a 2 second delay.

7. Click OK.
The color of the button changes and Dial appears on the button.

Enter Dial String Field

The Enter Dial String field indicates the number to dial when the button is clicked in C-Soft Runtime.

This field can contain up to 16 characters.

Tone Standard Group Box

DTMF Radio Button

The DTMF radio button indicates DTMF tones are transmitted to place the call.

Knox Radio Button

The Knox radio button indicates Knox tones are transmitted to place the call. 

Backup Line

The Backup Line function forces the line to route packets to and from either the primary or secondary radio interface. If the 
ping routine fails to receive a reply from the Base Radio IP, it automatically switches to the Backup IP settings specified in the 
Per Line Parameters window.

In C-Soft Runtime, the button changes to show the current condition. If there is a failure on both the primary and secondary 
radio interfaces, LINK FAIL is displayed on the Select button.

NOTE: When the Backup Line function is selected, a line must be selected from the Line to Associate Function With 
drop down menu.
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Backup Control Line Setup Page. When the Backup Line function is selected from the UI Element drop down menu, the 
Backup Control Line Setup page appears. See Figure 95.

Allow User to Switch Primary/Backup Check Box

The Allow User to Switch Primary/Backup check box indicates the console operator is allowed to manually switch between 
the primary and secondary radios. Otherwise, the button functions as an indicator only, and the console operator cannot control 
the radio in use. 

NOTE: The C-Soft program needs to be restarted to reset from the backup radio to the primary radio.

To add a Backup Line button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Backup Line.
The Backup Control Line Setup tab appears.

5. From the Line to Associate Function With drop down menu, select the line to setup the backup control.

6. Click the Backup Control Line Setup tab.
The Backup Control Line Setup page appears.

7. Select the Allow User To Switch Primary/Backup check box, if desired.

8. Click OK.
The button changes color and Primary appears on the button.

FIGURE 95. Backup Control Line Setup Page—UI Element Setup
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Call List Window

The Call List Window function creates a button used to view a list of User IDs. 

In C-Soft Runtime, if the console operator clicks the Call List button, the Call List window for the selected line, shown in 
Figure 96, appears. From this window, the user can make outgoing calls and send status messages based upon programming 
setup. The Call List displays generic, iDEN, and phone type users and groups.

To add a call list button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Call List.

5. Click OK.
The color of the button changes and Call List appears on the button.
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Call List Window

The Call List window, shown in Figure 96, is used to view and select from a list of IDs. Default messages are configured by 
the console administrator and assigned to the buttons on the bottom of the window.

ID Type Drop Down Menu

The ID Type drop down menu is used to select a sort type for the list. 

Available selections for this field are: 

Alias - Select Alias from the menu to sort the status IDs by alias in ascending alphabetical order.

ID - Select ID from the menu to sort the status IDs by ID number in ascending numerical order. The selected ID 
type determines the User ID drop down menu entries. 

User ID Drop Down Menu

The User ID drop down menu is used to select a user ID for placing a call. Either the alias or the ID number appears in the 
menu depending on the ID Type drop down menu selection. Alternatively, the status can be selected from the list at the bottom 
of the window. 

Filters Drop Down Menu

The Filters drop down menu is used to select a filter from the list. When selected, the list populates with users assigned to the 
filter by the console administrator

Available selections for this field are: 

No Filter - Displays a complete list of user IDs.

User-defined System Filter - Displays only user IDs belonging to the filter.

FIGURE 96. Call List Window—C-Soft Runtime
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Status Field

The Status field indicates the currently selected status. If no status is selected, No Status appears in the field. 

Set Status Button

The Set Status button is used to select a status to send. When clicked, the Status List window appears. See Figure 97.

To send a status ID from the Call List window in C-Soft Runtime, do the following:

1. While in C-Soft Runtime, select the line you want to place the call from.

2. Select a Call List button.
The Call List window appears.

3. From the ID Type drop down menu, select an alias or an ID number.
The selected status ID in the status list is highlighted.

4. Select Set Status.
The Status List window appears. 

5. From the ID type drop down menu, sort the list by alias or status ID number.
The list is sorted depending on the selected type.

6. From the Status drop down menu, select a status ID to send.
The selected status ID is highlighted.
OR
From the status ID list, select a status ID to send.
The selected status ID is highlighted

7. Click Done.
If a password is required to send the status ID, the Password Entry window appears.

8. Using the monitor keypad or your keyboard, enter the password.
For each character you enter, asterisks fill the empty field at the top of the window.

9. Click Enter.
The Password Entry window closes and the selected status’s alias appears in the Status Message field. If the password 
is incorrectly entered, an error message appears.
OR
Click Cancel.

10. Click a Call button to place the call.
The message is sent and a confirmation or error message appears in the dispatching status bar.

11. Click Done to close the window.

Call 1–10 Buttons

The Call (1–10) buttons are used to place user-defined calls configured in the 5/6 Tone DTMF ANI Setup page on page 80. 
The labels configured on the 5/6 Tone/DTMF ANI Setup page appear on these buttons in the Call List window.

NOTE: The Call1–Call10 buttons may have different labels assigned by the console administrator.

To place a call from the Call List window, do the following:

1. Select an ID from the list.
Available call buttons on the bottom of the window become active. 

2. Select a call button. 
The call is placed.

Done Button

The Done button is used to close the Call List window.
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Status List Window

The Status List window, shown in Figure 97, is used to select from a list of preprogrammed status IDs. When a status ID is 
selected and the window is closed, the selected status appears in the Status field located on the Status List window.

ID Type Drop Down Menu

The ID Type drop down menu is used to select a sort type for the list. 

Available selections for this field are:

Alias - Selecting Alias from the menu, sorts the status IDs by alias in alphabetical order.

Status ID - Selecting ID from the menu, sorts the status IDs by ID number in ascending numerical order. 

Status Drop Down Menu

The Status drop down menu is used to select the status to send. Either the alias or the ID number appear in the list and is 
determined by the selection in the ID Type drop down menu. Alternatively, the status can be selected from the list at the 
bottom of the window. 

To send a status from the Call List window, do the following:

1. While in C-Soft Runtime, select the line you want to place the call from.

2. From the ID Type drop down menu, select an alias or an ID number.
The selected status ID in the status list is highlighted.

3. Click Done.
If a password is required to send the status ID, the Password Entry window appears. 

4. Using the keypad, enter the password.
For each character you enter, asterisks fill the empty field at the top of the window.

5. Click Done.
The Password Entry window closes and the selected status’s alias appears in the Status Message field or, if the 
password is incorrectly entered, an error message appears.

6. Select the Status Message radio button.

7. Select a Call button.
The message is sent and a confirmation or error message appears in the status bar.

FIGURE 97. Status List Window
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To select a status from the Status List window, do the following:

1. From the Status drop down menu, select a status to send.
The status appears in the Status field.

2. Click Done.
If a password is required the Password Entry window appears.

3. From the Password Entry window, enter a password.

NOTE: The password can also be entered using the keyboard.

4. Click Enter.
The Status List window appears with the selected status in the Status field.
OR 
Click Cancel to clear the entry and close the window.
The Status List window appears.

5. Click Done.
The Call List window or Per Line History window appears.

NOTE: See “Call 1–10 Buttons” on page 209 or “Per Line Call History” on page 292 to continue with sending a 
message to the selected ID.

Cancel Button

The Cancel button clears any entries made and closes the window.

Done Button

The Done button is used to close the Status List window.

To select a user ID to place a call to, do the following:

1. Select the line you want to place the call from.

2. Click Call List.
The Call List window appears.

3. From the Filter drop down menu, select a filter to sort the list.
OR
Select No Filter.

4. From the User ID drop down menu, select an alias or user ID.
The selected user ID in the call list is highlighted.

5. Click Done.
If a password is required to send the status ID, the Password Entry window appears. 
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6. Using the monitor keypad or your keyboard, enter the password.
For each character you enter, asterisks fill the empty field at the top of the window.
OR
If the password is unknown, click Cancel.
The Password Window closes.

7. Click Done.
The Password Entry and Status List windows close and the selected status’s alias appears in the Status Message field 
or, if the password is incorrectly entered, an error message appears.

To view the Call List, do the following:

1. Click Call List. 

2. From the Filter drop down menu, select a filter to sort the list.
OR 
Select No Filter.

3. From the Status ID drop down menu, select a status or ID.
The status ID in the status list is highlighted.

4. Click Done.
If a password is required to send the status ID, the Password Entry window appears. 

5. Using the monitor keypad or your keyboard, enter the password.
For each character you enter, asterisks fill the empty field at the top of the window.

6. Click Done.
The Password Entry window closes and the selected status’s alias appears in the Status Message field or, if the 
password is incorrectly entered, an error message appears.

7. Select the Status Message radio button and click Send.
The message is sent and a confirmation or error message appears in the Dispatching status bar.

Crosspatch

The Crosspatch function allows the console operator to connect two (2) or more radios/phone lines, enabling different lines to 
talk to each other. 

Patch Group Page. When the Crosspatch function is selected from the UI Element drop down menu, the Patch Group page 
appears. See Figure 98.

FIGURE 98. Patch Group Page—UI Element Setup
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To add a Crosspatch button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Crosspatch.
The Patch Group tab appears.

5. Click the Patch Group tab.
The Patch Group page appears.

6. From the Select Patch Group drop down menu, select the number of the crosspatch group (1–30).

7. Click OK.
The color of the button changes and Patch appears on the button.

Crosspatch Block

The Crosspatch Block function allows a particular crosspatch line to be blocked from transmitting. 

EXAMPLE: If the line is stuck in receive mode due to noise, that line can be blocked, releasing its control of the 
crosspatch. After the line completes a transmit cycle, then it is eligible to transmit/receive as part of the 
patch.

Patch Group Page. When the Crosspatch function is selected from the UI Element drop down menu, the Patch Group page 
appears. See Figure 98.

To add a Patch Block button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Crosspatch Block.
The Patch Group tab appears. 

5. Click the Patch Group tab.
The Patch Group page appears.

6. From the Select Patch Group drop down menu, select the crosspatch group number.

7. Click OK.
The color of the button changes and a Patch Block button appears in the console window.
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Crosspatch Clear

The Crosspatch Clear function allows the console operator to drop the patch for the crosspatch group.

Patch Group Page. When the Crosspatch function is selected from the UI Element drop down menu, the Patch Group page 
appears. See Figure 98. 

To add a Patch Clear button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Crosspatch Clear.
The Patch Group tab appears. 

5. Click the Patch Group tab.
The Patch Group page appears.

6. From the Select Patch Group drop down menu, select the number of the crosspatch group.

7. Click OK.
The color of the button changes and Patch Clear appears on the button.

Crosspatch Programmed

The Crosspatch Programmed function allows the console operator to create a crosspatch on a pre-defined group of lines.

NOTE: Telex recommends you assign a unique color to this button because it is applied to all lines in the crosspatch.

Line Group Page. When the Crosspatch Programmed function is selected from the UI Element drop down menu, the Line 
Group page appears. See Figure 99.

FIGURE 99. Line Group Page—UI Element Setup
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Select Lines for Group Field

The Select Lines for Group field contains a list of all the lines configured on “Per Line Parameters Window” on page 67. 
Selecting a line from this list assigns the line to the group.

Group Patch Number Drop Down Menu

The Group Patch Number drop down menu is used to assign a unique crosspatch group number to the selected line. 

Autostart Crosspatch Check Box

The Autostart Crosspatch check box indicates the crosspatch is automatically created when the C-Soft program is started.

To add a Crosspatch Programmed button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, Crosspatch Programmed.
The Line Group tab appears.

5. Click the Line Group tab.
The Line Group page appears.

6. On the Line Group page, select the line(s) from the Select Lines for Group field.

7. From the Group Patch Number drop down menu, select the group patch number.

8. From the Options field, select the Autostart Crosspatch check box to automatically start the crosspatch, if desired.

9. Click OK.
The color of the button changes and Preset Patch appears on the button.

Crosspatch PTT

The Crosspatch PTT function allows the console operator to transmit audio to all lines included in the crosspatch.

Patch Group Page. When the Crosspatch PTT function is selected from the UI Element drop down menu, the Patch Group 
page appears. See Figure 98.

To add a Crosspatch PTT button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Crosspatch PTT.
The Patch Group tab appears. 

5. Click the Patch Group tab.
The Patch Group page appears.

6. From the Select Patch Group drop down menu, select the number of the crosspatch group.

7. Click OK.
The color of the button changes and Patch Clear appears on the button.
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DTMF Digit

The DTMF Digit function adds one (1) digit of a DTMF keypad. Multiple buttons can be added to the console to form a 
DTMF keypad. All 16 pairs are supported.

DTMF Digit Page. When the DTMF Digit function is selected from the UI Element drop down menu, the DTMF Digit page 
appears. See Figure 100.

DTMF Digit Drop Down Menu

The DTMF Digit drop down menu provides a list of numbers and letters for the DTMF keypad. 

Available selections for this field are 0-9, A-D, * and #.

NOTE:

• Each digit must be assigned to its own button.

• When creating a telephone keypad, the corresponding letters for the keypad are automatically inserted.

In C-Soft Runtime, if a DTMF digit button is clicked, the digit is sent to all selected lines during a PTT operation, or it 
generates its own PTT if clicked outside of a PTT operation.

To assign a digit to a button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select DTMF Digit.
The DTMF Digit tab appears. 

FIGURE 100. DTMF Digit Page—UI Element Setup
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5. Click the DTMF Digit tab.
The DTMF Digit page appears.

6. From the DTMF Digit drop down menu, select the digit you want to appear on the button.

7. Click OK.
The color of the button changes and the selected number (or letter) appears on the button. 
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Emergency ACK

The Emergency ACK function creates a button to indicate the emergency is acknowledged. 

NOTE: When the Emergency ACK function is selected, a line must be selected from the Line to Associate Function With 
drop down menu.

In C-Soft Runtime, if an emergency signal is received, the C-Soft program sends an emergency Hi-Lo tone to the selected 
speaker to notify the console operator. In addition, the Select button for the line that received the emergency call blinks.

To add an ACK button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select the Emergency ACK button.

NOTE: The emergency ACK button label may or may not be Emergency ACK. The label is determined by the 
console administrator.

5. From the Line to Associate Function With drop down menu, select the desired line to associate with this function.

6. Click OK.
The color of the button changes and Emergency ACK appears on the button.

Emergency Clear

The Emergency Clear function stops the Hi-Lo tone from playing on the selected speaker. 

To add an Emergency Clear button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Emergency Clear.

5. Click OK.
The color of the button changes and Emergency Clear appears on the button.
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Emergency History Window

The Emergency History Window function creates a button to access the emergency call history list. 

In C-Soft Runtime, if the Emergency History window button is clicked, the Emergency History window appears. From this 
window, you can view all emergencies, resolved emergencies, and acknowledged emergencies. 

To add a Emergency History Window button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Emergency History Window.

5. Click OK.
The color of the button changes and Emergency History appears on the button.

Encryption

The Encryption function allows the console operator to selectively turn on and off encryption message sent to an IP-223 or 
IP-224.

NOTE: When the Encryption function is selected, a line must be selected from the Line to Associate Function With 
drop down menu.

Encryption Setup Page. When the Encryption function is selected, the Encryption Setup page appears, shown in 
Figure 101.

FIGURE 101. Encryption Setup Page–UI Element Setup
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Default Secure Check Box

The Default Secure check box indicates encryption is enabled when C-Soft boots up.

To configure encryption on a line, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Encryption.

5. From the Line to Associate Function With drop down menu, select the desired line to associate this function.

6. Click OK.
The color of the button changes and Clear appears on the button.

FleetSync

The FleetSync function creates a button to open the FleetSync Dispatching window, shown in Figure 103. 

In C-Soft Runtime, when the window is open the user can view the system list, call history and status history, send status IDs, 
voice messages and data messages, select groups and individuals to place calls.

FleetSync Setup Page. When the FleetSync function is selected from the UI element drop down menu, the FleetSync Setup 
page appears, shown in Figure 102.

Console Requests Group Box

Timeout Field

The Timeout field is used to configure the amount of time, in seconds, the console waits after sending a status request 
command before indicating a response was never received.

The range for this field is 1 to 10 seconds.

FIGURE 102. FleetSync Setup Page - UI Element Setup
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To add a FleetSync button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select FleetSync.

5. Click OK.
A button with FleetSync on it appears.

FleetSync Dispatching Window

The FleetSync Dispatching window is used by the console operator in C-Soft Runtime to place calls, view call history, and 
send status and text messages. Console action feedback is provided in the Dispatching Status bar. 

System Drop Down Menu

The System drop down menu is used to change from the currently selected system to another system in the console position.

Up to 200 systems can be created.

NOTE: The default systems included in the drop down menu depend on the currently selected line’s configuration.

System List Field

The System List field populates with components that belong to the system currently selected from the System drop down 
menu. Filters components are listed next in the hierarchy. When a filter component is expanded, individual unit and fleet 
components are visible.

FIGURE 103. FleetSync Dispatching Window
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Systems can be configured, by the console admin, to display filters only. In that case, only components affiliated with a filter, 
shown in Figure 104, appear in the filter list. Otherwise, all components, including components with deny icons (permission to 
place calls is denied), shown in Figure 103, appear in the list.

System List Flyout Menu

The System List flyout menu, shown in Figure 105, is a quick method of accessing the Select Type commands also available 
in the Data Messaging Group Box. 

Available selections for this field are Status, Text Messages, Select Calls and Request Status

FIGURE 104. System Displays Only Filters Example

Icon Type Description

Filter The Filter icon indicates the component is a filter. Filters are used to group, sort, and label the 
components contained in the filter, see Figure 104.

To view or hide filters, do one (1) of the following:

• Click the expand button to view components. 

• Click the collapse button to hide components. 

Allow The Allow icon indicates the component is available for selection. 

The console operator can place calls and send status and text messages to these components, see 
Figure 104. 

Deny The Deny icon indicates the component does not allow broadcast calls, when a system is tagged, 
or, does not allow interfleet calls when Fleets or Units are tagged, see Figure 104.
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To access the System List flyout menu, do the following:

1. In the system list, right-click the unit or group to send the call or message to.
The System List flyout menu appears
OR
In the system list, right-click the system to send the call or message to.
The System List flyout menu appears.

2. Click Status.
OR
Click Text Message.
OR
Click Select Call.
OR
Click Status Request.

NOTE:  

• For more information, see “Status Message Radio Button” on page 229.

• For more information, see“Text Message Radio Button” on page 229.

• For more information, see “Select Call Radio Button” on page 230.

• For more information, see “Request Status Radio Button” on page 230.

Selected Items Page. The Selected Items page is used to view the currently selected component’s ID information. The 
selected item list is used to determine where the call or status message is sent. 

Selection of only one (1) component per system is allowed. Grayed out items with deny icon tags are not available for 
selection.

NOTE: For more information, see “Manual Select Group Box” on page 224.

FIGURE 105. System List Flyout Menu
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To add a component’s ID to the Selected Items page, do the following:

1. In the System list field, select the component.
The component is highlighted.

2. Click Add to Selected.
The item appears in the list.

To remove an ID from the Selected Items page, do the following:

1. Right-click the unwanted component.

2. Click Remove Item.
The item disappears from the list.

Manual Select Group Box

The Manual Select group box is used to manually enter Fleet and User ID numbers for placing calls, sending status messages 
and text messages. 

Fleet ID Field

The Fleet ID field is used to enter the Fleet ID portion of the ID number for placing and sending interfleet calls and messages. 
The Fleet ID field is populated, by default, with the Fleet ID when the system is selected and broadcast calls are allowed on the 
line. 

• If interfleet calls are not allowed on the selected line, the Fleet ID field is not editable for any 
component. It is possible, however, to place an individual intrafleet call manually. The selected line’s 
Fleet ID–grayed out–is added on to the unit ID number you enter manually.

• If a Fleet ID and User ID are both 0, then the console displays the following message: Cannot add a 
system! Allow Broadcast Call option is disabled, appears.

User ID Field

The User ID field is used to manually enter the unit ID portion of the ID number. It is used to place a call or send a message 
when the ID is not available for selection from the system list. 

The User ID field is also used to place broadcast calls using zeros, indicating it is a broadcast call, and is sent to all members 
of the fleet.

History Page. The History page is used to view past FleetSync calls and messages received by the console. Additionally, 
calls or messages can be sent by selecting the ID in the history log. When selected, the ID is added to the Selected Items page. 

The list is configured, by the console administrator, to contain up to 500 IDs. For more information, see “Per Line Call History 
Window Lines Field” on page 128.
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NOTE:

• Calls are not saved to the history list if C-Soft Runtime is closed.

• The FleetSync Call History list includes calls received from parallel console positions.

Call History View Group Box

The Call History View group box is used to control the log display.

All Lines Radio Button

The All Lines radio button is used to display all calls and messages received by the console. 

Selected Line Radio Button

The Selected Line radio button is used to display all calls and messages received on the selected line.

FIGURE 106. History Page—FleetSync Dispatching Window
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Call Details Group Box

The Call Details group box is used to display additional call information for the currently selected ID type. 

Add to Selected Button

The Add to Selected button is used to add the manually entered Fleet and Unit ID to the selected items page. When the ID 
number displays in the Selected Items page, the call can be placed or message sent. 

To manually place an individual call inside the current system, do the following:

1. In C-Soft Runtime, select a line.

2. Click the FleetSync button.
The FleetSync Dispatching window appears.The Fleet ID field is, by default, populated with the current system’s fleet 
ID. 

3. In the User ID field, enter the individual’s unit ID number.

4. Click Add to Selected.
The system name you are currently working with appears in the Selected Items page. 

NOTE: The name on the FleetSync button is configured by your console administrator. FleetSync is used generically 
to refer to any button configured for FleetSync functions.

To manually place an interfleet call, do the following:

1. Select a line with interfleet calls allowed.

2. Click FleetSync.
The FleetSync Dispatching window appears.

3. In the Fleet ID field, enter the individual’s fleet ID number.

4. In the User ID field, enter the individual’s unit ID number.

5. Click Add to Selected.
The system name you are currently working in appears in the Selected Items page.

To manually place a broadcast call, do the following:

1. Select a line with broadcast calls allowed.

2. Click FleetSync.
The FleetSync Dispatching window appears. The Fleet ID field contains the system Fleet ID number, and is not 
editable.

3. In the System List field, select the system name. 
The system name is highlighted.

4. In the Unit ID field, enter 0000.

5. Click Add to Selected.
The system name you are currently working in appears in the Selected Items page.

NOTE: Lines can be configured to allow or deny both broadcast calls or interfleet calls. 
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Permission to place calls can be determined by the window’s appearance. See Figure 107 and Figure 108. 

Icon Type Description

Deny Broadcast calls are not allowed as indicated by the deny icon. When the system name is selected, 
the Selected Items page is empty and the Fleet ID field is grayed out, see Figure 107.

Allow Broadcast calls are allowed as indicated by the allow icon. When the system name is selected the 
ID number appears in the Selected Items page and the Fleet ID field is active, see Figure 107.

FIGURE 107. Broadcast Call Permissions
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Icon Type Description

Deny Interfleet calls are not allowed as indicated by the deny icon. When the Fleet 
name is selected, the Selected Items page is empty and the Fleet ID field is grayed 
out, see Figure 108.

Allow Interfleet calls are allowed as indicated by the allow icon. When the Fleet name is 
selected, the ID appears in the Selected Items page and the Fleet ID field is active, 
see Figure 108.

FIGURE 108. Interfleet Call Permission 
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Status Message Field 

The Status Message field indicates the currently selected status message. If no status is selected, No Status appears in the field. 
The Set Status button is used to change the status ID.

Set Status Button

The Set Status button is used to select a status to send. When the Set Status button is clicked, the Status List window appears. 
See Figure 97. 

To set the status ID, do the following:

1. Click Set Status.
The Status List window appears. 

2. Select a Status ID from the list.
The ID is highlighted.
OR
From the Status drop down menu, select a Status ID.
The ID is highlighted.

3. Click Done.
The selected Status ID appears in the Status Message field.

Select Type Group Box

The Select Type group box is used to select the type of message or call sent when the Send button is clicked. 

Status Message Radio Button 

The Status Message radio button indicates the currently selected status message is sent to the ID number listed in the Selected 
Item page. 

To send the current status message, do the following:

1. Select the Status Message radio button.

2. Click Send.
The message is sent and a confirmation appears in the status bar.

NOTE: Status ID codes must be between 10 and 99. See manufacturer’s technical data for specific Status ID codes.

Text Message Radio Button

The Text Message radio button indicates the current entry in the Enter Text Message text box is sent to the ID number listed in 
the Selected Item page. 

To send the current text message, do the following: 

1. Select the Text Message radio button.

2. Click Send. 
The message is sent and a confirmation appears in the status bar.

NOTE: The text message can contain up to 48 characters. 
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Select Call Radio Button

The Select Call radio button indicates a select call is placed to the current ID in the Selected Items page. 

To place a select call to the ID, do the following:

1. Select the Select Call radio button.

2. Click Send.
The message is sent and a confirmation appears in the status bar.

Request Status Radio Button

The Request Status radio button is used to send a request for status from the ID currently listed in the Selected Items page. 

To request a status from the ID, do the following:

1. Select the Request Status radio button. 

2. Click Send.
The message is sent and a confirmation appears in the status bar.

Send Button

The Send button is used to send the currently selected call, status, or message to the ID listed on the Selected Items page. 
When selected, a confirmation or error message appears in the status bar at the bottom of the window.

Done Button

The Done button is used to close the FleetSync Dispatching window.

FleetSync Dispatching Window Status Bar

The FleetSync Dispatching window status bar, shown in Figure 103, indicates console activity. Confirmation and error 
messages appear when calls, statuses, or messages are sent.
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Frequency Change

The Frequency Change function sends a burst of packets onto the Ethernet network requesting the remote radio change to the 
new frequency of the selected line. Additionally, all other consoles on the network change to display the new frequency of the 
radio on that particular line.

NOTE: When the Frequency Change function is selected, a line must be selected from the Line to Associate Function 
with drop down menu.

Freq Set Page. When the Frequency Change function is selected from the UI Element drop down menu, the Freq Set page 
appears. See Figure 109.

Given that frequencies change, it is common to place frequency selection buttons in a pop-up window. The console operator 
opens the pop-up window to change frequencies and closes the window when they are done.

However, with the pop-up window closed, it becomes impossible to see exactly what frequency is currently selected for the 
line. By placing the variable $FREQX$, where X represents the line number, into the Button Up Text and Button Down Text 
field on the Colors page, the frequency for that line is automatically updated on the button when it changes.

When Scannable is selected for the line, see “Scannable Check Box” on page 71, right-click the button to display a shortcut 
menu that provides the console operator the ability to add or remove this channel from the scan list.

When a frequency is in the scan list, a scan icon appears on the frequency change button. Parallel consoles are also alerted to 
update their display if a frequency is added or removed from the scan list. 

FIGURE 109. Freq. Set Page—UI Element Setup
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Select PTT Frequency Drop Down Menu

The Select PTT Frequency drop down menu is used to select the frequency for the line. This field contains all the frequencies 
configured on “Freqs Button” on page 72.

To add or change a Frequency button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the UI button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Frequency Change.
The Freq Set tab appears.

5. From the Line to Associate Function With drop down menu, select the desired line to associate with this function.

6. Click the Freq Set tab.
The Freq Set page appears.

7. From the Select PTT Frequency drop down menu, select the desired frequency for the line selected.

8. Click OK.
The color of the button changes and FreqX (X representing the line of the frequency) appears on the button. Also, the 
frequency is changed for the line.

NOTE: Additions and changes can be made to the Per Line Frequency Setup window at any time. However, if any 
user interface elements have been placed on the console window, the changes made to a line must also be 
changed on the individual elements, if needed.

GPS Read Button

The GPS Read button is used to query the current GPS coordinates of the selected radio. This functionality is currently 
supported on lines using MOTOTRBO signaling only.

To query a radio of its GPS coordinates, do the following:

1. From the GPS Read drop down list, select the unit you want to send this command.

2. Click GPS Read. 
The command is sent. 

To add a GPS Read button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select GPS Read.

5. Click OK.
The color of the button changes and GPS Read appears on the button.
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GPS Trigger Setup Page. The GPS trigger Setup page is used to select the settings for the GPS Trigger.

GPS Trigger Off Button

The GPS Trigger Off button is used to stop periodic GPS coordinate updates from the selected radio. The functionality is 
currently supported on lines using MOTOTRBO signaling only.

To stop receiving periodic GPS coordinates from a radio, do the following:

1. From the GPS Trigger Time drop down menu, select the unit you want to send the GPS Trigger Off command.

2. Click GPS Trigger Off. 
The command is sent. 

To add a GPS Trigger Off button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select GPS Trigger Off.

5. Click OK.
The color of the button changes and GPS Trigger Off appears on the button.

GPS Trigger On Button

The GPS Trigger On button is used to start periodic GPS coordinate updates from the selected radio. The functionality is 
currently supported on lines using MOTOTRBO signaling only.

To start receiving periodic GPS coordinates from a radio, do the following:

1. From the GPS Trigger Time drop down menu, select the unit you want to send the GPS Trigger On command.

2. Click GPS Trigger On. 
The command is sent. 

FIGURE 110. GPS Trigger Off Setup Page - UI Element Setup
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GPS Trigger Setup Page. When the GPS Trigger On Button function is selected from the UI Element drop down menu, the 
GPS Trigger Setup Page appears. See Figure 111.

GPS Trigger Time Drop Down Menu

The GPS Trigger Time drop down menu is used to select the time duration between GPS coordinate updates.

The time duration between GPS coordinate updates is determined by the GPS Trigger Time drop down menu.

Available options are:

30 Seconds

1 Minute

2 Minutes

4 Minutes

8 Minutes

To add a GPS Trigger On button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select GPS Trigger On.

5. Click OK.
The color of the button changes and GPS Trigger On appears on the button.

FIGURE 111. GPS Trigger Setup Page - UI Element Setup
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Group Programmed

The Group Programmed function allows the console operator to broadcast to a pre-defined group.

Line Group Page. When the Group Programmed function is selected from the UI Element drop down menu, the Line Group 
page appears. See Figure 112.

Select Lines for Group Field

The Select Lines for Group field contains a list of all the lines configured on “Per Line Parameters Window” on page 67. 
Selecting a line from this list assigns it to the group. Pressing the Group Programmed button in the C-Soft Runtime program 
places the defined lines into a select condition.

To add a group programmed button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Group Programmed.
The Line Group tab appears. 

5. Click the Line Group tab.
The Line Group page appears.

6. From the Select Lines for Group field, select the line(s) for the group.

7. Click OK.
The color of the button changes and Preset Group appears on the button.

NOTE: To remove a line from the Group Programmed, deselect the line.

FIGURE 112. Line Group Page—UI Element Setup
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Group Select 

The Group Select function creates a button used to create a group of users to call. 

IMPORTANT: Group Select Limited and Group Select buttons cannot co-exist on the same console.

To add a Group Select button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Group Select.

5. Click OK.
The color of the button changes and Group Select appears on the button.

When the button is selected in C-Soft Runtime, a group can be defined manually. 

To manually select a group of IDs to call, while in C-Soft Runtime, do the following:

1. In C-Soft Runtime, click the Group Select button.

2. Click the desired lines.
The lines are added to the group. 

3. Click the Group Select button a second time.
The group clears.
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Group Select Limited

The Group Select Limited function is similar to the Group Select function, except the number of lines the console operator 
can select is limited.

IMPORTANT: Group Select Limited and Group Select buttons cannot co-exist on the same console.

Group Select Limited Page. When the Group Select Limited function is selected from the UI element drop down menu, the 
Group Select Limited page appears. See Figure 113.

Max Number of Simultaneous Selected Lines Field

The Max Number of Simultaneous Selected Lines field identifies the number of lines a console operator can select for a 
group. 

The range for this field is 0 to 200 lines.

To add a group select limited button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Group Select Limited.
The Group Select Limited tab appears. 

5. Click the Group Select Limited tab.
The Group Select Limited page appears.

6. From the Select Lines for Group field, enter the maximum number of line(s) for the group.

7. Click OK.
The color of the button changes and Group Limited appears on the button.

FIGURE 113. Group Select Limited Page—UI Element Setup
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Input Indication

The Input Indication function allows the console operator to monitor an HB-3, ADHB-4, or NEO-10 input, as well as 
configure the parameters particular to an input source.

Input Indication Setup Page. When the Input Indication function is selected from the UI element drop down menu, the Input 
Indication Setup page appears. See Figure 114.

Input Source Group Box

The Input Source group box identifies the input source to be monitored. When either HB-3, ADHB-4, or NEO is selected, the 
fields necessary to enter the setup information for input sources are enabled.

HB-3 Radio Button

The HB-3 radio button indicates an HB-3 device is used as the input source.

ADHB-4 Radio Button

The ADHB-4 radio button indicates an ADHB-4 device is used as the input source.

NEO Radio Button

The NEO radio button indicates a NEO-10 is used as the input source.

FIGURE 114. Input Indication Setup Page—UI Element Setup
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Polarity Group Box

Active High Check Box

The Active High check box indicates the input is set to active high. If selected, the status button changes when the input goes 
to a positive (high) state.

Annunciation of Input Change Group Box

Beep for Check Box

The Beep for check box indicates a beep sound is played when there is a change in input. When the Beep for check box is 
selected, the Beep for seconds field becomes active. Otherwise, there is no beep sound when the input changes.

Beep for seconds Field

The Beep for seconds field is used to set the amount of time, in seconds, the indicator beeps after the input is changed. The 
Beep for radio button must be selected. 

The range for this field is 0 to 20 seconds.

Play Check Box

The Play check box indicates the .wav file configured for the selected annunciation button plays when the input changes. 

NOTE: When a system is configured with parallel consoles, only one (1) console should be configured to play a .wav file 
on input change. This prevents multiple consoles attempting to transmit the .wav file simultaneously.

Play Drop Down Menu

The Play drop down menu is used to select an annunciation button from a list that exist in the design file. The .wav file format 
is: X:text (where X represents the line number associated with the Annunciation button and text is the button name of the 
Annunciation button). When the input changes, the .wav file is played on the line the annunciation button is configured on.

NOTE: The Play check box must be selected to activate the play function.

Input Destination HB-3/ADHB-4 Group Box

The Input Destination radio buttons identify the HB-3 or ADHB-4 input destination. 

None Radio Button

The None radio button indicates there is no input indication assigned to the button or there is no HB-3 or ADHB-4 connected.

Input 1 Radio Button

The Input 1 radio button is used to configure the Input Indication button to signal the console operator if the first relay is 
currently in control of an HB-3 or an ADHB-4.
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Input 2 Radio Button

The Input 2 radio button is used to configure the Input Indication button to signal the console operator if the second relay is in 
control of an HB-3 or an ADHB-4.

NEO Settings Group Box

NEO Settings

The NEO Settings field identifies the IP Address and the input, if any, for the NEO-10.

IP Field 

The IP field identifies the IP Address of the NEO-10.

Input Drop Down Menu

The Input drop down menu identifies the input port for relays. 

Available selections for this field are None and Ports 1 through 10.

To configure and add an HB-3 or ADHB-4 Input Indications button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Input Indication.
The Input Indication Setup tab appears.

5. Click the Input Indication Setup tab.
The Input Indication Setup page appears.

6. From the Input Source and Polarity group box, select HB-3.
The Input Destinations group box is active.
OR
From the Input Source and Polarity group box, select ADHB-4.
The Input Destinations group box is active.

7. From the Input Destination area, select None, Input1, or Input2.

8. Select the Active High check box for active high inputs.

9. From the Annunciation of Input Change group box, select No Audio.
OR
Select Beep.

10. In the seconds field, enter number of seconds the beep is heard, if applicable.

11. From the Input drop down menu, select the desired input.

To configure and add a NEO Input Indications button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.
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3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Input Indication.
The Input Indication Setup tab appears.

5. Click the Input Indication Setup tab.
The Input Indication Setup page appears.

6. Select NEO.
The NEO Settings group box is active.

7. In the IP field, enter the IP Address of the NEO-10.

8. Select the Active High check box for active high inputs.

9. From the Annunciation of Input Change group box, select No Audio.
OR
Select Beep.

10. In the seconds field, enter number of seconds the beep is heard.

11. From the Input drop down menu, to select the desired input.

Instant Recall

The Instant Recall function allows the console operator to play back a predetermined amount of audio.

Multiple Instant Recall buttons can be placed on the console window with each button set to playback a certain amount of 
audio.

NOTE: The button must be held down for the complete duration of the recording time to hear all audio in buffer.

The C-Soft program function constantly maintains a record of the last 600 seconds (or 10 minutes) of both parallel transmit 
and receive audio. The recorder only records the audio when the call is active, allowing for a long conversation to be replayed 
without the loss of audio. 

Duration Page. When the Instant Recall function is selected on the UI Element Setup window, the Duration page appears. See 
Figure 115. 

Audio Playback Start Field

The Audio Playback Start field identifies the amount of time to record from the end of the call backwards. 

The field value can range from 0 to 600 seconds.

FIGURE 115. Duration Page—UI Element Setup
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Audio Source Drop Down Menu

The Audio Source drop down menu determines the source from which the audio is recorded.

Available selections for this field are:

Select

Unselect

Speaker 3 [ADHB-4] 

Speaker 4 [ADHB-4]

Speaker 5 [ADHB-4]

Speaker 6 [ADHB-4]

To configure and add an Instant Recall button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Instant Recall.
The Duration tab appears.

5. Click the Duration tab.
The Duration page appears.

6. In the Audio Playback Start field, enter the number of seconds you want to play back audio.

7. From the Audio Source drop down menu, select the audio source to play back.

8. Click OK.
The duration and audio source are configured. The color of the button changes and IRR Select 10 appears on the 
button.

FIGURE 116. Audio Source Drop Down Menu
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Intercom

The Intercom function allows communication between consoles without keying remote radios. The Intercom button works 
just like the PTT- Main button, except additional information is included in the transmission that prevents the generation of 
PTT and radio keying.

To add an Intercom button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Intercom.

5. Click OK.
The color of the button changes and Intercom appears on the button.

Intercom-Per Line

The Intercom-Per Line function allows console operators to communicate with each other without keying a radio connected 
to the line. This button is similar to the Intercom button, except it works only on the line selected in the Line to Associate 
Function With field, and it does not transmit on the selected line.

To add an Intercom-Per Line button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Intercom-Per Line.
The Line to Associate Function With drop down menu becomes active.

5. From the Line to Associate Function With drop down menu, select the line to associate the Intercom-Per Line 
function.

6. Click OK.
The color of the button changes and Intercom appears on the button.
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Knox Digit 

The Knox Digit function is used to assign a Knox tone to the button. These digits must be assigned to UI elements 
individually.

Available selections for this field are: 1, 2, 3, 4, 5, 6, 7, 8, 9, A, B, C, D, *, and #.

To create a Knox digit button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Knox Digit.
The Knox Digit tab appears.

5. Click the Knox Digit tab.

6. From the Know Digit drop down menu, select a digit.

7. Click OK.
The Knox Digit button is created.

Launch Application

The Launch Application function creates a button called Launch Application. 

In C-Soft Runtime, if the Launch Application button is clicked, the specified application, such as a messaging software is 
started. The maximum number of Launch Application buttons in a design is 64.

Launch Application Setup Page. When the Launch Application function is selected from the UI Element Setup window, the 
Launch Application Setup page appears. See Figure 117.

FIGURE 117. Launch Application Setup Page—UI Element Setup
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File Path Field

The File Path field displays the path to the application you want to launch. For example, 
F:\RadioDispatch\CSoftDesigner.exe. You can either find the file with the browse button or enter the path in the field.

Parameters Field

The Parameters field is used to specify command line arguments to the application being started. The parameters that can be 
entered are dependent on the application. 

EXAMPLES:

• If the application is Internet Explorer and www.Telex.com is entered in the Parameters field, the Telex 
webpage opens in Internet Explorer. 

• If the application file path is Notepad, and C:\Logs\notebook.txt is entered in the Parameters field, the 
notebook.txt file opens.

This field can contain up to 1024 characters.

Browse Button

The Browse button opens a Windows folder from which you can navigate to the application you want to start with the Launch 
Application button.

To create a launch application button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Launch Application.
The Launch Application Setup tab appears.

5. Click the Launch Application Setup tab.
The Launch Application Setup page appears.

6. Click the browse button.
A Windows folder appears.

7. Navigate to the application you want to start when the Launch Application button is clicked.

8. Click OK.
The UI Properties window closes.

Manual Call List

The Manual Call List function creates a button called Manual Call List. The Manual Call List window is used to place calls 
by manually entering the user ID number.

In C-Soft Runtime, if the Manual Call List button is clicked, the manual call list for the selected line appears. From this 
window, the user can manually send calls or status messages on the selected line based on programming set up in “Signaling 
Parameters Window” on page 78.
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To add a Manual Call List button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Manual Call List.

5. Click OK.
The color of the button changes and Manual Call List appears on the button.

Manual Call List Window

The Manual Call List window is used to manually send messages, alerts and statuses. The User ID is entered by the console 
operator. 

User ID Field

The User ID field is used to enter an ID number to call or send status to.

Graphic DTMF Keypad

The Graphic DTMF keypad is used to enter DTMF digits to place calls and send status messages.

FIGURE 118. Manual Call List Window—C-Soft Runtime Application
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Clear Button

The Clear button is used to clear all digits from the User ID field. 

Backspace Button

The Backspace button is used to backup one (1) space to clear the last digit entered. 

Set Status Button

The Set Status button is used to select from a list of preprogrammed status IDs. When a status ID is selected and the window 
is closed, the selected status appears in the Status field in the Status List window 

For more information, see “Status List Window” on page 210.

A–F Buttons

The A–F buttons are valid digits for 5/6 Tone. Each digit corresponds to a different tone frequency. 

Call (1–10) Buttons

The Call (1–10) buttons are used to place user-defined calls configured in the “5/6 Tone DTMF ANI Setup Page” on page 80. 
The labels configured on the 5/6 Tone/DTMF ANI Setup page appear on these buttons in the call list window.

To place a manual call, do the following:

1. Select a line to call from.

2. Select a Manual Call List button.
The Manual Call List window appears, see Figure 118.

3. Using the monitor keypad or your keyboard, enter a user ID number.
The number appears in the User ID field.

Done Button

The Done button is used to close the Manual Call List window.

Marker Tone

The Marker Tone function controls a periodic automatic keyup of a radio channel, along with an associated tone burst 
transmission for a particular line.

NOTE: If the Marker Tone function is selected, a line must be selected from the Line to Associate Function With drop 
down menu on the Type page.
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Marker Tone Setup Page. When the Marker Tone function is selected from the UI Element drop down menu, the Marker 
Tone Setup page appears. See Figure 119.

Tone Type Group Box

The Tone Type group box identifies the type of tone to play. When a selection is made, the fields necessary to enter the setup 
information for that tone type are enabled on the page. 

Tone Radio Button

The Tone radio button indicates a single steady tone is used as an alert tone.

To add a marker tone button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Marker Tone.
The Marker Tone Setup tab appears.

5. Click the Marker Tone tab.
The Marker Tone Setup page appears.

6. In the Tone Type group box, select the Tone radio button.

7. In the Low Frequency field, enter the Frequency (in Hz).

8. In the Tone Level field, enter the Tone Level (in dB).

9. In the Key-up Duration field, enter the duration (in ms).

10. In the Time Between Tones field, enter a time (in seconds).

11. Click OK.
The Marker Tone button is created.

FIGURE 119. Marker Tone Setup Page—UI Element Setup
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Pulsed Tone Radio Button

The Pulsed Tone radio button indicates a pulsed tone is used as an alert tone.

To add a pulsed marker tone button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Marker Tone.
The Alert Setup tab appears.

5. Click the Alert Setup tab.
The Marker Tone Setup page appears.

6. In the Tone Type group box, select the Pulsed Tone radio button.

7. In the Low Frequency field, enter the Frequency (in Hz).

8. In the Low/On Duration field enter the duration (in ms). 

9. In the Hi/Off Duration field, enter the duration (in ms).

10. In the Tone Level field, enter the Tone Level (in dB).

11. In the Keyup Duration field, enter the duration (in ms).

12. In the Time Between Tones field, enter a time (in seconds).

13. Click OK.
The Marker Tone button is created.

Hi-Lo Radio Button

The Hi-Lo radio button indicates a Hi-Lo warble is used as an alert tone.

To add a hi-lo marker tone button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Marker Tone.
The Marker Tone Setup tab appears.

5. Click the Marker Tone tab.
The Marker Tone Setup page appears.

6. In the Tone Type group box, select the Hi-Lo radio button.

7. In the Low Frequency field, enter the frequency (in Hz).

8. In the Low/On Duration field, enter a duration (in ms).

9. In the Hi Frequency field, enter a frequency (in Hz).

10. In the Hi/Off Duration field, enter the duration (in ms).

11. In the Tone Level field, enter the Tone Level (in dB).

12. In the Key-up Duration field, enter the duration (in ms).

13. In the Time Between Tones field, enter a time (in seconds).

14. Click OK.
The Marker Tone button is created.
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Low Frequency Field

The Low Frequency field identifies the frequency, in Hz, of the low tone sent when the button is pressed.

The range for this field is 0 to 3000Hz.

Low/On Duration Field

The Low/On Duration field identifies the duration, in ms, the low frequency is played.

The range for this field is 0 to 5000ms.

NOTE:

• If Tone is selected, this field is ignored because the tone is continuous. 

• If Pulsed Tone is selected, this field indicates the length of each tone duration. 

• If Hi-Lo is selected, this field indicates how long the low tone is played.

Hi Frequency Field

The Hi Frequency field identifies the frequency of the Hi tone sent when the button is pressed.

The range for this field is 0 to 3000Hz.

Hi/Off Duration Field

The Hi/Off Duration field identifies the duration the Hi frequency is turned off.

The range for this field is 0 to 5000ms.

Tone Level Field

The Tone Level field identifies the relative change for allowable tone level.

The range for this field is -40 to 10dB.

NOTE: If Tone is selected, this field is ignored because the tone is continuous. If Pulsed Tone is selected, this field 
indicates the length of each tone off period. If Hi-Lo is selected, this field indicates how long the high tone is 
played.

Keyup Duration Field

The Keyup Duration field identifies the duration of the tone.

The range for this field is 0 to 10,000ms.

Time Between Tones Field

The Time Between Tones field identifies the duration, between key-ups.

The range for this field is 0 to 32 seconds.
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MDC-1200

The MDC-1200 function, creates a button to open the MDC-1200 Dispatching window.

In C-Soft Runtime, when the window is open the user can view the system list, call and status history, status IDs, voice and 
data messages and select groups and individuals to place calls.

MDC-1200 Setup Page. When the MDC-1200 window function is selected from the UI Element drop down menu, the 
MDC-1200 Setup page appears.

Console Requests Group Box

Timeout sec Field

The Timeout sec field is used to configure the amount of time, in seconds, the console waits when sending status requests, 
radio checks, radio enable, and radio disable messages. If the radio is unable to respond, No Response, appears in the status bar 
of the dispatching window depending on the current state of the radio.

The range for this field is 1 to 10 sec.

Password Protection Group Box

Emergency Check Box

The Emergency check box indicates the console operator is prompted for the supervisor password before they are allowed to 
send an emergency message.

Radio Enable/Disable Check Box

The Radio Enable/Disable check box indicates the console operator is prompted for the supervisor password before they are 
allowed to enable or disable the radio.

FIGURE 120. MDC-1200 Setup Page—UI Element Setup
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Radio Remote Monitor Check Box

The Radio Remote Monitor check box indicates the console operator is prompted for the supervisor password before they are 
allowed to remotely monitor the radio.

Remote Monitor Group Box

Enable Global Multiplier Check Box

The Enable Global Multiplier check box indicates the values entered in the RX Multiplier and TX Multiplier fields are 
multiplied by two (2).

Remote Monitor Type Drop Down Menu

The Remote Monitor Type drop down menu is used to select a mode for radio transmission indications.

Available selections for this field are:

Non-Silent - Radio indicates transmission is occurring by flashing TX LED on the radio display when using radio remote 
monitor.

Silent - No transmit indication appears during transmission.

FIGURE 121. Remote Monitor Type Drop Down Menu
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RX Multiplier Drop Down Menu

The RX Multiplier drop down menu indicates the amount of time the radio receiving the remote monitor command is unable 
to receive calls after transmitting. The value is multiplied by the remote monitor time programmed in the radio to determine 
the total time.

Available selections for this field are: 0 to 3.

TX Multiplier Drop Down Menu

The TX Multiplier drop down menu is used to indicate how long the radio receiving the remote monitor command is allowed 
to transmit. The value is multiplied by the remote monitor time programmed in the radio to determine total transmit time. 

Available selections for this field are: 0 to 3.

FIGURE 122. Rx Multiplier Drop Down Menu

FIGURE 123. Tx Multiplier Drop Down Menu
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To add an MDC-1200 Window button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select MDC-1200 Window.
The MDC-1200 Setup tab appears.

5. Click the MDC-1200 Setup tab.
The MDC-1200 Setup page appears

6. From the Console Request group box, enter a time for the timeout. 

7. From the Password Protection group box, select the password protection radio button.

NOTE: For more information, see “Password Protection Group Box” on page 251.

8. From the Remote Monitor group box, configure a multiplier.

NOTE: For more information, see “Remote Monitor Group Box” on page 252. 

9. Click OK.
A button with MDC-1200 on it appears.
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MDC-1200 Dispatching Window

The MDC-1200 Dispatching window, shown in Figure 124, is used by the console operator in C-Soft Runtime to send and 
receive MDC-1200 messages. The status bar provides feedback about MDC-1200.

System Type Drop Down Menu

The System Type drop down menu is used to change from the currently selected system to another system in the console 
position. When a system is selected, the system list populates with filters and components contained in the system. 

Up to 200 systems can be created.

NOTE: The default system included in the drop down menu depends on the currently selected line’s configuration.

FIGURE 124. Selected Items Page—MDC-1200 Dispatching Window
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System List

The System List populates with system components that belong to the system currently selected in the System drop down 
menu. The system name is the first item to appear in the list. Filter components are listed next in the hierarchy. When a filter 
component is expanded individual units and groups are visible.

Systems can be configured, by the console admin, to display filters only. In that case, only components affiliated with a filter 
appear in the System List. Otherwise, all components, including components with deny icons (permission to place calls 
denied), appear in the list. See Figure 125.

Icon Type Description

Filter The Filter icon indicates the component is used to group, sort, and label the components 
contained in the filter.
To view or hide filters, do one (1) of the following:

• Click  to expand the filter list.

• Click  to collapse the filter list.

Deny The Deny icon indicates the tagged item does not allow the console operator to place a 
call or send messages to this component.

Allow The Allow icon indicates the component is available for selection. The console operator 
can place calls to these components.

FIGURE 125. MDC-1200 System Displays Only Filters Example
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System List Flyout Menu

The System List Flyout menu is used as a quick method of accessing the Select Type commands that are also available with 
the MDC Message buttons. 

Available selections for this field are: 

Call Alert

Radio Check

Request Status

Select Call

Radio Status

Remote Monitor

Emergency

To access the System List flyout menu, do the following:

 > In the system list, right-click the system, individual or group to send the call or message to.
The System List flyout menu appears.

Selected Items Page

The Selected Items page is used to view the currently selected component’s ID information. The selected item list is used to 
determine where a call or status message is sent to. The operator can select one (1) component per system in the list. Up to 200 
messages can be sent simultaneously as long as they are each sent to a different system. When a system component in the 
system list is selected it is added to the selected items page.

NOTE: Grayed out icons with deny tags are not available for selection.

To add a component’s ID to the Selected Items page, do the following:

1. In the System List field, select the component.
The component is highlighted.

2. From the drop down menu, click the Add to Selected button
The item appears in the list.

NOTE: See “Manual Select Group Box” on page 224 to learn how to manually enter an ID.
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To remove an ID from the Selected Items page, do the following:

1. Right-click the unwanted component.
A flyout menu appears.

2. Click Remove Item.
The item disappears from the list.

Manual Select Group Box

The Manual Select group box is used to communicate with system users not in the system list.

User ID Field

The User ID field is used to enter an MDC ID (in hexadecimal format) for selection to add to the list.

Add to Selected Button

The Add to Selected button is used to add the MDC ID entered in the User ID field to the selected items list.

To manually place an individual radio ID in the selected items list, do the following:

 > In the User ID field, enter an ID from 001–DFFF.
The ID appears in the Selected Items list.

To manually place a group ID in the selected items list, do the following:

 > In the User ID field, enter an ID from 000–FFF.
The ID appears in the Selected Items list.

To manually place a system ID in the selected items list, do the following:

 > In the User ID field, enter FFFF.
The ID appears in the Selected Items list.

NOTE: The character F behaves like a wildcard.
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MDC Message Buttons

The MDC Message button, located at the bottom of the MDC-1200 Dispatching window, is used to send calls, alerts, statuses, 
and messages. When a button is clicked, the status bar confirms activity.

MDC offers ANI capabilities on PTT. When transmitting on a line, C-Soft sends the console’s ID to the radio. A PTT call 
displays in the history pages as a Voice message type. The ID alias or ID appear on the line’s Select button.

Call Alert Button

The Call Alert button is used to send an alert message.

To send a call alert, do the following:

1. From the system list, select the unit ID to send the alert message to.
OR
From the system list, select the group to send the alert message to
The highlighted item is added to the selected items list.

2. Click Call Alert.
An alert is sent to the selected user(s) MDC-1200 radio.

Radio Check Button

The Radio Check button indicates a message is sent to check for radio activity.

To send a radio check message to an MDC-1200 radio, do the following:

1. In the system list, select a unit ID to send the radio check message to.
The highlighted item is added to the selected items list.

2. Click Radio Check.

• If the selected radio is able to respond, Acknowledge appears on the line’s select button, the Per Line Call 
History window, and in the item list on the History page. 

• If the radio is unable to respond within the configured time allowed. No Response appears on the line’s 
select button, the Per Line Call History window and the list on the History page.

Status Request Button

The Status Request button is used to request status from a unit in the system.

To request a status from a unit, do the following:

1. In the system list, select a unit ID to send the alert message to.
The highlight item is added to the selected items list.

2. Click Status Request.

• If the selected radio is able to respond, the (status message) appears on the line’s select button, the Per Line 
Call History window, and in the item list on the History page. 

• If the radio is unable to respond within the configured time allowed, No Response appears on the line’s 
select button, the Per Line Call History window and the list on the History page.
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Select Call Button

The Select Call button is used to place a select call.

To place an MDC-1200 select call, do the following:

1. In the system list, select a unit ID to place the select call to.
The highlighted item is added to the selected items list.
OR
In the system list, select a group to place the select call to.
The highlighted item is added to the selected items list.

2. Click Select Call.
The select call message is sent and the receiving radio is able to perform select call action.

Radio Disable Button

The Radio Disable button is used to disable a radio in the field from use by unauthorized persons. 

To disable a radio, do the following:

1. In the system list, select a unit you want to disable from use.
The highlighted item is added to the selected items list.

2. Click Radio Disable.
The disable radio message is sent and the radio no longer functions. 

NOTE:

• If the selected radio is able to respond, Acknowledge appears on the line’s select button, History 
window, and in the item list on the History page.

• If the radio is unable to respond within the configured time allowed, No Response appears on the select 
button, the Per Line Call History window, and the list on the History page. 

Radio Enable Button

The Radio Enable button is used to enable a radio that has been disabled.

To enable a radio, do the following:

1. In the system list, select a unit you want to enable for use.
The highlighted item is added to the selected items list.

2. Click Radio Enable.
The microphone on the selected unit is open for monitoring. 

NOTE:

• If the selected radio is able to respond, Acknowledge appears on the line’s select button, History 
window, and in the item list on the History page.

• If the radio is unable to respond within the configured time allowed, No Response appears on the select 
button, the Per Line Call History window, and the list on the History page. 
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Remote Monitor Button

The Remote Monitor button is used to remotely keyup a microphone for monitoring purposes.

To monitor a unit, do the following:

1. In the system list, select a unit ID you want to monitor remotely.
The highlighted item is added to the selected items list.

2. Click Remote Monitor.
The microphone on the selected unit is open for monitoring.

Emergency Button

The Emergency button is used to send an emergency alert.

To send an emergency call, do the following:

1. In the system list, select the unit ID to send the emergency alert to.
The highlighted item is added to the selected items list.
OR
In the system list, select the group to send the emergency alert to.
The highlighted item is added to the selected items list.

2. Click Emergency.
The emergency alert is sent and the receiving unit performs emergency actions.

NOTE: For received emergency alerts, see “Emergency Type” on page 263.
Bosch Security Systems, Inc. Administrator’s Guide F.01U.218.561 Rev 03



262  C-Soft Designer Program C-Soft Administrator’s Guide
History Page. The History page is used to view a log of received messages. Calls received from parallel consoles are 
included in the log. The history page is also used to place calls. Status, group and call color coding is supported. Click and drag 
column headings to rearrange column order. Messages can be sent to an ID in the history list. Items in the history list can not 
be removed. When 
C-Soft Runtime is closed all call history is cleared.

For more information, see “Per Line Call History Window Lines Field” on page 128. 

NOTE:

• Received messages also appear on the line’s select button while receiving a call and in the Per Line Call 
History window, see “Per Line Call History Window” on page 292. 

• MDC-1200 call history can also be found on the Per Line Call History window.

To place a select call from the History page, do the following:

1. From the history log, select a unit ID entry in the history log.
The user ID is added to the list on the Selected Items page.
OR
From the history log, click a group calling ID.
The calling ID is added to the list on the Selected Items page.
OR
From the history log, click a system calling ID.
The calling ID is added to the list on the Selected Items page.

2. Click the Selected Items tab.
The Selected Items page appears.

3. Select the ID you want to place a call to.
The ID is highlighted.

4. Click Select Call.
The call is sent.

NOTE: For more calling options, see “Selected Items Page” on page 257

FIGURE 126. History Page—MDC Dispatching Window
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Date Column

The Date column displays the date the message was received.

Time Column

The Time column displays the time the message was received.

Channel Column

The Channel column displays the frequency the message was sent on.

Call Type Column

The Call Type column displays the type of message received.

There are seven (7) call type possibilities:

Call Alert Type

Call Alert indicates an alert message is being received from an MDC-1200 radio. When a call alert message is received, all 
alerts and the caller’s alias or ID appears on the receiving line’s button. If annunciations are configured, they are played when 
an alert is received. See “Annunciation of Call Alert Group Box” on page 312.

Emergency Type

Emergency indicates an emergency message was received from an MDC-1200 radio. When a emergency message is received, 
the button blinks red, an emergency alert tone is heard, and the ANI or ID appear on the select button and the Active 
Emergency window.

To clear the emergency, do the following:

 > Click Clear.
The alert tone stops and the color of the entry in the emergency window changes from red to orange.

To acknowledge the emergency, do the following:

 > Click ACK.
The alert tone stops (if an alert tone is still heard), the select button stops blinking, the emergency is removed from the 
Active Emergency list and an acknowledgement message is sent from the IP-223 or IP-224 to the radio that declared 
the emergency.

FIGURE 127. Active Emergency Window
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Group Call Type

Group Call indicates a group call received from an MDC-1200 radio. When a group call is received, the group call initiator’s 
ANI or ID appear on the receiving line’s select button. If annunciations are configured, they are heard when a group call is 
received. See “Annunciation of Select Call Group Box” on page 310.

Sel (Select) Call Type

Sel (Select) Call indicates a select call received from an MDC-1200 radio. When an individual call is received, the caller’s 
ANI or ID appears on the receiving line’s select button. If annunciations are configured, they are heard when a select call is 
received. See “Annunciation of Select Call Group Box” on page 310.

Status Type

Status indicates a status message was received from an MDC-1200 radio. When a status message is selected, the alias or ID 
appears in the Calling ID field and a status message appears in the Status message field.

Txt msg Type 

Txt msg (Text Message) indicates a text message was received from an MDC-1200 radio. When a text message is selected, 
the alias or ID appear in the Calling ID field and the text message appears in the Test Message field.

Voice Type

Voice indicates a voice message received from an MDC-1200 radio. If available, the ANI displays on the receiving line’s 
select button, otherwise the ID appears.

Call Details Group Box

The Call Details group box gives information about a selected item in the history list.

Calling ID

The Calling ID is the alias or ID number of the MDC-1200 radio that sent the selected message.

Status Message Field

The Status Message field is used to display the status message received by the selected message.

NOTE: If a text message appears in the field, the label changes to Text Message.

Text Message Field

The Text Message field is used to display the text message received by the selected message. 

NOTE: If a status message appears in the field, the label changes to Status Message.
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Call History View Group Box

All Lines Radio Button

The All Lines radio button indicates the history list displays all messages received on all lines.

Selected Line Radio Button

The Selected Line radio button indicates the history list displays messages received on selected lines in the system.

Monitor

The Monitor function allows the console operator to send a packet burst, similar to a frequency change, to a remote radio, 
instructing the radio to open squelch or ignore CTCSS tones.

To add a monitor button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Monitor.

5. Click OK.
The button changes color and MON appears on the button.

FIGURE 128. Monitor—UI Element Setup
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MOTOTRBO Radio Setup Page

When the MOTOTRBO function is selected from the UI Element drop down menu, the MOTOTRBO Radio Setup window 
appears. 

NOTE: Each line controlling a MTRBi (MOTOTRBO) requires its own window.

The MOTOTRBO Radio Setup page, shown in Figure 129, is used for setting Dispatch Window features and entering time 
intervals to check for the Master Console.

MOTOTRBO Dispatch Window Setup Group Box

Enable MOTOTRBO Dispatch Window Check Box

The Enable MOTOTRBO Dispatch Window check box, if selected, allows the user to open the Dispatch Window in 
Runtime. If not selected, the user is not able to open the Dispatch Window in Runtime. 

Dispatch Window Config Button

The Dispatch Window Config button is used to open the Dispatch Window settings. The button text and color of the Dispatch 
Window can be updated in this view.

For more information on Dispatch Window Config button, see Figure 130.

MOTOTRBO Radio List Font Size Field

The MOTOTRBO Radio List Font Size field is used to enter the font size of the ID List. 

The range for this field is 1 to 99.

FIGURE 129. MOTOTRBO Radio Setup Page Example
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MOTOTRBO Timing Group Box

Master Heartbeat Send Time Field

The Master Heartbeat Send Time field is used to enter an interval for the master console to send its heartbeat out to all other 
consoles on the control line (i.e., 1).

The range for this field is 1 to 999 seconds.
The default is 1.

MTRBi Check Send Time Field

The MTRBi Check Send Time field is used to enter an interval for C-Soft to verify the MTRBi on a certain line is alive (i.e., 
4). 

NOTE: Allow one (1) second for the check function to complete.

EXAMPLE: If this field is set to four (4) seconds, the console sends an MTRBi check command then waits for four 
(4) minus one (1) second, or three (3) seconds for a response.

The range for this field is 2 to 999 seconds.
The default is 4.

Slave Check Time Field

The Slave Check Time field is used to enter an interval for the console to wait to receive a heartbeat from the master before it 
changes into the master. (i.e., 4)

EXAMPLE: At startup, the console waits four (4) seconds for a heartbeat, if nothing is received, the console changes 
to the master console. If a heartbeat is detected, the console remains a slave and resets to four (4) 
seconds.

The range for this field is 3 to 999 seconds.
The default is 4.

Master Resend Command Time Field

The Master Resend Command Time field is used to enter an interval for C-Soft to resend a MOTOTRBO command (i.e., 1).

EXAMPLE: If C-Soft sends a MOTOTRBO command and does not get a response in one (1) second, it sends the 
command again, waits one (1) second, if nothing sends again, waits one (1) second. If no response is 
received after three (3) tries the command is cleared and goes to the next command to send to the buffer. 
The maximum tries is three (3).

The range for this field is 1 to 999 seconds.
The default is 1.
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Password Protection Group Box

The Password Protection group box enables the user to set up functions that require a user password before allowing the user 
access. 

If not selected, no password is required.

Radio Monitor Check Box

The Radio Monitor check box indicates the user must enter a password to use these functions.

Radio Inhibit/Uninhibit Check Box

The Radio Inhibit/Uninhibit check box indicates the user must enter a password to use the function.

Call Alert Check Box

The Call Alert check box indicates the user must enter a password to use the function.

MOTOTRBO Tones Group Box

Talk Permit Tones Check Box

The Talk Permit Tones check box, if selected, enables the user to hear go ahead Tones when PTT is pressed in Runtime. 

To permanently save changes, do the following:

1. Click OK.

2. Select File/Save from the menu bar.
The Save As window appears.

3. In the File Name field, enter the name for the file.

4. Click OK.
The C-Soft file is saved.
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Dispatch Window

The Dispatch Window, shown in Figure 130, is used to select the color, font and font size of the Dispatch Window settings.

Dispatch Window Color Drop Down Menu

The Dispatch Window Color drop down menu is used to select the color of the Dispatch Window.

To select the color of the Dispatch Window, do the following:

 > From the Dispatch Window Color drop down menu, select the desired color for the dispatch window.

Set Font Button

The Set Font button opens the Font window.

To set the font of the Dispatch Window do the following:

 > From the Font window, select the desired font for your text.

FIGURE 130. Dispatch Window Example

FIGURE 131. Dispatch Window Font Drop Down Menu
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Main Control Page

The Main Control page, shown in Figure 130, is used to change the color, font type, and font size for the following buttons.

• InPTT

• Private Call

• Group Call

• Mute

• Select

• Numerical Pad

• Delete

Button Color Up Drop Down Menu

The Button Color Up drop down menu is used to select the color of the button as it is released.

Button Color Down Drop Down Menu

The Button Color Down drop down menu is used to select the color of the button as it is pressed.

Button Text Color Drop Down Menu

The Button Text Color drop down menu is used to select a color for the button text.

Enable Button Check Box

The Enable Button check box is used to enable the button settings.

Button Text Field

The Button Text field is used to add text to the button.

OK Button
The OK button is used to accept the changes to the button.

Cancel Button

The Cancel Button is used to cancel the changes to the button.

FIGURE 132. Select Color and Text 
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To select color and text of the desired button, do the following: 

1. From the Main Control menu, press the desired button.
Select Color and Text appears.

2. From the Button Color Up drop down menu, select the desired color.

3. From the Button Color Down drop down menu, select the desired color.

4. From the Button Text Color drop down menu, select the desired color.

5. Select the Enable Button check box to enable the selected color and text of the button.

6. In the Button Text field, enter the desired text for the button.

7. Click OK.
The entries are saved.

Unit Control Page

The Unit Control page, shown in Figure 133 is used to change the color, font type, and font size for the following buttons:

Radio Check Button

The Radio Check button is used to select the color of the button and text of the Radio Check button.

Remote Monitor Button

The Remote Monitor button is used to select the color of the button and text of the Remote Monitor button.

Call Alert Button

The Call Alert button is used to select the color of the button and text of the Call Alert button.

Radio Disable Button

The Radio Disable button is used to select the color of the button and text of the Radio Disable button.

Radio Enable Button

The Radio Enable button is used to select color of the button and text of the Radio Enable button.

Open Google Earth Button

The Open Google Earth button is used to select the color of the button and text of the Open Google Earth button.

FIGURE 133. Unit Control Page Example
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GPS Trigger On Button

The GPS Trigger On button is used to select the color of the button and text of the GPS Trigger On button.

GPS Read Button

The GPS Read button is used to select the color of the button and text of the GPS Read button.

GPS Trigger Off Button

The GPS Trigger Off button is used to select color of the button and text of the GPS Trigger Off button.

Keypad

The Keypad buttons are used to select color of the button and text of the Keypad buttons.

To select color and text of the desired button, do the following:

1. From the Unit Control window, select the desired button.
Select Color and Text appears.

2.  From the Button Color Up drop down menu, select the desired color.

3.  From the Button Color Down drop down menu, select the desired color.

4.  From the Button Text Color drop down menu, select the desired color.

5.  Select the Enable Button check box to enable the selected color and text of the button.

6. In the Button Text field, enter the desired text for the button.

7. Click OK.
The entries are saved.

Text Message Page

The Text Message page, shown in Figure 134, is used to select the color of the button and text of the text message.

FIGURE 134. Text Message Page Example
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Clear History Button

The Clear History button is used to select the color of the button and text of the Clear History button.

Send Unit Text Button

The Send Unit Text button is used to select the color of the button and text of the Send Unit Text button.

Send Group Text Button

The Send Group Text button is used to select color of the button and text of the Send Group Text button.

To select color and text of the desired button, do the following:

1.  From the Text Message menu, press the desired button.
Select Color and Text appears.

2.  From the Button Color Up drop down menu, select the desired color.

3.  From the Button Color Down drop down menu, select the desired color.

4.  From the Button Text Color drop down menu, select the desired color.

5.  Select the Enable check box to enable the selected color and text of the button.

6.  In the Button Text field, enter the desired text for the button.

7. Click OK.
The entries are saved.

History Page

The History Message page, shown in Figure 135, is used to change the color, font type, and font size for the following 
buttons:

Emergency ACK Button

The Emergency ACK button is used to select the color of the button and text of the Emergency ACK button.

FIGURE 135. History Message Page Example
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Alert Cancel Button

The Alert Cancel button is used to select the color of the button and text of the Alert Cancel button.

Private Call Button

The Private Call button is used to select the color of the button and text of the Private Call button.

To select color and text of the desired button, do the following:

1. From the History menu press the desired button.
Select Color and Text appears.

2. From the Button Color Up drop down menu, select the desired color.

3. From the Button Color Down drop down menu, select the desired color.

4. From the Button Text Color drop down menu, select the desired color.

5. Select the Enable Button check box to enable the selected color and text of the button.

6.  In the Button Text field, enter the desired text for the button.

7. Click OK.
The entries are saved.

MOTOTRBO Dispatching Window

The MOTOTRBO Dispatching window, shown in Figure 136, is used by the console operator in C-Soft Runtime to manage 
a MOTOTRBO line’s call history, channel changes, sent text messages and alerts, read GPS coordinates and read remote radio 
positions. Volume adjustments, radio checks, and radio enable/disable are also conducted from this window.

During operation, all parallel consoles on the same network synchronize to each other. Consoles on the same network display 
the same channel and zone, received ID, alias, history and notifications.

NOTE: Each line controlling a MTRBi (MOTOTRBO) requires its own window.

To add a MOTOTRBO button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button. 
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears:

4. From the UI Element drop down menu, select MOTOTRBO.
The MOTOTRBO Radio Setup page appears.

5. In the Master Heartbeat Sent time field, enter a time interval to send a heartbeat. 

6. In the MTRBi Check Send Time field, enter a time interval to check MTRBi status.

7. In the Slave Check Time field, enter the amount of time C-Soft waits before changing to the master console.

8. In the Master Resend Command Time field, enter the amount of time C-Soft waits before resending a command. 

9. From the MOTOTRBO drop down menu, select a background color for the window. 

10. Click OK. 
The MOTOTRBO button is added to the console. 
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MOTOTRBO Window

The MOTOTRBO window displays the most frequently used MOTOTRBO fields. 

NOTE: The drop down menu selections are set up in C-Soft Designer and the MOTOTRBO radio programming 
software. The console must be restarted if admin changes to these lists occur while the console is open.

Channel Drop Down Menu

The Channel drop down menu is used to change the channel of the selected line. If a parallel console or the radio changes the 
channel, this field updates with the current channel information.

Available selections for this field are configured in the radio.

Zone Drop Down Menu

The Zone drop down menu is used to change the zone of the selected line. If a parallel console or the radio changes the zone, 
this field updates with the current zone information.

Available selections for this field are configured in the radio.

Volume Slider

The Volume Slider is used to increase or decrease the volume to the speaker or handset currently connected. The volume 
indicator gives a graphical representation of the total volume.

NOTE: MOTOTRBO is compatible with the ADHB-4 which can also be used to adjust volume. 

Trbo Ptt Button

The Trbo Ptt button is used the same as a normal key up of a mobile radio.

Private Call Button

The Private Call button is used to select what is entered in the ID field for a private call.

FIGURE 136. MOTOTRBO Dispatching Window
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Group Call Button

The Group Call button is used to select what is entered in the ID field for a group call.

Mute Button

The Mute button is used to mute or amplify the selected line’s volume. If the console speaker is muted, the universal no 
symbol appears on the speaker icon.

Select Button

The Select button is used to select or deselect the group ID.

Status Information Field

The Status Information field displays all incoming and outgoing MOTOTRBO radio status information.

MTRBi Connection Indicator

The MTRBi Connection Indicator indicates the status of one (1) currently selected MTRBi line. If green, the unit is online 
and functional. If red, the unit is offline or disconnected. 

NOTE: If no lines are selected, the indicator is red.

Groups Radio Button

The Group radio button is used to activate the Groups field and display the group navigation tree.

Groups Field

The Groups field is used to manually enter the group ID number you want to send a control to.

History Page. The History page appears when MOTOTRBO window is maximized. The History page is global for all 
MOTOTRBO lines. All MOTOTRBO active and previous calls appear in the list. Each call’s radio name, radio ID, date, time, 
call type, and the call’s current state appear.

NOTE: When C-Soft Runtime is closed, this list is cleared.

Date Column

The Date column displays the date the call was received.

Time Column

The Time column displays the time the call was received.

Freq Column

The Freq column displays the frequency the call came from.

Status Column

The Status column displays the current status of the call.

Available options for this field are Mobile PTT, In Progress, Call RX., GPS Position, On, Off, Passed and Failed. 
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User ID Column

The User ID column displays the caller’s user ID.

Call Type Column

The Call Type column displays the type of call. 

Available options for this field are Private, Group, Alert, Enable, Disable, Check, Scan, Monitor and GPS Read.

Control Buttons Page. When the Control Buttons tab is clicked from the maximized MOTOTRBO window, the Control 
Buttons page appears. The Control Buttons page is used to access MOTOTRBO functions. When a radio is selected from the 
navigation bar, a button can be clicked to perform an action.

Radio Check Button

The Radio Check button is used to verify if the radio is currently online and functional. 

Radio Disable Button

The Radio Disable button is used to disable a radio from use. This feature can be used in the case of a lost or stolen radio. 

Radio Enable Button

The Radio Enable button is used to enable the radio for use. This feature is used to enable a radio if it has been disabled with 
the Radio Disable button.

Remote Monitor Button

The Remote Monitor button is used to monitor the selected remote radio.

Call Alert Button

The Call Alert button is used to send an alert to the selected remote radio. 

Open Google Earth Button

The Open Google Earth button is used on computers with Google Earth installed, it is used to view the current MOTOTRBO 
radio locations.

NOTE: The radio IDs must first be configured in the User ID list.

GPS Read Button

The GPS button is used to request a read of the selected radio’s current location and navigate to the radio’s location on Google 
Earth.

Range Field

The Range field is used to enter the GPS camera’s distance, in feet, that Google Earth reads the earth’s image from. Each time 
the GPS button is clicked, the camera adjusts to the distance entered in this field.

The range for this field is 1 to 99999.
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GPS Trigger On Button

The GPS Trigger On button is used to enable the GPS to send status at a regular interval to the console. The interval is 
determined by the value entered in the GPS Trigger On field.

GPS Trigger Off Button

The GPS Trigger Off button is used to disable the radio from sending GPS status to the console.

GPS Trigger On Field

The GPS Trigger On field is used to configure the interval with which the selected radio sends a GPS location to the console.

The range for this field is 1 to 255 sec.

Text Message Page. When the Test Message tab is clicked the Text Message page appears. See Figure 134.

The Text Message page is used to send text messages to the selected individual or a group of radios and to view text messages 
sent during the current C-Soft Runtime session.

Radio Name Column

The Radio Name column displays the name assigned to the radio the text message was sent to.

Time Column

The Time column displays the time the text message was sent.

Text Message Column

The Text Message column displays the text message sent to the radio.

Quick Text Drop Down Menu

The Quick Text drop down menu is used to select a text ID number assigned to a preprogrammed text message. When a text 
ID is selected, its message appears in the Text field.

Text Field

The Text field displays a preview of the text message to be sent when Send Text is clicked. A text message can be entered 
using the Quick Text drop down menu or it can be entered manually.

This field can contain up to 100 characters.

To send a quick text message, do the following:

1. From the Quick Text drop down menu, select a text message ID.
The selected message appears in the Text field,

2. From the Select Radio or Group pane, select an individual to send the text message to.
OR 
From the Select Radio or Group pane, select a group to the text message to.

3. Click Send Text.
The text message is sent to the selected user.

Send Text Button

The Send Text button is used to send the message in the Text field to the selected radio. When clicked, the message is sent to 
the radio.
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To send a text message, do the following:

1. In the Text field, enter a text message to send.
OR
From the Quick Text drop down menu, select a Text ID.

2. From the Select Radio or Group pane, select an individual to send the text message to.
OR 
From the Select Radio or Group, select a user or group to the text message to.

3. Click Send Text.
The text message is sent to the selected user or group.

Clear History Button

The Clear History button is used to clear all text messages in the list.

To clear text message history, do the following:

 > Click Clear History.
The text message history list is deleted. 

Mute Group

The Mute Group function allows the console operator to mute the audio on a pre-defined group of lines. 

Line Group Page. When the Mute Group function is selected from the UI Element drop down menu, the Line Group page 
appears. See Figure 137.

The Line Group page is used to select the lines that belong to a specific Mute Group.

FIGURE 137. Line Group Page—UI Element Setup
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Select Lines for Group Field

The Select Lines for Group field contains a list of all the lines configured on the “Per Line Parameters Window” on page 67. 
Selecting a line from this list, assigns the line to the group. 

NOTE: Click the Group Programmed button in the C-Soft Runtime program to place the lines defined on the Line Group 
page into a select condition.

To add a Mute Group button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Mute Group.
The Line Group tab appears.

5. Click the Line Group tab.
The Line Group page appears.

6. From the Select Line for Group field, select the line(s) you want to add to the group.

7. Click OK.
The selected lines are assigned to the group. The button color changes and Mute Group appears on the button.

NOTE: Deselect the highlighted line, to remove a line from the Group Programmed.

Mute Main

The Mute Main function allows the console operator to mute all lines not currently selected.

NOTE: Selected lines can also be muted when the Allow Muting Selected Lines option is selected on the Global 
Parameters page. See “Global Parameter Setup Window” on page 108.

To add a Mute Main button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Mute Main.

5. Click OK.
The button changes color and Mute appears on the button.

Mute-Per Line

The Mute-Per Line function allows the console operator to mute a particular line. It is a toggle button that is active when 
clicked and inactive when released.

Mute Icon

A Mute icon, shown in Figure 138, appears on a line’s Select button, a group select button, a phone onhook/offhook button, a 
SIP button or a NENA indication anytime the line is muted, RX blocked, or group muted. 
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This icon can be customized by creating a graphic file named muteled.bmp. This file must be located in the same directory as 
the csoftruntime.exe file.  

Per Line Mute Button Setup Page. When the Mute - Per Line function is selected from the UI Element drop down menu, as 
shown in Figure 139, the Per Line Mute Button Setup page appears.

The Per Line Mute Button setup tab is used to set the Mute Time and Minimum Mute Level.

Mute Time Field

The Mute Time field identifies the duration audio is muted before the audio is automatically restored. A value of zero (0) 
disables this feature.

The range for this field is 0 to 180 seconds.

Min Mute Level Field

The Min Mute Level field identifies the level the unselected audio level is reduced at the speaker. Enter a value from 
-20 to -1dB to reduce the level on the muted line accordingly without completely muting the line. This ensures the console 
operator is unable to completely turn off audio being monitored. A value of zero (0) completely mutes the line.

The range for this field is -20 to -1dB. 

NOTE: Selected lines can also be muted when the Allow Muting Selected Lines option is selected on the Global 
Parameters page. See “Global Parameter Setup Window” on page 108.

FIGURE 138. Mute Icon—Select Button

FIGURE 139. Per Line Mute Button Setup Page—UI Element Setup
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To add a Mute-Per Line button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Mute - Per Line.
The Line to Associate Function With drop down menu becomes active. The Per Line Mute Button Setup tab appears.

5. From the Line to Associate Function With drop down menu, select the line you want to associate with the Mute - Per 
Line function.

6. Click the Per Line Mute Button Setup tab.
The Per Line Mute Button Setup page appears.

7. In the Mute Time field, enter the amount of time the line is muted before audio is automatically restored.

8. In the Min Mute Level field, enter the audio level for the unselected line.

9. Click OK.
The button changes color and Mute appears on the button.

NENA-Hold

The NENA-Hold function allows the console operator to place a NENA (National Emergency Number Association) phone 
line connected to an ADHB-4, on hold. If the NENA is on hold, the TX audio is not sent to the NENA and RX audio is routed 
to a specified speaker. Otherwise the TX and RX are sent from the NENA.

To add a NENA-Hold button, do the following:

1. From the insert menu, select Add UI button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select NENA-Hold.

5. Click OK.
The button changes color and Hold appears on the button.
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NENA-Hook Control

The NENA-Hook Control function allows the console operator to place a NENA phone line that is connected to an ADHB-4, 
on or off hook.

To add NENA-Hook Control button, do the following:

1. From the Insert menu, select Add UI Button,
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select NENA-Hook Control

Click OK.
The button changes color and NENA-Hook Control appears on the button

NENA-Indication

The NENA-Indication function indicates the current on- or offhook state of a NENA connected to an ADHB-4. A speaker 
icon appears on the button to indicate audio routing for the NENA. 

NOTE: A Mute-Per Line button can be associated with a NENA Indication button to mute the NENA line’s mic.   The 
mute icon appears when the NENA line is muted, RX blocked, or when a Mute-Main button is selected. See 
“Mute-Per Line” on page 280.

To add NENA-Indication button, do the following:

1. From the Insert menu, select Add UI Button,
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select NENA-Indication.

5. Click OK.
The button changes color and NENA On Hook appears on the button.
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NENA-Mute

The NENA-Mute function allows the console operator to mute a NENA phone line.

To add a NENA-Mute button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select NENA-Mute.

5. Click OK.
The button changes color and NENA Mute appears on the button.

P25-DFSI Window

The P25-DFSI Window allows the console operator to open the P25-DFSI Dispatching Window.

P25-DFSI Misc Page. When the P25-DFSI function is selected from the UI Element drop down menu, the P25-DFSI Misc 
page appears. See Figure 140.

FIGURE 140. P25-DFSI Misc - UI Element Setup
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Misc Group Box

Enable P25-DFSI Dispatch Window Check Box

The Enabled P25-DFSI Dispatch Window check box allows the user to open the Dispatch Window in Runtime. If not 
selected, the user is not able to open the Dispatch Window in Runtime.

Receive All Talk Groups Check Box

The Receive All Talk Groups check box, allows all incoming Talk Groups to be heard. If not selected, only incoming calls 
with Talk Groups matching the current Talk Group will be heard, all others are muted.

Receive All Private Calls Check Box            

The Receive All Private Calls check box allows all incoming Private Calls to be heard. If not selected, only incoming Private 
Calls sent directly to the console will be heard, all others will be muted.                                    

P25-DFSI Radio List Font Size Field

The P25-DFSI Radio List Font Size field is used to select a font size for the P25-DFSI Radio List.

The range for this field is 0 to 99.
Default is 12.

Dispatch Window Config Button

The Dispatch Window Config button is used to open the Dispatch Window settings. The button text and color of the Dispatch 
Window can be updated in this view.

Password Protection Group Box

The Password Protection group box enables the user to set up functions that require a user password before allowing the user 
access. If not selected, no password is required.

Radio Monitor Check Box

The Radio Monitor check box, if enabled, indicates the Radio Monitor function is password protected.

For more information, see “Global Parameter Setup Window” on page 108.

Radio Inhibit/Uninhibit Check Box

The Radio Inhibit/Uninhibit check box, if enabled, indicates the Radio Inhibit/Uninhibit function is password protected.

For more information, see “Global Parameter Setup Window” on page 108.

Call Alert Check Box

The Call Alert check box, if enabled indicates the Call Alert function is password protected.

For more information, see “Global Parameter Setup Window” on page 108.
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Vote Select/Disable Check Box

The Vote Select/Disable check box, if enabled, indicates the Vote Select/Disable function is password protected.

For more information, see “Global Parameter Setup Window” on page 108.

OK Button

The OK button saves the entries and closes the window.

Page

The Page function allows the console operator to send a single page to a specific line on a specific frequency.

Page Setup Page. When the Page function is selected from the UI Element drop down menu, the Page Setup page appears. 
See Figure 141.

Format Drop Down Menu

The Format drop down menu is used to select the desired pager. This field contains all the pagers defined for the line in the 
“Pagers Window” on page 131. 

Frequency Drop Down Menu

The Frequency drop down menu is used to select the frequency for the page. This field contains all of the frequencies defined 
for “Freqs Button” on page 72.

Talk Time Field

The Talk Time field is used to enter the amount of time, in ms, allowed for the console operator to add a voice message to a 
page after the page has been sent. 

The range for this field is 0 to 32000ms.

FIGURE 141. Page Setup Page—UI Element Setup
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Page String Field

The Page String field is used to enter the page string specific to the pager selected in the format field.

This field can contain up to 35 characters.

Send on Selected (not steered) Check Box

The Send on Selected (not steered) check box indicates the page is sent to the selected line or the unselected line. Otherwise, 
the page is sent to the line configured for the page button.

To add a Page button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Page.
The Line to Associate Function With drop down menu becomes active. The Page Setup tab appears.

5. From the Line to Associate Function With drop down menu, select the line you want to associate with the Page 
function.

6. Click the Page Setup tab.
The Page Setup page appears.

7. From the Format drop down menu, select the type of pager being used.

8. From the Frequency drop down menu, select the frequency for the pager.

9. In the Talk Time field, enter the amount of time allowed for the console operator to add a voice message to the page.

10. In the Page String field, enter the page string or code specific to the pager. 

11. Select the Send on Selected (not steered) check box, if desired.

12. Click OK.
The button changes color and Page appears on the button.
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Page Manual Entry

The Page Manual Entry function allows the incorporation of up to five (5) single tones in sequence for a specific line.

Manual Page Setup. When the Page Manual Entry function is selected from the UI Element drop down menu, the Manual 
Page Setup page appears. See Figure 142.

Initial Lead-In Delay Field

The Initial Lead-in Delay field identifies the amount of time to use for the lead-in delay. 

The range for this field is 0 to 20000ms.

Frequency Drop Down Menu

The Frequency drop down menu identifies the frequency to send the page on. This field contains all of the frequencies 
defined for the line in “Freqs Button” on page 72.

Tone Level Field

The Tone Level field identifies the audio level of the tone.

The range for this field is -60 to 10dB.

Tone (1–6) Fields

The Tone (1–6) fields identify the frequency for the tone.

The range for this field is 0 to 3000Hz.

Tone (1–6) Level Fields

The Tone (1–6) Level fields identify the length for the tone.

The range for this field is 0 to 65000ms.

FIGURE 142. Manual Page Setup Page—UI Element Setup
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Talk Time Field

The Talk Time field identifies the maximum amount of time, allowed for talk time.

The range for this field is 0 to 65000ms.

Send on Selected (not steered) Check Box

The Send on Selected (not steered) check box indicates the page is sent to the selected line. Otherwise, the page is sent to the 
line configured for the page button.

To add a Manual Page button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Page-Manual Entry.
The Line to Associate Function With drop down menu becomes active. The Manual Page Setup tab appears.

5. From the Line to Associate Function With drop down menu, select the line you want to associate with the Manual 
Page function.

6. Click the Manual Page Setup tab.
The Manual Page Setup page appears.

7. In the Initial Lead in Delay field, enter the lead-in delay for the pager.

8. From the Frequency drop down menu, select the type of frequency for the pager.

9. In the Tone 1 through Tone 5 fields, enter the level and amount of time for each tone.

10. In the Talk Time field, enter the amount of time allowed for the console operator to add a voice message to the page. 

11. Select the Send on Selected (not steered) check box, if desired.

12. Click OK.
The button changes color and Page appears on the button.

Page Send

The Page Send function allows a console operator to send a group of pages selected using the Page Stack button. This option 
also works when the Always Stack Pages check box is selected, see page 116.

In C-Soft Runtime, the console operator is notified when the last stacked page is sent. A voice message can be sent to page 
recipients.

To add a Page Send button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Page Send.

5. Click OK.
The button changes color and Page Send appears on the button.
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Page Stack

The Page Stack function allows the console operator to select the number of pages to be sent in succession.

In C-Soft Runtime, after pressing the Page Stack button, the console operator can select multiple Page buttons. Normally, a 
page is sent the moment the Page button is pressed, but when the Page button is pressed after the Page Stack button, all 
selected pages are stacked first and sent when the Page Send button is clicked.

Programmed Stack Setup. When the Page Stack function is selected from the UI Element drop down menu, a Programmed 
Stack Setup page appears. See Figure 143.

Unlatch stack button after page Check Box

The Unlatch stack button after page check box indicates the Page Stack button automatically unlatches (toggle off) after 
pages are sent.

To add a Page Stack button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Page Stack.
The Option tab appears.

5. Click the Options tab.
The Options page appears.

6. Select the Unlatch stack button after page check box to automatically unlatch after the pages are sent, if desired.

7. Click OK.
The button changes color and Stack Pages appears on the button.

Page Stack Programmed

The Page Stack Programmed function creates a button used to select a pre-defined group of pages. While in C-Soft Runtime, 
clicking the Page Stacked Programmed button causes the pre-defined pages to be stacked. Pages are sent in the same order as 
the Selected Pages field, starting from the top.

FIGURE 143. Options Page—UI Element Setup
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To send stacked pages, do the following:

1. From C-Soft Runtime, click the Page Stacked Programmed button.
The pages are stacked in the order defined in the Selected Pages list.

2. Click the Page Send button.
The Pages are sent. 

Programmed Stack Setup Page. When Pages Stack Programmed is selected from the drop down menu, the Programmed 
Stack Setup page appears. See Figure 144.

All Pages Fields

The All Pages field displays all pages in the system. This list is used to select a page to add to the Selected pages field. 

Selected Pages Field

The Selected Pages field displays pages selected for the stack. When the console operator clicks the Page Stack Programmed 
button, a page is sent to members in this field.

Move Right Button

The Arrow Right button  is used to move pages from the All Pages field to the Selected Pages field.

Move Left Button

The Arrow Left button  is used to move pages from the Selected Pages field to the All Pages field.

Move Up Button

The Move Up button  is used to move the selected page up in the lists.

Move Down Button

The Move Down button  is used to move the selected page down in the list. 

FIGURE 144. Programmed Stack Setup—UI Element Setup
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Per Line Call History

The Per Line Call History function creates a button used to open a list of past calls received on the selected line.

In C-Soft Runtime, the Per Line Call History window is used to view incoming calls, make outgoing calls, and status messages 
based upon programming setup.

To add a per line call history button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Per Line Call History.

5. From the Line to Associate Function With drop down menu, select the line to display call history.

6. Click OK.
The color of the button changes and In Call History appears on the button.

Per Line Call History Window

The Per Line Call History window is used to view the selected line’s call history. The console operator can also send 
messages, statuses, and alerts to the ID listed in the window by clicking a Call button at the bottom of the window.

NOTE: The Call1–Call 10 buttons may have different labels assigned by the console administrator.

Date Column

The Date column displays the date the call was received on the selected line.

Time Column

The Time column displays the time the call was received on the selected line.

FIGURE 145. Per Line Call History Window—C-Soft Runtime
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Freq Column

The Freq column displays the frequency the call was received on for the selected line. 

Status Column

The Status column displays the status if one was sent on the call. 

User ID Column

The User ID column displays the User ID (alias) of the call received on the selected line. 

Calling ID Column

The Calling ID column displays the ID number of the call received on the selected line. 

Status Field

The Status field shows the status selected from the Status List window. 

To navigate to the Status List window, do the following:

 > Click the Set Status button.
The Status List window appears.

Set Status Button

The Set Status button is used to select a status to send. When clicked, the Status List window appears. See Figure 97.

To send a status ID from the Per Line Call History window in C-Soft Runtime, do the following:

1. While in C-Soft Runtime, select the line you want to place the call from.

2. Select a Per Line Call History button.
The Call List window appears.

3. From the ID Type drop down menu, select an alias or an ID number.
The selected status ID in the status list is highlighted.

4. Select Set Status.
The Status List window appears. 

5. From the ID type drop down menu, selecting an alias or ID number to sort the list.
The list is sorted depending on the selected type.

6. From the Status drop down menu, select a status ID to send.
The selected Status ID is highlighted.
OR
From the status ID list, select a status ID to send.
The selected Status ID is highlighted

7. Click Done.
If a password is required to send the status ID, the Password Entry window appears.

8. Using the keypad, enter the password.
For each character you enter, asterisks fill the empty field at the top of the window.

9. Click Enter.
The Password Entry window closes and the selected status’s alias appears in the Status Message field or, if the 
password is incorrectly entered, an error message appears.

10. Click a Call button to place the call.
The message is sent and a confirmation or error message appears in the Dispatching status bar.

11. Click Done.
The window closes.
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Call (1–10) Buttons

The Call (1–10) buttons are used to place user-defined calls configured in the “5/6 Tone DTMF ANI Setup Page” on page 80. 
The labels configured on the 5/6 Tone/DTMF ANI Setup page appear on these buttons in the call list window.

To place a call from the Per Line Call History window, do the following:

1. Select an ID in the list.
Available call buttons on the bottom of the window become active. 

2. Select a call button. 
The call is placed.

Save to File Button

The Save to File button is used to save the currently selected items to a .csv file.

To save a .csv file of the items in the list, do the following:

1. From the Per Line Call History list, select the items you want to save.

2. Click Save to File.
The Save window appears.

3. In the File name field, enter a name for your .csv file. 

4. Click Save.

Done Button

The Done button is used to close the Call List window.

Phone-Flashhook

The Phone-Flashhook function allows the console operator to perform a flashhook operation on the phone line. This button is 
generally included as part of a DTMF keypad.

To add a Flash button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Phone - Flashhook.

5. Click OK.
The button changes color and Flash appears on the button.
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Phone-Hold

The Phone-Hold function allows the console operator to place a particular line on hold. While a line is in hold status, no TX 
audio is sent to the line and RX audio is sent to the unselect speaker.

To add a Hold button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Phone - Hold.
The Line to Associate Function With drop down menu becomes active.

5. From the Line to Associate Function With drop down menu, select the line to associate the Hold function.

6. Click OK.
The button changes color and Hold appears on the button.

Phone-On/Offhook

The Phone-On/Offhook function is available to add a line set up as a phone line.

A phone, like a radio circuit, can be used as a network device. A C-6200 console with a phone card offers phone lines for use 
by anyone on the network. A phone line can be used for direct phone communications by a console operator, or to add a 
crosspatch to telephone capability for radio users.

When the console operator presses the Phone-On/Offhook button, the line goes offhook and a dial tone is audible. All radio 
traffic is moved to the unselect speaker. Full-duplex audio is present from the microphone while the line is offhook and not on 
hold. Placing the line on hold mutes the transmit audio and places the receive audio on the unselect speaker.

When a hard-wired phone card receives an incoming call, a ring signal is sent out. The C-Soft program generates a ringing 
sound and places a RING icon on the on/offhook button. When the line is taken offhook, the first console to answer the call 
takes control of the line and all others are denied. 

NOTE: A Mute-Per Line button can be associated with a Phone line to mute the phone line’s mic. The mute icon appears 
when the Phone line is muted, RX blocked, or when a Mute Main button is selected. See “Mute-Per Line” on 
page 280.
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To add a Phone On/Offhook button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Phone - On/Offhook.
The Line to Associate Function With drop down menu becomes active and the Remote Phone Select tab appears.

5. From the Line to Associate Function With drop down menu, select the line to associate the On/Offhook function.

6. Click the Remote Phone Select tab.
The Remote Phone Select page appears.

7. From the Remote Phone Number drop down menu, select the physical line of the device the PSTN line is attached to.
C-6200 choices can be 1–18 with IP-223 or IP-224 lines 1 and 2.

8. Click OK.
The button changes color and Phone Onhook appears on the button.

Remote Phone Line Select Page. When the Phone On/Offhook function is selected from the UI Element drop down menu, 
the Remote Phone Line Select page appears. See Figure 146.

Remote Phone Number Drop Down Menu

The Remote Phone Number drop down menu identifies the line to force the use of a particular phone line on the console. 

To use any line, do the following:

 > From the Remote Phone Number drop down menu, select Pool. 
C-Soft creates a ring only if the selected line is ringing.

FIGURE 146. Remote Phone Line Select Page—UI Element Setup
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PTT-Group Call

The PTT-Group Call button is used to call a specific group/talk group. The functionality is currently supported on lines using 
MOTOTRBO or P25-DFSI signaling only.

To send a group call, do the following:

1. From the Group-PTT drop down menu, select the group you want to call.

2. Press and hold the Group PTT button and begin speaking.

3. Release the Group PTT button to stop transmitting.

The PTT-Group Call function allows the console operator to transmit audio to a group of radios.

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select PTT-Group Call.

5. Click OK.
The button changes color and PTT appears on the button.

FIGURE 147. PTT-Group Call Setup Page - UI Element Setup
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PTT-Main

The PTT-Main function allows the console operator to transmit audio to all selected channels. This button is generally 
included on all console designs. In C-Soft Runtime, if the console operator presses the PTT-Main button, audio is sent to all 
selected channels.

To add a PTT-Main button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select PTT-Main.

5. Click OK.
The button changes color and PTT appears on the button.

PTT-Per Line

The PTT-Per Line function, or instant PTT function, allows the console operator to immediately key up a specific line on the 
current frequency.

NOTE: When the PTT-Per Line function is selected, a line must be selected from the Line to Associate Function With  
drop down menu on the Type page.

Per Line PTT Setup Page. When the PTT-Per Line function is selected from the UI Element drop down menu, the Per Line 
PTT Setup page appears. See Figure 149.

FIGURE 148. PTT - Main Setup Page - UI Element Setup

FIGURE 149. Per Line PTT Setup Page - UI Element Setup
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Select PTT Frequency Drop Down Menu

The Select PTT Frequency drop down menu identifies the desired frequency to use per selected line.

To add a PTT-Per Line button, do the following:

1. From the UI Element drop down menu, select PTT-Per Line.
The Line to Associate Function With drop down menu becomes active.

2. From the Line to Associate Function With drop down menu, select the line to associate with PTT Per Line.

3. Click the Per Line PTT Setup tab.
The Per Line PTT Setup page appears.

4. From the Select PTT Frequency drop down menu, select the frequency.

5. Click OK.
The color of the button changes and Freq X (where X is the frequency) appears on the button.

PTT-Private Call

The PTT-Private Call button is used to call an individual radio user. The functionality is currently supported on lines using 
MOTOTRBO or P25-DFSI signaling only.

To add a PTT-Private Call button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select PTT-Private Call.

5. Click OK.
The button changes color and PTT-Private Call appears on the button.

To send a private call, do the following:

1. From the PTT-Private Call drop down menu, select the user you want to call.

2. Press hold and the PTT-Private Call button and begin speaking.

3. Release the PTT-Private Call button to stop transmitting.

FIGURE 150. PTT-Private Call Setup Page - UI Element Setup
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PTT-Talk Back

The PTT-Talk Back function allows the console operator to transmit back to the last line from which audio was received.

To add a PTT-Talk Back button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button and select Properties.
The UI Element Setup window appears.

3. From the UI Element drop down menu, select PTT-Talk Back.

4. Click OK.
The button changes color and PTT-Talk Back appears on the button.

Radio Call Alert

The Radio Call Alert button is used to send an alert message to the selected radio. The functionality is currently supported on 
lines using MOTOTRBO or P25-DFSI signaling only.

FIGURE 151. PTT-Talk Back Setup Page - UI Element Setup

FIGURE 152. Radio Call Alert Setup Page - UI Element Setup
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To add a Radio Call Alert button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button and select Properties.
The UI Element Setup window appears.

3. From the UI Element drop down menu, select Radio Call Alert.

4. Click OK.
The button changes color and Call Alert appears on the button.

To send a radio call alert message, do the following:

1. From the Radio Call Alert drop down menu, select the unit to send the radio call alert message to.

2. Click Radio Call Alert. 
The command is sent. 

Radio Check

The Radio Check function is used to send a message to check for radio activity. The functionality is currently supported only 
on lines using MOTOTRBO or P25-DFSI signaling.

To add a Radio Check button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button and select Properties.
The UI Element Setup window appears.

3. From the UI Element drop down menu, select Radio Check.
Click OK.
The button changes color and Radio Check appears on the button.

To send a radio check message, do the following:

1. Right-click the Radio Check button.
A shortcut menu appears.

2. From the shortcut menu, select Open Drop Down List.
The Drop Down List appears.

3. Select the unit to send the radio check message to.

4. Click the command button on the Radio Check button.

FIGURE 153. Radio Check Setup Page - UI Element Setup
Bosch Security Systems, Inc. Administrator’s Guide F.01U.218.561 Rev 03



302  C-Soft Designer Program C-Soft Administrator’s Guide
Radio Disable

The Radio Disable button is used to disable a radio in the field from use by unauthorized persons. The functionality is 
currently supported on lines using MOTOTRBO or P25-DFSI signaling only.

To add a Radio Disable button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button and select Properties.
The UI Element Setup window appears.

3. From the UI Element drop down menu, select Radio Disable.

4. Click OK.
The button changes color and Radio Disable appears on the button.

To disable a radio, do the following:

1. From the Radio Disable drop down menu, select the unit to disable.

2. Click Radio Disable.
The command is sent.

Radio Enable

The Radio Enable button is used to enable a radio that has been disabled. The functionality is currently supported on lines 
using MOTOTRBO or P25-DFSI signaling only.

FIGURE 154. Radio Disable Setup Page - UI Element Setup

FIGURE 155. Radio Enable Setup Page - UI Element Setup
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To add a Radio Enable button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button and select Properties.
The UI Element Setup window appears.

3. From the UI Element drop down menu, select Radio Enable.

4. Click OK.
The button changes color and Radio Enable appears on the button.

Radio Status Request

The Radio Status Request button is used to send message to request status from a unit in the system. The functionality is 
currently supported on lines using MOTOTRBO or P25-DFSI signaling only.

The Radio Status Request function allows the console operator to request the status of a radio. (P25-DFSI Only).

To add a Radio Status Request button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button and select Properties.
The UI Element Setup window appears.

3. From the UI Element drop down menu, select Radio Status Request.

4. Click OK.
The button changes color and Status Request appears on the button.

To request the status from a unit, do the following:

1. From the Radio Status Request drop down menu, select the unit to send the radio check message to.

2. Click Radio Status Request. 
The command is sent.

Radio-On/Offhook

The Radio-On/Offhook function allows the console operator to control a radio using a standard PSTN (public switched 
telephone network) phone line. Radio - On/Offhook is similar to “Phone-On/Offhook” on page 295, except radio-on/offhook 
has a Keep-Alive tone generated to keep the phone line from dropping. A keep-alive tone goes between the radio and console 
so the system knows to stay active until after the connection is broken.

FIGURE 156. Radio Status Request Setup Page - UI Element Setup
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To add a Radio On/OffHook button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Radio - On/Offhook.
The Line to Associate Function With drop down menu becomes active and the Remote Phone Select tab appears.

5. From the Line to Associate Function With drop down menu, select the line to associate the On/Offhook function.

6. Click the Remote Phone Line Select tab.
The Remote Phone Line Select page appears.

7. From the Remote Phone Number drop down menu, select the line to force the use of a particular phone line on the 
console.

8. Click OK.
The button changes color and Radio OnHook appears on the button

Relay Control Button

The Relay Control Button function allows the console operator to control the relays on an attached HB-3, ADHB-4, or a 
network-connected NEO-10.

Relay Control Setup Page. When Relay Control Button is selected from the UI Element drop down menu, the Relay Control 
Setup page appears.

To open the Relay Control Setup page, do the following:

1. Select Insert|Add IU Button.
A None button is added to the console.

2. Right-click the None button and select Properties.
The UI Element Setup button window appears.

3. From the UI Element Function drop down menu, select Relay Control.
The Relay Control Setup tab appears.
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Relay Destination Group Box

The Relay Destination radio buttons identify the relay to be controlled. When a selection is made, the fields necessary to enter 
the setup information for the relay are enabled.

HB-3 Radio Button

The HB-3 radio button indicates an HB-3 is controlled by the relay.

ADHB-4 Radio Button

The ADHB-4 radio button indicates an ADHB-4 is controlled by the relay. 

NEO Radio Button

The NEO radio button indicates the NEO-10 is controlled by the relay.

HB-3/ADHB-4 Settings Group Box

The HB-3/ADHB-4 Settings radio buttons identify which relay controls an HB-3 or ADHB-4.

None Radio Button

The None radio button indicates there is no HB-3 or ADHB-4 connected.

Relay 1 Radio Button

The Relay1 radio button indicates the first relay in the HB-3 or ADHB-4 is being controlled.

Relay 2 Radio Button

The Relay2 radio button indicates the second relay in the HB-3 or ADHB-4 is being controlled.

NEO Settings Group Box

The NEO Settings field identifies the IP Address and the relay, if any, for the NEO-10. 

IP Field

The IP field identifies the IP Address of the NEO-10. 

Relay Drop Down Menu

The Relay drop down menu is used to select the desired relay.
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Available selections for this field are None, Port 1, Port 2, Port 3, Port 4, Port 5, Port 6, Port 7, Port 8, Port 9 and Port 10.

To configure and add an HB-3 or ADHB-4 Relay Control button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Relay Control Button.
The Relay Control Setup tab appears.

5. Click the Relay Control Setup tab.
The Relay Control Setup page appears.

6. From the Relay Destination group box, select the HB-3 radio button.
The HB-3/ADHB-4 Settings group box becomes active.
OR
From the Relay Destination group box, select the ADHB-4 radio button. 
The HB-3/ADHB-4 Settings group box becomes active.

7. From the HB-3/ADHB-4 Settings group box, select the None radio button.
OR
From the HB-3/ADHB-4 Settings group box, select the Relay1 radio button.
OR
From the HB-3/ADHB-4 Settings group box, select the Relay2 radio button.

8. From the Relay drop down menu, select the desired relay.

9. Click OK.
The button changes color and Relay Off appears on the button.

To configure and add a NEO Relay Control button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Relay Control Button.
The Relay Control Setup tab appears.

5. Click the Relay Control Setup tab.
The Relay Control Setup page appears.

FIGURE 157. Relay Drop Down Menu
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6. From the Relay Destination group box, select NEO.
The NEO Settings group box becomes active.

7. From the Relay Behavior group box, select the desired mode radio button for the relay control.

8. In the IP field, enter the IP Address of the NEO-10.

9. From the Relay drop down menu, select the desired relay.

10. Click OK.
The button changes color and Relay Off appears on the button.

Relay Behavior Group Box

The Relay Behavior radio buttons identify the mode for the relay control. 

Latch Relay On/Off Radio Button

The Latch Relay radio button indicates the relay’s latch is controlled by the operator. When the Relay Control button is 
clicked the device is active. When the Relay Control button is pressed again the device is inactive.

Momentary Relay Radio Button

The Momentary Relay radio button indicates the relay is active when the button is pressed. When the button is released, the 
relay is inactive.

Timed Relay Radio Button

The Timed Relay radio button indicates that when an Relay Control button is clicked, it remains active for the amount of time 
configured in the Timed field. When the radio button is selected, you must configure a time in the Timed field.

Timed Relay Field

The Time Relay field is used to set the time, in ms, when the Timed Relay radio button is selected.

The range for this field is 0 to 30000ms. 

Emergency Relay Trigger Group Box

The Emergency Relay Trigger group box is used to configure how the relay behaves when an emergency call is received.

Activate Relay on Emergency Call Check Box

The Activate Relay on Emergency Call check box indicates an emergency call activates the configured relay. If the check 
box is selected, a radio emergency deactivation radio button can be selected.

Relay Control Button Only Radio Button

The Relay Control Button Only radio button is used to configure the relay to deactivate when the relay control button is 
released.

Emergency Clear and Acknowledge Radio Button

The Emergency Clear and Acknowledge radio button indicates the relay is deactivated when the emergency is 
acknowledged, cleared, or when the relay control button is released.
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Emergency Acknowledge Radio Button

The Emergency Acknowledge radio button indicates the relay is deactivated when the emergency is acknowledged or when 
the relay control button is released.

Phone Relay Trigger Group Box

The Phone Relay Trigger group box is used to configure how the relay behaves when a phone call is received.

Activate Relay on Phone Ring Check Box

The Activate Relay on Phone Ring check box indicates a phone ring activates the configured relay. When the check box is 
selected, the phone ring behavior can be configured.

Cadence Radio Button

The Cadence radio button indicates the relay is activated when an individual phone ring starts and deactivated when the phone 
ring ends.

EXAMPLE: A phone ringing three (3) times, produces an on/off/on/off /on/off pattern. 

Steady Radio Button

The Steady radio button indicates the relay is activated when the first phone ring is received and deactivates when the call is 
answered or the caller terminates the call. 

EXAMPLE: A phone ringing three (3) times, produces a on/off pattern.

PTT Relay Trigger Group Box

Activate Relay on PTT Check Box

The Activate Relay on PTT check box indicates the configured relay is active when any console-generated transmit event, 
with the exception of intercom and intercom per line, occurs. Also, the relay is triggered whenever a phone line is taken 
offhook.

Remote Monitor

The Remote Monitor button allows the dispatcher to open the mic of a targeted radio and hear any audio in the vicinity of that 
radio. The functionality is currently supported on lines using MOTOTRBO or P25-DFSI signaling only.

FIGURE 158. Remote Monitor Setup Page - UI Element Setup
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To add a Remote Monitor button, do the following:

1. From the Insert menu, select Remote Monitor.
A None button appears on the console window.

2. Right-click the None button and select Properties.
The UI Element Setup window appears.

3. From the UI Element drop down menu, select Remote Monitor.

4. Click OK.
The button changes color and Remote Monitor appears on the button.

To monitor a unit, do the following:

1. From the Remote Monitor drop down menu, select the unit to monitor.

2. Click Remote Monitor. 
The command is sent.

RX All

The RX All function allows the console operator to remove mute on selected lines if Allow Muting Selected Lines is selected. 

In C-Soft Runtime, if the console operator presses the RX All button it does not change the select status of any line.

To add an RX All button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select RX All.

5. Click OK.
The button color changes and RX All appears on the button.

Scan

The Scan function allows the console operator to scan a selected line.

To add a Scan button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Scan.
The Line to Associate Function With drop down menu becomes active.

5. From the Line to Associate Function With drop down menu, select the line to associate with Scan.

6. Click OK.
The button color changes and Scan Off appears on the button.
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Select

The Select function allows the console operator to toggle transmission channels when a master or accessory PTT button is 
selected. DTMF and Alert tones are also transmitted to all selected lines. Select buttons also indicate the type of activity on a 
line, such as: audio receive, audio transmit, mute, crossmute, intercom, and supervisor status.

NOTE: A Mute-Per Line button can be associated with the line assigned to the Select button to mute the Select line’s 
mic.   The mute icon appears when the Select line is muted, RX blocked, or when a Mute-Main button is 
selected. See “Mute-Per Line” on page 280.

For more information, see “Button Bitmaps Group Box” on page 186.

Select Button Setup Page. When Select is chosen from the UI Element drop down menu, the Select Button Setup page 
appears.

To open the Select Button Setup page, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Select.
The Select Button Setup tab appears.

5. Click the Select Button Setup tab.
The Select Button Setup page appears.

Annunciation of Select Call Group Box

Blink Select Button Check Box

The Blink Select Button check box is used to indicate the button blinks light blue when the console receives a select call.

No Beep Radio Button

The No Beep radio button indicates no tones are heard when a select call is received.

FIGURE 159. Select Button Setup - UI Element Setup
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Beep for Radio Button

The Beep for radio button is used to indicate a select call alert tone is heard when a select call is received.

Beep for seconds field

The Beep for seconds field indicates the amount of time the select call alert tone plays.

The range for this field is 1–10 seconds.

NOTE: The Beep for radio button must be selected for this field to be active.

Beep Until PTT Radio Button

The Beep Until PTT radio button indicates the select call alert tone is heard until a PTT operation is performed on the line that 
received the select call.

To configure a blinking button indication, do the following:

 > From the Select Button Setup page, select the Blink Select Button check box.

To configure the desired notification, select one (1) of the following:

• No Beep radio button - no beep sound is played when a select call is received.

• Beep For radio button - a beep sounds for the specified the number of second.

• Beep Until PTT radio button - a beep sounds until a PTT when a select call is received.

Action on Select Call Group Box

No Action Radio Button

The No Action radio button indicates an active mute button is not opened during a select call.

Open Mute for Radio Button

The Open Mute for radio button indicates a muted line is opened upon receiving a select call.

NOTE: The Open Mute for seconds field must also be configured.

Open Mute for seconds Field

The Open Mute for seconds field indicates the amount of time a muted line is unmuted upon receiving a select call.

The range for this field is 1 to 20 seconds.

To configure the desired action, select one (1) of the following:

• No Action radio button - no action occurs. 

• Open Mute for radio button - specifies the duration, in seconds, muted line remains open (unmuted).

To add a Select button, do the following

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.
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3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Select.
The Line to Associate Function With drop down menu becomes active and the Select Button Setup tab appears.

5. From the Line to Associate Function With drop down menu, select the line to associate with Select.

6. Click the Select Button Setup tab.
The Select Button Setup page appears.

7. In the DTMF Digits for Select Call field, enter the digits required to activate the select call feature.

8. From the Annunciation of Select Call group box, select the type of notification to be used.

9. From the Action on Select Call group box, select the mute action during a select call.

10. Click OK.
The button changes color and Select appears on the button.

Annunciation of Call Alert Group Box

Blink Select Button Check Box

The Blink Select Button check box indicates the button blinks orange when the console receives a call alert.

No Beep Radio Button

The No Beep radio button indicates no tones are heard when a call alert is received.

Beep for Check Box

The Beep for check box indicates a call alert tone is heard when a call alert is received.

NOTE: The Beep for seconds field indicates the amount of time the alert tone plays.

Blink Border on Receive Group Box

No Blinking Radio Button

The No Blinking radio button indicates the Select button does not blink when receiving a call.

Blink for Radio Button

The Blink for radio button indicates the Select button’s border blinks for the amount of time set in the seconds field. When the 
line is transmitting the blinking stops.

NOTE: When selected, the Blink for Radio button check box is active.

Blink for seconds field

The Blink for seconds field indicates the Select button blinks for the amount of time set in this field. 

Blink Until PTT Radio Button

The Blink Until PTT radio button indicate the Select button’s border blinks until a PTT is generated on the line.

Blink Color Drop Down Palette

The Blink Color drop down palette indicates the color of the button border when it blinks.
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DTMF Digits for Select Call Fields

The DTMF Digits for Select Call fields identifies the digits required to activate the select call feature. C-Soft can respond up 
to five (5) different DTMF strings.

This field can contain up to 10 characters.

Beep for seconds Field

The Beep for seconds field indicates the amount of time the call alert tone plays.

The range for this field is 1 to 10 seconds.

NOTE: The Beep for check box must also be configured.

Beep Until PTT Radio Button

The Beep Until PTT radio button indicates the alert tone is heard until a PTT operation is performed on the line that received 
the call alert.

To configure a blinking button indication, do the following:

 > From the Select Button Setup page, select the Blink Select Button check box.

To configure the desired notification, select one (1) of the following:

• No Beep radio button - no beep sound is played when a select call is received.

• Beep For radio button - a beep sounds for the specified the number of second (0-10 seconds).

• Beep Until PTT radio button - a beep sounds until a PTT when a select call is received.

DTMF Digits for Select Call Group Box

The DTMF Digits for Select Call group box contains five (5) fields to specify DTMF digit strings to trigger a select call in 
C-Soft. When the console receives any of the DTMF strings configured in the select call setup, the button notifies the operator 
by either blinking or beeping depending on the console configuration.

Trigger Emergency Check Box

The Trigger Emergency check box indicates an emergency is triggered when the string entered in the field is received. 

SIP Call Control

The SIP Call Control function creates a button to open the SIP Calls window shown in Figure 162. 

In C-Soft Runtime, when the window is open, the user can receive, place, and transfer phone calls, control the call volume, 
view history or view a list of missed calls. Monitor the Status Bar at the top of the console window for success or failure 
messages.

To initiate a connection to the SIP server, do the following:

 > Open C-Soft Runtime.
C-Soft attempts to connect to the server.
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NOTE:

• If the SIP server connection is successful, the message appears on the console status bar.

• If the SIP server connection fails, the message appears on the console status bar.

• If the SIP server connection becomes disconnected during use, the failure message appears in the status 
bar. 

During SIP calls, some status messages and icons appear directly on the SIP Call control button during SIP call activity. These 
same indications as well as status messages, appear in the SIP Calls window. See Figure 160.

NOTE:

• A Mute Per Line button can be associated with a SIP Call Control button to mute the SIP line’s 
microphone and speaker. The mute icon, see Figure 160, appears when the SIP line is muted per line, 
RX blocked, or when a Mute-Main button is selected. 

• If the line is muted, and a call is initiated from the SIP Calls window, the line is automatically unmuted.

Registration Failed Ringing

Incoming Call Connected

On Hold Do Not Disturb

Mic Mute Mute (Per Line)

FIGURE 160. SIP Call Buttons with Status Indications
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SIP Incoming Call pop-up Menu

The SIP Incoming Call pop-up menu, shown in Figure 161, can be used to quickly access the incoming SIP call. During an 
incoming call, the status indicator changes to RING. Right-click the incoming SIP call button to access the pop-up menu.

Available selections for this menu are: 

Open SIP Window -Opens the SIP Calls window. For more information, see “SIP Calls Window” on page 315.

Answer - Answers the incoming call. For more information, see “Call/Answer Button” on page 316.

Ignore - Ignores the incoming call. For more information, see “Hang Up/Hang Up >/Ignore Button” on page 318.

SIP Calls Window

The SIP Calls window is used to manage SIP Calls, view call history and view missed calls.

NOTE: If using SIP Basic features only, buttons for SIP Enhanced features on the Call, History and Missed pages are 
disabled.

Call Page. When a SIP Call Control button is clicked in C-Soft Runtime, the SIP Calls window opens to the Call page. See 
Figure 162.

The Call page is used to place incoming and outgoing SIP phone calls. When licensed for SIP Enhanced, this window is also 
used to place holds, initiate 3-way calling, mute the microphone, and activate do not disturb. 

FIGURE 161. SIP Incoming Call pop-up Menu

FIGURE 162. SIP Calls Window —Call Page
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SIP Call Display

The SIP Call display is used to enter a phone number to call. It also provides status messages and icons to indicate the state of 
the associated SIP line.

To enter a phone number to call, do the following:

1. Ensure the SIP Calls window is open.

2. Using the Keypad pane or the keyboard keypad, enter the phone number to call.
The digits appear in the SIP display.

3. Click Call. 
OR
While the SIP display has focus, press Enter.

NOTE: When the call is connected, the Connected icon appears in the display. 

Call/Answer Button

The Call/Answer button is used to place or answer a call. 

This button is disabled until a number is entered or an incoming call is received.

• If a contact is selected from the Contacts pane, or a phone number is entered in the SIP Call display, the 
Call button is enabled.

• If a call is being received on a line while the SIP Calls window is open, a ring icon appears on the SIP 
Call display and the Answer button is enabled.

To answer a call, do the following:

 > Click Answer.
The incoming call is connected.

FIGURE 163. SIP Calls —Incoming Call
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NOTE: If the line is already engaged in a call, the existing call is placed on hold and the button label changes to 
Switch.

To return to a caller on hold while on another call, do the following:

 > Click Switch.
The current caller is placed on hold and the other call is taken off hold.

To answer and merge a waiting call with the current call, do the following. 

1. While already engaged in a call, click Answer.
The current call is placed on hold and the incoming call is answered.

2. Click 3-way Call.
The on-hold call is taken off hold, and joined with the other call. The two (2) callers and console operator are 
connected in one (1) conversation. The 3-Way Call button label changes to Leave Call.

To place an outgoing call, do the following:

1. Using the Keypad pane or keyboard, enter the phone number.
The number appears in the SIP Calls display.

2. Click Call.
OR
Press Enter.
The call is placed to the phone number entered in step 1.

NOTE: To disconnect from the call, click Hang Up.

FIGURE 164. SIP Calls—Outgoing Call
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Hang Up/Hang Up >/Ignore Button

The Hang Up/Hang Up >/Ignore button is used to disconnect the current SIP call or ignore an incoming call. 

• During a call, the Hang Up button is enabled.

• If multiple parties are connected via consultant transfer, 3-way calling, or call waiting the Hang Up > 
button appears. Click the Hang Up > button to open a pop-up menu containing all currently connected 
calls.

• While an incoming call is ringing, the Hang Up button’s text changes to Ignore.

To disengage a 2-way call, do the following:

 > Click the Hangup button. 
The call is disconnected and the connected icon disappears.

To disengage a call with multiple participants, do the following:

1. Click Hang Up >.
A pop-up menu appears. See Figure 165.

2. Select an individual call to disconnect from.
OR
Select Both to disconnect both calls.

To ignore an incoming call, do the following: 

 > Click Ignore.
The call is ignored and the caller information is added to the list on the Missed page.

FIGURE 165. Hang Up > Button with pop-up Menu
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Hold Button (SIP Enhanced only)

The Hold button places the current call on hold. During hold, C-Soft does not send or receive audio. 

• If multiple parties are connected at one (1) time, the hold button places all calls on hold or takes all calls 
off hold. 

• If the console operator is talking to the consulting party during a consultant transfer or speaking to one 
(1) party during a call waiting event, clicking the Hold button places the active participant on hold.

NOTE:

• Hold options can be configured on the SIP server. 

• The SIP hold button stops both incoming and outgoing audio, whereas the console hold button only 
stops the outgoing audio.

To place a call on hold, do the following:

 > While in a SIP call, click Hold.
The call is placed on hold and the On Hold icon appears in the SIP Call display. 

To take a call off hold, do the following:

 > Click the Hold button.
The call is taken off hold.

FIGURE 166. Call Page—On Hold
Bosch Security Systems, Inc. Administrator’s Guide F.01U.218.561 Rev 03



320  C-Soft Designer Program C-Soft Administrator’s Guide
Mute Mic/Unmute Mic Button (SIP Enhanced only)

The Mute Mic button is used to stop microphone audio from reaching any connected party. 

To mute the microphone, do the following:

 > While engaged in a SIP call, click Mute Mic.
The button changes to Unmute Mic, the Mute Mic icon appears in the SIP Call display, and microphone audio is not 
sent.

To unmute the microphone, do the following:

 > Click Unmute Mic.
The button label changes to Mute Mic, the icon disappears from the display, and the microphone is open.

FIGURE 167. Call Page—Mute Mic
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DND/Disable DND Button (SIP Enhanced only)

The DND (Do Not Disturb) /Disable DND button is used to activate do not disturb mode. While active, callers automatically 
receive a message stating the number is unavailable. While DND is active, DND icons appear on the Call page and the 
associated SIP button.

To activate DND, do the following:

 > Click DND. 
The button label changes to Disable DND and the DND icon appears in the SIP Call display.

NOTE: Calls received while in do not disturb mode are logged on the Missed page.

To disable DND, do the following:

 > Click Disable DND.

NOTE: The specific do not disturb message is configured on the SIP server.

FIGURE 168. Call Page—DND
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Consultant Xfr/Blind Xfr Button (SIP Enhanced only)

The Consultant Xfr/Blind Xfr button is used to blind transfer a call or transfer with consultation. 

• A blind transfer is a call transferred to a second party without announcing the call to the receiver.

• A consultant transfer allows the console operator to announce the transferred call to the receiver. 

• The button label is changed by right-clicking the button and selecting the function from the pop-up 
menu. 

NOTE: To abort the transfer function at any time, click Cancel.
The incoming call remains connected.

To make a consultant transfer, do the following: 

1. From the Call page for the line, if the button label is Consultant Xfr, go to step 2.
OR
Right-click Blind Xfr.
A pop-up menu appears. 

a. Select Consultant Xfr. 
The button label and function changes to Consultant Xfr.

2. Click Consultant Xfr. 
Enter transfer destination appears and the SIP Call display is ready to accept a transfer destination.

3. Using the Keypad pane, keyboard, or the Contacts list, enter the new destination number in the SIP Calls window. 

4. Click Consultant Xfr.
The current call is placed on hold and a call is placed to the destination number. When the call is answered, the Hang 
Up button changes to Hang Up >.

5. Announce the caller to the second party.

6. Click Consultant Xfr.
The first and second call are now connected, and disconnected from C-Soft.

7. Click Hang Up to disconnect from the call.
Both callers are disconnected from the console. 

FIGURE 169. Consultant Xfr pop-up Menu
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To make a blind transfer, do the following:

1. From the Call page for the line, if the button label is Blind Xfr, go to step 2.
OR
Right-click Consultant Xfr.
A pop-up menu appears.

a. Select Blind Xfr.
The button changes to Blind Xfr.

2. Click Blind Xfr. 
Enter Transfer destination appears in the display and the SIP Call display is ready to accept a number.

3. Using the Keypad pane, keyboard, or Contacts list enter the destination number. 
The phone number appears at the bottom of the display.

4. Click Blind Xfr. 
The original call is transferred to the destination number and immediately disconnected from the console.

Line Conf Button (SIP Enhanced Only)

The Line Conf button is used to join two (2) SIP phone calls already in progress into a line conference. A line already 
involved in a 3-way call can be included in the line conference. During a line conference, the SIP Calls window border 
changes to black. An example is shown in Figure 170.

NOTE: Due to processing demands, a maximum of six (6) remote parties (plus the console) can be mixed together at one 
(1) time. 

FIGURE 170. SIP Calls Page—Line Conference
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To place two (2) lines into a line conference, do the following:

1. Engage two (2) SIP calls on two (2) separate lines.

2. From the first line’s call window, click Line Conf.
The window’s border turns black.

3. From the second line’s call window, click Line Conf.
The second line’s SIP Call window turns black. Both lines are now in communication with each other.

3-Way Call Button (SIP Enhanced Only)

The 3-Way Call button is used to establish a call in which three (3) participants are engaged. 

NOTE: To abort the 3-way call function at any time, click Cancel.
The original call remains connected to the console.

To establish a 3-way call, do the following:

1. While already engaged in a call, click 3-Way Call.
Enter New Destination appears in the display.

2. Using the Keypad pane, keyboard, or Contacts list enter the new destination number.
The number appears at the bottom of the display.

3. Click 3-Way Call.
The current call is placed on hold and a call is placed to the new destination number. The Hang Up button changes to 
Hang Up >.

4. Click 3-Way Call.
The first call is taken off hold and joined in the current call. Both parties and the console operator are connected. The 
3-Way Call button’s label changes to Leave Call.

Cancel/Switch Button

The Cancel/Switch button is used to cancel an operation or switch to another call. 

• If the button is active and Cancel appears on it, it can be used to cancel a blind transfer, consultant 
transfer, 3-way call or restore a call to its previous state. 

• If the button is active and Switch appears on it, it can be used to switch from the current call to a call-
waiting call.

To cancel a transfer or 3-way call operation before it is completed, do the following:

 > Click Cancel. 
The operation is canceled, the current caller remains on the line, and the Cancel button is disabled.

To switch to a waiting call while already in a call, do the following:

 > Click Switch.
The current call is placed on hold, the waiting call becomes active. 

NOTE: Click Switch to switch back to the other call.
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Mute Icon

The Mute icon is used to instantly mute the console audio. Clicking the Volume icon mutes the currently selected line.

To mute the selected line, do the following:

 > Click Mute.
The Volume slider moves to the bottom of the volume bar. The speaker icon changes to a red mute icon and audio is 
turned off.

NOTE: Clicking Mute restores the Volume slider to its previous value.

Volume Slider

The Volume slider is used to adjust the speaker volume.

To decrease the volume, do the following:

 > Slide the volume slider down.

To increase the volume, do the following:

 > Slide the volume slider up. 

FIGURE 171. Call Page—Mute Icon
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Expand Button

The Expand button is used to maximize the SIP Calls window, see Figure 172. When the Expand button is clicked, a Misc tab, 
Forward tab, and additional features appear on the Call, History, and Missed pages.

• Expand button. 

Collapse Button

The Collapse button is used to minimize the SIP Calls window, see Figure 171.

• Collapse button. 

Contacts Pane

The Contact list is used to view the list of contacts within the SIP system. This list is managed using a pop-up menu.

NOTE: The Contacts pane appears on the Call page when the Expand button is clicked.

FIGURE 172. Call Page—Contacts Pane
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To place a call to a contact in the list, do the following:

1. From the Contacts pane, select a contact.
The contact’s number appears in the SIP call display.

2. Click Call.
A call is placed to the selected contact.
OR
Double-click the contact.
The default action (the bold item in the pop-up menu i.e Call) is performed and the call is placed.
OR
Right-click the contact and select Call. 
A call is placed to the selected contact.

NOTE: List supports 5000 SIP contacts.

To add a new contact to the list, do the following:

1. Right-click the contact list.
A pop-up menu appears.

2. Click Add New.
The Edit Contacts window appears.

3. In the First Name field, enter the first name of the contact.

4. In the Last Name field, enter the last name of the contact.

5. In the Display Name field, enter a user-recognizable name for the contact.

6. In the Number field, enter the phone number for the contact.

7. In the Notes field, enter appropriate comments for the contact.

8. Click OK.
The contact is added to the contacts list. 

To edit a contact in the list, do the following:

1. Right-click the contact to edit.
A pop-up menu appears.

2. Click Edit.
The Edit Contact window appears.

3. Make changes to the appropriate fields.

4. Click OK. 
The changes to the contact information are saved.
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To delete an entry from the contacts list, do the following:

1. From the list, right-click a contact to delete.
The contact list pop-up menu appears.

2. Click Delete. 
The contact is removed from the list. 

To import a contact, do the following:

1. Right-click the contact list. 
The contact list pop-up menu appears.

2. Click Import.
The Import window appears. 

3. Select a .csv file to import.

4. Click OK.
All contacts contained in the .csv file are added to the list.

To export a contact, do the following:

1. Right-click the Contacts list.
A pop-up menu appears

2. Click Export.
The Export window appears.

3. From the Name drop down menu, select a name.
OR
In the Name field, enter a name for the .csv file.

4. Click OK.
All contacts are exported to the selected .csv file.
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Keypad Pane

The Keypad pane is used to enter DTMF digits and access voicemail messages. 

TIP: The Keypad appears when the Keypad tab is clicked while in the maximized Call page. The Call page is 
maximized using the Expand button.

NOTE:

• These digits can also be entered using the keyboard.

• While in a call, the keypad generates DTMF tones. When not in a call, the keypad inserts the digits in 
the SIP call display.

To access the keypad pane, do the following:

1. From the Calls page, click the expand button.
The contacts page appears.

2. Click the Keypad tab.
The Keypad pane appears.

CLR Button

The CLR (Clear) button is used to clear the information from the SIP Call display. 

NOTE: The SIP Call display entry field must be enabled. 

<-- Button

The <-- button is used to delete the last entered character from the SIP Call display.

NOTE: The SIP Call display entry field must be enabled. 

FIGURE 173. Call Page—Keypad Pane
Bosch Security Systems, Inc. Administrator’s Guide F.01U.218.561 Rev 03



330  C-Soft Designer Program C-Soft Administrator’s Guide
Flash Button

The Flash button is used to send a hook flash signal. 

NOTE: This feature is only available during a SIP call.

Voice mail Button (SIP Enhanced Only)

The Voice mail button is used to access a specific voice mail number. The SIP server must support this feature. 

To configure a specific voice mail number for the button, do the following:

1. Right-click Voice mail and select Configure from the pop-up menu.
The Edit Contact window appears.

2. In the Number field, enter the phone number for the button.

3. Click OK.
The voice mail number is stored. 

To call the stored voice mail number, do the following:

 > Click the Voice mail button.
A call is placed to the specified phone number. 

Voice mail Notification Icon

When the Voice mail notification icon, shown in Figure 173, appears in the SIP Calls display, voice mails are waiting. The 
number indicated to the right of the New text, (e.g. 4), is the quantity of voice mail messages in queue.

History Page. When the History tab is clicked from the SIP Calls window, the History page appears. See Figure 174. The 
History page is used to view past SIP Calls received on the selected line.

FIGURE 174. History Page—Maximized
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Description Column

The Description column displays the call’s number and url or the alias.

Date and Time Column

The Date and Time column displays the date and time the call occurred 

Phone Number Column

The Phone Number column displays the phone number that called.

History Legend 

The History legend displays the color format used for incoming and outgoing calls.

Call Button

The Call button is used to place a call to the selected phone number. If no call is selected from the list, the Call button is 
disabled. 

TIP: The Call button appears on the History page when the Expand button is clicked. 

To call a contact in the History list, do the following:

1. Select the phone number to place a call to.

2. Click the Call button.
OR
Select Call from the entry’s pop-up menu.
OR
Double-click the entry.
The call is placed and the SIP Calls window switches to the Call page.

Missed Page (SIP Enhanced Only)

When the Missed tab is clicked from the SIP Calls window, the Missed page appears. See Figure 175.The Missed page is used 
to view calls received, but not answered on the selected SIP line. 

FIGURE 175. Missed Page
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Description Column

The Description column displays the call’s number and url or the alias.

Date and Time Column

The Date and Time column displays the date and time the call occurred 

Phone Number Column

The Phone Number column displays the phone number the call originated from.

This column is visible when the Expand button is clicked to maximize the window.

Missed Calls Legend

The Missed Calls legend display the color format used for unanswered, ignored, do not disturb, and forwarded calls. 

Call Button

The Call button is used to place a call to the selected phone number. If no call is selected from the list, the Call button is 
disabled.

TIP: The Call button appears when the Missed page is maximized. Click the Expand button to maximize the window.

Call Button

The Call button is used to place a call to a phone number selected from the list. This button is visible when the Expand button 
is clicked to maximize the window.

To place a call from the missed call list, do the following:

1. Select a call from the list. 

2. Click Return Call. 
OR
Double-click an entry.
OR
Right-click an entry and select Call from the pop-up menu.
The call is placed to the selected phone number.

Clear List Button

The Clear List button is used to clear all calls from the list. This button is visible when the window is maximized.

To clear all calls from the list, do the following:

 > Click Clear List.
The list is cleared. 
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Misc Page. The Misc page is used to view the following system information:

Domain - Displays the registered domain of the SIP line. 

Protocol - Displays the SIP protocol for the line.

SIP Registration - Displays the registration information for the SIP line. 

The Misc page, see Figure 176, becomes available in the SIP Calls window when the expand button is clicked

FIGURE 176. Misc Page
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Forward Page (SIP Enhanced Only). The Forward page is used to configure forwarding options. 

The Forward page, shown in Figure 177, becomes available in the SIP Calls window when the expand button is clicked.

Forward All Calls Check Box

The Forward All Calls check box indicates all calls received on the line are forwarded to the phone number entered in the 
Destination field for this check box.

NOTE: This selection cannot be combined with any other forwarding option.

Destination Field

The Destination field is used to enter the phone number to forward all incoming calls to.

Address Book

The Address Book button is used to locate a phone number to enter in the Destination field. 

Forward calls while busy Check Box

The Forward call while busy check box indicates calls received while the line is busy are forwarded to the phone number in 
the Destination field for this check box

NOTE: This check box can be used in combination with the Forward unanswered calls option.

• Some SIP servers (i.e. 3CX) have their own settings for forwarding a call when an extension is busy. 
When using these servers the call forwarding logic in the server takes precedence over the call 
forwarding settings in C-Soft.

FIGURE 177. Forward Page
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Destination Field

The Destination field is used to enter the phone number to forward incoming calls to when the line is busy.

Address Book

The Address Book button is used to locate a phone number to enter in the Destination field. 

Forward unanswered calls after Check Box

The Forward unanswered calls after check box indicates calls left unanswered are forwarded to the phone number entered in 
the Destination after the amount of time configured in the Forward unanswered all after seconds field. 

NOTE: This check box can be used in combination with the Forward calls while busy option.

Forward unanswered calls after seconds Field

The Forward unanswered calls after seconds field is used to enter the amount of time, in seconds, the call is left unanswered 
before it is forwarded to the phone number in the Destination field.

Destination Field

The Destination field is used to enter the phone number to forward unanswered calls after [X] seconds.

Address Book

The Address Book button is used to locate a phone number to enter in the Destination field. 

Apply Button

The Apply button is used to save changes made to the Forward page.

To set up call forwarding, do the following:

1. From the Forward page, select the Forward all calls check box
OR
Select the Forward calls while busy check box
OR
Select the Forward unanswered calls check box

2. In the Forward unanswered calls after seconds field, enter the amount of time in seconds.

3. In the Destination field for the selected check box, enter the phone number the call is to be forwarded to.
OR
Click the Address Book button.
The address book appears. 

4. Select a phone number to forward calls to.
The phone number appears in the Destination field.

5. Click Select.
The window closes and the phone number appears in the selected field.
OR
Click Cancel
The changes are not accepted and the window closes.

6. Click Apply to accept changes.
The changes are applied.
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Close Button

The Close button is used to close the SIP Calls window.

Supervisor

The Supervisor function allows a single dispatch location to seize control of a line or group of lines.

In C-Soft Runtime, after clicking the Supervisor button, the console operator enters the 4-digit PIN number. When the PIN is 
entered, a supervisor packet burst is sent to all selected lines. When a console receives a packet burst, those lines are removed 
from local control. The console operator of those lines is no longer able to hear receive traffic or create transmit traffic.

NOTE: Supervisor password and timeout are configured on the “Control Settings Page” on page 115.

To add a Supervisor button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Supervisor.

5. Click OK.
The button changes color and Supervisor appears on the button.

Talk Around Button (Kenwood Radio Only)

The Talk Around button is used, on a per line basis, to toggle the Kenwood radio talk around feature. Talk around bypasses a 
radio repeater system, permitting direct radio-to-radio communication.

In C-Soft Runtime, after clicking the talk around button, the button changes colors and talk around is enabled (the button 
position is down). After clicking the button again, talk around is disabled (the button position is up).

Text Button

The Text button displays text or can serve as a colored space filler. 

IMPORTANT: There is no action associated with this UI Button.

To add a text button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Text Button.

5. Click the Colors tab.
The Colors page appears.

NOTE: From the Colors page you can enter the text and change the color you want on the button. Also, you can 
leave the text field blank and change the color of the button to serve as a colored space filler. For more 
information, see “Colors Page” on page 185.
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TX All

The TX All function allows the console operator to place all lines into a selected mode. A subsequent PTT is then transmitted 
on all lines.

To add a TX All button, do the following:

1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select TX All.

5. Click OK.
The button color changes and TX All appears on the button.

UI Element Setup Window—Add UI Vol. Control

The Add UI Vol. Control button, shown in Figure 178, is used to place a volume control slider in the upper 
left-hand corner of the console window. This section provides information on the functionality of the different volume controls 
selected from the UI Element Function drop down menu.

FIGURE 178. Volume Control Slider

FIGURE 179. Type Page—UI Element Setup Volume Control
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To access the UI Element Setup window for Volume Control, do the following:

1. From the Insert menu, select Add UI Vol. Control.
A UI Vol. Control slider appears on the C-Soft console window.

2. Right-click the UI Vol. Control slider.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

Type Page. When Add UI Vol Control is selected from the menu bar, the UI Element window opens to the Type page. 
Figure 179.

UI Element Function Drop Down Menu

The UI Element Function drop down menu is used to select the desired functionality for the volume control.

Available selections for this field are:

Volume-Master Select -              Provides a single volume control that manipulates the volume of all selected audio.

Volume-Master Unselect - Allows the console operator to change the unselect volume for all lines.

Volume-NENA - Allows the console operator to change the volume of NENA audio when operating with 
ADHB-4.

Volume-Per Line - Allows the console operator to control the relative level of the selected line with respect to 
other lines.

Line to Associate Function With Drop Down Menu

The Line to Associate Function With drop down menu is used to select the line to associate the button or volume control 
with. This field is only enabled when the selected entry in the UI Element Function field requires a line association.

OK Button

The OK button saves the entries and closes the window.

NOTE: If the associated line is muted, the volume control for the line is disabled.

FIGURE 180. UI Element Drop Down Menu
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Volume Control Page. When the Vol Control tab is selected from the UI Element Setup window, the Vol. Control page 
appears. See Figure 181.

Orientation Group Box

The Orientation group box contains buttons to orient the volume control. 

To set the volume control orientation, select one (1) of the following:

• Horizontal radio button - the control is positioned horizontally.

• Vertical radio button - the control is positioned vertically.

Minimum Volume Field

The Minimum Volume field identifies the minimum volume level for the control. 

The range for this field is -20dB to -1dB. 
Zero (0) mutes the audio.

Maximum Gain Drop Down Menu

The Maximum Gain drop down menu identifies the maximum volume level for the control.

Available selections for this field are: 0, 3, 6, 9, and 12.

Slider Background Color Drop Down Menu

The Slider Background Color drop down menu displays the color of the volume control slider. Use the drop down color 
palette to select the desired color.

FIGURE 181.  Vol.Control Page—UI Element Setup Volume Control
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To add a volume control, do the following:

1. From the Insert Menu, select Add UI Vol. Control.
The Volume Control slider appears on the console window.

2. Right-click the Vol. Control slider.
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element Function drop down menu, select a volume function.
The Vol. Control tab appears.

5. Click the Vol. Control tab.
The Vol Control page appears.

6. In the Orientation field, select the desired orientation radio button of the volume control slider.

7. In the Minimum Volume field, enter a minimum volume.

8. From the Maximum Gain drop down menu, select the maximum gain.

9. From the Slider Background Color drop down menu, select the background color for the slider control.

10. Click OK.
A volume control appears on the console.

UI Element Setup Window - Add UI Pop-up Button

Select Add UI pop-up Button from the Insert menu to place a pop-up button in the upper left hand corner of the console 
window. Pop-up buttons can also be added to a pop-up window.

To add a pop-up button to the C-Soft Console window, do the following:

 > From the Insert menu, select Add pop-up Button.
A pop-up button appears on the C-Soft console window.

To open a pop-up window in C-Soft Designer, do the following:

1. Right-click the UI Element pop-up button.
A shortcut menu appears.

2. From the Shortcut menu, select Open pop-up.
A pop-up window appears.

To close a pop-up window, do the following

 > Click Done on the pop-up window.
The pop-up window closes.

To resize the pop-up window in C-Soft Designer, do the following:

1. From the Insert menu, select Add pop-up Button.
A pop-up button appears on the C-Soft console window 

2. Right-click the pop-up window

3. From the Shortcut menu, select Open pop-up.
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4. Click the pop-up button.
Target icon appears on the button.

5. Click resize buttons  to increase/reduce width/height.
OR
Press the Ctrl key while pressing the arrow keys on your keyboard. 

NOTE:

• If, as a result of resizing, the window extends past the window view, move the pop-up button to a new 
position.

• The pop-up window cannot be resized in C-Soft Runtime.

To insert items into the pop-up window, do the following:

1. From the Insert menu, select Add pop-up Button.
A pop-up button appears on the C-Soft console window.

2. From the Insert Menu, select the desired element.

3. Repeat step 2, as necessary.

NOTE: The pop-up button must be selected in order to insert items into a pop-up window.

To edit items in the pop-up window, do the following:

1. Open a pop-up window as described above:

2. Select the item(s) in the pop-up window.
Red targets appear on the items.

3. Perform the desired action on the selected item(s).

NOTE: The parameters for the item(s) can be changed, and the item(s) can be cut, copied, or moved in the same way 
as an item(s) is when it is placed directly on the console window.
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Type Page 

The Type page is used to configure the type of function for the UI Element Pop-up (Control) button. Some UI Elements 
require further configuration and when selected from the function drop down menu additional configuration pages appear. See 
Figure 183.

UI Element Function Drop Down Menu

The UI Element Function drop down menu is used to select an operation for the pop-up button. Each function configuration 
is described in the following section.

Available selections for this field are:

Pop-up Call History
Pop-up Webpage
Pop-up Window Control

Pop-up Call History

The Pop-up Call History function creates a button used to open the Global Call History window.

In C-Soft Runtime, the Global Call History is used to view per line calls received and stored in the history log. In addition to 
displaying the global call history, the log can be used to play back received audio only. Transmitted audio is not recorded.

Up to three (3) minutes of audio is stored for playback. Silence between calls is not stored.

NOTE:

• C-Soft supports one (1) Global Call History window per console. If a Global Call History window 
button already exists, the Pop-up Call History function is not available for selection.

• Recording calls is also accomplished by adding an Instant Recall Recording button to the console, see 
“Instant Recall” on page 241 for details.

• While the call history audio is playing, the recorder continues to record other calls that come in, but 
they are not played because a previous call is being played.

FIGURE 182. Type Page—UI Element Setup Pop-up Control
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Call List Options Page. When the pop-up Call History function is selected, the Call List Options page appears. See 
Figure 183.

Include Muted Calls in List Check Box

The Include Muted Calls in List check box indicates muted calls are included in the call history log.

Include NEO Changes in List Check Box

The Include NEO Changes in List check box indicates the NEO-10 event changes are included in the call history log.

Call Window Lines Field

The Call Window Lines field identifies the number of lines of text saved in the call history log. 

The range for this field is 1 to 500.

Call Window Font Size Field

The Call Window Font Size field identifies the font size of the text in the call history log. 

The range for this field is 0 to 72.
The default is 8 point.

FIGURE 183. Call List Options Page—UI Element Setup
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Global Call History Window 

The pop-up Call History window provides a log of past calls received by the console. The operator can use the log to view 
previously received calls. In addition, the call can be selected for playback. 

This log can contain up to 500 calls.

Stop Playing Button

The Stop Playing button is used to stop playing back the selected calls recording

Play Button

The Play button is used to begin playing back a recording from the selected call.

To play back a call from the Global Call History log, do the following:

1. From C-Soft Runtime, double-click the global call history button.

NOTE: The global call history button’s label is determined by the user. 

2. In the call history window. double-click the date-stamped entry 
Received audio is played back.

3. Click the Stop Playing button to stop playback.

Done Button

The Done button is used to close the window. 

Pop-up Webpage

The Pop-up Webpage function provides the ability to embed a webpage in the pop-up window. When the pop-up Webpage 
button is pressed, the specified webpage is displayed in the pop-up window.

NOTE: A maximum of three (3) webpages are allowed on any console design.

FIGURE 184. Global Call History Window
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Pop-up Webpage Setup Page. When the pop-up Webpage function is selected, the pop-up Webpage Setup page appears. 
See Figure 185.

Webpage URL Field

The Webpage URL field identifies the URL of the webpage to display in the pop-up window.

This field can contain up to 98 characters.

Refresh Interval Field

The Refresh Interval field identifies the amount of time that passes before the webpage displayed in the pop-up window is 
automatically refreshed. For example, if a radar weather map is displayed on the console operator’s window, an entry of 300 in 
this field automatically refreshes the radar image every five (5) minutes. A value of zero (0) indicates the webpage refreshes 
on C-Soft application startup.

The range for this field is 0 to 999 seconds.

Refresh when a Pop-up button is pressed Check Box

The Refresh when pop-up button is pressed check box indicates the webpage display is refreshed when the pop-up Webpage 
button is pressed.

To access the UI Element Setup window for a pop-up button, do the following:

1. Right-click the pop-up button.
A shortcut menu appears.

2. From the shortcut menu, select Properties.
The UI Element Setup window appears.

FIGURE 185. pop-up Webpage Setup Page—UI Element Setup
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Pop-up Window Control

The Pop-up Window Control function is used to add button(s) to a pop-up window. The pop-up window is one of the most 
versatile user interface options. pop-up windows can be used to group together similar line functions, pages, alerts, or any 
combination of button and slider controls. pop-up buttons can even be included within a pop-up window allowing for nested 
controls. When pop-up Window Control is selected from the UI Element Function drop down menu, the pop-up Window 
Setup page appears.

Allow window to be moved Check Box

The Allow window to be moved check box indicates the pop-up window can be moved in C-Soft Runtime. 

Open Window on Activity Check Box

The Open Window on Activity check box indicates the pop-up window automatically opens when activity is occurring 
within the pop-up window. 

Window Background Color Drop Down Menu

The Window Background Color drop down menu is used to set a background color for the pop-up window.

FIGURE 186. pop-up Window Setup Page
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UI Element Setup Window—Add Text

The Add Text option opens the Font window, shown in Figure 187.

NAVIGATION: Select Insert|Add Text from the menu bar.

Font Window

The Font window is used to add descriptive text to the console window or to a pop-up window. The Font window includes 
standard options for Font, Font Style, Size, and Color formatting. When you change the format, a preview of the text appears 
in the sample field. 

NOTE: Generally, it is a good idea to select generic fonts like Arial and Times Roman for console layouts. Otherwise the 
designer must ensure the selected fonts are installed on the computer running C-Soft Runtime.

For more information, see “User Interface Element Manipulation” on page 61.

Horizontal Check Box

The Horizontal check box indicates the text is displayed on the console window in a horizontal orientation. If not selected, the 
text is displayed vertically.

Enter Text Field

The Enter Text field identifies the text to place on the console window.

This field can contain up to 50 characters.

OK Button

The OK button saves the entries and closes the window.

Cancel Button

The Cancel button clears any entries made and closes the window.

FIGURE 187. Font Window
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UI Element Setup Window—Add Clock

The Add Clock option inserts a clock on the console. The time and button format are controlled with the Clock Control page.

While in C-Soft Runtime, the clock displays as configured. An example is shown in Figure 188.

To insert a clock button, do the following:

 > From the menu bar, select Insert|Add Clock.
A clock button appears on the console.

Clock Control Page

The Clock Control page, shown in Figure 189, appears when the clock button is right-clicked. 

FIGURE 188. Console Clock Example

FIGURE 189. Clock Control Page
Bosch Security Systems, Inc. Administrator’s Guide F.01U.218.561 Rev 03



C-Soft Administrator’s Guide C-Soft Designer Program  349
Time Format Group Box

12 Hour Radio Button

The 12 Hour radio button indicates the time displays in civilian time format. 

24 Hour Radio Button

The 24 hour radio button indicates the time displays in military time format. 

Appearance Group Box

Background Color Drop Down Palette

The Background Color drop down palette is used to set the button’s background color. 

Border Color Drop Down Palette

The Border Color drop down palette is used to set the button’s border color. 

Test Color Drop Down Palette

The Text Color drop down palette is used to set the button’s text color.

Border Thickness Field

The Border Thickness field is used to set the button’s border thickness.

The range for this field is 0 to 20.

Set Font Button

The Set Font button is used to open the font window.

Font Window

The Font window, shown in Figure 190, indicates the font used to display the time on the clock button display. The font 
window includes standard options for Font, Font Style, and Size. When you change the format, a preview of the text appears in 
the Sample field.

NOTE: It is recommended to select generic fonts like Arial and Times Roman for console layouts. Otherwise, the 
designer must ensure the selected fonts are installed on the computer running C-Soft Runtime.
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Time Source Group Box

Use Local Computer Time Check Box

The Use Local Computer Time check box indicates the time that displays on the clock button is derived from the PC running 
C-Soft. Otherwise, an offset time must be selected from the Time Offset drop down menu.

Time Offset Drop Down Menu

The Time Offset drop down menu is used to select an offset time for the clock. The Use Local Computer Time check box 
must be cleared for this field to be active.

Available selections for this field are: 

FIGURE 190. Font Window—Clock Control

GMT-12:00 GMT-11:00 GMT-10:00 GMT-09:00 GMT-08:00 GMT-07:00

GMT-06:00 GMT-05:00 GMT-04:00 GMT-03:30 GMT-03:00 GMT-02:00

GMT-01:00 GMT GMT+01:00 GMT+02:00 GMT+03:00 GMT+03:30

GMT+04:00 GMT+04:30 GMT+05:00 GMT+05:30 GMT+05:45 GMT+06:00

GMT+06:30 GMT+07:00 GMT+08:00 GMT+09:00 GMT+09:30 GMT+10:00

GMT+11:00 GMT+12:00 GMT+13:00
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Date Format Drop Down Menu

The Date Format drop down menu is used to select the display format for the console clock. The console clock displays in the 
selected format.

Available selections for this field are:

Selection Console Clock Display Format

None No clock appears on the console

Wednesday, March 17, 2010 Day of the Week, Month Day, Year (4-digit)

Wednesday March 17 Day of the Week Month Day

Wed March 17 Day of the Week Abbreviated Month Day

Wednesday Mar 17 Day of the Week Month Abbreviated Day

March 17, 2010 Month Day, Year (4-digit)

Mar 17, 2010 Month Abbreviated Day, Year (4-digit)

17-Mar-2010 Day-Month Abbreviated-Year (4-digit)

17-Mar-10 Day-Month Abbreviated-Year (2-digit) 

March 17 Month Day

03/17/10 dd/mm/yy

03/17/2010 mm/dd/yyyy

17/03/2010 dd/mm/yyyy

17.03.2010 dd.mm.yyyy

2010-03-17 yyyy-mm-dd

17 March 2010 Day Month Year (4-digit)

17 Mar 2010 Day, Month Abbreviated, Year (4-digit)

2010 March 17 Year (4-digit) Month Day

2010 Mar 17 Year (4-digit), Month Abbreviated Day
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UI Element Setup Window—Add VU Meter

The Add VU Meter option inserts a VU Meter on the console. The button format and color are controlled with the VU Meter 
Control page.

To insert a VU Meter button, do the following:

 > From the menu bar, select Insert|Add VU Meter.
A VU Meter button appears on the console.

To insert a VU Meter button, do the following:

 > From the menu bar, select Insert|Add VU Meter.
A VU Meter button appears on the console.

VU Meter Control Page

The VU Meter Control page, shown in Figure 191, is where the button format and color are configured.

To access the VU Meter Control page, do the following:

1. Right-click the VU Meter button.
A shortcut menu appears.

2. From the shortcut menu, select Properties.
The UI Element Setup window appears.

Orientation Group Box

Horizontal Radio Button

The Horizontal radio button indicates the VU Meter Control is in the horizontal position on the console

Vertical Radio Button

The Vertical radio button indicates the VU Meter Control is in the vertical position on the console.

VU Meter Background Color Drop down Menu

The VU Meter Background Color drop down menu is used to select the VU Meter background color.

FIGURE 191. VU Meter Control Page
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UI Element Setup Window—Add Frame

The Add Frame option inserts a Frame on the console. The button format and color are controlled with the Frame Setup page.

To insert a Frame button, do the following:

 > From the menu bar, select Insert|Add Frame.
A Frame button appears on the console.

Frame Setup Page

The Frame Setup page, shown in Figure 189, appears when the Frame button is right-clicked on the edge of the frame.

Border Width Field

The Border Width field is used to enter the border width of the frame.

The range for this field is 0 to 20.

Border Color Field

The Border Color field is used to select the border color of the frame.

FIGURE 192. Insert/Add Frame from Insert Drop Down Menu

FIGURE 193. Frame Setup Page
Bosch Security Systems, Inc. Administrator’s Guide F.01U.218.561 Rev 03



354  C-Soft Designer Program C-Soft Administrator’s Guide
Use Bitmap Check box

The Use Bitmap check box enables the Browse button.
The Frame changes into a bitmap that is selected when the Browse button is clicked.

UI Element Setup Window—Add Frequency Control

The Frequency Control

The Frequency Control is used to change the frequency on a line. When a frequency is changed, a burst of packets is sent 
onto the Ethernet network requesting the remote radio to change to the new frequency of the selected line. Additionally, all 
other consoles on the network must change to display the new frequency of the radio on that particular line.

A Frequency Control is composed of two (2) buttons, (frequency up and frequency down) and the current frequency display 
area. 

The Frequency Control automatically contains all frequencies configured for the line, except for frequencies configured for 
Pair Mode and are non-transmittable.

For more information, see “Freqs Button” on page 72.

Frequency Down Button

The Frequency Down button is used to select the previous configured frequency. 

Frequency Up Button

The Frequency Up button is used to advance to the next configured frequency. 

FIGURE 194. Use Bitmap Check Box

FIGURE 195. Frequency Control
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Current Frequency Display

The Current Frequency display displays the active frequency on the line associated to the frequency control. The selected 
frequency can be changed by either; clicking the Frequency Down or Frequency Up buttons, or by clicking on the Current 
Frequency Display area and selecting a frequency from a drop down list.

A Frequency change packet is sent from C-Soft each time the Frequency Down or Frequency Up button is clicked. 

To scroll through the available frequencies, do the following:

 > Press and hold the Frequency Down or Up buttons. 
The Frequency Control begins cycling through the available frequencies on the configured line. 

To select a frequency while scrolling, do the following:

 > Release the Frequency Up or Down button when the desired frequency is visible.

To select a frequency from the drop down list, do the following:

1. Click the Current Frequency Display area. 
A drop down menu containing all available frequencies are displayed. Frequencies are displayed in ascending 
numeric order starting at Frequency 1.

2. From the drop down menu, select the desired frequency.

When Scannable is selected for the line, right-click the frequency control to display a shortcut menu that provides the console 
operator the ability to add or remove the currently selected frequency from the scan list. 

When a frequency is in the scan list, the  icon appears next to the frequency in the Frequency Display area and in the 
Frequency drop down list. Parallel consoles are also alerted to update their display if a frequency is added or removed from the 
scan list.

For more information see “Scannable Check Box” on page 71.

Add Frequency Control

The Add Frequency Control function inserts a Frequency Control on the console. The button format and color are controlled 
with the Frequency Control page.

To insert a frequency control button, do the following:

 > From the menu bar, select Insert|Add Frequency Control.
A Frequency Control button appears on the console.

FIGURE 196. Frequency Control Drop Down
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Colors Page. The Colors page, shown in Figure 197, is used to select the settings for the Orientation, Arrow Button Settings, 
and Text settings. 

Orientation Group Box

The Orientation group box specifies whether the Frequency Up and Down buttons are placed to the left and right of the 
control or the top and bottom of the control.

Horizontal Radio Button

The Horizontal radio button indicates the Frequency Up and Down buttons are drawn to the right and left of the frequency 
display area.

Vertical Radio Button

The Horizontal radio button indicates the Frequency Up and Down buttons are drawn to the top and bottom of the frequency 
display area.

Border	Color	Group	Box

Border Color Drop Down Menu

The Border Color drop down menu displays the color of the border around the frequency control. The border color can be 
changed by opening the palette with the drop down menu to select the desired color. The button border is half of the grid size 
on the console window. The button border being half the size of the grid size allows UI Elements with the same color border to 
be grouped together, or to help create a visual separation between groups of buttons.

FIGURE 197. Colors Page - UI Element Setup

FIGURE 198. Frequency Control in the Horizontal Orientation

FIGURE 199. Frequency Control in the Vertical Orientation
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Arrow Button Settings Group Box

The Arrow Button Settings group box contains settings which control the appearance of the Frequency Up and Down 
buttons. 

Button Size Field

The Button Size field sets the height (if the orientation is set to vertical) or width (if the orientation is set to horizontal) of the 
Frequency Up and Down buttons The button size field allows for a larger drop down button to accommodate users of touch 
screen monitors. 

The Range for this field is 10 to 200. 
Default value is 17. 

Up Color Drop Down Menu

The Up Color drop down menu displays the color of the button when it is available for selection (Button Up). The button 
colors can be changed by selecting the drop down menu to open a color palette.

Down Color Drop Down Menu

The Down Color drop down menu displays the color of the button when it is selected (Button Down). The button colors can 
be changed by selecting the drop down menu to open a color palette.

Arrow Color Drop Down Menu

The Arrow Color drop down menu displays the color of the arrow in the drop down button. The arrow color can be changed 
by opening the palette with the drop down menu to select the desired color. 

Text	Settings	Group	Box

The Text Settings group box properties control the appearance of the Frequency Display area and the Frequency drop down 
list.

Background Color Drop Down Menu

The Background Color drop down menu displays the background color of the Frequency Display area and Frequency drop 
down list. The background color can be changed by selecting the drop down menu to open a color palette.

Text Color Drop Down Menu

The Text Color drop down menu displays the color of the text in the Frequency Display area and Frequency drop down list. 
The text colors can be changed by selecting the drop down menu to open a color palette.

Set Font Button

The Set Font button displays a Font window used to select the text attributes for the Frequency Display area and Frequency 
drop down list.

OK Button

The OK button saves the entries and closes the window.
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Frequency Control Page. The Frequency Control page, shown in Figure 200, is used to select the Frequency List Settings 
and the Scrolling Settings.

Frequency List Settings Group Box

The Frequency List group box properties control the appearance and the display location of the Frequency drop down list. 
The Frequency List appears when the user clicks the Frequency Display area and disappears when either a frequency has been 
selected or the user has clicked on another control.

Drop	Down	Direction	Radio	Buttons

The Drop Down Direction group box is used to select the direction the drop down list containing the list of available 
frequencies is displayed relative to the frequency control. 

Above Radio Button

The Above radio button indicates the drop down list is displayed above the frequency control.

Below Radio Button

The Below radio button indicates the drop down list is displayed below the frequency control.

Left Radio Button

The Left radio button indicates the drop down list is displayed to the left of the frequency control.

Right Radio Button

The Right radio button indicates the drop down list is displayed to the right of the frequency control.

FIGURE 200. Frequency Control Page - UI Element Setup
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Entry Spacing Field

The Entry Spacing field is used to enter the amount of space in pixels between individual entries in the drop down list. The 
valued entered for Entry Spacing and the font type determine the height of the individual entries in the drop down list. When 
using a touch screen monitor the entry spacing value can be increased to allow individual entries to be selected from a touch 
screen.

The range for this field is 0 to 99.
The default value for this field is 8.

Visible Entries Field

The Visible Entries field is used to enter the number of frequencies visible in the drop down list without scrolling. 

The range for this field is 1 to 99.
The default value for this field is 10.

Scrolling Settings Group Box

Scrollbar Width Field

The Scrollbar Width field is used to set the width in pixels of the scrollbar in the drop down list.

The range for this field is 1 to 99.
The default value for this field is 17. 

Minimum Slider Size Field

The Minimum Slider Size field is used to set the minimum height of the scrollbar’s thumbtack slider in the drop down list. 
The thumbtack slider is sized proportionally to the total number of entries in the list and the number of entries which are 
displayed. The minimum slider size ensures the scrollbar will always be as large as the entered value.

The range for this field is 1 to 99.
The default value for this field is 17.

Initial Delay Field

The Initial Delay field is used to set the number of milliseconds a Frequency Up or Down button must be held down before 
the frequency control begins scrolling through the available frequencies. The larger the value, the longer the Frequency Up or 
Down buttons must held before scrolling begins.

The range for this field is 10 to 9999.
The default value for this field is 500.

Repeat Delay Field

The Repeat Delay field is used to set the number of milliseconds between frequency changes once the Frequency Control 
begins scrolling. The larger the value, the slower the Frequency Control will cycle though the available Frequency List.

The range for this field is 10 to 9999.
The default value for this field is 100.
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View Menu

The View menu contains commands used to change the window view.

Toolbar Toggle

The Toolbar toggle indicates whether the toolbar is visible or not.

• If the toolbar is toggled on (selected), the toolbar is visible on the console window. 

• If the toolbar is toggled off (not selected), the toolbar is not visible on the console window.

Status Bar Toggle

The Status Bar toggle indicates whether the Status bar is visible or not. 

• If the Status Bar is toggled on (selected), the status bar is visible on the console window. 

• If the Status Bar is toggled off (not selected), the status bar is not visible on the console window.

About C-Soft Designer

The About C-Soft Designer window is used to view C-Soft version information, Bosch’s mailing address and website URL, 
and the pop-up button count for the current file.

NAVIGATION: Select Help|About C-Soft Designer.
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CHAPTER 5

C-Soft Runtime Program
C-Soft Runtime

Once the design is created and saved, the C-Soft Designer program generates a file read by the C-Soft Runtime program. The 
C-Soft Runtime software does the actual IP communications with the other radio elements available on the network. The
C-Soft Console appears when the C-Soft Runtime program is opened.

A hardware security key must be installed in the USB port or parallel port of the computer to run the full version of the C-Soft 
Runtime program. When a hardware security key is not installed, the console design can be tested in Demo mode. 

To run CSoftDesinger in Demo mode, do the following:

1. Double-click the C-Soft Runtime desktop shortcut.
The Key Read Error window appears.

2. Click the Demo button to open the file.
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C-Soft Console

The C-Soft Console opens to the configuration stored in the default file. If no default file is specified by the user, the Set 
Default .Veg File window appears.

Alternatively, any .veg file can be double-clicked to open the C-Soft Console. In this case, the Set Default Veg File window 
does not appear.

Set Default Veg File Window

The Set Default Veg File window is used to locate and set the default .veg file that opens when C-Soft Runtime is opened. 
This window appears the first time C-Soft Runtime is opened or when the default .veg file is reset to none. For more 
information, see “Reset Default .Veg File” on page 366.

To set the default .veg file, do the following:

1. Double-click the CSoft Runtime shortcut installed on your desktop during C-Soft installation.
The Set Default .Veg File window appears. 

2. Browse to the .veg file created in CSoft Designer.

3. Select the .veg file.

4. Click Open. 
The default file is set to the selected configuration and C-Soft Runtime opens.
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Example Console

When the C-Soft Runtime program is started, the C-Soft Console displays the console design. A six (6) line console design, 
along with several other user interface elements is shown in Figure 201.

The Title Bar contains the C-Soft Console label and is used to access a drop down menu. For more information, see “C-Soft 
Console Title Bar Drop Down Menu” on page 364.

The status bar, located directly below the title bar, is divided into seven (7) panes providing different status information. From 
left to right, these panes display: text messages, the IR playback position, the NENA on an ADHB-4, the connected ADHB-4, 
the PTT status, the VU meter, and the current time, as set on the computer clock.

FIGURE 201. C-Soft Console Window
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C-Soft Console Title Bar Drop Down Menu

The C-Soft Console Title Bar drop down menu is used to set the window size, find the current C-Soft version, and set the 
default .veg file. 

To open the title bar drop down menu, do the following:

 > Right-click the Title Bar to open the drop down menu. 
If the current window is maximized, the menu shown in Figure 202 appears. 

Restore

Restore is used to restore the window to the last-set window size.

To shrink the window to the size last set by the console operator, do the following:

1. Right-click the title bar.
The Title Bar drop down menu appears.

2. Click Restore.
The window is restored.

Move

Move is used to the move window. This option is not available (grayed out) if the window is maximized. 

NOTE: The window can also be sized when the move cursor is active. 

To move the window, do the following:

1. Right-click the title bar. 
The Title Bar drop down menu appears.

2. Click Move.
The Move cursor appears.

3. Click and hold the title bar.

4. Drag the window into place.

FIGURE 202. C-Soft Console Title Bar Drop Down Menu—Minimize
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Size

Size is used to change the height and/or width of the window. This option is not available (grayed out) if the window is 
maximized.

NOTE: The window can also be moved when the size cursor is active. 

To size the window, do the following:

1. Right-click the title bar.
The Title Bar drop down menu appears.

2. Click Size.
The Size cursor appears. 

3. Click and hold the cursor on the edge of the window.
The cursor changes.

4. Drag the window to the desired size. 

Minimize

Minimize is used to shrink the window to a minimized icon on the taskbar. 

NOTE: If the current view is already minimized, this selection is grayed out.

Maximize

Maximize is used to change the window to full screen view. 

NOTE: If the current view is already maximized, this selection is grayed out.

Close

Close is used to close the C-Soft Runtime program.

About C-Soft Runtime...

About C-Soft Runtime... is used to open the about C- Soft Runtime window.

This window contains the following information:

Version

Telex’s address

Sales Support Phone Number

Website Address
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Reset Default .Veg File

Reset Default .Veg File is used to change the default file to none. When reset, and C-Soft Runtime is opened, the Set Default 
Veg File window appears. 

To reset the default file to none, do the following:

1. Right-click the title bar.
The Title Bar drop down menu appears. 

2. Select Reset Default Veg File.
The default file is set to none.

Set Default .Veg File

Set Default .Veg File is used to set the current configuration as the default file. When a .veg file is double-clicked C-Soft 
Runtime opens to the selected configuration. This configuration can be set as the default file.

To set the current C-Soft Console configuration as the default .veg file, do the following:

1. Right-click the Title Bar menu.
The Title Bar drop down menu appears.

2. Select Set Default Veg File. 
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Window Sizing

By default, the C-Soft Runtime program window fills the entire monitor window. However, this may not be acceptable for a 
single monitor system, when only a small monitor is available, or if the console operator views the software on a 
multi-monitor computer. In these cases, the size of the console window can be changed to match the size of the console 
operator’s monitor window.

When the C-Soft Runtime program starts it looks for the file cposi.txt. This file is created each time the C-Soft Runtime 
program is closed. The cposi.txt file records the size and position of the C-Soft Runtime program window. In addition to 
storing the position information, the cposi.txt file also stores the console state at shutdown. This includes information such as 
the selected channels, mute states, volumes, channel frequencies, and the entries in the call log (without the IRR audio). Since 
the cposi.txt file does not exist the first time the C-Soft Runtime program is started, the C-Soft Runtime window fills the entire 
screen.

NOTE: If one (1) console design is closed and a different console design is started, the states do not match.

To change the size of the program window, do the following:

1. Ensure the following fields are selected, see “Window Controls Check Boxes” on page 117 for details.

• Allow Minimize

• Allow Maximize

• Allow Resize

• Allow Close

NOTE: For more information, see “Save Runtime Status on Close Check Box” on page 117.

TIP: If this is an existing design, verify these controls are enabled for the design. If they are not, select 
the Windows controls listed above, and then proceed to the next step.

2. Save the designer file (.veg).

3. Open the .veg file you just saved.

4. Resize and position the console window, as desired.
The elements on the window do not rescale to fit the window size and some may be hidden from view when the 
window is resized. This step is only to create the size and position of the window. The next time the console window is 
opened, all of the elements on the console window are automatically scaled to fit the console window by the C-Soft 
Runtime program.

5. Close the C-Soft Runtime program when the console window is set to the desired size and position.
The cposi.txt file is created by the program is when it is closed

6. Open the .veg file.
The window opens using the last location and size with the buttons, sliders, VU Meter, and clock in the correct 
locations. 

7. If the console display needs further adjustment, repeat the above steps until the console window is the desired size.
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APPENDIX A

Telex Tone Group Numbers and Paging
Plans
Telex Tone Group Numbers 

TABLE 7. Telex Tone Group Numbers (1–7)

Telex Group No. 1 2 3 4 5 6 7

Tone Group Mot 1 Mot 2 Mot 3 Mot 4 Mot 5 Mot 6 Mot A

0 330.5 569.31 1092.4 321.7 553.9 1122.5 358.9

1 349.0 600.9 288.5 339.6 584.8 1153.4 398.1

2 368.5 634.5 296.5 358.6 617.4 1185.2 441.6

3 389.0 669.9 304.7 378.6 651.9 1217.8 489.8

4 410.8 707.3 313.0 399.8 688.3 1251.4 543.3

5 433.7 746.8 953.7 422.1 726.8 1285.8 602.6

6 457.9 788.5 979.9 445.7 767.4 1321.2 668.3

7 483.5 832.5 1006.9 470.5 810.2 1357.6 741.3

8 510.5 879.0 1034.7 496.8 855.5 1395.0 822.2

9 539.0 928.1 1063.2 524.6 903.2 1433.4 912.0

Diagonal 569.1 979.9 569.1 569.1 979.9 979.9 979.9
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TABLE 8. Telex Tone Group Numbers (8–15)

Telex Group No.
8 9 10 11 12 13 14 15

Tone Group Mot B Mot Z GE A’ GE B’ GE C’ Mot 10 Mot 11 Custom

0 371.5 346.7 682.5 652.5 667.5 1472.9 1930.2 1034.9

1 412.1 384.6 592.5 607.5 712.5 1513.5 1989.0 953.9

2 457.1 426.6 757.5 787.5 772.5 1555.2 2043.8 0

3 507.0 473.2 802.5 832.5 817.5 1598.0 2094.5 0

4 562.3 524.8 847.5 877.5 862.5 1642.0 2155.6 0

5 623.7 582.1 892.5 922.5 907.5 1687.2 2212.2 0

6 691.8 645.7 937.5 967.5 952.5 1733.7 2271.7 0

7 767.4 716.1 547.5 517.5 532.5 1781.5 2334.6 0

8 851.1 794.3 727.5 562.5 577.5 1830.5 2401.0 0

9 944.1 881.0 637.5 697.5 622.5 1881.0 2468.2 0

Diagonal 979.9 979.9 742.5 742.5 742.5 None None None

Tone and Gap Durations for Standard Paging Plans

TABLE 9. Tone and Gap Durations for Standard Paging Plans

Tone #1 (ms) Gap (ms) Tone #2 (ms) Group Call (ms) Type

1000 - 3000 8000 GE std, Mot std Tone 
and Voice

400 0 800 8000 Mot Tone Only

1000 0 3000 6000 NEC-B

1000 300 3000 6000 NEC-A

1000 0 1000 4000 NEC-C

400 0 800 4000 NEC-M

500 0 500 3000 NEC-L

400 0 400 3000 NEC-D
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2 Tone 1000 Plan Numbers
2 Tone 1000 Plan Numbers

TABLE 10. 2 Tone 1000 Plan Numbers (1-9)

Telex Code Plan # 1 2 3 4 5 6 7 8 9

Pager Capcodes Mot A Mot C Mot D Mot E Mot F Mot G Mot H Mot J Mot K

0xx 2+4 N/A N/A N/A N/A N/A N/A N/A N/A

1xx 1+1 1+1 1+1 1+1 1+1 1+1 1+1 1+1 1+1

2xx 2+2 2+2 2+2 2+2 1+3 1+3 1+3 1+4 1+4

3xx 3+3 1+2 1+2 1+2 3+3 3+3 3+3 4+1 4+1

4xx 1+2 4+4 1+5 2+1 4+4 3+1 3+1 4+4 4+4

5xx 1+3 1+4 5+5 1+6 3+1 5+5 1+6 5+5 1+6

6xx 2+1 2+1 2+1 6+6 1+4 1+5 6+6 1+5 6+6

7xx 3+1 4+1 5+1 6+1 4+1 5+1 6+1 4+5 6+1

8xx 2+3 2+4 2+5 2+6 3+4 3+5 3+6 5+4 4+6

9xx 3+2 4+2 5+2 6+2 4+3 5+3 6+3 5+1 6+4
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2Tone 1000 Plan Numbers (10–17)

Telex Code Plan # 10 11 12 13 14 15 16 17

Pager Capcodes Mot L Mot M Mot N Mot P Mot Q Mot R Mot S Mot T

0xx N/A 4+2 4+2 4+2 4+2 4+2 4+2 4+2

1xx 1+1 2+3 2+3 2+3 2+4 2+4 2+5 3+4

2xx 1+5 2+2 2+2 2+2 2+2 2+2 2+2 4+3

3xx 5+1 3+3 3+3 3+3 4+2 4+2 5+2 3+3

4xx 1+6 4+4 3+2 3+2 4+4 4+4 2+6 4+4

5xx 5+5 3+2 5+5 2+6 5+5 2+6 5+5 5+5

6xx 6+6 2+4 2+5 6+6 2+5 6+6 6+6 3+5

7xx 6+1 4+2 5+2 6+2 4+5 6+2 6+2 4+5

8xx 5+6 3+4 3+5 3+6 5+4 4+6 5+6 5+4

9xx 6+5 4+3 5+3 6+3 5+2 6+4 6+5 5+3

TABLE 11. 2 Tone 1000 Plan Numbers (18–25)

Telex Code Plan # 18 19 20 21 22 23 24 25

Pager Capcodes Mot U Mot V Mot W Mot Y Mot MT GE X GE Y GE Z

0xx 4+2 4+2 4+2 N/A 4+2 10+10 11+11 10+10

1xx 3+4 3+5 4+6 7+7 1+1 11+10 12+11 12+10

2xx 4+3 5+3 6+4 8+8 2+2 11+11 12+12 12+12

3xx 3+3 3+3 5+6 9+9 1+2 10+11 11+12 10+12

4xx 4+4 3+6 4+4 7+8 4+4 12+12 N/A N/A

5xx 3+6 5+5 5+5 7+9 5+5 12+10 N/A N/A

6xx 6+6 6+6 6+6 8+7 2+1 12+11 N/A N/A

7xx 6+3 6+3 4+5 9+7 4+5 10+12 N/A N/A

8xx 4+6 5+6 5+4 8+9 5+4 11+12 N/A N/A

9xx 6+4 6+5 6+5 9+8 2+4 N/A N/A N/A
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Supported Tone Frequencies
Supported Tone Frequencies

TABLE 12. Telex Supported Tone Frequencies
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TONE 0 0 2400 2400 815 2400 2200 2200 1981 1981 1981 1981 979.8 1633 600 637.5

TONE 1 1 1060 1060 882 1060 970 970 1124 1124 1124 1124 903.1 631 741 787.5

TONE 2 2 1160 1160 954 1160 1060 1060 1197 1197 1197 1197 832.5 697 882 937.5

TONE 3 3 1270 1270 1032 1270 1160 1160 1275 1275 1275 1275 767.4 770 1023 1087.5

TONE 4 4 1400 1400 1117 1400 1270 1270 1358 1358 1358 1358 707.4 852 1164 1237.5

TONE 5 5 1530 1530 1209 1530 1400 1400 1446 1446 1446 1446 652.0 941 1305 1387.5

TONE 6 6 1670 1670 1308 1670 1530 1530 1540 1540 1540 1540 601.0 1040 1446 1537.5

TONE 7 7 1830 1830 1415 1830 1670 1670 1640 1640 1640 1640 554.0 1209 1587 1687.5

TONE 8 8 2000 2000 1531 2000 1830 1830 1747 1747 1747 1747 510.7 1336 1728 1837.5

TONE 9 9 2200 2200 1657 2200 2000 2000 1860 1860 1860 1860 470.8 1477 1869 1987.5

GROUP
TONE

A 2800 885 1939 970 825/
885

825 2400 1050 1055 2151

B 810 810 2270 810 740 886 930 930 930 2292

RESET
TONE

C 970 740 2098 2800 2600 2600 2247 2400 2247 2010

D 885 680 2457 885 885 856 991 2110 991 991 2292

REPEAT
TONE

E 2600 970 1792 2600 2400 2400 2110 2400 2110 2110 1062.9 1805 459 487.5

F 680 2600 680 680 1055 2400 1995 1091 1995 1091
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APPENDIX D

Echo Packets Diagram
Echo Packets Diagram

FIGURE 203. Echo Packets Diagram
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APPENDIX E

P25-DFSI (Digital Fixed Station Interface)
P25-DFSI C-Soft Architecture

A C-Soft console can be configured for two (2) different types of system architectures; a stand alone console, or a 
Client/Server console. 

A Stand Alone Console is defined as a single console connection to n (where n is the number of repeaters or Fixed Stations).

A Client/Server console is defined as multiple consoles connected to a server console which is connected to n (where n is the 
number of repeaters or Fixed Stations). 

A Stand Alone Console is a simple configuration, requiring the least amount of setup time. See Figure 204.

FIGURE 204. Stand Alone Console Configuration
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If more than one (1) console operator is controlling the fixed stations, a Client/Server configuration should be used. See 
Figure 205. One (1) console is setup as a server, two (2) consoles are setup as clients and one (1) console is setup as a client 
console providing back up to the main server console. 

IMPORTANT: There is no special software needed between consoles. Any C-Soft console can be configured as a Stand 
Alone, Server, Client or Backup console via user setting in C-Soft designer.

FIGURE 205. Server/Client Console Configuration
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P25 DFSI Global Setup Window

The P25 DFSI Global Setup window, shown in Figure 206, is used to determine what type of console is required for the 
system. 

For example, if you require a stand alone system, then you have only one (1) console, and an equal number of lines to base 
stations in your system. Only one (1).veg file needs to be created with the global console type set to stand alone.

If you require a client/server system, you must create one (1). veg file with a global console type set to server and a second 
.veg file with the console type set to client or client and backup server console.

IMPORTANT: Each Client console has a unique Console ID, therefore, it is required to have a different veg file for 
each console position in the system.

NOTE: The parameters on this page affect all line types set to P25-DFSI. 

A Console ID must first be added. See Figure 206. This ID is used by the individual radios to make Private Calls with the 
console. This ID shows up as the radio ID when implementing a PTT from the console.

The P25 DFSI Global Values window can be opened one (1) of two (2) ways:

• From the Edit menu.

• From the Edit Global DFSI Parameters window.

FIGURE 206. P25 DFSI Global Setup Window
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To set up P25 DFSI Global Values, do the following:

 > From the Edit menu, select Setup P25-DFSi.
P25 DFSI Global Setup window appears.

Console Type Group Box

The Console Type group box is used to make a selection between Stand Alone Console, Server Console, Client Console and 
Client and Backup Server Console.

Stand Alone Radio Button

The Stand Alone radio button indicates one (1) console is used.

Server Console Radio Button

The Server Console radio button indicates multiple consoles are used.

NOTE: Only one (1) server per system.

Client Console Radio Button

The Client Console radio button indicates the C-Soft Console is connected with a Server Console.

Client & Backup Server Console Radio Button

The Client & Backup Server Console Radio Button indicates a Server is already setup and a backup Server is needed, in case 
the server computer goes down. 

NOTE: Only one (1) Backup Server per system.

Console ID Field

The Console ID field is used to enter the ID of the console. This ID is used by the individual radios to make Private Calls with 
the console, and appears as the radio ID when implementing a PTT from the console.

Backup Server Ping Address Group Box

The Backup Server Ping Address group box is used for communication between all C-Soft Consoles to determine if the 
Server is operational or if the Server is down. 

IP Field

The IP field is a multicast address. It is used for communication between all the C-Soft Consoles to determine if the primary 
server is operational or is down. IP field number is the same among all of the consoles in the system.

Port Field

The Port field is a multicast port. It used for communication between all the C-Soft Consoles to determine if the primary 
server is operational or is down. The Port field number is the same among all of the consoles in the system.
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Heartbeats Group Box

The Heartbeats group box is used to configure a Fixed Station Heartbeat Time, a Host Heartbeat Time, and the Number of 
Missed Heartbeats Allowed.

Fixed Station Heartbeat Time Field

The Fixed Station Heartbeat Time field indicates the time, in seconds, the fixed station sends heartbeats to the C-Soft 
Console. This field is only enabled if the console type is set to Server Console or Client & Backup Server Console mode.

The range for this field is 5 to 255.

The default is 30.

Host Heartbeat Time Field

The Host Heartbeat Time field indicates the time, in seconds, the C-Soft Console sends heartbeats to the fixed station. This 
field is only enabled if the console type is set to Server Console or Client & Backup Server Console mode.

The range for this field is 5 to 255.

The default is 30.

Number of Missed Heartbeats Allowed Field

The Number of Missed Heartbeats Allowed field indicates the number of missed heartbeats from the Fixed Station before 
C-Soft terminates communication with the fixed station and tries to connect again.

The range for this field is 0 to 5.

The default is 2.

Radio/Repeater Control Signals Group Box

The Radio/Repeater Control Signals group box is used to configure the number of control retries and the wait time between 
retries from the server to establish contact with the radio.

Number of Control Retries Field

The Number of Control Retries field indicates the number of times a control command is sent if no acknowledgment is 
received.

The range for this field is 0 to 5.

The default is 3.

Control Retry Time

The Control Retry Time field indicates the time, in ms, C-Soft waits before sending the same control command.

The range for this field is 500 to 1000.

The default is 600.
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Packet Controls Group Box 

The Packet Controls group box is used to set the packet delay for the C-Soft Console.

Control Packet Delay Field

The Control Packet Delay field is used to enter a value that is multiplied by 20ms to set the delay between P25 DFSI Control 
Packets sent from C-Soft. This field is only enabled if the console type is set to Server Console or Client & Backup Server 
Console mode.

The range for this field is 0 to 99.

The default is 0.

Setting up a P25-DFSI Line Type

To set up a P25-DFSI Line Type, do the following:

1. From the Edit Window, select Setup Per Line Parameters.
The Per Line Parameters window appears.

2. From the Line Type drop down menu, select P25-DFSI.

3. Click the Signal Setup button.
The P25-DFSI Setup window appears.

NOTE: Below are four (4) examples of how a console can be configured, depending the Console Type selected in P25 
DFSI Global Setup window (i.e. Stand Alone, Server or Client). See Figure 206.

Console Type SetUp 

The Console Type Setup is used to configure the console depending on the Console Type selected in P25 DFSI Global Setup 
window. 

Stand Alone Console

Stand Alone Console Type

The Stand Alone Console is the easiest console type to set up and should be the starting point for building a Client/Server 
system.

The three (3) parameters to be set up are:

• The Per Line IP connections which consist of the control Unicast Address of FS and the Voice Address 
of the FS.

• The channel numbers to a single base station.

• P25 manufacture.

FIGURE 207. P25-DFSI Line Type
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NOTE: The Control Port of FS must match the DFSI control port of the Base Station. The Voice Port of FS can be the 
same as, or different than the DFSI Voice Port of the base station.

The Signaling Parameters window, shown in Figure 208, is used to set up the per line IP connections and channel numbers to 
a single base station.

Fixed Station (FS) Connections Group Box

The Fixed Station (FS) Connections group box contains the Control Address of Fixed Station group box and the Voice 
Address of Fixed Station group box.

Control Address of Fixed Station Group Box

Control Unicast Address of FS Field

The Control Unicast Address of FS field is used to enter an IP Address of the P25 base station.

Control Port of FS Field

The Control Port of FS field is used to enter the port number of the P25 base station.

NOTE: The Control Port of FS field must match the DFSI Control Port of the base station.

The range for this field is 1054 to 65536.

FIGURE 208. P25-DFSI Setup-Stand Alone Console
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Voice Address of Fixed Station Group Box

Voice IP Address of FS Field

The Voice IP Address of FS field is used to enter the voice IP address of the P25 base station.

Voice Port of FS

The Voice Port of FS field is used to enter the unique port number of the P25 base station.

The range for this field is 1054 to 65536.

Backup Enabled Check Box

The Backup Enabled check box enables the backup FS setup button. It is used when the system needs to have a secondary 
P25 base station for backup in the event the primary base station is down.

Backup FS Setup Window

The Backup FS Setup button opens the Backup Fixed Station Setup window.

To open the Backup Fixed Station Setup window, do the following:

1. Select the Backup Enabled check box. 

2. Click Backup FS Setup.
The Backup Fixed Station Setup window appears.

3. Configure your backup station.

NOTE: If connection is lost to a Fixed Station, C-Soft automatically switches to the Backup Fixed Station if Backup 
Enabled is selected.

4. Restart C-Soft to return to the original Fixed Station.

Control Address of Fixed Station Group Box

Control Unicast Address of FS Field

The Control Unicast Address of FS field is used to enter an IP Address of the P25 base station.
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Control Port of FS Field

The Control Port of FS field is used to enter the port number of the P25 base station.

NOTE: The Control Port of FS field must match the DFSI Control Port of the base station.

The range for this field is 1054 to 65536.

Voice Address of Fixed Station Group Box

Voice IP Address of FS Field

The Voice IP Address of FS field is used to enter the IP Address of the P25 base station.

Voice Port of FS

The Voice Port of FS field is used to enter the unique port number of the P25 base station.

The range for this field is 1054 to 65536.

P25 Manufacture Drop Down Menu

The P25 Manufacture drop down menu is used to select the manufacturer of the repeater. 

Available selections are:

Daniels

Tait

IMPORTANT: Since there may be small differences between radio designs, this field is important to insure C-Soft 
works correctly with the repeater.

Channel Setup Button

The Channel Setup button is used to open the DFSI Channel Table window. For more information, see “DFSI Channel Table” 
on page 395.

Edit Global DFSI Parameters Button

The Edit Global DFSI Parameters button is used to open the P25 DFSI Global Setup window, shown in Figure 206.
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Server Console

The Signaling Parameters window, shown in Figure 209, is used to set up the Server Console Configuration. The Fixed 
Station (FS) Connection portion of the window is the same as that for a Stand Alone Console. As in the case of the “Stand 
Alone Console”, one (1) line of the Server Console connects to one (1) base station. The difference between the Stand Alone 
and Server is the client(s) now connect and talk to the server on a per line basis in order to control and communicate with the 
base station connected to this line.

To change settings to a Server Console do the following:

1. From the menu bar, select Edit|Setup P25|DFSI.
The P25 DFSI Global Setup window appears.

2. In the Console Type group box, click the Server Console radio button.
Server Console will now the console for the system.

3. From the menu bar, select Edit|Setup Per Line Parameters.
The Per Line Parameters window appears.

4. With P25-DFSI selected in the Line Type drop down menu, click Signal Setup. 
The P25-DFSI Setup - Console configuration: Server Console window appears. 

Fixed Station (FS) Connections Group Box

The Fixed Station (FS) Connections group box contains the Control Address of Fixed Station group box and the Voice 
Address of Fixed Station group box.

FIGURE 209. P25-DFSI- Server Console
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Control Address of Fixed Station Group Box

Control Unicast Address of FS Field

The Control Unicast Address of FS field is used to enter an IP Address of the P25 base station.

Control Port of FS Field

The Control Port of FS field is used to enter the port number of the P25 base station.

NOTE: The Control Port of FS field must match the DFSI Control Port of the P25 base station.

The range for this field is 1054 to 65536.

Voice Address of Fixed Station Group Box

Voice IP Address of FS Field

The Voice IP Address of FS field is used to enter the IP Address of the P25 base station.

Voice Port of FS

The Voice Port of FS field is used to enter the voice port number of the P25 base station. The Voice Port of FS field must 
match the voice port number configured in Daniels P25 base station and unique for Tait P25 base station.

The range for this field is 1054 to 65536.

Backup Enabled Check Box

The Backup Enabled check box enables the backup FS setup button. 

Backup FS Setup Window

The Backup FS Setup button opens the Backup Fixed Station Setup window.

To open the Backup Fixed Station Setup window, do the following:

1. Select the Backup Enabled check box. 

2. Click Backup FS Setup.
The Backup Fixed Station Setup window appears.

3. Configure your backup station.

NOTE: If connection is lost to a Fixed Station, C-Soft automatically switches to the Backup Fixed Station, if Backup 
Enabled is selected.

4. Restart C-Soft to return to the original Fixed Station.
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Control Address of Fixed Station Group Box

Control Unicast Address of FS Field

The Control Unicast Address of FS field is used to enter an IP Address of the P25 base station.

Control Port of FS Field

The Control Port of FS field is used to enter the port number of the P25 base station.

NOTE: The Control Port of FS field must match the DFSI Control Port of the P25 base station.

The range for this field is 1054 to 65536.

Voice Address of Fixed Station Group Box

Voice IP Address of FS Field

The Voice IP Address of FS field is used to enter the IP Address of the P25 base station.

Voice Port of FS

The Voice Port of FS field is used to enter the voice port number of the P25 base station. The Voice Port of FS field must 
match the voice port number configured in Daniels P25 base station and unique for Tait P25 base station.

The range for this field is 1054 to 65536.

Server Connections Group Box

IP Address of this Computer Field

The IP Address of this Computer field cannot be modified. When a client is configured, it must connect to the IP Address of 
the PC the server console resides on.

Server Control Port Field

The Server Control Port field is used to enter the port number the client connects to the server and to control the base station/
radio functionality.

The range for this field is 1054 to 65536.

Server’s Voice Address Group Box

The Server’s Voice Address group box is used to configure the (MCA) Multicast Address and ports the server uses to 
communicate with the client and client consoles.

Rx MCA Field

The Rx MCA field is used to enter the receive Multicast Address used to receive P25 audio.
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Port Field

The Port field is used to enter the port number used to receive P25 audio.

The range for this field is 1054 to 65536.

Tx MCA Field

The Tx MCA field is used to enter the transmit Multicast Address used to transmit P25 audio.

Port Field

The Port field is used to enter the port number used to transmit P25 audio.

The range for this field is 1054 to 65536.

P25 Manufacture Drop Down Menu

The P25 Manufacture drop down menu is used to select the manufacturer of the repeater.

Available selections for this field are:

Daniels

Tait

IMPORTANT: Since there may be small differences between radio designs, this field is important to insure C-Soft 
works correctly with the repeater.

Channel Setup Button

The Channel Setup button is used to open the DFSI Channel Table window. For more information, see “DFSI Channel Table” 
on page 395.

The Channel Table window displays all of the channels open for a selected line.

Edit Global DFSI Parameters

The Edit Global DFSI Parameters button is used to open the P25 DFSI Global Setup window. For more information, see 
“P25 DFSI Global Setup Window” on page 379.

The P25 DFSI Global Setup window is used to select the type of console required for the system.
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Client Console

The Signaling Parameters window, shown in Figure 210, is used to set up the Client Console Configuration. Each client 
requires a different .veg file because of the console ID.

IMPORTANT: The server console must have the number of lines equal to the number of base stations; clients cannot 
directly access the base station without going through the server.

To change settings to a Server Console, do the following:

1. From the menu bar, select Edit|Setup P25|DFSI.
The P25 DFSI Global Setup window appears.

2. Select the Client Console radio button to make the console type a Client Console.

3. From the menu bar, select Edit|Setup Per Line Parameters.
The Per Line Parameters window appears.

4. From the Line Type drop down menu, select P25-DFSI.

5. Click Signal Setup.
The P25-DFSI Setup - Console configuration Client Console window appears.

Client Connections Group Box

The Client Connections group box is used to configure per-line signaling setup address fields.

FIGURE 210. P25-DFSI Client Console
Bosch Security Systems, Inc. Technical Manual F.01U.218.561 Rev 03



C-Soft Technical Manual   391
Control Address of Server Group Box.

Control Unicast Address of Server Field

The Control Unicast Address of Server field is used to enter the IP Address of the server PC.

Control Port of Server Field

The Control Port of Server field is used to enter the port address of the server control port for this line.

NOTE: The Port Address must match the value setting of the Server Control Port on the Server Console setup.

Voice Address of Server Group Box

Rx MCA Field

The Rx MCA field is used to enter the receive Multicast Address used to receive P25 audio.

Tx MCA Field

The Tx MCA field is used to enter the transmit Multicast Address used to transmit P25 audio.

P25 Manufacture Drop Down Menu

The P25 Manufacture drop down menu is used to select the manufacturer of the repeater.

Available selections for this field are:

Daniels

Tait

IMPORTANT: Since there may be small differences between radio designs this field is important to insure C-Soft 
works correctly with the repeater.

Channel Setup Button

The Channel Setup button is used to open the DFSI Channel Table window. For more information, see “DFSI Channel Table” 
on page 395.

The Channel Table window displays all of the channels open for a selected line.

Edit Global DFSI Parameters

The Edit Global DFSI Parameters button is used to open the P25 DFSI Global Setup window. For more information see 
“P25 DFSI Global Setup Window” on page 379.

The P25 DFSI Global Setup window is used to select the type of console required for the system.
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Client Console with Server Backup

The Signaling Parameters window, shown in Figure 211, is used to set up the Server Console Configuration. The backup 
client console or .veg file must have the same number of lines the server console or .veg file does. 

The top half of the page, shown in Figure 211, is exactly the same as the setting for a Stand Alone Console or for a Server 
Console. The bottom half of the page is exactly the same as the setting for a client console.

To change settings to a Server Console do the following:

1. From the menu bar select Edit|Setup P25|DFSI.
The P25 DFSI Global Setup window appears.

2. Click the Client & Backup Server Console radio button to make the console type Client and Backup Server.
Client & Backup Server Console is now the console for the system.

3. From the menu bar, select Edit|Setup Per Line Parameters.
The Per Line Parameters window appears.

4. From the Line Type drop down menu, select P25-DFSI. 

Fixed Station (FS) Connections (For Backup Server) Group Box

The Fixed Station (FS) Connections (For Backup Server) group box is used to connect with the backup FSI if the Server 
Console fails to receive heartbeats from the Primary FSI.

FIGURE 211. P25-DFSI Client Console with Server Backup
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Address of Fixed Station (For Backup Server) Group Box

Control Unicast Address of FS Field

The Control Unicast Address of FS field is used to enter an IP Address of the P25 base station.

Control Port of FS Field

The Control Port of FS field is used to enter the port number of the P25 base station.

NOTE: The Control Port of FS field must match the DFSI Control Port of the base station.

The range for this field is 1054 to 65536.

Voice Address of Fixed Station (For Backup Server) Group Box

Voice IP Address of FS Field

The Voice IP Address of FS field is used to enter the IP Address of the P25 base station.

Voice Port of FS

The Voice Port of FS field is used to enter the voice port number of the P25 base station. The Voice Port of FS field must 
match the voice port number configured in Daniels P25 base station and unique for Tait P25 base station.

The range for this field is 1054 to 65536.

Backup Enabled Check Box

The Backup Enabled check box enables the backup FS setup button. 

Backup FS Setup Window

The Backup FS Setup button opens the Backup Fixed Station Setup window.

To open the Backup Fixed Station Setup window, do the following:

1. Select the Backup Enabled check box. 

2. Click Backup FS Setup.
The Backup Fixed Station Setup window appears.

3. Configure your backup station.

NOTE: If connection is lost to a Fixed Station, C-Soft automatically switches to the Backup Fixed Station, if Backup 
Enabled is selected.

4. Restart C-Soft to return to the original Fixed Station.
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Client Connections Group Box

The Client Connections group box is used to configure per-line signaling setup address fields.

Control Address of Server Group Box

Control Unicast Address of Server Field

The Control Unicast Address of Server field is used to enter the IP Address of the server PC.

Control Port of Server Field

The Control Port of Server field is used to enter the port address of the server control port for this line. 

NOTE: The Port Address must match the value setting of the Server Control Port on the Server Console setup.

Voice Address of Server Group Box

Rx MCA Field

The Rx MCA field displays the RX Multicast Address and Port that the server and clients use to receive P25 voice (a different 
value for each line). The MCA and ports must match the MCA and ports you entered in the server console. 

Tx MCA Field

The Tx MCA field displays the TX Multicast Address and Port that the server and clients use to transmit P25 voice (a 
different value for each line). The MCA and ports must match the MCA and ports you entered in the server console. 

P25 Manufacture Drop Down Menu

The P25 Manufacture drop down menu is used to select the manufacturer of the repeater.

Available selections for this field are:

Daniels

Tait

IMPORTANT: Since there may be small differences between radio designs this field is important to insure C-Soft 
works correctly with the repeater.

Channel Setup Button

The Channel Setup button is used to open the DFSI Channel Table window. For more information, see “Server Console” on 
page 386.

The Channel Table window displays all of the channels open for a selected line.
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Channel Table Window

The Channel Table window, shown in Figure 212, is used to view channel information.

To open the Channel Table window, do the following:

 > In the Per Line Parameters window with P25 DFSI line type selected, click the Freqs button.
The Channel Table appears.

Channel Number Column

The Channel Number column displays the physical channel number assigned to the radio.

NOTE: The Channel Number must match the Channel Number set up in the Fixed Station.

Channel Label Column

The Channel Label column displays the name of the channel.

RX-NAC (Hex) Column

The RX-NAC (Hex) column displays the receive NAC (Network Access Code). This code must match the incoming NAC 
from a radio so the audio can be heard on C-Soft. 

NOTE: The RX-NAC must match the RX-NAC set up in the Fixed Station.

TX-NAC (Hex) Column

The TX-NAC (Hex) column displays the TX-NAC (Transmit Network Access Code). 

NOTE: The TX-NAC must match the TX-NAC, set up in the Fixed Station. 

FIGURE 212. DFSI Channel Table
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TGID NAC (Hex) Column

The TGID (Talk Group ID) (Hex) column displays the Talk Group ID for the channel and is an additional filter, used in both 
TX and RX directions.

Analog/Digital Column

The Analog/Digital column displays the type of voice encoding/decoding by the console for the selected channel. 
(A setting of P25 Digital causes the channel to transmit and receive in P25 digital audio).

Analog uses G711 encoding/decoding for both transmit and receive. Mixed mode receives in either analog or digital and 
transmit audio is selectable (analog or digital) via a user defined button.

Available selections are:

P25 Digital - The channel transmits and receives in P25 digital audio

Analog - The channel transmits and receives using G711 encoding/decoding.

Mixed Mode - Receives audio in either analog or digital. Transmit audio is selectable (analog or digital) through the 
use of a user-defined button.

RX Block Lines Panel

The RX Block Lines panel is used to select lines that have their receive audio blocked when having their configurations 
modified. This allows the console operator to transmit on a radio that has overlapping coverage with other radios, without 
getting feedback from the radios receiving the transmitted signal. 

NOTE: This function also operates when a parallel console is transmitting on the line.

To mute a line during transmission, do the following:

1. From the RX Block Lines panel, select the lines you want to block
The line is highlighted.

2. Click the line(s) a second time to clear the selection.
The line is no longer highlighted.

Load File Button

The Load File button is used to load a saved Channel Table from an Exel file.

The Excel file shows as a .csv file.

Save File Button

The Save File button is used to save the Channel Table to an Excel file.    

The Excel file shows as a .csv file.

Add Channel Button

The Add Channel button is used to manually configure another line.
Bosch Security Systems, Inc. Technical Manual F.01U.218.561 Rev 03



C-Soft Technical Manual   397
Delete Channel Button

The Delete Channel button is used to delete a channel from the channel table.

To delete a channel, do the following:

1. From the Channel Table, highlight the channel row to be deleted.

2. Click the Delete Channel button.
The channel is deleted.

Edit Global DFSI Parameters Button

The Edit Global DFSI Parameters button is used to open the P25 DFSI Global Setup window. For more information, see  
“P25 DFSI Global Setup Window” on page 379.

The P25 DFSI Global Setup window is where the type of console required for the system is selected.

Setting Up Additional P25-DFSI Lines

When adding multiple lines, the procedure is repeated from above

IMPORTANT: When setting up multiple lines, each line must have unique Unicast Addresses, Ports, and Multicast 
Addresses. The only address that is constant among the lines is the IP Address of the Server P.C.
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Adding Buttons to the Design

Once you have created the lines to be used for the P25 system, buttons need to be created on the console. You can assign 
buttons to either individual lines or you can use the preconfigured P25-DFSI Window button.

The P25-DFSI Window button contains all P25 radio/base station functionality in a single pop-up window.

IMPORTANT: Each DFSI line requires one (1) P25_DFSI button; however, only one (1) window is shown, depending 
on the line/button selected.

For a P25 DFSI button without a Select Button, an “S” appears on the button for selected. A “U” appears on the button if 
unselected.

FIGURE 213. DFSI Design Options

FIGURE 214. P25 DFSI - Select and Unselect
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P25-DFSI Misc Page Setup

The P25-DFSI Misc. window is used to change the colors of the buttons.

To add a P25-DFSI button to the console, do the following:

1. From the Insert menu, select Add UI button.
A None button appears on the console window.

2. Right-click the None button.
A shortcut menu appears.

3. From the short cut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select P25-DFSI Window.

5. Click the P25-DFSI Misc. tab.
The P25-DFSI Misc. Page appears.

Misc Group Box

Enable P25-DFSI Dispatch Window Check Box

The Enable P25-DFSI Dispatch Window check box is used to enable the P25-DFSI Dispatch Window. If unselected, the user 
cannot open the DFSI Window in Runtime.

The default is selected.

Receive All Talk Groups

The Receive All Talk Groups check box, if enabled, allows the console operator to be able to hear all incoming Talk Groups 
on that line. When the check box is not enabled, the line mutes all audio not matching the current Talk Group of that line. 

The default is selected.

Receive All Private Calls

The Receive All Private Calls check box, if enabled, allows the console operator be able to hear all Private Calls on that line. 
When the check box is not enabled, the line mutes private calls not directed to the console.

The default is selected.

FIGURE 215. P25-DFSI Misc
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P25-DFSI Radio List Font Size Field

The P25-DFSI Radio List Font Size field indicates the size of the P25-DFSI Radio List Font Size. 

The range for this field is 1 to 99.

The default is 12.

Password Protection Group Box

Radio Monitor Check Box

The Radio Monitor check box, if enabled, indicates the Radio Monitor function is password protected. 

For more information, see “Global Parameter Setup Window” on page 108.

Radio Inhibit/Uninhibit Check Box

The Radio Inhibit/Uninhibit check box, if enabled, indicates the Radio Inhibit/Uninhibit function is password protected.

For more information, see “Global Parameter Setup Window” on page 108.

Call Alert Check Box

The Call Alert check box, if enabled, indicates the Call Alert function is password protected.

For more information, see “Global Parameter Setup Window” on page 108.

Vote Select/Disable Check Box

The Vote Select/Disable check box, if enabled, indicates the Vote Select/Disable function is password protected.

For more information, see “Global Parameter Setup Window” on page 108.
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Dispatch Window Config Button

The Dispatch Window Config button is used to change the color of the buttons and background of the Dispatch Window. 
See Figure 216.

FIGURE 216. Dispatch Window
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P25-DFSI Window and C-Soft Runtime:

The P25-DFSI window is the general control of a DFSI line.

Clicking on the P25-DFSI button in Figure 213, during runtime, opens the window shown in Figure 217.

Main Control Page

The Main Control page is used to change the settings of the main control.

Channel Drop Down Menu

The Channel drop down menu is used to select the channel.

Volume Slider

The Volume slider is used to increase or decrease the volume of the P25 audio. 

Group Call Button

The Group Call button is used to make a group call to the group ID in the ID box.

Talk Group Field and Drop Down Menu

The Talk Group drop down menu is used to place group calls to the group selected from the list. The text above the drop 
down menu displays the selected value.

Private Call Button

The Private Call button is used to initiate a Private Call to the radio ID in the ID box.

Private Call Drop Down Menu

The Private Call drop down menus is used to place private calls to the radio selected form the list.

Mute Button

The Mute button is a latching button (press it, it stays muted, press again, it unmutes).

FIGURE 217. DFSI 1: Channel 1 - Main Control
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Selected Button

The Selected button changes the current line from Selected Audio to Unselected audio.

Digital Button

The Digital button is used to toggle the channel between Analog and Digital.

IMPORTANT: The channel must be configured for mixed mode. For more information, see “Analog/Digital Column” 
on page 396.

Repeat On Button

The Repeat On button is used to turn the base stations Repeater functionality On or Off.            

Monitor Off Button

The Monitor Off button is used to enable or disable monitor mode directly over the DFSI.       

Keypad Flyout

The Keypad flyout is used to manually select unit IDs for a private call.

Unit Control Page

The Unit Control page us used to send unit specific commands.

FIGURE 218. DFSI 1: Channel 1- Main Control Keypad
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ID List Flyout

The ID List flyout contains all the Unit IDs and Group IDs setup for P25-DFSI. The ID List flyout is used to access the 
preprogrammed Unit ID and Group ID list.

Date Column

The Date column is used to show the historical date commands were sent.

Time Column

The Time column is used to show the historical time commands were sent.

Freq Column

The Freq column is used to show the frequency that was sent.

Status Column

The Status column is used to show the status that was sent.          

TG-NAC Column

The TG-NAC column is used to show the identifier number for the radio call.

Source ID Column

The Source ID column is used to identify the number of the calling subscriber unit.

Target ID Column

The Target ID column is used to identify the number the source ID is calling.

FIGURE 219. DFSI 1: Channel 1 - Unit Control
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Radio Check Button

The Radio Check button is used to verify if the radio is currently online and functional.

Status Request Button

The Status Request button is used to read the Status of a Radio.

Radio Inhibit Button

The Radio Inhibit button is used to disable a radio from use. This feature can be used in the case of a lost or stolen radio.

Call Alert Button

The Call Alert button is used to send an alert to the selected remote radio.

Radio Monitor Button

The Radio Monitor button is used to monitor the selected remote radio.

Radio Uninhibit Button

The Radio Uninhibit button is used to enable the radio for use. This feature is used to enable a radio if it has been disabled 
with the Radio Inhibit button.

Text Message Button

The Text Message button is used to send the selected Text Message from the drop down menu to the selected radio.

FIGURE 220. DFSI 1: Channel 1 - Unit Control - ID List
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Voting page

The Voting Page is used to provide a visual representation of voter status.

Receiver Column

The Receiver column is used to display the various voting receivers that are being used.

Vote State Column

The Vote State column display the status of the various voting receivers.

Report Button

The Report button is used to view the current Vote State of the receiver selected in the ID box.

Normal Button

The Normal button is used to set the receiver into normal state.

Select Button

The Select button is used to select the receiver to use.

Disable Button

The Disable button is used to disable the receiver input at voter.

FIGURE 221.  DFSI 1: Channel 1 - Voting
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Repeater Page

The Repeater page shows the current state of all P25-DFSI lines setup in C-Soft.

When a line is selected, if the call is a Group Call, the PTT Button turns into a Group Call button. If the call selected is a 
Private Call, the PTT Button becomes a Private Call button.

History Page

The History page is used to show the historical information for traffic on the line.

Emergency ACK Button

The Emergency ACK button is used if an emergency is received on the P25-DFSI line, it can be ACKed by pressing the 
Emergency ACK button.

Alert Cancel Button

The Alert Cancel button is used to ignore a Call Alert on the P25-DFSI line.

FIGURE 222. DFSI 1: Channel 1 - Repeater

FIGURE 223. DFSI: Channel 1 - History
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System features and requirement for DFSI interface:

Supported DFSI Repeaters:

NOTE: For the most up to date information on repeater support, go to www.telex.com.

• Tait

• Daniels

Supported DFSI Repeater Functions:

NOTE: For the most up to date information on supported DFSI repeater functions, go to www.telexradiodispatch.com.

• Channel Change

• Repeat mode

• Monitor

• Voting

Supported DFSI Radio Functions:

NOTE: For the most up to date information on supported DFSI radio functions, go to www.telexradiodispatch.com.

• Digital\Analog\Mixed Mode

• Radio Check

• Radio Inhibit

• Radio Un-inhibit

• Status request

• Call Alert

• Radio Monitor

• Private Call

• Group Call

Required for C-Soft Setup

• C-Soft 6.100 or higher

• Dongle with P25-DFSI Key or ADHB-4 with P25-DFSI optional code enable
 (Increments of 2 P25-DFSI Lines)

• Tait or Daniels Repeater

• IP Addresses and Ports of Repeater

Optional for C-Soft Setup:

• Network Recorder (Used for recording P25-DFSI audio)
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Frequently Asked Questions
1. P25-DFSI Line of Server Console won’t connect to Fixed Station:

a. Check the Control Unicast Address of FS and Control Port of FS in the P25-DFSI Setup.

2. P25-DFSI Line of Client Console won’t connect to Fixed Station:

a. Check the Control Unicast Address of Server and Control Port of Server in the P25-DFSI Setup.

3. The wrong channel selected is shown.

a. Check the P25 Manufacture in the P25-DFSI Setup.
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